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ACID Music Studio 11
Copyright © 2018 MAGIX Software GmbH
All Rights Reserved

ACID Music Studio software is a DAW powerhouse that combines multitrack recording,   MIDI sequencing, and 
legendary ACID looping functionality into a seamless   music and post-production environment. ACID inspires you 
like nothing   else. Fast and intuitive, it's more like a creative partner than a production   tool.
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New features
 l 32 and 64 bit program version
 l New user interface skin
 l New virtual instruments:

 o Pop Drums
 o Vita Rock Drums
 o Vita Drum Engine
 o Vita Urban Drums
 o Concert Grand
 o Vita Electric Piano
 o VITA 2
 o DN-e1

 l New effects
 o essentialFX: Some essential bread-and-butter effects for your daily need: Limiter, Chorus/Flanger, Phaser, 

Stereo Delay.
 o Track analog compressor am|track SE.
 o Vandal SE guitar amp simulation

 l New loop content
 l Event Effects: All plugin-effects can now also applied on single events on the track.
 l Event grouping: Combine events from the same or different tracks to groups for easier editing.
 l Customizable Keyboard shortcuts

 

New features in ACID Music Studio 7
In case you missed the version before, here are the features that were new in Version 7

Fundamentals
 l Interactive Tutorials.
 l External control surface channel tracking.
 l Custom labels for ASIO drivers and ports.
 l Support for opening and rendering FLAC files.
 l Support for rendering AC-3 files with the Dolby Digital AC-3 Studio plug-in.

Mixing and Editing
 l Mixing Console window for a traditional hardware-style mixer view.
 l Audio routing enhancements:

 o You can now route busses to assignable effects via the Mixing Console window .
 o You can now route busses to multiple sends via the Mixing Console window.
 o If you want to apply track panning to bus or assignable FX sends, right click the bus or FX fader in the track 

header and choose Link to Main Track Pan from the shortcut menu.
 l The Track Prefader  Sends Listen to Mute check box in Preferences > Audioenables pre-volume sends from 

tracks to busses and assignable effects to respond to the track mute state.

New features 9



 l Input busses allow you to record from external devices with effects, mix external audio sources with your pro
ject, use external effects processors with your tracks and busses, and provide input monitoring.

 l Real-time rendering.
 l Audio, MIDI, and bus tracks now include output meters.
 l Tempo curves between tempo markers.
 l Enhanced timestretch and pitch shifting for Beatmapped clips with élastique Pro.
 l Metronome count-off.
 l Enhanced Beatmap markers for clips with multiple tempos.
 l Phase, normalization, and channel control for audio clips.
 l You can now invert the phase of audio tracks.
 l Mute and lock event switches.
 l You can now drag events across tracks to create and move clips.

MIDI and Effects
 l MIDI track freeze.
 l Enhanced plug-in management.
 l Improved plug-in scanning via the Plug-In Manager.

Interactive Tutorials
From the Help menu, choose Interactive  Tutorials to start an interactive guide that will show you each   part of the 
ACID interface and teach you how to create a project.
Choose a topic from the Interactive Tutorials overview   to start a tutorialyou'll be up and running in no time! —

Technical Support
If you experience problems or have questions   while using ACID software, our technical support department is   
always ready to help you. Additional support and information about Sound   Forge software and other MAGIX 
products can be found on the MAGIX Web site.
For a detailed list of Technical Support options, please   visit the Support page on our Web site.
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Acid Music Studio restrictions
This manual is written for both versions of ACID,  ACID Music Studio (the program you are using right now) and 
ACID Pro, the bigger brother of ACID Music Studio.The following functions from ACID Pro are not available in 
ACID Music Studio:

 l External control surface support
 l 5.1 Surround mixing
 l Rewire mixer/device functionality
 l MIDI piano roll editor, editing of MIDI clips is done by Inline Editing
 l Automation recording
 l Real-Time Rendering
 l Groove Pool, Groove Strip,Groove Files loading
 l Input Busses
 l Loop Export
 l MIDI Synchronization
 l Video output on external monitor
 l Program Map editor
 l MIDI Merge recording
 l Vita Sampler

Less content and effects are available in ACID Music Studio:

 l Instead of 25 Vita Solo Instruments, only 6 are available
 l Only four essentialFX (Limiter, Chorus/Flanger, Phaser, Stereo Delay) instead of 11.
 l Less loop content

Acid Music Studio restrictions 11



The ACID Window
The ACID window is divided into four main areas.

The   track list, timeline, and window docking area can be sized to your preferences   by dragging the dividers 
between them.

The Timeline
The majority of the track   view   is made up of the timeline where you will draw events on each track. However,   there 
are other aspects of the timeline to become familiar with.
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The Beat Ruler
The beat ruler is displayed along the top of the timeline. This timeline   will allow you to place events in reference to 
the musical time of measures,   beats, and ticks (ticks are visible when you zoom   in). 
This timeline changes only when you change time   signature. Tempo changes will not change the beat ruler; this 
allows   events to maintain their size when the tempo is adjusted.

Beat ruler

Time ruler

In the sample image, 1.1 represents beat one   of measure one, and each ruler mark represents one beat. The scale of   
the beat ruler varies depending on the zoom level of the timeline. 
If you want to view the timeline in a scale   other than measures, beats, and ticks, you can use the time   ruler.

Scroll Bars
The scroll bars allow you to scroll through your project and change   its magnification.
The horizontal scroll bar is displayed below the time ruler.   Drag the scroll box to pan left or right through the project.

The scroll box also functions as a zoom control. Drag   the edges of the scroll box to zoom in and out, or double-
click the scroll   box to zoom out so that the entire length of the project will be displayed.

The vertical scroll bar is displayed on the right side of   timeline. Drag the scroll box to pan up and down through the 
project.

Double-click the scroll box to zoom the project out   so that as many tracks will be displayed as possible. 

Zooming and Magnification
From the View menu, choose Zoom, and choose a command from the submenu   (or use the controls in the lower-
left corner of the timeline) to change   the magnification level of your ACID project.

Double-clicking   the Zoom button    in the corner   of the timeline adjusts the horizontal and vertical 

magnification so that   as much of the project is displayed as possible.

Zoom in or out quickly

From the View menu, choose Zoom   and choose a command from the submenu to change the magnification of the   
timeline.

Item Description

Normal  
(F9)

Restores the   project’s magnification to the default settings. This feature is   useful for quickly zooming 
to a reasonable level when you are zoomed in   or out to the magnification extents.                         

Edit  
(Shift+F9)

Restores the   track height zoom to a level where all track list edit controls are visible.   This feature is 
useful when you want to edit using the track list but   do not want to change your time-zoom 
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magnification.                         

Overview  
(Ctrl+F9)

Reduces the   magnification of the timeline so that the entire length of the project   and as many tracks 
as possible are displayed.                         

Zoom in to track height             

 l Click   to increase the track height zoom level to show more event detail.

 l Click  to decrease the track height zoom level to   show more tracks.

 l Click and drag the area between   the  and  buttons to increase or decrease track height zoom level.

Zoom in to an event             

 l Click  to increase the horizontal zoom level to show more event detail.

 l Click  decrease the horizontal zoom level to show   more of the timeline.

 l Click and drag the area between   the  and  buttons to zoom in or out on the timeline.

Zoom in to a selection

Click the Zoom   button in the corner of the timeline to temporarily change the cursor   into the Zoom tool. Select an   
area of the timeline that you want to magnify, and the cursor will revert   to the previously active tool.

 

Transport Controls
Item Description

Record Click to start recording   into all armed audio and MIDI   tracks.

Loop  
Playback

Click to toggle   looped playback mode. When the button is selected, only the portion of   
the current project within the loop region  will be 
played back.                     

Play  from 
Start

Click to start   playback from the beginning of the project regardless of the current cursor   
position.                     

Play Click to play   back the project from the current cursor position.                     

Pause Click to stop   playback and leave the cursor at its current position. Click again to   resume 
playback.                     
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Stop Click to stop   playback and return the cursor to its starting position.                     

Go  to Start Click to move   the cursor to the start of the current project.                     

Go  to End Click to move   the cursor to the end of the current project.                     

MIDI Step   
Record

Click to open the MIDI   Step Record dialog, where you can record by specifying the interval   
between MIDI notes. Step recording allows you to record notes with very   precise timing.

MIDI 
Merge   
Record

Click to enable MIDI   merge recording to build a MIDI part by recording repeatedly into   a 
loop region. MIDI merge data is recorded in real time, and you can add   more notes or 
MIDI controller data each time recording passes through   the loop region.

Metronome Click to use the metronome   during playback or recording.

Metronome   
Countoff

Click the button to turn metronome   countoff on or off, or click the down arrow next to the 
button to set   countoff options.
Metronome countoff allows   you to use the metronome to count off a set number of bars 
before beginning   recording or playback in the same way a drummer counts off with her 
sticks   before the band starts playing.
For more information about   using and confuguring metronome countoff, please see the 
Metronome   help topic.

The Track List
The Track List   contains the master controls for each track. From here you can adjust   the mix, select playback devices, 
and reorder tracks.

The Window Docking Area and Floating Window Docks
The lower half of the ACID window is the window docking area. You can   use this area to keep frequently used 
windows available, but out of the   way, while you are working with a project.
You can also create multiple floating docks to organize your ACID windows.   These docks can float over the ACID 
window or    if you have a dual-monitor video card    on a secondary monitor.——
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 l To dock   a window, drag it to the docking area or a floating dock.
 l To undock   a window, click the handle  and drag it out of the docking area or floating   dock.

 l To prevent   a window from docking when you drag it, hold the Ctrl key.
 l To expand   a docked window so it fills the docking area, click the Maximize   button .   Click again to restore the 

window to its previous size.
 l To remove   a window from the docking area, click the Close   button .

You can dock several windows in the same area of the screen, and the   windows will be layered. Click a window’s tab 
to bring it to the top.

The Toolbar
From the View menu, choose Toolbar to toggle the display. A check mark is displayed next to the Toolbar 
command when the toolbar is displayed.
The toolbar contains buttons that enable you to select frequently used   commands quickly. You can customize   it by 
adding, removing, or reordering buttons.

Item Description

New Click to open   a new project. You will be prompted to save any changes to the current   project.                     

Open Click to display the Open File dialog.   From this window, you can browse all of the available 
drives to select   an ACID project or audio file to open.                     
If you choose   an ACID project and there is an unsaved project currently open, you will   be 
prompted to save your changes first. If you choose an audio file, the   file will be opened as a 
new track in the current ACID project.                     

Save Click to save any changes to the current   project.                     
The first   time you save a project, the Save As dialog is displayed.                     

Publish Click to publish   your project to the Web.

Get  Media 
from the 
Web

Click to open the Get Media   from the Web dialog, where you can search for media files that 
you can   use in your ACID project.

Cut Click to clear   the selected events from the timeline and place them on the ACID clipboard.   You 
can then paste them to a new location.                     

Copy Click to create   copies of the selected events on the ACID clipboard. You can then paste   them 
to a new location on the timeline.                     

Paste Click to insert   the contents of the ACID clipboard at the current cursor position. The   pasted 
events will cover any existing events. To make room for the pasted   events, choose Paste  
Insert from the Edit menu.                     

Undo Click to reverse   the last action performed. You can perform unlimited Undos, allowing you   to 
restore the project to any state since the last Save command.                     

Redo Click to reverse   an Undo command.                     

Enable  
Snapping

Click to turn the snapping   feature on or off. 
When this   button is enabled, the Grid  Only command is available on the   Options menu 
(Options > Snapping > Grid Only) to allow you to indicate   which elements in the timeline can 
be used as snap points.                     
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Automatic   
Crossfades

Click to turn automatic crossfades on or off.
When this button is enable,   crossfades are created automatically when you overlap events.

Lock  
Envelopes 
to Events

Click if you   want envelope points and position to move with an event when it is moved   along 
the timeline.                     

Ignore 
Event 
Grouping

Select this button to override event groups without removing the groups. For more 
information, see "Grouping Events" on page 95.

Enable   
Inline MIDI 
Editing

Click to edit   MIDI data directly on the timeline in a piano roll or drum grid view.

Draw  Tool Click to select the Draw   tool.

Selection  
Tool

Click to use the Selection   tool.

Paint  Tool Click to use the Paint tool. 

Erase  Tool Click to use the Erase tool. 

Envelope  
Tool

Click to use the Envelope   tool.

Time  
Selection 
Tool

Click to use the Time Selection   Edit tool. 

Groove   
Tool

Click to use the Groove tool.

Grooves   cannot be applied to Beatmapped   tracks.

Groove   
Erase Tool

Click to use the Groove Erase  tool. 

The Status Bar
From the View menu, choose Status Bar to toggle   the display of the Status Bar (located at the bottom of the 
timeline).   
The Status Bar displays text help   when your mouse is over menu items and will also show progress meters   for any 
actions that take time to complete. Click the Cancel   button to stop an in-progress operation.

The RAM meter   on the Status Bar shows the amount of used and total RAM in your computer.   
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Working with Projects
A project (.acd)   file saves the relevant information about your source media: file locations,   edits, insertion points, and 
effects.
A project file is not a multimedia   file. It contains pointers to the original source files, so you can edit   your project 
nondestructively  you can be creative without worrying   about corrupting your source files.—

Creating a Basic ACID Project
ACID is a full-featured digital audio workstation (DAW), but its simple   pick/paint/play model makes it easy to 
create ACID projects from scratch.

 1. Create a new project   file.
A project file is like your canvas and palette: it's not a multimedia   file, but it contains information about all the 
media in your project,   how the media is arranged, effects, and so on. A project file lets you   edit without worrying 
about changing your source media files.

 2. Choose the media that you want to use in your project.   Your media can come from any number of sources:
 l You can add   media files from your computer.
 l You can record   audio to add vocals or instruments to your project.
 l You can record   MIDI to add notes from a keyboard or other MIDI controller to your   project.
 l You can download media from the Web.

 3. Drag files from the Explorer window, or Windows   Explorer to create events. Events indicate where you want to 
play each   media file. 
When you drag files to an area of the timeline that does not contain   a track, a new track is created. If you drag a 
file to an existing track,   the file is added to the track as a new clip.

When we drag a loop from the Explorer window   to a 
blank portion of the timeline, a track is added to the 
project, and   an event is created where we drop the loop.

 4. Click and drag in the timeline with the Draw Tool  or Paint   Tool    to create events:

Events are drawn in the timeline as you   drag: the 
event starts where you click and ends where you 
release the   mouse button.
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 5. Edit the   events on the timeline as needed.  You can move events, adjust their length, or edit properties to fine-tune   the sound of your 
project.

 6. Save your project.
 7. Deliver your project in its final format:

 l You can render   a file if you want to create a video or audio file.
 l You can burn   CDs.

Starting a New Project
From the File menu, choose New.   The Project Properties dialog is   displayed so you can enter information about your 
project, and the new   project is created using those settings.
If you have an unsaved ACID project open, you will be prompted to save   your changes first.

Click   the New button     on the toolbar (or hold the Shift key while choosing New   from the menu) to skip the 

Project Properties dialog and use the previously   selected project settings.

Project Properties
From the File menu, choose Properties to display the Project Properties dialog,   where you can adjust settings for 
your project and establish default settings   that will be used for all new projects.

Summary             
The information on the Summary tab is saved with the ACID   project and can be displayed by media players when 
you render   your project in different file formats.

Item Description

Title Enter the   title of the project.                         

Artist Enter name   of the artist who performed in the project.                         

Engineer Enter the   name of the person who mixed or edited the project.                         

Copyright Enter copyright   information about the project.                         

Comments Enter any   comments you want to associate with the project.                         

Universal  Product 
Code (UPC) / 
Media Catalog 
Number (MCN)  

Universal Product   Codes (UPC) or Media Catalog Numbers (MCN) can be written to a 
disc-at-once   audio CD as a means of identification. However, not all CD-R drives   support 
this feature. Check your CD-R drive documentation to determine   if your drive will write 
these codes.
Enter   the code in this box, and the codes will be written to the CD along with   the rest of the 
project.                         
Universal   product codes are administered by the Uniform Code Council. 

Start  all new 
projects with these 
settings

Select this check box to   use the current dialog settings as the default.

The Universal  Product Code (UPC) / Media Catalog Number (MCN)   setting is a 
unique value and will not be used for new projects.                         

Audio
Use the Audio tab to change the data format for the current   project.
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When ACID software is connected to a ReWire   mixer application, the ACID project will automatically use the 
mixer   application's bit depth and sample rate. Saving the ACID project in ReWire   mode will not overwrite the 
project's original bit depth and sample rate.

Item Description

Master  
bus mode

If   you're using ACID Music Studio, choose Stereo from the drop-down list  to create a two-channel 
stereo project.
Choose   5.1 Surround if you want to perform  advanced 5.1-channel mixing. More...

Number of 
additional 
stereo 
busses

If you're using ACID Music Studio, enter the number of stereo busses   for the project. More...

Sample  
rate

Choose   a setting from the drop-down list to specify the sample rate   of the project.

Bit  depth Select   a setting from the drop-down list to specify the number of bits used to   store each sample. 
Higher values will increase the quality of playback   and any recordings that you make.

Enable 
low-pass 
filter  on 
LFE
 

Select this check box if you want to   apply a low-pass filter to each track in a 5.1 surround project that 
is   assigned to the LFE channel.                         
Applying a low-pass   filter approximates the bass-management system in a 5.1 decoder and ensures   
that you're sending only low-frequency audio to the LFE channel.                         

Before rendering   your surround project, check your surround authoring application's 
documentation   to determine its required audio format. Some encoders require a specific   cutoff 
frequency and rolloff, and your encoder may require that no filter   be applied before encoding.                         

Cutoff  
frequency 
for low-
pass filter

Choose a frequency   from the drop-down list or type a frequency in the box   to set the frequency 
above which audio will be ignored by the LFE channel.                         

Low-pass  
filter 
quality

Choose a setting   from the drop-down list to determine the sharpness of filter's rolloff   curve. Best  
produces the sharpest curve.                         

Recorded 
files folder

This   box displays the path to the folder that will be used when you record new audio or MIDI tracks. 
Choose <Project> to save recorded files  in the same folder as your ACID project file, or click the 
Browse   button to choose a different folder.
The   recorded files folder from the Folder   tab of the Preferences dialog is used by default unless you 
choose a project-specific   location. If you select the Start all  new projects with these settings check 
box, the setting on the   Folder tab of the Preferences dialog will be updated to use the folder   specified 
in the Project Properties dialog. 

Start all 
new 
projects
with these 
settings

Select   this check box to use the current dialog settings as the default.                         

The Explorer Window
The Explorer window allows you   to view and access your media files without leaving the ACID workspace.   You may  
preview media files  and place media files in your project   from the Explorer window.
From the View menu, choose Explorer to toggle   the display of the window.

20

www.magix-audio.com



You   can also use the Get   Media from the Web  to find media to use in your project.

Learn more about the   Explorer window             

Item Name Description

Address  
Bar

Displays the   current folder. You may also specify a file type to display. To 
specify   a file type, make sure that All Files is not selected in the Views   
button menu and click in the combo box. Type the wildcard followed by   
the extension. For example, *.wav or ?intro?.avi

Tree  
View

Displays all   of the available files and folders where you can find media 
files.                         

Contents  
Pane

Displays the   folders and media files contained in the active folder.                         

Up Opens the   folder one level above the active folder.                         

Refresh Refreshes the contents of the active   folder.                         
If you insert   a new CD (or other removable media), click to refresh the 
Explorer.                         

Add  to 
My 
Favorites

Adds the selected   folder to the My Favorites folder for quick access.                         

Start  
Preview

Plays the   selected media file.                         

Stop  
Preview

Stops the   playback of the selected media file.                         

Auto  
Preview

Automatically   preview media files when you click them in the Explorer 
window.                         

Views Allows you to change the way the files are   viewed in the list view.

Tree 
View

Displays all of the available drives and folders   that you may 
choose from to find files.

Summary 
View

Displays a short description of the selected   media file at the 
bottom of the Explorer window.

Details Displays the file size, date and when the   file was last 
created or last   modified.
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All Files Displays all file types in the active folder.

Preview a file             
If the Auto  Preview button  is selected, you can click a file   in the Explorer window to preview it. Click the Stop  

Preview button  to stop the preview, or turn off the preview feature by deselecting   the Auto  Preview button.

When the Auto Preview button is not selected, click the Start Preview button    to hear a loop.

You can preview loops   during project playback to help you decide which loops work well together.   Begin by 
playing the project,   and then select any loop to preview. The selected loop will play in sync   with the rest of 
project. If you like the loop, double-click it to add   it to the project. If you do not like the loop, simply choose 
another   to preview.

Very small files that   have not been optimized may not preview correctly. If the file’s tempo   is not estimated 
correctly, it must be optimized   first for proper results.

Preview multiple selected files sequentially             
When the Enable  multiple-selection preview in Explorer window check box is selected   on the Other tab of the 
Preferences   dialog (Audio tab in ACID Music Studio   software), you can select multiple files in the Explorer, and they 
will   be played back in order when you click the Play   button (or   when the Auto Preview   button  is selected).

Each file's icon will change to a play icon  during playback. Press Ctrl+Enter to add   the currently playing file to the 

timeline, or press Enter to add all   selected tracks. 
Tips:

 l Use   the Other tab in the Preferences dialog (Audio tab in ACID Music Studio   software) to indicate how long 
each file should play.

 l When   you're playing back a selection in looped   playback mode, this feature will help you find the perfect loop to   
match your project.

Adjust preview volume             
Drag the Preview   fader in the Mixing Console window   to adjust preview volume.             
This setting also controls   the loudness of media played through the Chopper   window and Beatmapper Wizard.   
When adding media to the project, the new track's volume is set to the   preview volume.             

If the Preview   fader is not displayed, right-click the Mixer and choose Show  Preview Fader from the shortcut 
menu.

Add tracks to a project or add clips to a track             
Adding tracks             

Double-click a file in the Explorer   or drag it to an area of the timeline that does not contain a track to   add it to your 
ACID project and create a   track.
Right-click   and drag a file to the timeline or track list to specify the type of track   that will be created. When you drop 
the file, a shortcut menu is displayed   that allows you to choose whether the file will be treated as a loop,   one-shot, 
Beatmapped track, or as an autodetected type.             
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Until you set a default track volume in the   Set Default Track Properties   dialog, the setting of the Preview   fader 
will determine the volume of new tracks. 

Adding clips             

Drag a file from the Explorer   to an existing track in the timeline to create a new clip   and set the new media file as the 
active clip.

Tips:

 l Before using long media (one-shots   or Beatmapped tracks) from CDs or shared network folders, copy the 
media   to your local drive for the best possible performance.

 l To add multiple files to the timeline,   Ctrl+click (or Shift+click) to select the files and drag them to the timeline   or 
track list.

 l To add a track from an audio CD, browse   to your CD drive and double-click a .cda file (or drag it to the timeline).   
The track is extracted from the CD and added as a track in your ACID project.

 l When   a media file is added to a project from a removable device, a copy of   the media file is stored in a subfolder 
within a temporary files folder.   This keeps the media file available for use even if the source of the   media is no 
longer accessible.

 Be aware that these subfolders are cleared when you close then application.   However, they are not cleared if the 
application closes inappropriately.                     

Add multitrack/multichannel MIDI files
Adding MIDI files to your ACID project is just like adding   audio: you can double-click a MIDI file to create new 
tracks and events,   or you can drag a MIDI file to an existing track to add a new clip.   

When you select a MIDI file in the Explorer   window, its length, tempo, type, and number of tracks are displayed 
at   the bottom of the window:

When you right-click a MIDI file in the Explorer window,   you can choose how you want to add it to your project:

Command Description

Add to 
Project

Adds the file to the current ACID project and   adds tracks to the track list. No events are created. 

 l For   Type 0 MIDI files, a separate track is created for each channel in the   MIDI file, and all tracks 
are organized within a folder track. 

 l For   Type 1 MIDI files, a separate track is created for each track in the MIDI   file, and all tracks are 
organized within a folder track.

When you draw events after adding a file to   your ACID project, MIDI controller data is not 
added to the timeline.   Right-click an event and choose Create  Envelopes from Clip from the   
shortcut menu to represent MIDI controllers as envelopes on the timeline.
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Add  to 
Project with 
Events

Adds the file to the current ACID project at   the cursor position, adds tracks to the track list, and 
creates events   for the MIDI note data on each track. Envelopes   are added to the tracks to represent 
MIDI controller data. 

 l For   Type 0 MIDI files, a separate track is created for each channel in the   MIDI file, and all tracks 
are organized within a folder track. 

 l For   Type 1 MIDI files, a separate track is created for each track in the MIDI   file, and all tracks are 
organized within a folder track.

Add  to 
Project with 
Events 
Rippled

Adds the file to the current ACID project at   the cursor position, adds tracks to the track list, and 
creates events.   Existing events are shifted downstream to make room for your MIDI file.   Envelopes 
are added to the tracks to represent MIDI controller data.

 l For   Type 0 MIDI files, a separate track is created for each channel in the   MIDI file, and all tracks 
are organized within a folder track.

 l For   Type 1 MIDI files, a separate track is created for each track in the MIDI   file, and all tracks are 
organized within a folder track. 

Open as 
New 
Project

Starts a new project, adds tracks to the track   list, and creates events for the MIDI note data on each 
track:

 l For   Type 0 MIDI files, a separate track is created for each channel in the   MIDI file. 
 l For   Type 1 MIDI files, a separate track is created for each track in the MIDI   file.

When you draw events after opening a MIDI   file as a new project, MIDI controller data is not 
added to the timeline.   Right-click an event and choose Create  Envelopes from Clip from the 
shortcut   menu to represent MIDI controllers as envelopes on the timeline.                         

Use the My Favorites folder
Select the My Favorites   folder  or choose   My Favorites   from the Address Bar to view the contents of the My 

Favorites folder.   This folder contains shortcuts to folders that you use often.             

Adding a folder to the My Favorites   folder             

 1. Browse   to the folder you want to add.                     
 2. Right-click   the folder and choose Add  Folder to My Favorites from the shortcut menu. A shortcut to the   folder 

is created.                     

Removing a folder from the   My Favorites folder             

 1. Select   the My Favorites folder.                     
 2. Right-click   the folder you want to delete and choose Delete  from the shortcut menu.

Deleting a folder   from My Favorites deletes only the shortcut to the folder; the target   folder is unaffected.             

ACID Types
There are four types of media that you use in ACID projects: loops,   one-shots, Beatmapped clips, and MIDI clips.
A single audio track can contain any combination of loops, one-shots,   or Beatmapped clips. MIDI tracks   can contain 
only MIDI clips.

Right-click   and drag a file to the timeline or track list to specify the type of clip   that will be created. When you 
drop the file, a shortcut menu is displayed   that allow you to choose whether the file will be treated as a loop, 
one-shot,   Beatmapped clip, or as an autodetected type.
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Loops             
Loops are small audio clips that are designed to create   a repeating beat or pattern. Loops are usually one to four 
measures long   and are stored completely in RAM for playback.
When Event  Information is selected on the View menu, events that use loop   clips display the  icon in the timeline.
Loops are the type of events that you will use most frequently.   Because a loop clip can be drawn continuously across 
the timeline, loops   are very easy to arrange.

One-shots             
One-shots are audio clips that are not designed to loop.   Cymbal crashes, sound bites, and vocals could be 
considered one-shots.   
When Event  Information is selected on the View menu, events that use one-shot   clips display the  icon in the 
timeline.
The main differences between   a one-shot and a loop are that a one-shot will not change tempo with the   rest of the 
loops, will not be transposed to the project key, and is streamed   from disk rather than being loaded into RAM.             

If you've upgraded   from ACID 1.0 or 2.0 software, you'll notice that Disk-Based is no longer   available as a 
media type. Use one-shots for clips that you previously   used as disk-based tracks, and you'll notice increased 
performance during   playback.

Beatmapped clips             
When a file that is longer than thirty seconds is added   to an ACID project, the Beatmapper   Wizard starts to allow 
you to add tempo information to the file. 
When Event  Information is selected on the View menu, events that use Beatmapped   clips display the  icon in the 
timeline.

                  MIDI clips
You can use MIDI clips to play back MIDI files. You can   also route   MIDI tracks to external devices for playback and 
record   data from MIDI equipment. 
When Event  Information is selected on the View menu, the ACID type icon is   displayed on events in the timeline:

 l MIDI clips are displayed with a    icon if the Loop   button  is selected in the Clip   Pool. When this button is 

selected, MIDI clips repeat when painted   on the timeline.
 l If the Loop   button is not selected, MIDI clips are displayed with a    icon. When this button is not selected, 

MIDI clips are painted as one-shots.   

MIDI tracks can use .mid, .smf,   and .rmi files. For more information about adding MIDI   files to your project, please 
see "Adding MIDI Files to a Project" on page 214.

Extracting Audio from CDs
From the File menu, choose Extract  Audio from CD to extract tracks from a CD and open them as tracks   in your 
ACID project.

Double-click   a .cda file in the Explorer window (or drag it to the timeline) to extract   a CD track without opening 
the Extract Audio from CD dialog.
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ACID   software is not intended and should not be used for illegal or infringing   purposes, such as the illegal 
copying or sharing of copyrighted materials.   Using ACID software for such purposes is, among other things, 
against   United States and international copyright laws and contrary to the terms   and conditions of the End User 
License Agreement. Such activity may be   punishable by law and may also subject you to the breach remedies 
set   forth in the End User License Agreement.

 1. From the File menu, choose Extract  Audio from CD.
 2. Choose a setting from the Action   drop-down list to indicate how you want to extract audio:

Item                             Description                             

Read  by 
track

Choose to extract individual   CD tracks. Select the tracks you want to extract in the Tracks  to read 
list. Each CD track is extracted to a new track in your   project.

Read  
entire 
disc

Choose   to extract the current CD to a single file. The disc is extracted to a   new track in your 
project.                             

Read  by 
range

Choose   to extract a time range. You can specify a starting time and ending time   (or a starting time 
and length). The time range is extracted to a new   track in your project.                             

 3. If   you choose Read by track or   Read by range from the Action drop-down list, select the tracks or time range 
you want to extract.                 

Click Play to preview your selection.   In order to preview, your CD drive's audio output must be connected 
to   your sound card, or you can connect headphones to the front of the CD   drive.         

 4. From   the Drive drop-down list, choose  the drive that contains the CD from which you want to extract audio.
 5. From the Speed   drop-down list, choose the rate at which you want to extract audio. If   you experience gapping 

or glitching, decrease the speed or click Configure and adjust  the Audio extract optimization   slider.
 6. Click OK   to start extracting audio.
 7. Type a file name and choose a location for the file.

After the track   is extracted, the Beatmapper Wizard   starts if the track is longer than 30 seconds.                 
Select   the Autoname extracted  tracks check box on the General   tab in the Preferences dialog if you want 
to automatically assign file   names to tracks that you've extracted from CDs. File names will include   the 
CD's identification number and track number, and the files will be   saved in the folder specified on the 
Folders   tab of the Preferences dialog.

Opening a Project or File
From the File menu, choose Open   to display the Open File dialog. From this dialog, you can select an ACID   project, 
media file, or groove map   to open. If you choose to open an ACID project without saving the current project,   you will 
be prompted to save your changes first. If you choose a media   file, the file will be added to the current ACID project 
as a new track.   If you choose a groove map, the groove will be added to your project's   Groove Pool.

Before   using large media files (such as one-shots or Beatmapped   tracks) from CDs or network folders, copy the 
media to a local drive for   the best possible performance.

 1. From the File menu, choose   Open. The Open   dialog is displayed.
 2. Choose the folder   where the file you want to open is stored:    from the Look in   drop-down list or from the Recent   

drop-down list to quickly select a folder from which you have previously   opened files.
 3. Select a file in   the browse window or type a name in the File  name box. Detailed information about the selected 

file is displayed   at the bottom of the dialog box.
 4. Choose a file type from   the Files   of type   drop-down list to limit the files displayed in the dialog.
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Item Description

All  Files Displays all   files in the current folder, including files that are not supported in   ACID.                                 

All  Project, 
Groove, and 
Media Files

Displays ACID project, supported   media files, and groove files.

ACID  
Project Files 
(*.acd, 
*.acd-bak)

Displays only ACID project files. An   ACID project file contains all of the information 
about a single project.   Track layout, envelope settings, and effects parameters are saved 
in this   project file. This type of file does not contain any audio, but only references   to 
audio files.                                 

By   default, backup project files are   created when you open or save. Backup files are 
stored in the same folder   as your project and use the extension .acd-bak. You can 
use these files   to revert to a project's previous state.                                 

ACID  
Projects 
with 
Embedded 
Media 
(*.acd-zip)

Displays only ACID Zip files. An ACID   Zip file contains all of a project's media files and 
the project file   in a compressed format.                                 

When you open an .acd-zip   project, the project file and all media files are copied to a 
temporary   folder. Any changes you make to the project will be saved to the files   in 
this temporary folder until you save the .acd-zip file again. You can   change the 
location of the temporary folder on the General   tab of the Preferences dialog.

ACID 
Groove   
(.groove)

Displays only ACID groove file. A groove file   is a file you can add to your project's 
Groove   Pool to adjust the rhythmic timing of loops, one-shots, and MIDI tracks.

MIDI   
(*.mid, 
*.smf, *.rmi)

Displays only MIDI files.                                 

When you open a multitrack   MIDI file, the file is displayed in a single track in your 
ACID project.                                 

CD  Audio 
(*.cda)

Displays only tracks from audio CDs.   When you open a .cda file, audio is extracted from 
the CD and added as   a new track.                                 

ACID software is not intended and should not   be used for illegal or infringing 
purposes, such as the illegal copying   or sharing of copyrighted materials. Using 
ACID software for such purposes   is, among other things, against United States and 
international copyright   laws and contrary to the terms and conditions of the End 
User License   Agreement. Such activity may be punishable by law and may also 
subject   you to the breach remedies set forth in the End User License Agreement.                                 

Audio  
Interchange 
File Format 
(*.aiff, *.aif, 
*.snd)

Displays   only AIFF files. AIFF files are   a popular format on the Macintosh. 16- and 24-bit 
files of this format   can be added as tracks into an ACID project.                                 

FLAC Audio 
(*.flac)

Displays only FLAC Audio files. FLAC is the abbreviation for "Free Lossless Audio 
Codec". This is a freely savable format that can be used to compress your audio data to 
50% of their original size. Unlike lossy compression methods like MP3 or OGG, the full 
sound quality is kept intact with FLAC.

MP3  Audio
(*.mp3)

Displays only MPEG (Moving Picture Expert   Group) Layer 3 files.                                 

Variable bit rate   MP3 files typically loop more accurately than files encoded with a 
fixed   bit rate.                                 

OggVorbis  
(*.ogg)

Displays only   files encoded with the OggVorbis codec.                                 

Video  for Displays only .avi files.                                 
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Windows 
(*.avi)

You can add   only one video track to a project. If your project already contains a   video 
track, you will be prompted to replace the existing video if you   open another video file.                                 

Wave  
(Microsoft) 
(*.wav)

Displays only   wave files.                                 

Sony Wave 
64 (*.w64)

Displays only files saved using Sony's Wave64 format. Files saved in this format can 
exceed the 2 GB file-size limit imposed by the standard Wave format (if your operating 
system supports files larger than 2 GB).

Windows   
Media 
Audio V9 
(*.wma)

Displays only Windows Media   Audio files.

Windows   
Media 
Video V9 
(*.wmv, 
*.asf)

Displays only Windows Media   Video files.

You can use wildcard   characters to filter the files displayed in the dialog. For example, you   can enter 
*guitar*.wav  to display   all wave files that include the word guitar in the file name.

 5. Click the Open button.

If a media file cannot   be located when you open an ACID project, you can choose to leave the   media offline and 
continue to edit events on the track. The events will   point to the location of the source media file. If you restore 
the source   media file at a later time, the project will open normally. 

Listening to Your Creation
The transport controls allow you to play back your entire project (or   portions of the project). You can also change the 
project tempo   during playback.

Time   compression and expansion is performed on all of the loops in a project   so that they match the project 
tempo. Although the compression/expansion   algorithm is very good, there are some limitations: you will 
probably   not be able to make a 120 bpm loop sound great at 60   bpm. You can use the Stretch tab in the Track   
Properties window to optimize stretching properties.

If your project includes processor-intensive effects, you can   choose Bypass All Audio  FX from the Options 
menu to conserve processing power and avoid   playback problems.

Play from the cursor   position             
Click the Playbutton  to start   playback from the current cursor position.

If the Metronome   button  is selected, the metronome will   keep time during playback.

Play the entire project             
Click the Play  from Start  button  to play the entire project, regardless of   cursor position.

If the Metronome   button  is selected, the metronome will   keep time during playback.
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Play a selection             
With the Time Selection tool , drag along the marker bar to create a time   selection and click the Play button .

If the Metronome   button  is selected, the metronome will   keep time during playback.

If the Loop  Playback button  is selected, the selection will play back repeatedly.   If the Loop Playback   button is 

not selected, playback will stop after the selection is played.

If you create a new selection during playback,   the cursor will move to the start of the new loop region and 
playback   will begin at that point. To adjust the selection without interrupting   playback, drag from the center or 
ends of the loop region.

Loop playback           
Looping a section of your project is useful when you want   to concentrate on a portion of the timeline.
The loop region  defines the playback region. 

 1. Turn on looped playback by   doing any of the following:
 l Select   the Loop Playback   button .

 l From the   Options menu, choose Loop  Playback.
 l Press Q   or Ctrl+Shift+L. 

 2. Click the Play   button  to hear your selection looped

To move the loop region, click between the endpoints of   the loop region and drag the bar to a new position. To edit 
the length   of the loop region, drag either of the endpoints.

If you create a new selection during playback,   the cursor will move to the start of the new loop region and 
playback   will begin at that point. To adjust the selection without interrupting   playback, drag from the center or 
ends of the loop region.

 Shortcuts:

 l Double-click   the inside colored bar of the loop region to force the endpoints to the   extents of the timeline.
 l Hold   the Ctrl key while   clicking to move the start of the loop region to the spot you click, while   preserving the 

length of the loop region.
 l Hold   Shiftwhile clicking to   extend the length the loop region in either direction.
 l Hold   Ctrl+Shift while clicking to move the beginning or end of the loop region   to the spot you click, stretching 

or reducing the length of the region.
 l Hold   Ctrl+Shift+Left Arrow to set the loop region from the cursor to the previous   marker if markers exist or from 

the cursor to the beginning of the project   if no marker exists prior to the cursor.
 l Hold   Ctrl+Shift+Right Arrow to set the loop region from the cursor to the next   marker if markers exist from the 

cursor to the end of the project if no   marker exists after the cursor. 

Metronome
From the Options menu, choose Metronome   if you want the metronome to keep time while you're recording   or 
playing back your project.   

Turn the metronome on or off
From the Options menu, choose Metronome  (or click the  button on   the transport bar) to turn the metronome 
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on or off. 
When you start recording   or playing your project,   the metronome will start playing the project tempo and will follow 
any   tempo or time signature   changes. For example, if you start recording at measure 20 and your project   tempo 
changes at that measure is 160 BPM, the metronome will play at 160   BPM.
The metronome sounds are created by the general MIDI sound   set, and the volume of the metronome is determined 
using the Preview   fader in the Mixing Console.

Notes:

 l The metronome’s sound is not mixed   in the final rendering of the project.
 l Before rendering from a ReWire   mixer application, turn off the ACID metronome, or the metronome will   be 

included in the rendered output.

The metronome will not follow grooves   that you've applied to your project. If you want to hear a grooved 
metronome,   use a simple click loop and apply the desired groove to the track.

Use the metronome to count off for playback or recording
Metronome countoff allows you to use the metronome to count   off a set number of bars before beginning recording 
or playback in the   same way a drummer counts off with her sticks before the band starts playing.
From the Options menu, choose Enable  Metronome Countoff (or click the  button on the transport   toolbar) 

to turn metronome countoff on or off.
You can click the down arrow next to the button to set countoff   options:

Item Description

Enable 
Metronome 
Countoff

Turns countoff on or off.

Countoff 
Always On

Metronome counts off during playback and recording.

Countoff 
Only During 
Playback

Metronome counts off during playback only.
When countoff is turned on for playback only,   the button will display a play icon: 

Countoff 
Only During 
Recording

Metronome counts off during recording only.
When countoff is turned on for recording only,   the button will display a record icon: 

One-Bar 
Countoff

Sets the number of measures before the cursor   position the metronome will count off. 
Countoff always uses the tempo at the cursor position.   In the following example, if you 
positioned the cursor at measure three   and choose Two-Bar Countoff, the   metronome would 
count off for two measures at 120 BPM before reaching   the cursor position:Two-Bar 

Countoff

Four-Bar 
Countoff

Configure 
Metronome

Displays the Audio   tab in the Preferences dialog, where you can choose a metronone sound.
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Adjust the metronome's volume
If you need to adjust the volume of the metronome, drag   the Preview fader   in the Mixing Console.
If the Preview   fader isn't visible, click the Preview  Bus button in the Mixing Console View   pane. 

Changing Tempo, Time Signature, and Key
A project can be played at any tempo, time signature, or key, and you   can make adjustments during playback.
You can add automatic tempo and key changes using tempo, time signature,   and key change markers. These 
markers are added above the marker bar at   the top of the timeline. When the cursor passes over one of these 
markers,   the master project tempo, time signature,   and/or key will change. 
If the Metronome   button  is selected, the metronome will   follow tempo changes during playback   and recording.

Notes:

 l When you   use key change markers, any subsequent events that have a pitch shift   specified will be shifted based 
on the new key.

 l When a MIDI   clip's key is set on the Clip Pool tab of the MIDI   Track Properties window, the project key and key 
change markers are   applied to MIDI clips, and the MIDI   event data will display notes as WYSIWYH (what you 
see is what you   hear).

 l When a MIDI   clip's key is set to None,   the project key and key change markers are not applied to MIDI clips.

Adjust the project   tempo             
Drag the Project  Tempo slider:

Double-click the Project Tempo label   to type an exact value. The text will change to an edit box where you   can 
specify a tempo. Press Enter   when you are finished.

When you click the   Project Tempo   slider, a bar is displayed in each track header to represent the amount   the 
track is being stretched to match the project tempo. The mark in the   center of the bar represents the original 
tempo of a loop.

Change the time signature             
Click the Project  Time Signature control and choose a signature from the menu to   adjust the project's time 
signature.

Choose Other   to display the Custom Time Signature dialog, where you specify the number   of beats per measure 
and which note receives one beat. 
When you change the time signature, the time ruler and grid   spacing are updated accordingly.
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For loop clips, the   software assumes that each beat is a quarter note. When you choose a time   signature in 
which a note other than the quarter note receives one beat,   you can see inconsistencies in loop lengths on the 
timeline. For example,   a five-beat loop occupies ten beats on the timeline in 5/8 time. The same   loop will 
occupies twenty beats in 5/16 time.

When you're working with a   time signature in which a note other than the quarter note receives one   beat, one-
shot tracks will draw correctly on the timeline.

Change the project key             
Click the Project  Key  control and choose a key from the menu to adjust a project's   key:

Each loop clip that has a specified Root note will be   transposed to the key indicated by the Project  Key  control.
For example, if three loops that have root notes  of   A, B and C, and your Project Key control is set   to D, the loops will 
be pitch shifted by 5, 3 and 2 semitones respectively

Add a key, tempo, or time signature change   marker within the project             

 1. Position the cursor where   you want to place the marker.
 2. From the Insert menu, choose Tempo/Key/Time  Signature Change. The   Tempo/Key/Time Signature Change 

dialog is displayed.

Command Keyboard Shortcut

Add key  change marker K

Add tempo  change marker T

Add time  signature marker Shift+K

 3. Select the Key change   check box and choose a new key from the drop-down list if you want to   change the key 
of all tracks until   the software encounters another key change marker.                     

 4. Select the Tempo  change check box and enter a new tempo in the edit box if you want   to change the tempo of 
all tracks until the software encounters another   tempo change marker.

 When you add a tempo change marker, you can choose a setting from the   Transition type   drop-down list to 
indicate how ACID will interpolate tempo between markers.   When you choose Hold,   each tempo marker's 
settings are preserved until a new tempo marker is   encountered (as in previous versions of ACID).

 For more information about using tempo curves, see "Use a tempo   curve to change tempo between markers" in 
this help topic.

 5. 

Select the Time signature change check box and enter new  Beats per measure and Beat value settings   to 
change the time signature at the marker position. The time ruler   divisions and grid spacing will be updated 
accordingly.                     
 

Time signature changes must occur on the first   beat of a measure. If your cursor is not on the first beat of a 
measure,   the marker is placed at the nearest measure.             

 6. Click OK.

Use a tempo curve to change tempo between markers             
When you add a tempo change marker to the timeline, you   can choose to change tempo gradually between markers. 
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Tempo curves are   perfect for ramping tempo up or down.

 1. Add a tempo change marker to the   timeline or double-click a tempo-change marker to edit an existing marker.
 2. Choose a setting from the Transition type drop-down   list to indicate how ACID will interpolate tempo between 

markers:

Transition 
Type

Description Looks Like

Hold No interpolation will take place. The tempo   marker's settings will be maintained 
until the next marker.

Linear Tempo changes between markers in a linear path.

Fast Tempo changes between markers in a fast logarithmic   path.

Slow Tempo changes between markers in a slow logarithmic   path.

Smooth Tempo changes between markers along a smooth,   natural curve.

Sharp Tempo changes between markers along a sharp   curve.

 3. Click OK.

If you want to change the timing resolution   ACID uses to interpolate tempo curves, choose a setting from the 
Tempo curve segmentation   drop-down list on the Editing tab   of the Preferences dialog.

Edit a key, tempo,   or time signature change marker
There are several ways to edit a key/tempo/time signature   change marker:

 l Place the cursor on or after   the marker, and adjust the Project Tempo slider, Project Time Signature, or Project  
Key control. The marker will be updated to match the control settings.

 l Position the cursor before   or after the marker and right-click the marker. Choose Adjust  Tempo to Match 
Cursor to Marker from the shortcut menu. The marker   maintains its position on the beat ruler, and the tempo 
of the project   is adjusted so the cursor matches that position.

 l Right-click a tempo/key   change marker and choose Edit   from the shortcut menu. The Tempo/Key/Time 
Signature Change dialog is   displayed.

 l Double-click the text of   the marker and type the value you want: 

When editing a combination   marker, you do not have to type all three values: for example, if the   current marker 
value is 130,F and you want to edit only the key, you can   simply type A and press Enter. The marker will change 
to 130,A.

Fit to Time
From the Edit menu, choose Fit  to Time to specify an exact length for the ACID project. Your project   tempo is 
adjusted accordingly to conform to the new length.
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The maximum and minimum lengths are limited so your   project doesn't fall outside of the available project 
tempo range of 40   to 300 BPM. 

Project References in Rendered Files
When you save the project path in a rendered   file, you can easily return to the source project if you use your rendered   
file in another project.

The project information in the rendered file is a reference to   a project file only. If you modify the project file after 
rendering, the   project data will no longer match the rendered file. To edit a project   using a path reference, the 
project file and all media must be available   on your computer.

Save the project path in the rendered file

 1. Save   your ACID project. The project must be saved before you can embed the   project reference in the rendered 
file.

 2. Perform the procedure described   in the Rendering Files topic to choose the   file type and location for rendering 
your files, and select the Save project as path reference  in rendered file check box.

The check box will be unavailable if you haven't   saved your project or if you're rendering using a third-party file-
format   plug-in.
 

Edit a referenced project

 1. Do either of the following:
 2. Right-click   a media file in the Explorer window.

 l Right-click   an track header choose Track  Clip from the shortcut menu to edit the track's active clip.
 l Right-click   an event on the timeline and choose Event  Clip from the shortcut menu to edit an event's clip.

 3. Choose Edit  Source Project. A new ACID window will open with the source project.   
If a track's media was created from an ACID   project and rendered with the project path reference in the file, 
you   can also click the Edit  Source Project  button in the Track   Properties window to open the source 

project in a new ACID window.

 4. Edit the project as necessary.
 5. Render   the edited project using the same name as the original media file and   close the second ACID window.  If 

you're editing an existing track, your project will automatically   be updated to use the latest rendered media file.

Saving Your Project
You can save a project in several formats: you can save to an ACID project   file, render to another format, or even 
create audio CDs.

Saving a Project
To save changes to the current project, choose Save from  the File menu. Your project is saved with its existing name 
and   the project is updated so it contains the latest changes.
The first time you save a project, the Save As   dialog is displayed.
If you want to render a project to a different format, choose Render  As from the File menu.
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If   you save an ACID 1.0 ...11.0 project in recent ACID software,   it will be unusable in earlier versions of the 
software. Use the Save   As dialog to save the project with a new name after editing it with ACID software.

By   default, backup project files are   created when you open or save. Backup files are stored in the same folder   as 
your project and use the extension .acd-bak. You   can use these files to revert to a project's previous state.         

If the Enable  autosave check box is selected on the General   tab of the Preferences dialog, a temporary project 
file is saved every   five minutes to aid in crash recovery. Your original project is not overwritten.   

Save As
From the Save As   dialog, you can save the current project to a different location or with   a new name.
If you want to save a file to a new format, choose Render   As from the File menu.

 1. From the File menu, choose Save  As. The Save   As dialog is displayed.
 2. Choose a drive and folder from the Save  in drop-down list, or use the browse window to locate the folder   where 

you want to save your project.
 3. Type a name in the File  name box, or select a file in the browse window to replace an existing   project.
 4. Choose a file type from the Save as type   drop-down list.

File  Type Description

ACID 
Project  File 
(*.acd)

An ACID project   file contains all of the information about a single project. Track layout,   
envelope settings, and effects parameters are saved in this project file.   This type of file does not 
contain any media, but only references to media   files.                                 

ACID 
Project  with 
Embedded 
Media
(*.acd-zip)

An ACID Zip file contains all of a project's   media files and the project file in a compressed 
format.                                 

If you save a project   in .acd-zip format, the project file and all media files are copied to   a 
temporary folder. If you continue to work on your project after saving   the .acd-zip file, your 
changes will be saved to the files in this temporary   folder. You can change the location of 
the temporary folder on the Folders tab of the Preferences dialog.                                 

Select the Copy  all media with project check box   to create copies of each of the project's media files in the 
same location   as the project file. This allows you to collect all of a project's assets   in a single location.

 5. Click the Save   button. 

Rendering Files
From the Render As dialog, you can save the current project to a different   location, with a new name, or to a different 
format.

Render a project to   a different format             

 1. From the File menu, choose   Render As. The Render As   dialog is displayed.
 2. Choose a drive and   folder from the Save  in drop-down list, or use the browse window to locate the folder   where 

you want to save your file.
 3. Type a name in the   File name box,   or select a file in the browse window to replace an existing file.
 4. Choose a file type from   the Save as Type   drop-down list.
 5. Choose a template   from the Template   drop-down list to specify the parameters that should be used for 

rendering   your file, or click the Custom   button to create a new template.
 6. Select the Render  loop region only check box if you want to save only the portion   of the project that is 

contained within the loop   region. Loop Playback   does not need to be selected for this option to work.

 7. If the selected   file type supports it, you can select the Save  project markers with media file check box to 
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include markers,   regions, and time markers   in the rendered media file. If the information cannot be saved to your   
media file, an .sfl file will be created (using the same base name as   your media file).

 8. If the selected file type   supports it, you can select the Save  sections as regions with media file check box to 
include sections   in the rendered media file. If the information cannot be saved to your   media file, an .sfl file will 
be created (using the same base name as   your media file).

 9. Select the Stretch  video to fill output frame (do not letterbox) check box if you   are saving to a format with a 
different aspect ratio than your source   media settings. When this check box is cleared, black bars may appear   at 
the top and bottom (letterboxing) or sides (pillarboxing) of the frame   to preserve the aspect ratio.

 10. Clear the  Fast video resizing check box if you see unacceptable video artifacts   in the rendered video (these 
artifacts are most obvious with MPEG and   streaming formats). Turning this option off can correct the artifacts,   
but your rendering times will increase significantly.

 11. Click the Save   button. A dialog is displayed to show rendering progress.
 12. When rendering is complete,   click the Open   button to play the file with its associated player, or click Open  

Folder to open the folder where you saved the file.

Save the project path in the rendered file

Perform the preceding procedure to choose the file type   and location for rendering your files, and select the Save  
project as path reference in rendered file check box if you want   to save the path to your ACID project in the 
rendered file. Saving the   project path allows you to easily return to the source project if you   use your rendered file in 
another project.

The project information in the rendered file   is a reference   to a project file only. If you modify the project file after 
rendering,   the project data will no longer match the rendered file. To edit a project   using a path reference, the 
project file and all media must be available   on your computer.

Render each track as a separate file             

Perform the preceding procedure to choose the file type   and location for rendering your files, and select the Save  
each track as a separate file check box.
When you click the Save   button, each audio track will be saved to a separate file. All of the volume adjustments, 
panning, FX, and events are   saved with the track.

MIDI tracks must be   routed   to  VSTi soft synths to be included in the rendered output.

Custom Rendering Templates
If the selected file type supports it, the Render   As dialog allows you to create custom templates for saving files.

Create or edit a template             

 1. Use the Render   As dialog to specify a location and name for the file you want to   save.
 2. Click the Custom   button to open the Custom Template dialog.
 3. Choose a template from the   Template drop-down   list, or enter a new name in the edit box.

Notes:

 l Built-in   presets cannot be edited.
 l When   determining bit rates, 1K=1024.
 l Use the Custom Template   dialog to set the template's properties.
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For information about   specific controls in each file type's Custom Template dialog, click the   Help button ?.

 l Click the Save Template button   .

 l Click OK   to return to the Save As or Render As dialog.

Delete a template             

 1. Use the Render   As dialog to specify a location and name for the file you want to   save.
 2. Click the Custom   button to open the Custom Template dialog.
 3. Choose a template from the   Template drop-down   list.
 4. Click the Delete  Template button .

Built-in presets cannot   be deleted.

 5. Click OK   to return to the Save As or Render As dialog.

                       Copy rendering templates between computers or user accounts

You can make your customized rendering templates available   on another computer or user account by copying .sft2 
files to the appropriate   location in the new account or computer.
Rendering templates are stored in C:\Users\<username>\AppData\Roaming\MAGIX\Render  
Templates\<plug-in name>\.

The Application Data/AppData   folder is not visible unless the Show  hidden files and folders radio button   is 
selected on the View tab of the Windows Folder Options control panel.             

You can find a plug-in's   name by clicking the About button in the Render As dialog.

To make a template available on   another computer or user account, copy the .sft file to the same location   in another 
account.
For example, to make JSmith's custom wave template available   for the AJones user account, copy the appropriate 
.sft2 file from this   folder:
C:\Users\JSmith\AppData\Roaming\MAGIX\Render  Templates\wave 
to this folder:
C:\Users\AJones\AppData\Roaming\MAGIX\Render Templates\wave.   

If you're copying   templates from an older application, templates   are saved as .sft files in the following folder: 
C:\Users\<username>\AppData\Roamin\MAGIX\File Templates\<plug-in   name>\<plug-in GUID>.

Rendering Projects with MIDI Tracks
In order to render   projects that contain MIDI tracks, MIDI tracks must be routed   to  VSTi soft synths. Tracks that are 
routed to external MIDI devices   will not be included in the rendered file. 

Exporting Loops
From the File menu, choose Export  Loops to create new loops using the media in your ACID project.
For each loop track, a separate loop will   be created for each tempo and key change, so multiple files can be created   
for each track. 

MIDI,   Beatmapped, and one-shot tracks will not be exported.

 1. From the File menu, choose Export  Loops. The Export Loops dialog is displayed.
 2. Choose a drive and folder from the Save  in drop-down list, or use the browse window to locate the folder   where 

you want to save your file.
 3. Choose a file type from the Save  as type drop-down list.
 4. If the selected file type supports it, you can choose   an encoding template from the Template drop-down list or 
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click the Custom   button to create a new template.
 5. Click Save   to start exporting loops.

Each loop will be saved with a tempo and   key appended to its base name. For example, the loop 
GuitarChops.wav   could create the loops GuitarChops 150.00 BPM C.wav and GuitarChops 120.00 BPM 
A.wav.

Burning CDs
You can create two types of CDs to archive and distribute your project:

 l Track-at-once   (TAO) CDs can be burned in multiple sessions over a period of time. Before   you can use a TAO 
disc in an audio CD player, however, you must close   the session. TAO CDs are convenient for sharing your 
projects and testing   your mix, but are generally not acceptable as masters for duplication.

 l Disc-at-once   (DAO or Red Book) CDs are burned in a single session. Use DAO burning   when creating a master 
disc for replication.

Burning Track-at-Once CDs
From the Tools   menu, choose Burn  Track-at-Once Audio CD to save your project as a track on an audio   CD. Before 
you can use a track-at-once (TAO) disc in an audio CD player,   however, you must close the session.

Notes:

 l Track-at-once   CDs contain two-second pauses between tracks. If you want to burn a CD   with no pause time, 
burn a disc-at-once   CD.

 l The entire   project is written to a CD track. If your project has events on muted   tracks that extend beyond the end 
of the audible material, the muted events   burn as silence at the end of your CD track. To burn only a portion of   a 
project, create a loop region and select the Burn  loop region only check box.

 1. If you have not already   done so, save your project.
 2. From the Tools menu, choose   Burn Track-at-Once  Audio CD. The Burn Track-at-Once Audio CD dialog 

displays the length   of the current file and the amount of time remaining on the disc in your   CD recorder.
 3. Choose a setting from the Action   drop-down list:

Item Description

Burn  audio Begins   recording audio to your CD when you click the Start button. You will need to close the 
disc before   it can be played in an audio CD player.                             

Test,  then 
burn audio

Performs   a test to determine whether your files can be written to the CD recorder   without 
encountering buffer underruns. Recording begins after the test   if it is successful.                             

Test  only Performs   a test to determine whether your files can be written to the CD without   encountering 
buffer underruns. No audio is recorded to the CD.                             

Close  disc Closes   your disc without adding any audio when you click the Start button. Closing a disc 
allows your files to   be played on an audio CD player.                             

Erase  RW 
disc

If you're   using a rewritable CD, the disc will be erased when you click theStart   button.                             

 4. Select your burning options:

Item Description

Buffer  
underrun 

Select this check box if your CD recorder   supports buffer underrun protection. Buffer 
underrun protection allows   a CD recorder to stop and resume burning.
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protection Buffer underrun protection   can create a disc that can be played in CD players but may 
contain a bit   error where burning stopped and restarted. Consider clearing this check   box 
when creating a premaster disc.

Erase  RW 
disc before 
burn

If you're   using a rewritable CD, select this check box to erase the CD before you   begin 
burning.                             

Close  disc 
when done 
burning

Select   this check box to close the CD after burning. Closing a disc allows your   files to be 
played on an audio CD player.                             

Eject  disc 
when done

Select   this check box to eject the CD automatically when burning has completed.                             

Burn  
selection only

Select   this check box to burn only the audio within the loop region.                             

Render   
temporary 
image before 
burning

Select this check box   if you want to render your CD project to a temporary file before 
recording.   Prerendering can prevent buffer underruns if you have a complex project   that 
cannot be rendered and burned in real time.
The rendered temporary   file will remain until you modify your project or exit the application.   If 
an image file exists when you open the Burn Track-at-Once Audio CD   dialog, the check box 
is displayed as  Use existing rendered temporary image.

 5. From the Drive   drop-down list, choose the CD drive that you want to use to burn your   CD.
 6. From the Speed drop-down list, choose the speed at which you want to burn. Max   will use your drive's fastest 

possible speed; decrease the setting if   you have difficulty burning.
 7. Click the Start   button.

Clicking the Cancel button after   the disc-writing process has begun will render your disc unusable (though   it 
will still make a fine coaster for your favorite beverage).

Burning Disc-at-Once (DAO or Red Book) CDs
From the Tools menu, choose Burn Disc-at-Once Audio CD to burn a disc-at-once (DAO) CD using the current CD 
layout.
Use DAO CDs when you need to create a master disc for mass replication   or want to create a CD without two-
second pauses between tracks.

If   you want to burn CD tracks using the media's original tempo rather than   your project tempo, select the track 
and use the Track   Properties window to change the ACID type setting to One-Shot.

Right-click   the Time Display window, choose Time at Cursor Format,   and then choose Audio  CD Time to help 
you arrange your project. The Time at Cursor portion   of the Time Display window will display tt+mm:ss:ff   (track 
number +/- minutes:seconds:frames). Audio CD time uses a frame   rate of 75 fps.

Add CD track markers   to your ACID project             

 1. Arrange your audio files   on the timeline. Use the Track Properties   window to change each track's ACID type 
setting to One-Shot  to burn the media to CD using the   original project tempo.

If you want to burn a CD using audio from   multiple projects, render each project as a 16-bit, 44 kHz wave 
file and   add the rendered wave files to a new project. 

 2. Position the cursor   where you want a CD track to begin and choose CD  Track Marker from the Insert menu (or 
press N) to add a CD track   marker at the cursor position. A Red Book CD can contain up to 99 tracks.   
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 When you burn your CD, two seconds of silence will be added before   the first CD track. Subsequent tracks will 
have silence between them only   if you use the Insert Time command to add   silence before a CD track marker.

If your first CD track marker is not placed   at the beginning of your project, audio that occurs before that marker   
will not be burned to disc.

CD track markers must be at least 4 seconds   apart. Use the Time Ruler to check marker   spacing.

Set Universal Product Code/Media Catalog Number   information             

Universal Product Codes (UPC) or   Media Catalog Numbers (MCN) can be written to a CD as a means of 
identification.   However, not all CD-R drives support this feature. Check your CD-R drive   documentation to 
determine if your drive will write these codes.
Enter the code in the Universal  Product Code / Media Catalog Number box on the Summary tab of the   Project 
Properties dialog.
Universal product codes are administered   by the Uniform Code Council.

Burn your disc             

After arranging your media on the timeline and adding CD   track markers, you're ready to burn.

 1. From the Tools menu, choose Burn  Disc-at-Once Audio CD. The Burn Disc-at-Once Audio CD dialog is   
displayed.

 2. From the Drive   drop-down list, choose the CD drive that you want to use to burn your   CD.
 3. From the Speed drop-down list, choose the speed at which you want to burn. Max   will use your drive's fastest 

possible speed; decrease the setting to   prevent the possibility of buffer underruns.
 4. Select the Buffer  underrun protection check box if your CD recorder supports buffer   underrun protection. Buffer 

underrun protection allows a CD recorder to   stop and resume burning.

Buffer underrun protection   can create a disc that can be played in CD players but may contain a bit   error 
where burning stopped and restarted. Consider clearing this check   box when creating a premaster disc.

 5. Choose a radio button in the Burn  mode box:

Item Description

Burn  CDs Begins   recording audio to your CD immediately.                                 

Test  first, 
then burn 
CDs

Performs   a test to determine whether your files can be written to the CD recorder   without 
encountering buffer underruns. No audio is recorded to the CD   during the test, and recording 
begins after the test if it is successful.                                 

Test  only 
(do not 
burn CDs)

Performs   a test to determine whether your files can be written to the CD recorder   without 
encountering buffer underruns. No audio is recorded to the CD.                                 

 6. Select the Render  temporary image before burning check box if you want to render   your CD project to a 
temporary file before recording. Prerendering can   prevent buffer underruns if you have a complex project that 
cannot be   rendered and burned in real time.
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The rendered temporary   file will remain until you modify your project or exit the application.   If an image file 
exists when you open the Burn Disc-at-Once Audio CD dialog,   the check box is displayed as Use  existing 
rendered temporary image.

 7. Select the Automatically erase rewritable  discs check box if you're burning to rewritable media and want   to 
erase the disc before burning.

 8. Select the Eject  when done check box if you want to eject the CD automatically when   burning has completed.
 9. Click   OK to  start burning.
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Track Editing
Tracks are containers along the timeline where you arrange events.
Events sit on tracks to determine when media playback starts and stops,   and multiple tracks are mixed together to 
produce your final output.

Inserting Tracks
From the Insert menu, choose Audio  Track  to add a new, blank audio track at the end of the track list, or   choose 

MIDI Track  to   add a new, blank MIDI track.

If you want to add a track in a specific location, right-click a track   header and choose Insert Audio Track or Insert 
MIDI Track from the shortcut menu. The new track will be inserted   above the selected track.
Tracks are created automatically when you add   MIDI files to your project. Inserting tracks manually is helpful when   
you want to create placeholders for creating new MIDI tracks with inline   MIDI editing or recording from a MIDI   
keyboard.

Notes:

 l When you drag a media file from the Explorer window to an area of the timeline that does not contain a track,   a 
new track will be created and a new event is added to the new track   where you drop the media. 

 l Drag a file from the Windows Explorer, Explorer Window window to an existing track in the timeline to add a   
clip to the track and add an   event where you drop the clip. The new clip is set as the active clip   for creating 
events with the Draw  or Paint  tool.

 l When you add a MIDI track, its output is automatically   assigned to the next available channel (channel 10 is 
skipped since some   devices reserve channel 10 for drums). For more information about routing   MIDI tracks to 
soft synths or MIDI devices, see "Routing Tracks to Soft Synths or MIDI Devices" on page 216.

 l MIDI tracks can use .mid, .smf, and .rmi files.

You can change the default track volume, pan type, height, track   effects, record input monitor status, and 
automation mode by right-clicking   a track and choosing Set Default Track Properties   from the shortcut menu.

Selecting Playback Devices for Audio Tracks
Each track can be played through any device that is installed in your   computer. To choose a playback device, click the 
Device  Selection button  in the track list. 

For information about routing MIDI tracks to soft synths or MIDI ports,   please see Routing   Tracks to Soft Synths or 
MIDI Devices.

To   change the playback device for multiple tracks, select a track by clicking   on its icon. While holding the Shift  
key, click on another   track in the track list. All of the tracks in between will be selected.   Using the Ctrl key   in this 
manner will allow you to select multiple, nonadjacent tracks.   Change the playback device for one track, and all 
will change.

After you add busses to   your project, the Device  Selection button  is displayed in the track list.
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 1. Click the Device  Selection button. A list of all available playback devices   is displayed.

 2. Choose a device from the   list to send the current track to that device.

Selecting Tracks
Selecting tracks is the first step in a variety of editing tasks. You   can move selected tracks, copy them to the 
clipboard, delete, and edit   multiple tracks at once.

When   multiple tracks are selected, you can perform editing tasks on all selected   tracks simultaneously. For 
example, to adjust the volume of several audio   tracks while preserving their relative levels, select the tracks and 
drag   the Volume fader   on any selected track. All the faders will move together.

Select a single track             
Click anywhere in the track header of the track you want   to select. The track is highlighted.

Select multiple adjacent tracks             
Hold the Shift   key and click the track headers of the first and last track you want to   select. The tracks    including those 
between the selected tracks    are highlighted.——

Select multiple nonadjacent tracks

 1. Hold the Ctrl   key and click the track header of each track that you want to select.   The tracks are highlighted.

If you   have selected a track that you do not want to select, simply click the   track again.

 2. When you have selected   all of the tracks, release the Ctrl   key.

Arranging Tracks
Tracks can be moved to create logical groupings at any time during project   editing.
To move a track, drag its track icon to a new location or to a folder   track in the track list. The new location is indicated 
by a line separating   the tracks.
To move multiple tracks, select the   tracks you want, and then drag them to a new location.

Tips:

 l You can   also drag track channel strips in the Mixing Console window to rearrange   tracks.
 l You can   change track colors to create groupings   of similar material.

Folder Tracks
When you have a complex project, the timeline can get cluttered. Folder   tracks help you clean up the track list and 
timeline by grouping related   tracks or sections of a project so they can be easily expanded or minimized.   For 
example, if you have many drum tracks in your project, you can add   a folder track to consolidate drum tracks and 
minimize their vertical   space in the track list.
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When the folder track is minimized, you can perform edit operations   on clustered events in the group, but you 
cannot create   events with the Draw  or Paint  tools or perform edge-trimming.   Expand the folder track to edit 

individual events. 
You can also use folder tracks to maintain alternate mixes of   a project. For example, create two distinct drum 
parts and move the tracks   to separate folder tracks. Mute one of the drum folder tracks to choose   which beat is 
used when you play   or render your project.

Create a folder track
From the Insert menu, choose Folder  Track. A folder track is added below the currently selected track.
You can create nested folder tracks by dragging a folder   track to an existing folder track.

Add tracks to a folder track
Drag tracks to the folder track to add them. If you drop   the track on the folder track header, the track will be added as 
the first   track in the folder.
When the track is expanded, you can drop a track in a specific   location within the folder track. An insertion bar will 
be displayed where   the track will be added.

Remove tracks from a folder track

 1. Click the Expand   button    to expand the folder track.

 2. Drag tracks from the folder   track to another location in the track list.

Expand or minimize a folder track
Click the Expand   button    to expand the folder track, or click the Minimize  button  to collapse the expanded 
track.

You can also double-click a folder track icon   to expand and minimize the track.

Mute a folder track
Click the Mute   button  to prevent the tracks in a folder track from being played in   the mix. Muting a folder track 

does not override soloed tracks in the   folder track. 
Click the Mute   button on additional folder tracks to add them to the mute group. To unmute   a folder track, click the 
Mute   button again.

Solo a folder track
Click the Solo   button  to effectively mute all unselected tracks and folder tracks.   Soloing a folder track does not 

override muted tracks in the folder track.   
Click the Solo   button on additional folder tracks to add them to the solo group. To remove   a folder track from the 
solo group, click its Solo   button again.

Edit clustered events             
When the folder track is minimized, you can also perform   edit operations on clustered events in the group. The 
following edit operations   will affect clustered events:
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 l Pitch-shifting   events.
 l Dragging   events.
 l Cutting,   copying, pasting, and deleting events.

Click to select a clustered group of events, or hold Ctrl   or Shift while clicking to select multiple clusters of events. 
Selected   events are displayed in a darker color than unselected events. 
Events that overlap are treated as a single event when the   folder track is minimized:

Editing an event in the magenta cluster affects   all magenta events. Editing an event in the green cluster affects all   
green events.

Editing an event in either cluster affects all   events in the green and magenta clusters.

When snapping is   enabled, events within the same grid space are clustered if you click   or drag from within that 
grid space. If you click or drag outside that   grid space, only events that overlap directly are affected.

Cutting, Copying, and Pasting Tracks
When the track list   has focus, you can use the Cut,Copy, and Paste commands to   rearrange and duplicate tracks.

If   you have multiple instances of the software running, you can cut, copy,   and paste tracks across projects.

Cut tracks             
Select the tracks you   want to remove and click the Cut   button  (or press   Ctrl+X). The selected   tracks are moved 

to the ACID clipboard. 

Copy tracks             
Select the tracks you   want to copy and click the Copy   button  (or press   Ctrl+C). The selected   tracks are copied to 

the ACID clipboard. 
Hold the Ctrl key while dragging to create copies of selected events.

Paste tracks                          
Select a track and then click the Pastebutton  (or press Ctrl+V).   The tracks from the ACID clipboard are inserted 

above the currently selected   track.

Audio Track Controls
The controls in the track list allow you to adjust track volume, panning,   assignable effects send levels, and bus send 
levels.
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Tips:

 l Audio track       controls are duplicated on audio       track channel strips in the Mixing Console window.
 l To move   faders and sliders in fine increments, hold Ctrl while dragging the control.

Change a track's color             
Right-click the track   header, choose Color   from the submenu, and then choose the color you want to use to display   
waveforms on the track.
If you've changed the   color of any of a track's clips,   changing the track color will not update the color of those clips.

Change a track's height             
Drag a track's bottom   border to set its height. If you want to set a track's height as the default   height for new tracks, 
right-click within the track list and choose Set Default Track Properties   from the shortcut menu.
Click Minimize  to minimize a track vertically.
Click Maximize    to zoom in vertically so a track fills the track view.
After minimizing or   maximizing a track, click the Minimize or Maximize button again to return a track to its previous 
height.

Track height keyboard shortcuts

 l Press Ctrl+Shift+Up   Arrow or Down Arrow to change the height of all tracks at once.
 l Press `   to minimize all tracks. Press again to restore tracks to their previous   height.
 l Press Ctrl+`   to return all tracks to the default height.

Pitch shift a track             
Right-click a track header, choose Pitch  Shift Track from the shortcut menu, and then choose a command from   the 
submenu to change the pitch of all events on a track. The event-specific   pitch shift is calculated after the project key 
and the track’s pitch   shift.

Tips:
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 l When a track is selected, press +   and - on the numeric keypad to change track pitch. 
 l From the View menu, choose Event  Information to toggle the display of event-specific information    including 

the clip   name and event pitch shift    in the timeline:

Rename a track             

 1. Double-click the track name   and type a new name.
 2. Press Enter   to save the name.

Arm a track for recording
Click the Arm  for Record button  on an audio track to prepare it for recording.

When you click the Record button  on the main transport   bar, all armed tracks will begin recording.

For more information about recording audio, see "Recording Audio" on page 106.

Invert the phase of a track
Click the  Invert Track Phase button  to reverse the phase   of all events on an audio track.

Although inverting data does not make an audible difference   in a single file, it can prevent phase cancellation when 
mixing or crossfading   audio signals.
Select multiple tracks to invert several tracks simultaneously.

Add or edit track effects
Click the Track  FX button  to add effects to a track or edit the existing effects   chain. 

For more information about using track effects, please see   "Track Effects" on page 153.

Mute a track             
Click the Mute   button  to prevent   a track from being played in the mix. Click the Mute   button on additional tracks 

to add them to the mute group. To unmute   a track, click the Mute   button again.

Muting a track mutes its main output and post-fader   sends only unless the Track  prefader sends listen to 
mute check box on the Audio tab of the   Preferences dialog is selected. For more information and examples 
about   how the Track prefader sends listen to mute check box works, please see "Preferences - Audio Tab" on 
page 287. 

Muting or unmuting a track

 1. Deselect the Automation  Settings button  to toggle trim mode. 

 2. Click the Mute   button .
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When you have a group   of tracks muted, hold Ctrl while clicking the Mute   button on an unmuted track to 
remove all other tracks from the mute group.   Hold Ctrl while clicking the Mute button on a muted track to reset 
all Mute   buttons.

Adjusting mute automation

When you select the Automation  Settings button , the mute button is displayed as a , and you can use the 

control to edit volume   automation.

Solo a track             
Click the Solo button  to mute  all unselected tracks. Click the Solo   button on additional tracks to add them to the 

solo group. To remove a   track from the solo group, click its Solo   button again.
Hold Ctrl while clicking   a Solo   button to solo a single track and remove all other tracks from the solo   group.

Choose a track's input/recording device
The Record  Device Selector button  in a track header chooses the audio input   that will be used to record to a 

track.
You can click the Record  Device Selector button to turn input monitoring on or off and choose   a recording device:

Record Device  Selector with a compact 
track header.

Record Device  Selector with an expanded 
track header.

For   more information about recording audio, see "Recording Audio" on page 106.

Assign a track to a bus             
The bus button in a track header chooses the track's primary   output. Assigning tracks to busses is especially useful 
for creating submixes   that allow you to adjust the levels of multiple tracks at once or apply   an effect to multiple 
tracks.
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 1. Click the bus button on the   track. 

 The button is displayed as a  when the track is routed to the master bus,   and the bus letter is displayed ( , 

, and so on) when a track is routed to another   bus.

 2. Select the desired bus from   the submenu. The Bus   button changes to display the selected bus.

If the Bus   button does not appear on the track, then you have not specified more   than one bus in your project 
settings. For more information about specifying   the number of busses for your project, please see "Adding or 
Deleting Busses" on page 166.

If you want to send   a track to multiple outputs — for creating cue   mixes or effects sends — you   can use the 
multipurpose fader to control the level of the track sent   to each bus or assignable effects chain. 

Monitor track output levels             
During playback, a responsive meter is displayed in the   track header to monitor the track's output. 

Horizontal meters

Vertical meters

When clipping is detected, the peak meter displays a red   Clip indicator.

Right-click the meters and choose a command from the shortcut   menu to adjust the display of the meters. This 
shortcut menu allows you   to reset clip indicators, choose a display scale, toggle vertical display,   or turn output 
meters off.

Adjust a track's volume             
The Volume   fader in the track header can function as a trim control that adjusts   the overall volume of the track, or it 
can adjust track volume automation   settings.
The trim level is added to the   volume automation settings so   your envelope is preserved, but with a boost or cut 
applied. For example,   setting the trim control to -3 dB has the same effect as decreasing every   envelope point by 3 
dB.
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When adjusting the mix of your tracks, remember   to look at the meters in the track headers and on the Mixing   
Console. Because you are adding the volumes of all of the tracks together,   it is easy to clip the audio output. 
Make sure that the meters never display   the red Clip indication during playback.

Adjusting the volume trim level

 1. Deselect the Automation  Settings button  to toggle trim mode. 

 2. Drag the Vol  fader to control how loud a track is in the mix. 

 A value of 0 dB means that the track is played with no boost or cut.   Dragging the fader to the left cuts the 
volume; dragging to the right   boosts the volume. 

 You can hold Ctrl while dragging a fader to adjust the setting in finer   increments, or double-click the fader to 
return it to 0   dB.

 If multiple tracks are selected, all selected tracks are adjusted.   

Adjusting the volume automation level

When you select the Automation  Settings button , the fader thumb is displayed as a , and you can use the 

control to edit volume   automation.

Pan a track             
The Pan   slider in the track header can function as a trim control that adjusts   the overall panning of the track, or it can 
adjust track panning automation   settings.
The trim level is added to the pan automation   settings so your panning envelope is preserved, but with an offset 
applied.   For example, setting the trim control to -9% left has the same effect   as moving every envelope point 9% to 
the left.

This procedure applies to stereo panning only.   For information about panning 5.1 surround projects, please see 
"5.1 Surround Panning and Mixing" on page 186.

Adjusting track panning trim levels

 1. Deselect the Automation  Settings button  to toggle trim mode. 

 2. Drag the Pan   slider to control the position of the track in the stereo field: dragging   to the left will place the track 
in the left speaker more than the right,   and dragging to the right will place the track in the right speaker. You can 
hold Ctrl while dragging the slider to adjust the setting in   finer increments, or double-click the slider to return it 
to 0. If multiple tracks are selected, all selected tracks are adjusted.   

Adjusting the track panning automation level

When you select the Automation Settings button , the Pan   slider handle is displayed as a , and you can use 

the control to edit pan   automation.

Change the pan mode             
To change the behavior of the Pan   slider, right-click the slider and choose a pan   type from the shortcut menu. 

The selected panning   mode is also used for track-level pan   envelopes.

Adjust an assignable effects send level             
The multipurpose slider in the track header can function   as a trim control that adjusts the overall assignable effects 
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send level   of the track, or it can adjust assignable effects send automation settings.
The trim level is added to the   assignable effects automation   settings so your envelope is preserved, but with a boost 
or cut applied.   For example, setting the trim control to -3 dB has the same effect as   decreasing every envelope point 
by 3 dB.

Tips:

 l FX sends are post-volume by default.   To change to pre-volume, click the Pre/Post   button at the end of the fader 
(or right-click the fader handle and choose   Pre Volume from the shortcut menu).

 l If you want to apply track panning   (including pan position and panning mode) to FX sends, right-click the   FX 
fader and choose Link to Main Track Pan from the shortcut menu. 
 When Link to Main Track Pan is not selected, the track sends a center-panned stereo   signal using the track's 
current panning mode. 

 l Select the Use  legacy track send gain check box on the Audio   page of the Preferences dialog  if you want to 
configure   audio track sends to behave as they did in ACID 6.0 and earlier. When   the check box is selected, you 
can open projects created with earlier   versions of ACID and be assured they will sound the same as they did in   
earlier versions of ACID.

Adjusting the assignable effects trim level

 1. Deselect the Automation  Settings button  to toggle trim mode. 

 2. Click the label on the multipurpose   slider and choose an assignable effects chain from the menu. The   
multipurpose slider will change to display effects send levels for all   tracks so you can monitor their relative send 
levels.

 3. Drag the FX fader to control   the level of the track sent to each of the assignable   FX chains that you have created. 
Dragging the fader to the left cuts   the volume; dragging to the right boosts the volume.  You can hold Ctrl while 
dragging a fader to adjust the setting in finer   increments, or double-click the fader to return it to 0 dB.  If multiple 
tracks are selected, all selected tracks are adjusted.   

Adjusting the assignable effects automation level

When you select the Automation  Settings button , the fader thumb is displayed as a , and you can use the 

control to edit assignable   effects send level automation.  

Adjust a bus send level             
The multipurpose slider in the track header can function   as a trim control that adjusts the overall bus send level of the 
track,   or it can adjust assignable bus send automation settings.
The trim level is added to the   bus send automation settings so   your envelope is preserved, but with a boost or cut 
applied. For example,   setting the trim control to -3 dB has the same effect as decreasing every   envelope point by 3 
dB.

Tips:             
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 l Bus sends are pre-volume (and pre-mute)   by default. When bus sends are pre-volume, you can create a cue   mix 
that is independent of your main mix. To change to post-volume,   click the Pre/Post   button at the end of the 
fader (or right-click the bus fader and choose   Post Volume from   the shortcut menu).

 l If you want to apply track panning   to bus sends (including pan position and panning   mode), right click the bus 
fader and choose Link to Main Track Pan from the shortcut menu. 

 When Link to  Main Track Pan is not selected, the track sends a center-panned   stereo signal using the track's 
current panning mode. 

 l Select the Use  legacy track send gain check box on the Audio   page of the Preferences dialog if you want to 
configure audio track sends   to behave as they did in ACID 6.0 and earlier. When the check box is selected,   you 
can open projects created with earlier versions of ACID and be assured   they will sound the same as they did in 
earlier versions of ACID.

Adjusting the bus send trim level

 1. Deselect the Automation  Settings button  to toggle trim mode. 

 2. Click the label on the multipurpose   slider and choose a bus from the menu.

 3. Drag the fader to control   the level of the track sent to each of the additional busses   that you have created for 
your project. Dragging the fader to the left   cuts the volume; dragging to the right boosts the volume.  You can 
hold Ctrl while dragging a fader to adjust the setting in finer   increments, or double-click the fader to return it to 
0 dB.  If multiple tracks are selected, all selected tracks are adjusted.   

Adjusting bus send automation

When you select the Automation  Settings button , the fader thumb is displayed as a , and you can use the 

control to edit bus   send level automation.  

Adjust trim levels             
The controls in the track header can function as trim controls   or automation controls for track volume, panning, 
assignable effects send,   and bus send levels. Adjusting the trim control affects the level of the   entire track as it did in 
previous releases of ACID software.
The trim level is added to the track   automation setting so your automation settings are preserved, but   with a boost or 
cut applied. For example, setting the trim control to   -3 dB has the same effect as decreasing every envelope point by 
3 dB.    
To adjust trim levels, deselect the Automation  Settings button . When the button is selected, the track controls 

adjust   automation settings.
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Set the track's paint clip

 1. Click the Paint  Clip Selector button in the track header. A menu is displayed to   list the track's current clips.

 2. Choose a clip from the menu.   The selected clip will be used for creating   events with the Draw  or Paint tool 

.

For more information about using clips, please see "Using Clips with Tracks" on page 70.
 

Editing Audio Track Properties
From the View menu, choose Track  Properties to display the Track Properties window. The contents   of the Track 
Properties window reflect the currently selected track.
For audio tracks, you can use the Clip Pool to organize each track's   media. The Clip Pool displays each track's clips,   
the number of times each clip is used on the track, and the path to each   clip's media file.
For information about editing track properties for MIDI tracks,   see "Editing MIDI Track Properties" on page 251.

If you want to edit media properties and stretching   information, use the Clip   Properties window.

Tips:

 l If   the Track Properties window isn't visible, you can also double-click a   track number  to display that track in 

the Track Properties window. 
 l Right-click   a track and choose Properties   from the shortcut menu to display its properties.
 l When   the Track Properties window is visible, properties for the selected track   are displayed. Click a track to view 

its properties.

Set the track's paint clip             
To set the active clip, click the space next to a   clip's name on the Clip Pool tab. The  icon indicates which clip will 

be used for   creating events with the Draw      or Paint tool .

Track Editing 53



You can also click the Paint  Clip Selector button in the track header and choose a clip from   the menu:

Filter the contents of the track's Paint Clip Selector             
Clear a clip's check box on the Clip Pool tab to remove   it from the Paint Clip  Selector menu in the track header 
without removing it from the   track. To make the clip available again, select its check box.

If a track has many clips, removing clips from   the Paint Clip Selector menu can make the track list easier to 
navigate.

Add clips to the Clip Pool             
Click the Open    button to display the Open dialog, where you can browse to clips you want   to add to the track.

Tips:

 l Drag a file from the Windows Explorer,   Explorer Window to the Clip Pool tab to add a   clip to a track and set it 
as the active clip for creating   events with the Draw  or Paint  tool.

 l Drag a file from the Windows Explorer,   Explorer Window to an existing track in the timeline   to add a clip to the 
track and add an event where you drop the clip.

 l You can also use the Chopper   window to create new clips from a track's existing media.
 l If you want to add a clip to a track   without creating an event, drag a file from the Windows Explorer, Explorer   

Window and drop it on the Paint  Clip Selector button: 

Remove clips from the Clip Pool
You can use either of the following methods to remove   clips from the Clip Pool:

 l Click the Remove  Unused Clips button  to remove all unused clips from the track.

 l Select a clip in the clip   list and click the Delete   button  to remove   it from the track. 

Tips:
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 l Right-click a clip in   the Clip Pool and choose Remove  from Project if you want to remove it from your project. 
Any events   that use the clip will be removed from your project.

 l Right-click a clip in   the Clip Pool and choose Remove  from Project and Delete File(s) if you want to remove it 
from your   project and delete the clip's file from your hard drive. Any events that   use the clip will be removed 
from your project.

Save a clip as a new file             
Click the Save    button to display the Save as New File with Track Properties dialog, where   you can choose a file 

name and folder where you want to save a copy of   the selected clip.
The new file is saved in the folder you specify, and   the file's original attributes are replaced with the settings from the   
Clip Properties window.

Cut, copy, and paste clips across tracks             
You can use the Cut , Copy ,   and Paste    buttons in the Clip Properties window to cut, copy, and paste 

clips across   tracks.
For more information about cutting, copying, and pasting   clips, see "Using Clips with Tracks" on page 70.

Preview clips
Select a clip in the clip list, and then click the Play  button  to play it. 

Click the Stop   button  to stop playback.

Render to New Track
From the Tools menu, choose Render  to New Track to mix all   audio contained in unmuted tracks into one clip. This 
function is similar   to track bouncing in the analog world.

Tips:

 l When your   project contains many tracks, mixing down can help conserve processing   power: any envelopes or 
track effects that were applied to the original   tracks will be rendered into the new clip.

 l You can   use the Render to New  Track command to downmix 5.1   surround projects to stereo.

MIDI tracks must be   routed   to  VSTi soft synths to be included in the rendered output.

 1. Click the Solo   button  for the tracks   that you want to mix down. If no tracks are soloed, the rendered track   

will match the Master Bus output. Create a time selection if you want   to mix down a portion of your project.
 2. From the Tools menu, choose Render  to New Track. The Render to New Track dialog is displayed.
 3. Select the folder where you want to save the file:

 l Choose a drive and folder   from the Save in   drop-down list or
 l Choose   a folder from the Recent   drop-down list to quickly select a folder where you have previously saved   

files.
 4. Type a name in the File  name box, or select a file in the browse window to replace an existing   file.
 5. Choose a file type from the Save  as type drop-down list.
 6. Choose a setting from the Templatedrop-down list to choose the desired   sample rate, bit-depth, and number 

of channels for the output file, or   click the Custom   button to specify your own settings.

If you're downmixing a 5.1 surround project, choose a stereo   rendering template. 

 7. Select the Render  loop region only check box if you want to save only the portion   of the project that is 
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contained within the Loop   Region. The loop region does not need to be active for this option   to work.
 8. Click the Save   button. The rendering process begins and the status bar displays the completion   percentage as 

the new Track.
 9. When the mixing is complete, the new track appears at   the bottom of the track list.

 10. Use the Draw  or Paint    tool to paint the clip on the new track.

After the new track   appears, you may delete or mute the original events. 

Optimizing Clip Stretching
Optimizing a file refers to the process defining a media file's root   note, number of beats or tempo, and stretching 
properties and saving the   information to a loop or Beatmapped   file. 
This information is then used by ACID software to time stretch and pitch   shift the file for you automatically when 
you open it.
The software can use files that have not been optimized; however, their   stretching properties may not be optimized 
and they will not conform to   the key of the current project. Use the Stretch tab on the Clip   Properties window to edit 
a file's stretching properties.

Click the Redetect  Beats button in the Clip Properties window to apply the ACID beat-detection   algorithm to 
existing media. 

Monitoring Clip Stretching
When you click the Tempo   slider, a bar is displayed below each track name to represent the amount   a track is being 
stretched to match the project tempo. 
The mark in the center of the bar represents the original tempo of a   loop. When the bar is to the right of the mark, the 
project tempo is faster   than the original loop; when the bar is to the left of the mark, the project   tempo is slower than 
the original loop.

 

Using the Beatmapper Wizard
When a long file is added to a project, the Beatmapper Wizard starts   to allow you to add tempo information to the 
file.

Notes:

 l The Beatmapper   Wizard is started by default for files longer than 30 seconds. Use the   Open files as loops  if 
between (seconds) setting on the Audio   tab of the Preferences dialog to determine the file length.

 l Support   for multitempo clips is available for clips that are recorded or rendered   in ACID or by adding Beatmap 
markers on the Clip Properties dialog.

 1. Perform either of the following   actions to start the Beatmapper Wizard:
 l Add a long file to your project.   If tempo information is not detected in the file, the Beatmapper Wizard   

starts.
Select the Yes radio button and click Next   to detect measures and downbeats. The file will be able to 
stretch/compress   with the project's tempo.
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Select the No radio button and click Finish   if you want to add the file as a one-shot. The file will maintain its   
original length regardless of the project tempo.
or

 l Open   the Clip Properties window   for a Beatmapped track, switch to the Stretch tab, and click the 
Beatmapper Wizard button.

 2. The Beatmapper Wizard will draw the   file's waveform and place a marker to locate the first beat of the first   
measure.
Click the Play   button  to verify   the marker's position. If the marker is positioned on a downbeat, click   Next. 

Otherwise,   drag the marker to the appropriate location and click Next.
Click the Reset  button to return the downbeat marker to its original position.

 3. The Beatmapper Wizard will draw the   file's waveform and place a region to indicate the length of the first   
measure.
Click the Play   button to verify the measure's length. If the region is positioned correctly,   click Next.   Otherwise, 
drag the ends of the loop region to the appropriate locations   and click Next.

 4. Click the Halve  Selection    or Double Selection  buttons or drag   the ends of the loop region to adjust the 

measure length.
 5. Select the Metronome   check box if you want to play a click track at the detected tempo.
 6. The waveform is displayed with markers   at the end of the measure. Drag the Measure slider to scroll through 

the song, and click the Play   button to verify that the detected measure length is accurate throughout   the song.
The Beatmapper Wizard uses a single   measure length for the entire song. You can drag the end of the measure   
selection to change the measure's length. However, changing the length   will affect the entire song; if adjusting 
the last measure of the song   causes the first measure to be incorrect, the downbeat may not be positioned   
correctly or the song's tempo may not be consistent enough for the Beatmapper   Wizard.

For more information about editing stretching properties   for Beatmapped clips, please see Editing   Audio 
Clip Properties.

 7. Click Next   when the measure lengths are correct. Tempo information is added to your   file.
 8. Select the desired check   boxes:

 l Select the Change  project tempo to match Beatmapped track check box if you want to   set your project 
tempo to match the tempo calculated by the Beatmapper   Wizard. Selecting this check box will ensure that 
your Beatmapped track   plays at its original tempo. When the check box is cleared, the track   will conform to 
the current project tempo.

 l Select the Preserve  pitch of the Beatmapped track when the tempo changes check box   if you want your 
track to maintain its pitch when your project tempo changes.   Clear the check box to create DJ-style 
remixes: the track's pitch will   raise and lower with tempo changes as it would when a turntable's speed   is 
manipulated.

 l Select the Save  Beatmapper information with file check box if you want to save   tempo information in the 
file. When the check box is selected, you can   add the file to other ACID projects without starting the 
Beatmapper Wizard   every time.

If the information   cannot be saved to your media file, an .sfl file will be created (using   the same base name 
as your media file) to store tempo information. If   you move your media file, you should also move its 
associated .sfl file.

 9. Click Finish   to close the Beatmapper Wizard.

To paint the entire   track, select the Paint tool  and Ctrl+click in the track.
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If a track has an   intro before its downbeat, the intro will not be included when you draw   or paint events. Drag 
the left edge of the event to expose the intro.

Fine-Tuning Beatmapped Clips
For more control over Beatmapped   clips, you can use the Stretch tab in the Clip   Properties dialog to add tempo 
changes to a clip or edit time signature   and root note information.

Support for multitempo clips is available   for clips that are recorded or rendered in ACID or by adding Beatmap 
markers   on the Clip Properties dialog. 

 1. If the window isn't already visible,   choose Clip Properties   from the View menu.
 2. Click an event in the timeline to   select the Beatmapped clip you want to edit. The clip's information is   displayed 

in the Clip Properties window.
 3. From the Options menu, choose Grid Spacing, and then  choose Quarter Notes   from the submenu. We'll use 

the grid lines in the Clip Properties window   to check our tempo map.
 4. Click the Stretch tab. The Stretch   tab shows the Beatmap and measure markers. This clip represents a four-on-

the   floor kick drum with several tempo changes, but the Beatmap markers have   been removed to demonstrate 
how we can add and adjust Beatmap markers   manually.
Notice now the measure markers don't align with beats in the waveform   and how the measures contain varying 
numbers of beats:

 5. Let's add a Beatmap marker at each   measure marker.  Right-click each measure marker and choose Insert  
Beatmap Marker from the shortcut menu (or double-click the measure   marker):

 6. The second measure marker occurs slightly   after the beat in the waveform, so we can drag the Beatmap marker 
to the   left:
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 7. We know each measure should have four   beats, but the second measure currently has five beats, and the beats   
in the waveform don't align with the grid marks.  Let's drag the third Beatmap marker to the left. Notice how the 
measure   now contains four beats that are aligned with the grid:

 8. Repeat for measure four:

 9. . . . and again for measure five:
 

 10. In the previous screenshot, you can   see that a measure marker was added near the end of the clip as we dragged   
the fifth Beatmap marker to the left. Let's double-click it to convert   it to a Beatmap marker.
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 11. As we drag the last Beatmap marker   to the left, we can see that each measure now contains four beats that   are 
aligned with the grid.

You can also change the root note or time signature of a Beatmap   marker by right-clicking it and choosing a 
new setting from the Root Note or Time  Signature submenu.
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Editing Events on the Timeline
Once you have created tracks, you   will create events   to tell the software when to play the media files.

Adding Events to a Track
After you've created tracks, you can use the Draw tool  or Paint   tool    to create events in the timeline.

If a track has multiple clips,   events will be created using the active clip.

 l The Draw   tool adds events to a single track at a time. 
 l You can   drag the Paint tool across multiple tracks to create events on several   tracks at once.

Tips:

 l When   the Paint tool is selected, hold Ctrl while clicking to paint the entire   media file as an event.
 l When   painting MIDI or one-shot clips, you can click the down arrow  next to   the Paint tool to set the length 

of events that will be created when you   drag with the Paint tool.

For more information about the available editing tools, please see "Editing Tools" on the facing page.
If you want to create events quickly during   playback, use the Insert Event at Play Cursor   and Paste   Event at Play 
Cursor commands. 

Inserting Events at the Play Cursor
From the Edit menu, choose Insert  Event at Play Cursor to create an event at the play cursor on the   focus track. If 
playback is stopped, the command creates an event at the   edit cursor. 
You can use this feature to create rhythms on one-shot tracks while   listening to the track you're editing in the 
context of the rest of your   project. When you're done creating events, you can use the Render to New Track   
command to save the rhythm to a new track, or you can copy   and paste your new events across the timeline.

Important   notes:

 l If the Chopper has focus, the current Chopper   selection will be inserted at the play cursor.
 l Even when   using low-latency audio drivers, you won't hear the initial attack of   events as they're added, and very 

short events may not play at all.

 1. Create a time selection in the portion of the project   you want to edit.
 2. Select the Loop  Playback button . 

 3. Click the Play   button  to start playback.

 4. Click a track header in the track list to set the focus   track.
 5. Press Y to add an event at the play cursor (during playback,   the edit cursor remains fixed, and the play cursor 

follows playback).   

 If snapping is enabled, events are created   at the next snap point. You can use snapping to quantize your events.
 6. Repeat step 5 as needed.
 7. You can press the Up Arrow and Down Arrow keys to change   the focus track.
 8. Click the Stop   button  when you're finished creating events.

 9. Edit event positions   as necessary.
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If you're using this feature to tap rhythms   with one-shot tracks, try applying   a groove to adjust the timing of 
your rhythm.

Pasting Events at the Play Cursor
From the Edit menu, choose Paste  at Play Cursor to paste the contents of the clipboard at the play   cursor. If 
playback is stopped, the command pastes at the edit cursor.
You can use this feature to create rhythms on one-shot tracks while   listening to the track you're editing in the 
context of the rest of your   project. When you're done creating events, you can use the Render to New Track   
command to save the rhythm to a new track, or you can copy   and paste your new events across the timeline.

Only events and envelope points (when Lock  Envelopes to Events  is selected) are pasted. 

Even when using low-latency audio drivers, you won't hear the   initial attack of events as they're added, and very 
short events may not   play at all.

 1. Create a time selection in the portion of the project   you want to edit.
 2. Select the Loop  Playback button . 

 3. Copy   the one-shot you want to use.
 4. Click the Play   button    to start playback.

 5. Press Shift+Y to paste at the play cursor (during playback,   the edit cursor remains fixed, and the play cursor 
follows playback).  
If snapping is enabled, events are pasted   at the next snap point. You can use snapping to quantize your events.

 6. Repeat step 5 as needed.
 7. Click the Stop   button    when you're finished creating events.

 8. Edit event positions   as necessary.

If you're using this feature to tap rhythms   with one-shot tracks, try applying   a groove to adjust the timing of 
your rhythm.

Inserting Time
From the Insert menu, choose Time   to insert a specified amount of blank space into the project at the cursor   
position. This feature can be used to create space in the project for   new events.

 1. Position the cursor where you want to insert time.
 2. From the Insert menu, choose Time.   The Insert Time dialog box appears.
 3. Enter the amount of time you want to insert (in measures:beats:ticks   format) and click OK.

Editing Tools
From the Edit menu, choose Editing  Tool, and select a tool from the submenu to change the active tool.

Draw             
To use the Draw tool , choose Editing Tool from the Edit menu, and then choose Draw   from the submenu (or 

press Ctrl+D). This tool allows you to insert, edit,   select, and move events in the timeline.
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Adding events

Click in the timeline and drag   to add an event. The longer you drag, the more times the loop will be   repeated (one-
shots and Beatmapped clips do not repeat). 
Repetitions in a loop are denoted   by the black indentations in the top and bottom borders of the event:

Selecting events

Click an event to select it.   Hold Ctrl while clicking to select multiple events, or hold Shift to select   all events between 
the first and last event you click.

Move events

Select events and drag them   along the timeline.

Change an event's length

Drag either edge of an event   to change its length. The event edge will snap to grid lines if snapping   is on. Hold the 
Shift key while dragging to temporarily suspend snapping   (press Shift after clicking).

Selection             
To use the Selection tool , choose Editing Tool from the Edit menu, and then choose Selection   from the 

submenu.
The Selection  tool is designed to select   multiple events across tracks by drawing selection boxes around the events   
you want to include. The Selection   tool can draw three types of selection boxes:

Type Description

Free  
Selection

The default behavior of the tool:                         

 l Click to select individual   events (hold Shift or Ctrl to select multiple events).                                 
 l Drag   to draw a rectangular region that begins where you start drawing and ends   where you 

release the mouse button. All of the events that are inside   the region will be selected. This 
method is good for selecting a group   of events that are close together.                                 

Vertical Can be used   to easily select all events that occur within a time range. The vertical   selection box 
automatically selects all of the tracks between your first   mouse click and where you draw the 
selection box; even tracks that are   not visible at the current magnification are selected.                         

Horizontal Can be used   to easily select all events on a single or multiple adjacent tracks. The   horizontal selection 
box automatically selects all events on a track that   is touched by the selection box; even events that 
are not visible at the   current magnification are selected.                         

To change the type of selection box you are using, right-click   the mouse while holding down the left mouse button. 
Clicking the right   mouse button will toggle through the three types of selection boxes.

Paint             
To use the Paint tool , choose Editing Tool from the Edit menu, and then choose Paint   from the submenu.

The Paint tool   is designed to paint events across multiple tracks. With the Paint   tool selected, you can paint events 
across multiple tracks by clicking   and dragging the mouse. This tool is also useful for inserting one-shot   events 
evenly along the grid.
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The Paint tool is different from the Draw tool in that it   can cross track boundaries. Use the Paint tool to add a random 
element   to your ACID projects.
When painting MIDI or one-shot clips, you can click the   down arrow  next to the Paint tool to set the length of 
events that will   be created when you drag with the Paint tool.
Loops and MIDI clips (with the Looped   check box selected in the Clip   Pool) will paint continuously across the 
timeline. One-shots and Beatmapped   clips do not repeat.

To do this Do this

Add  Events Click and drag across tracks to add   events.                         
Hold Ctrl while clicking   to paint the entire media file as an event, or Ctrl+right-click to 
delete   an entire event.                         

Merge  
Events

Click and   drag across two or more existing events to merge them.                         

Erase  
Events

Right-clicking   will cause the tool to function like the Erase tool.                         

Erase             
To use the Erase tool , choose Editing Tool from the Edit menu, and then choose Erase   from the submenu.

The Erase tool   allows you to remove sections of an event.

To do this Do this

Erase  
Events

With the Erase  tool selected, click and drag across an event to erase sections equal   to the 
current Snap to   value.                         

Split  
Events

With the Erase tool selected, click once in the middle of an event to split the event   at the 
closest snap point.                         

Paint  
Events

Right-clicking   with the Erase tool selected will cause the tool to function like the   Paint tool.                         

Envelope             
To use the Envelope   tool , choose Editing Tool from  the Edit menu, and then choose Envelope   from the 

submenu.
The Envelope tool   is designed to manipulate envelopes   in events. With the Envelope tool   selected, you can add, 
delete, select, and move envelope points, but events   cannot be moved or edited.

Time Selection             
To use the Time Selection tool , choose Editing Tool from the Edit menu, and then choose Time  Selection from 

the submenu.
The Time Selection tool is designed to select all events   within a range of time. Drag within the timeline to make a 
selection.

Groove             
To use the Groove tool , choose Editing Tool from the Edit menu, and then choose Groove   from the submenu. 

You can use the Groove tool to adjust the timing of   media in your project by applying grooves   to events on the 
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timeline. 

Choosing a groove

To choose the groove you want   to apply, click the down arrow  next to the Groove toolbar button and choose   a 
groove from the menu (or double-click a groove in the Groove   Pool window). The name of the selected groove is 
displayed next to   the toolbar button: 

Painting or erasing groove events

When the Groove tool is selected,   perform any of the following actions to add or remove groove events:

 l Click and drag in the timeline to   paint groove events. Groove events indicate where a groove will be applied.
 l Hold Ctrl while clicking the space   between two groove events to create a new groove event to fill the space   

between the events.
 l Right-click and drag with the Groove   tool to erase a groove event, or hold Ctrl while right-clicking to remove   an 

entire groove event.

Tips:

 l Drag a groove from the Groove Pool   to an existing groove event to change the event's groove.
 l Drag a groove from the Groove Pool   to a space between two groove events to create a new groove event to fill   

the space between the events.

Grooves cannot be applied to Beatmapped   tracks.

Groove Erase

 1. Select the Groove Erase tool   .

 2. Click and drag across a groove   event to remove it.

Tips:

 l Hold Ctrl while clicking a track   with the Groove Erase tool    to erase all groove events from a track.

 l You can also right-click and drag   with the Groove tool  to erase a groove event, or hold Ctrl while right-

clicking   to remove an entire groove event.

Next Tool             
Choose Next  Tool (or press D) to switch to the next tool in the list. For example,   if you're using the Paint tool, Next  
Tool selects the Erase tool.

Previous Tool             
Choose Previous  Tool (or press Shift+D) to switch to the next tool in the list.   For example, if you're using the Erase 
tool, Previous  Tool selects the Paint tool.

Selecting Events
Selecting events is the first step in a variety of editing tasks. You   can move selected events, copy them to the 
clipboard, delete, edit, and   more.

Whoops!   You just adjusted your selection until it was perfect, and now you've   lost it with a stray click? No 
problemit's   not lost at all. Press backspace to toggle through the previous five time   selections.—
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Select a single event             
With the Draw ,   Selection  , or Time Selection  tool active, click the event. The event is   highlighted to 

indicate that it has been selected.

Select multiple adjacent events             
Use this procedure to select multiple events that are located   next to each other.

 1. Hold the Shift key and click   the first and last event that you want to select. The events, including   those between 
the selected events, are highlighted.

To select all events   in the project, choose Select  All from the Edit menu.

 2. When you have finished   selecting events, release the Shift key.

Select multiple nonadjacent events             
Use this procedure to select multiple events that are not   located next to each other.

 1. Hold down the Ctrl   key and click the events you want to select. The events are highlighted.

To deselect an event,   click it again.

 2. When you have finished   selecting events, release the Ctrl   key.

Select a range of events             

 1. From the Edit menu, choose   Editing Tool,  and choose Selection from the shortcut menu.

You can add or subtract   events from the selection area by holding the Ctrl key and clicking an   event.

 2. Place the mouse   pointer at any corner of the area that you want to select.
 3. Drag the cursor to the opposite   corner of the area you want to select.
 4. Release the mouse button.   The events within the rectangle are highlighted.

Select all events on all tracks             
To select all of the events in the timeline, choose Select All from the   Edit menu (or press Ctrl+A).

Select all events on a track             
Right-click an event and choose Select  All on Track from the shortcut menu. All events on the track are   selected.

Select events to the end of a track             
Right-click an event and choose Select  Events to End from the shortcut menu. The event and all subsequent   events 
are selected.

You can also use this   command with events selected on multiple tracks.

Select events that use a specified clip             
Right-click an event and choose Select  Events Using This Event's Clip from the shortcut menu to select   all events 
on the track that use the same clip   as the selected event.
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Right-click the timeline, choose Select  Events Using Clip, and then choose a clip from the submenu to select   all 
events on the track that use the specified clip.

Select all events within a time range             
Using the Selection, Envelope,   or Time Selection tool, drag along the marker bar.   A loop region is created, and all 
events (and portions of events) within   the region are highlighted.

To quickly select all events on a track, right-click   an empty space on the track and choose Select  all on Track 
from the shortcut menu.

If you create a new   selection during playback, the cursor will move to the start of the new   loop region and 
playback will begin at that point. To adjust the selection   without interrupting playback, drag from the center or 
ends of the loop   region.

Remove an event from the current selection
Hold the Ctrl key while clicking a selected event. The event   is deselected.

Go To
Use the Go To   command to move the cursor to a specific location in your ACID project.
Double-click either of the fields in the Time Display window to type   a value in the edit box. When you press Enter, 
the cursor will move to   that position.

Notes:

 l When the   timeline has focus, press Ctrl+G to type a Go  To time in the right-hand field in measures.beats.ticks. 
Press   Shift+G to type a Go  To time in the left-hand field using the current time ruler format.

 l When the   Chopper window has focus, press Ctrl+G to type a Cursor  Position (or   Selection Start   time) in 
measures.beats.ticks. Press Shift+G to type a Cursor  Position (or   Selection Start   time) using the current time 
ruler format.

Pitch-Shifting Events
After selecting   events, you can apply a pitch shift. The event-specific pitch shift is   calculated after the project key and 
the track’s pitch shift.

From the View menu, choose Event  Information to toggle the display of event-specific information    including 
the clip   name and event pitch shift    in the timeline:

Apply a pitch shift   using the shortcut menu             
Right-click an event, choose Pitch  Shift from the shortcut menu, and choose a setting from the submenu:
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Command Function

Up  Semitone Shifts the   selected event up one semitone.                         

Down  Semitone Shifts the   selected event down one semitone.                         

Reset Removes any   pitch shifting that currently exists in the event.                         

When the Preserve  pitch when stretching check box is cleared in a Beatmapped track's   Properties, you cannot   
change the pitch of a Beatmapped event.

Apply a pitch shift   using keyboard shortcuts             
You can use keyboard shortcuts to quickly apply pitch shifting   to selected events.

Command Shortcut

Pitch up 1 semitone Numeric Keypad +
=

Pitch down   1 semitone                         Numeric Keypad -
-

Pitch up 4 semitones Shift+=
Shift+Numeric Keypad +

Pitch down   4 semitones                         Shift+-
Shift+Numeric Keypad -

Pitch up 1 octave Ctrl+Numeric Keypad +

Pitch down   1 octave                         Ctrl+Numeric Keypad -

Reset pitch Ctrl+Shift+-/=
Ctrl+Shift+Numeric Keypad +/-

Moving Events
After selecting events, you can drag   them to new locations along the timeline. An event's position on the timeline   
determines when it will be played.

You can use snapping to help you   align events.

Drag an event to a new position

 1. With the Draw ,   Selection  , or Time Selection  tool active, click an event and hold the   mouse button.

 2. Drag the event to the position   where you want it to be played.

Notes:

 l If you   drag an event to a different track, the event will move to the new track,   and a clip will be added.
 l If   you drag an event so that it overlaps another event, a crossfade is inserted   to transition smoothly between the 

two events. For more information about   automatic crossfades, see "Automatic Crossfades" on the next page.
 l Release the mouse   button.

If you right-click   and drag an event, a shortcut menu is displayed when you release the mouse   button. You can 
choose Move Here from the menu to move the event, or choose Copy Here to preserve the position of the 
original and create a copy   of the event where you release the mouse.
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Move multiple events along the timeline

 1. If you want to move an event   and all subsequent events on a track, right-click the event and choose   Select 
Events to End.

 2. Drag the events to the position   where you want them to be played.

You can also use keyboard   shortcuts to move events: press 4 or 6 on the numeric keypad to move   one pixel left 
or right.

Cut, copy, and paste events             
In the same way you might use a word processor, you can   use ACID to cut, copy,   and paste events along the 
timeline.

 1. Click an event to select   it.
 2. Click the Copy   or Cut    button.

 3. Click to position the cursor   where you want to insert the event.
 4. Click   the Paste button   .   

Automatic Crossfades
From the Options menu, choose Automatic  Crossfades if you want to automatically create crossfades   when you 
overlap two audio events.

Event crossfades are not available   for MIDI events.         

Create a crossfade             
You can easily create crossfades between events by simply   dragging an event.

 1. From the Options menu, choose   Automatic Crossfades   to turn on automatic crossfades.
 2. Drag an event so that it overlaps another   event on the same track.

A crossfade is automatically added to   transition smoothly between the two events.

Change the fade type             
You can change a crossfade to use one of many combinations   of fast, slow, linear, smooth, and sharp fade curves.

 1. Right-click the overlapping   area to display a shortcut menu.
 2. Choose Fade  Out Type from the shortcut menu and choose a fade curve from the   submenu to set the curve for 

the first event's fade out.
 3. Choose Fade  In Type from the shortcut menu and choose a fade curve from the   submenu to set the curve for 

the first event's fade in.
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Using Clips
In previous versions of ACID, each track in your project corresponded   to a single media file. If you're comfortable 
with the track-equals-media   model, this version of ACID can behave in much the same way: when you   add media to 
your project, a new track is created for the media file.   When you use the Draw  and Paint  tools, you create 

events using the track's   media.
However, if you want to use multiple media files on each track, you   can now add those files as clips.   For example, if 
you want to use a single track for all the guitar loops   in your project, you can add a single guitar track and add each 
guitar   loop as a separate clip. When a track has multiple clips, the Draw    and Paint  tools create events using 

the active clip.

Using Clips with Tracks
Think of clips as the palette you can dip your paintbrush in when you   paint on the timeline.
A single audio track can contain any combination of loops, one-shots,   or Beatmapped clips. MIDI tracks can contain 
only MIDI clips. For more   information about ACID media types, please see ACID   types.

On a track with a single clip, events are always   
created using the track's media.

On a track with multiple clips, each event can   point 
to a different media file. In this example, each 
event represents   one of the track's three clips. 
The banner at the top of each event displays   the 
name of the event's source clip. 

From the View menu, choose Event  Information to toggle the display of event-specific information    including 
the media   type, clip name and event pitch   shift  in the timeline:

Add a clip to a track

Drag a file from the Windows Explorer, Explorer Window to an existing track in the timeline to add a   clip to the track 
and add an event where you drop the clip. The new clip   is set as the active clip for creating   events with the Draw  

or Paint  tool.

You can also record into   a track to create a new clip.
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You can drag single-stream MIDI files to a   track to add clips. When you drag multistream MIDI   files to the 
timeline, tracks and events are created. For more information,   please see Adding MIDI Files   to a Project.

Tips:

 l You can also drag events across   tracks. When you drag an event to a new track, the event is added to the   new 
track where you drop it, and a clip is added to the track's clip pool.

 l You can use the Chopper   window to create new clips from a track's existing media.
 l If you want to add a clip to a track   without creating an event, drag a file from the Windows Explorer, Explorer   

Window and drop it on the Paint  Clip Selector button: 

 l Hold Shift while clicking the Paint Clip Selector   button to display the Open dialog, where you can add a new 
clip.

Set the active clip and create events

 1. Click the Paint  Clip Selector button in the track header. A menu is displayed to   list the track's current clips.

 2. Choose a clip from the menu.   The selected clip will be used for creating   events with the Draw  or Paint tool 

.

Copy clips and events across tracks

In previous versions of ACID, you could only copy and paste   events within the same track. You can use clips to copy 
events between   tracks.

Tips:

 l You can also use the Cut , Copy , and Paste  buttons in the Clip   Pool tab on the audio Track   

Properties or MIDI Track   Properties window to cut, copy, and paste clips across tracks.
 l Hold Ctrl while dragging an event   to a different track to copy the event and clip to the destination track.
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 1. Select the events you want   to copy. 

 Hold Ctrl or Shift to select multiple events. You can select multiple   events that use different clips.
 2. Click to position the cursor   where you want to paste the events.
 3. Click the track header of   the track where you want to paste the contents of the clipboard. 
 4. From the Edit menu, choose   Paste.

 Events are added at the cursor position, and clips are added to the   track for the pasted events as needed.

If you copy an event from track 1. . .
. . . and paste it into track the same track,   a new event is created on the 
same track. No clips are created.

 

If you copy an event from track 1. . .
. . . and paste it into track 2, the event from   track 1 is added to track 2, and a 
new clip is created for the new event.

 

If you copy events from tracks 1 and 
3. . .

. . . and paste them into track 2, the event   from track 1 is added to track 2, 
and a new clip is created for the new   event. A new track is created for the 
event from track 3.

Copy clips across tracks without copying events

You can use the Cut , Copy ,   and Paste    buttons on the audio Track   Properties or MIDI Track   Properties 

window to cut, copy, and paste clips across tracks: 
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 1. Click the Paint Clip Selector button in the track header and choose Clip  Pool from the menu.

 2. In the Clip Pool, select the   clip you want to cut or copy, and then click Cut or Copy.
 3. Click the Paint  Clip Selector button in the track header where you want to paste   clips, and then choose Clip  Pool 

from the menu.
 4. Click the Paste   button in the Clip Pool.

Create new MIDI clips

Right-click a MIDI clip and choose Copy  to New Clip from the shortcut menu to copy the selected clip to   a new, 
separate clip. Copying an event to a new clip allows you to edit a single MIDI event without   affecting other events 
that use the same clip.
Right-click a MIDI track and choose Create  Empty Clip from the shortcut menu to create a new, empty clip and   set it 
as the track's active clip. 

You can also use the Chopper   window to create new clips from a track's existing media.

Create new audio clips   (chop to new clip)             

Right-click an audio event and choose Chop  to New Clip from the shortcut menu to copy the selected event to   a 
new, separate clip. 
Chopping an event to a new clip allows you to edit   a single event without affecting other events that use the same 
clip.

Tips:

 l You can also use the Chopper   window to create new clips from a track's existing media.
 l You can use Chop  to New Clip to a create new one-shots and loops from recorded   clips.
 l Chopping to new clips can also help   you reduce file sizes when saving your   project as an .acd-zip file. If you 

have a project with many recorded   clips, chop each recorded event to a new clip, and then choose Remove  all 
Unused Clips from the Tools menu. When you save your .acd-zip   file, only clips that actually appear on the 
timeline are saved.

 1. Right-click an event   on the timeline and choose Chop  to New Clip from the shortcut menu.

 The event length determines the type of clip that will be created:
 a. If the event is an integral number   of beats, a loop will be created.
 b. If the event is shorter than the   Open files as loops if  between setting on the Audio   tab of the Preferences 

dialog, a one-shot will be created.
 c. If the event is longer than the   Open files as loops if  between setting on the Audio tab of the Preferences 
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dialog, a Beatmapped   clip will be created.

The Chop  to New command is not available for events that contain a loop   point: 

 2. Use the Chop to   New dialog to specify the format and location where you want to save the   new file. The original 
file name is used, and Chopped  [number] is appended to the   file name.

 3. When you click Save,   the new file is saved, and the selected event switches to use the new   clip.

Change an event's clip

 1. Select   the events you want to change.
 2. Right-click a selected event   and choose Event Clip  from the shortcut menu. The track's current clips are 

displayed   in a submenu.
 3. Choose the clip you want to   use from the submenu. All selected events are updated to use the new clip.

Press C or Shift+C to change       all selected events' clips by cycling forward or backward through the      track's 
clips.

Change a clip's color             

By default, the events   on a track are drawn using the track   color. However, you can change the color used to display 
individual   clips. Perform any of the following actions to change the color used to   draw a clip's events:

 l Right-click the track header, choose   Paint Clip from  the shortcut menu, choose Color   from the submenu, and 
then choose the color you want to use for events   created with the track's active clip.

 l Right-click an event, choose Event Clip from the  shortcut menu, choose Color   from the submenu, and then 
choose a color from the submenu. 

 l Right-click a clip on the Clip Pool   tab for an audio or MIDI track, choose Color from the submenu,   and then 
choose a color from the submenu.

Rename a clip             

You can change the   name used to display clips in the Clip Pool and on the timeline. Perform   either of the following 
actions to change a clip's name:

 l Right-click an event, choose Event Clip from the   shortcut menu, choose Rename  from the submenu, and then 
type a new name. 

 l Right-click a clip on the Clip Pool   tab for an audio or MIDI track, choose Rename from the submenu,   and then 
type a new name. 

The new name is displayed in the Clip Pool and in the event   when Event Information   is selected on the View menu.

Remove clips from a track

To remove unused clips from individual tracks, click the   Remove Unused Clips   button  in the Clip Pool window.

To remove the unused media from your project,   choose Remove All Unused  Clips from the Tools menu. 

Manage clips

You can use the Clip Pool tab in the Audio   Track Properties or MIDI   Track Properties window to organize each 
track's media.

Pitch shift audio clips

You can use the Clip   Properties window to pitch shift all events on the track associated   with a specific audio clip.
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Select events that use a specified clip             

Perform any of the following actions to select events created   from a clip:

 l Right-click an event in the timeline   and choose Select Events  Using This Event's Clip from the shortcut menu 
to select all events   on the track that use the same clip as the selected event.

 l Right-click the timeline, choose Select Events Using Clip,   and then choose a clip from the submenu to select all 
events on the track   that use the specified clip.

 l Right-click a clip in the Clip Pool   window and choose Select  Timeline Events from the shortcut menu.

Event Clip Settings
To change settings for an event's clip, right-click an event in the   timeline, choose Event  Clip from the shortcut menu, 
and then choose a command from the   submenu:

Editing a clip affects all events on the track that use the clip.

Command Description

Rename Allows you to type a new name for the selected   event's clip.
The new name is displayed in the Clip Pool and   in the event when Event Information   is selected on 
the View menu.

Color Choose a color from the submenu to change the   color used to draw a clip's events.

Loop Select this command if you want a MIDI clip   to repeat when painted on the timeline.
When the command is not selected, the MIDI clip   will be treated as a one-shot.
For more information about ACID types, please   see ACID Types.

This command is available only for MIDI clips.

Use 
Original 
Tempo

Sets the project tempo to match the clip's original tempo.

Edit in 
Audio 
Editor

Opens the clip's media in your selected audio editor.
After you have edited and saved the file, ACID   automatically detects the updated file and updates the 
events in the project.   However, if you change the media file’s name or location (by using Save   As), 
you must import the edited (new) file into your project.

Edit 
Source 
Project

If the clip's media was rendered with an embedded   project path reference, this command opens the 
source project in the associated   application if you need to edit the media later. ACID 5.0, Sound 
Forge   8.0, and Vegas 6.0 and later allow you to save the project path reference   when you render files.

This command is available only for audio clips.

Add to 
Groove 
Pool

Makes the selected clip available in the Groove Pool so   you can apply its timing to other tracks.

Groove cloning can extract grooves from loop   tracks only.

This command is available only for audio clips.

Invert 
Phase

Reverses the phase   of the sound data. Although inverting data does not make an audible difference   in 
a single file, it can prevent phase cancellation when mixing or crossfading   audio signals.

This command is available only for audio clips.

Normalize Maximizes a clip's volume without clipping.
The Normalize  peak level setting on the Audio   tab of the Preferences dialog sets the level to which 
the largest peak   in the clip will be normalized.

This command is available only for audio clips.
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Channels Specifies how to treat the channels in a clip:

Both Treats the clip as a normal stereo file.

Left Only Creates a mono clip using only the left channel   of your media file.

Right 
Only

Creates a mono clip using only the right channel   of your media file.

Combine Creates a mono clip by mixing the channels of   your media file. After mixing the 
channels, the amplitude is divided by   two to prevent clipping. 

Swap Exchanges the right and left channels in a stereo   file.

This command is available only for audio clips.

Clip List Displays the track's available clips. Choose   a clip from the menu to set the event's clip.

Next Clip Updates the event's contents to use the next   clip in the clip list.
Select an event and press C to switch to the   next clip quickly.

Previous 
Clip

Updates the event's contents to use the previous   clip in the clip list.
Select   an event and press Shift+C to switch to the previous clip quickly.                     

Editing Audio Clip Properties
From the View menu, choose Clip  Properties to display the Clip Properties window. The contents   of the Clip 
Properties window will change to display properties for the   currently selected clip in the timeline.
For information about MIDI clip properties, see "Editing MIDI Clip Properties" on page 253.

Notes:

 l If you adjust   a clip's properties and do not click the   Save button , the new properties are saved in your ACID   

project only (the media file is not modified).
 l If you adjust   a clip's properties and click the Save   button , the modified properties are embedded in the 

media file if possible   (you will be prompted to save to a different file if necessary).
 l When you   load a project, the clip properties saved in the ACID project are displayed   first. If clip properties have 

been edited since the project was saved   or if the clip was modified in an external editor, you can click the Reload 
button    to load the properties saved in the file.

Manage a track's clips

Each track in your ACID project can contain multiple, distinct   media files, called clips. Use   the Clip Pool tab in the 
Track   Properties window to add, remove, and preview clips.
For more information about using clips with tracks, please   see Using Clips with Tracks.

Adjust general properties for a loop, one-shot,   or Beatmapped clip             

The General tab displays information about the file associated   with a track and allows you to change the ACID type, 
apply pitch shifting   to all events on the track that use the same clip, and adjust time-stretching   for Beatmapped clips.

Changing ACID type

Choose a setting from the ACID Type drop-down   list to change how the clip's media is handled in your ACID 
project.

ACID Type Description

Loop When Loop is selected, the clip will be transposed to   the project key and stretched to fit the project 
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tempo.                         
Loops can   be drawn across the track and will repeat end-to-end.                         

One-shot When One-shot is selected, the clip is streamed from the   hard disk rather than being stored in 
RAM, will not change tempo with   the rest of the loops, and will not be transposed to the project 
key.                         
The Stretch   tab is not available when One-shot is selected.                         

Beatmapped When a file that is longer than thirty   seconds is added to a project, The Beatmapper Wizard starts 
to allow you   to add tempo information to the file.                         
You cannot choose Beatmapped  for very short media files. A file   must be at least one measure 
long at 300 BPM to be Beatmapped.                         

Use the Open files  as loops if between (seconds) setting on the Audio   tab of the Preferences 
dialog to determine the file length.

Adjusting pitch shift

Enter a value in the Pitch shift box (or   use the spinner control) to adjust the pitch of all events that use the   same clip.

Track pitch shifting is not saved to the media file   when you click the Save  button .

Adjusting time-stretching (Beatmapped tracks only)

ACID provides two time-stretching   methods for Beatmapped tracks: Classic and élastique. Classic is the standard   
time-stretch method used by ACID. 

 1. Select the Preserve  pitch when stretching check box if you want your track to maintain   its pitch when your 
project tempo changes.

 When the check box is cleared, the clip's pitch will raise and lower   with tempo changes. When the check box is 
cleared, you cannot change the   pitch of a Beatmapped event.

 2. Choose a setting from the   Method drop-down   list to determine the time-stretch method to use.

Method Description

Classic Classic is the standard time-stretch method   used by ACID. 

élastique The élastique method uses technology from zplane.development,   and provides enhanced real-
time time stretching and pitch-shifting capabilities.   The élastique method also allows you to 
preserve and shift a track’s formants,   which are the characteristic resonant frequencies of a sound.

 3. Choose a setting from the   Mode drop-down   list to choose the stretching method best suited to your media.
The   élastique Pro   mode provides the highest quality stretching but requires more RAM usage   and CPU 
power. The élastique  Efficient mode uses fewer resources while still producing great   time-stretching 
quality for polyphonic audio. The Soloist (Monophonic)  and Soloist  (Speech) provide good quality for 
monophonic audio with little   effect on system resources.

 4. Select the Preserve formants when stretching check box if you want your track to maintain   its characteristic 
resonance when your project tempo changes. Formant   preservation is most often used to avoid the "chipmunk 
effect"   in vocal performances. 

 This option is only available for élastique Pro and Soloist  (Monophonic) modes.
 5. Type a value in the Formant  shift (semitones) box (or use the spinner control) to adjust the   formants of all 

events that use the same clip. 

  Formant shifting can be used to deepen the tone of a vocal performance   without changing the pitch. 

 For élastique Pro   mode, this amount represents the number of semitones to shift the timbre   in addition to the 
offset required to compensate for any pitch shifting.   For example, a setting of 0.000 applies formant correction 
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with no additional   shifting, while a setting of -7.000 will apply formant correction and   deepen a sound by 7 
semitones.

 This option is only available when the Preserve  formants when stretching check box is selected.

Adjust clip offset for looped recordings

When you perform looped recording,   multiple clips are created in your recorded file. You can use the General   tab of 
the Clip Properties dialog to adjust which portion of the recording   is used for each clip (clip take offset).
A green region marks the clip's location in the recorded file. Drag the   region markers to adjust the clip:

Adjust stretching properties for a loop             

The Stretch tab allows you to specify how to handle pitch   shifting and time stretching for loops or Beatmapped 
tracks. 

Click the Redetect  Beats button to apply the ACID beat-detection algorithm to existing   media. 

You'll notice that the Stretch   tab looks similar to the Groove   Editor window. Both windows contain   beat anchors  
and   markers; however, the markers on these windows perform complementary functions:                

 l On the Stretch tab of the   Clip Properties window, the beat markers  indicate beats in the media, and the beat 

anchors    indicate the   adjustment that is required to quantize the media to straight time before   applying a new 
groove.

 l In the   Groove Editor window, a beat anchor  represents the beat that will be adjusted, and a   groove marker  

represents the point in time when that   beat will be played when the groove is applied. A groove marker can 
occur   before or after the beat anchor. A line connects a groove marker to its   associated beat anchor. 

If you want to hear the results   of editing beat anchors and markers, select the Play  Quantized button  at the 

bottom of the Clip Properties window and use the Clip   Properties transport controls to preview the loop. Playing the 
clip in   Play Quantized mode demonstrates how the track sounds  when the Quantize to Straight groove is applied. 
Click the Play   button  to hear the   original loop.

After you've edited a clip's properties, click the Save button  to embed ACID information   in the file.

Hold Ctrl while clicking the Save   button  to save your   changes to a new file.

If you save stretching properties to a new file, the   changes will also be applied to the current clip and saved with 
the ACID   project; the changes are not saved to the original file.

If you edit a file in another   audio-editing program, it is possible that the ACID data will be removed.   Simply edit 
the settings on the Stretch tab to optimize the file again.

Item Description

Root  note Choose a note from the drop-down list   to set the base note for loops that you want to conform to the 
project   key.                         
If you do not want a clip   transposed to the project key (a clip that contains a drum sample, for   
example) choose Don't transpose.

Number  
of beats

Choose a setting from the drop-down   list to specify the length of the original file.                         
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Selecting   a value that does not match the actual file will cause the loop to play   at a different speed 
than normal. For example, specifying a length of   8 beats for a 4-beat loop will cause the loop to play 
at half speed at   any given tempo.                         

Stretching   
method

Stretching properties determine how time compression   and expansion is performed on audio events. 
If you hear audio anomalies   due to time compression, try editing the stretching properties of the   
track.

 l Looping segments   is the default stretching method, and it will work well with most types   of 
material. The clip media is divided into sections that are crossfaded,   and some sections may be 
looped if necessary to achieve the necessary   length. Combination   beat/stretch markers    and 

stretch-only markers  represent the divisions  in the clip media. 

 l Choose Nonlooping  segments for sustaining material such as synthesizer pads and held   notes. 
The clip media is divided into sections that are crossfaded, but   no sections are looped. Com
bination   beat/stretch markers    and stretch-only markers  represent the divisions   in the clip 

media.                                     
 l Choose   Pitch shift segments to shift the pitch of the clip to adjust for variations   in tempo. Using 

this option, you can eliminate some of the problems that   occur with extreme tempo changes or 
just create new sounds from existing   loops.                                  For example, if you have slowed   the project tempo 
and hear echo artifacts, using the Pitch  shift segments setting can eliminate these artifacts. Com
bination   beat/stretch markers    and stretch-only markers  represent the divisions  in the clip 

media.
 l Choose Sliced  segments for material such as drum loops where silence exists between   notes. 

Instead of crossfading the segments, silence is added between beats   to reduce warbling or other 
artifacts. When you set the stretching   method to Sliced segments, beat   markers  represent divi

sions in the clip media where   silence will be inserted to accomplish stretching. Stretch-only mark
ers    are not used in this mode and are displayed   in gray: . 

Transient   
sensitivity 

Type a value in the box   or use the spin control to adjust the sensitivity for beat detection.   When you 
set the control to 100, beat markers , stretch markers  or ,   and beat anchors    are created for 

every transient. 
As you decrease the setting,   markers are created for only strong transients. Increasing   this setting can 
be advantageous when working with audio that has complex   rhythms. Lower settings are more 
suitable for synthesizer pads and other   basic material.

Timing   
tightness

Choose a setting from the   drop-down list to choose the resolution for beat anchors . For example, if   
you wanted to quantize beat anchors to sixteenth notes, choose Sixteenth Notes from the drop-
down list. 
Quantized beat anchors are   displayed as .   If the you choose a resolution from the Timing  tightness 
drop-down list that is too coarse, you'll notice that   not all beat markers will be quantized.

Stretch   
spacing

Choose a setting from the drop-down list to   specify how many stretch markers  or  will be 

displayed along the bottom of the waveform display. 
Audio that   contains rapid notes such as drum rolls will benefit from setting the   divisions at a smaller 
fraction of a beat. Slower-paced material, however,   may actually suffer from high resolution.                         

Re-Detect   
beats

Click to automatically detect the beats in the   current file. Use this button to reapply the ACID beat-
detection algorithm   to existing media. 

Stretch  
markers

Stretch markers correspond to subdivisions   of beats in the audio file. These markers tell ACID 
software where to   divide the audio when performing time stretching to match tempo. Accurately   
detecting these beats is the key to making the time-compression process   sound good.

Indicates a stretch-only marker that was detected   by the software or added manually.
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Indicates a combination beat/stretch marker.   Each beat marker    on the beat ruler corresponds 

to a combination beat/stretch marker  on the timeline. 

If you want to convert a combination beat/stretch   marker to a stretch-only marker, double-click 
the marker (or right-click   the marker and choose Convert to Stretch  Marker from the shortcut 
menu).

Indicates an inactive stretch marker. 
When Sliced  segments is selected from the Stretching  method drop-down list, beat markers  

represent the   points where silence will be inserted to accomplish stretching. Stretch-only   
markers  are not used in this mode and are displayed   in gray: . 

Use the Zoom  In Time  and   Zoom Out Time  buttons to change the magnification of the   

waveform.

As a general rule, markers that are excessively   close to each other may cause clicks in the audio. 
However, markers should   not be more than one second apart, or pitch and echo artifacts may result.
You can add, move, and delete stretch markers   on the Stretch tab. If snapping   is enabled, markers will 
snap to the current grid spacing.

Moving   markers

You can drag any marker   to a new location. If you move a combination stretch/beat marker , its 

associated beat marker  will also be moved.

Adding markers

Double-click   the marker bar at the bottom of the waveform display to create a new marker.   It is 
advantageous to add new markers if the software does not detect   any quick subdivisions in beats.                         
The biggest   cause of audio artifacts due to time compression is a lack of beat detection.   Make sure 
that you add markers anywhere the application fails to put one   on a pronounced beat.                         

Deleting markers

You can remove a user-defined   marker by right-clicking and choosing Delete   from the shortcut 
menu. Double-click   a combination stretch/beat marker  to remove the  beat marker , or double-

click a stretch marker  to delete it. 

Reset stretching markers
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Click   the Reload button  to reset the markers to their last-saved   positions.                         

Beat 
anchors   
and 
markers

Beat anchors  correspond to musical beats on the ruler at the top   of the waveform display. Beat 
markers  correspond   to points in time on the ruler at the bottom of the waveform display.   Each beat 

marker corresponds to a combination beat/stretch marker  on the timeline. If   you want to convert a 

combination beat/stretch marker to a stretch-only   marker, double-click the marker (or right-click the 
marker and choose   Convert to Stretch Marker from   the shortcut menu).
Beat anchors   and markers are used only when a groove   is applied to a track.                         
Offsets between beat anchors and beat markers   indicate that the beat represented by an anchor is 
actually played at   the marker position, which may occur before or after the beat. This mapping   
represents the difference required to remove an existing groove from a   media file and return the media 
to straight machine time so that grooves   can be applied accurately.
If you want to hear the results of editing   beat anchors and markers, select the Play  Quantized button 

 at the bottom of the Clip Properties window and use the Clip   Properties transport controls to 

preview the loop. Playing the track in   Play Quantized mode demonstrates   how the track sounds 
when the Quantize to Straight groove is applied.

In most cases, you won't need to edit beat   anchors. 
Use the Zoom  In Time  and   Zoom Out Time  buttons to change the magnification of the   

waveform.

Grooves are not applied using the markers on the Stretch   tab. Autodetected stretch markers are 
used to establish a baseline for   applying other grooves with the Groove   Pool window and Groove 
tool. User-defined markers   have no effect on groove quantization.

You can add, move, and delete beat anchors and   markers on the Stretch tab. 

Moving anchors

You can drag beat anchors   and stretch markers to map the sample data in the waveform to a specific   
beat:

 l Moving   a beat marker  changes the audio that will be played   at a beat anchor location. 

 l Moving   a beat anchor  changes   the beat on which the audio represented by a stretch marker 
will be played.   Beat anchors snap to the current grid spacing. Hold Shift while dragging to   bypass 
snapping.

In this example,   the audio at the 
stretch marker occurs before the beat 

but will be played   at the time 
indicated by the beat anchor. 

In this example,   
the audio at the 
stretch marker 

occurs on the beat. 

In this example,   the audio at the 
stretch marker occurs after the beat 

but will be played   at the time 
indicated by the beat anchor. 

Adding anchors

Double-click   the marker bar (above or above the beat ruler) to create a new anchor   and marker.                         

Deleting anchors

You can   remove a marker by right-clicking and choosing Delete from the shortcut menu (or by 
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double-clicking   it).                         

Reset beat anchors

Right-click   the beat marker bar and choose Reset  All from the shortcut menu to reset   the markers to 
their last-saved positions.                         

Adjust stretching properties for a Beatmapped   clip             

Use the Stretch tab to quickly edit Beatmapper information   for a clip without starting the Beatmapper   Wizard. After 
you've edited a clip's properties, click the Save  button  to   embed ACID information in the file.

Hold Ctrl while clicking the Save   button  to save your   changes to a new file.

Notes:

 l If you save stretching properties   to a new file, the changes will also be applied to the current clip and   saved with 
the ACID project; the changes are not saved to the original   file.

 l If you edit a file in another audio-editing   program, it is possible that the ACID data will be removed. Simply edit   
the settings on the Stretch tab to optimize the file again.

 l Support for multitempo clips is   available for clips that are recorded or rendered in ACID or by adding   Beatmap 
markers on the Clip Properties dialog.

 l The ruler on the General tab is   fixed, and the ruler on the Stretch tab is stretched to represent measures   of 
varying lengths. In the following image, you can see how the beat ruler   has been compressed to change the 
lengths of the measures as we switch   from the Stretch to the General tab:

Item Description

Initial   root 
note

Choose a note from the drop-down list to set   the first root note for clips that 
you want to conform to the project   key.
If you do not want a track   transposed to the project key, choose Don't  
transpose.

Initial   tempo Displays the starting tempo   of the clip as determined by the Beatmapper 
Wizard. Type a value in the   box or use the spin control to adjust the tempo.

Initial   time 
signature

Choose settings from the Beats per measure and Beat value controls to set the 
starting time signature of your clip.   Time signature changes in the clip will be 
marked by Beatmap markers.

Ignore   root 
note changes

Select this check box if you   do not want to transpose the Beatmapped clip when 
stretching. Root note   changes in the Beatmap will be ignored. 
When the check box is cleared,   pitch-shifting will be applied so the clip will 
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conform to your project   key

Beatmapper   
Wizard

Click the Beatmapper  Wizard button to use the Wizard to adjust a track's 
tempo information.   More.   . .

The waveform display shows tempo changes and measures:

 l The blue marker  represents the first downbeat.
 l Tempo changes are indicated with Beatmap   markers . These   markers can be added manually or are added by 

ACID when recording   or rendering. 
 l Orange markers  represent measures.

You can adjust tempo by dragging measure or Beatmap markers:

Dragging a measure marker that occurs before   the first Beatmap 
marker sets the clip's initial tempo.

Measure markers between Beatmap markers cannot   be moved.

Dragging a Beatmap marker adjusts the tempo   of the Beatmap 
marker you drag and the previous marker. The length of   the 
measures between the Beatmap markers is adjusted as you drag.

Dragging a measure marker that occurs after   the last Beatmap 
marker sets the clip's final tempo.

You can add Beatmap markers to signal a tempo change: just   double-click a measure marker or a blank area of the 
Beatmap marker bar   to add a marker.
To remove a Beatmap marker, double-click an existing marker.
To edit a Beatmap marker, right-click it and choose a new   setting from the Root Note or Time Signature   submenu.
For more information about using the Stretch tab to add   Beatmap information to a clip, please see Fine-Tuning   
Beatmapped Clips.

Reload a clip             

Click the Reload   button  in the Clip   Properties window to reload the last-saved version of a media file. All   events 

remain in the timeline, but changes made in the Clip Properties   window since the file was last saved are discarded.

When you edit a clip in an external   editor, changes to the sound file will be reflected immediately after   you save 
the file in the external editor.

Replace a clip with another media file             

Click the Replace   button  to replace the current clip with another   file. The events and envelopes in the timeline 

remain intact, but the   audio will be replaced with the new file.
Drag a file from the Explorer to the track name in the track   list to quickly replace the active paint clip with another 
file.
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Edit a clip's source project              

If a clip's media was created from an ACID project and rendered   with the project path   reference in the file, you can 
click the Edit Source Project button  to open the   source project in a new ACID window.

If you render the edited file using the same file name and   location as the track's original media, your project will 
automatically   be updated to use the latest rendered media file.

Add a clip to the Groove Pool

Click the Add  to Groove Pool button  to make the selected clip available in the Groove   Pool so you can apply its 

timing to other tracks.

Groove cloning can extract grooves from loop tracks   only. 

Save changes to clip properties           

Click the Save  File button    to save the current clip and clip properties.

Click the Save  File As button    to save the current clip and clip properties to a new file. The clip is   updated to use 

the new file.

Clip pitch shifting is not saved to the media file.

Edit in Audio Editor
From the Tools menu, choose Edit  in [editor name] to open the selected track's paint clip using   an editor specified 
on the Editing   tab of the Preferences dialog. For example, if you have Sound Forge selected   as an audio editor, you 
could choose Tools  > Edit in Sound Forge to start Sound Forge.

Right-click an event in the timeline, choose Event Clip from the shortcut menu, and then choose Edit  in [editor 
name] from the submenu.

Important:

 l The command   is not available if you have not specified an audio editor on the Editing   tab of the Preferences 
dialog.

 l When   you edit a clip in an external editor, audio, MIDI, and external control   hardware is released regardless of 
theClose audio and  MIDI ports when ACID is not the active application check box setting   (see Preferences > 
General).   The ports are re-enabled when focus is restored to ACID.   

 1. Select the track you want to edit.

You can select multiple   tracks to open each track's clip in a separate window in the sound editor.

 2. From the Tools menu, choose Edit  in [editor name]. The editing application is opened with the track's   active 
clip.

 3. Edit and save the file.

 The changes will automatically be applied in your ACID project.

If you save the edited   media with a different file name or location, your changes are not applied   automatically. 
You can add the newly created media to the project as a   new track or click the Replace   button  in the Clip 

Properties   window to replace an existing track with your new file. 

Using Sections
With sections, you can create different arrangements using simple drag-and-drop   operations.
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Each section label above the timeline represents a segment of your project.   When you drag a section label to a new 
location of the timeline, all events,   envelopes, regions,   commands, and markers   within the section follow. 

Insert a section

 1. Create a time selection   that includes the portion of the timeline that you want to use as a section.
 2. From the Insert menu, choose   Section (or press   Shift+S). A section label is added above the marker   bar.
 3. Type a name to identify the   section and press Enter.

Adjust a section's length

 1. Hover over the end of a section   label. The mouse pointer is displayed as a .

 2. Drag the end of the section:      to extend or shorten it.

Tips:

 l Hold   Shift to override snapping.
 l If you   drag a section over an adjacent section, both will be adjusted simultaneously:

Rename a section

 1. Right-click the section   label and choose Renamefrom the shortcut menu. The section   label changes to an edit 
box.

Press F2 to rename the selected section.

 2. Type a new name   in the edit box.
 3. Press Enter

Change a section's color

 1. Right-click the section   label and choose Color from the shortcut menu. 
 2. Choose a color from the   menu. The color of the section label is updated, but event colors do not   change.

Move (shuffle) sections
Shuffling sections allows you to move all events, envelopes,   regions, commands, and markers within a section in a 
single operation.
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 1. Drag a section label to   a new position on the timeline. A  is displayed to indicate where the section will be 
moved.

 2. When you drop the section,   events are split at each end of the section, and   all events within the section are 
moved to the position where you dropped   the section. Downstream events ripple to make room for (or fill the 
space   of) the section you dragged:

Notes:

 l Hold   Ctrl or Shift to select and shuffle multiple selections. 
 l When   shuffling envelope points, the shape of the envelope is copied to the   new location and  additional points 

are created   at each end of the section if necessary.
 l The tempo,   time signature, and key of the section will be preserved during shuffling,   and  tempo, time signature,   

and key markers will be created if necessary.

Copy a section
When you copy a section, you copy all events within the   section in a single operation.

 1. Hold Ctrl and drag a section   label to a new position on the timeline. A  is displayed to indicate where the 
section   will be copied.

 2. When you drop the section,   it is copied to the position where you dropped it.

Hold   Ctrl or Shift to select and copy multiple selections. 

Delete a section
Deleting a section removes the section and all events from   the timeline.
Right-click a section label and choose Delete   from the shortcut menu. Events are split at each   end of the section, 
and all events, envelope points, regions, commands,   and markers within the section are deleted. Downstream events 
ripple to   fill the space of the section you deleted.

Move a section label
Hold Alt while dragging a section label to move the selected   labels without affecting the contents of the timeline.
Hold Ctrl+Alt while dragging a section label to create copies   of the selected labels without affecting the contents of 
the timeline.

Remove a section label
Removing a section label removes the section label from   the timeline without affecting the section's events.
Right-click a section label and choose Remove  Label from the shortcut menu.

Clear all events from a section
Clearing events removes the events from a section while   leaving the section label intact.
Right-click a section label and choose Clear  Events from the shortcut menu. Events are split   at each end of the 
section, and all events within the section are deleted.
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Snapping
From the Options menu, choose Snapping, and then choose Enable   from the submenu to turn snapping on or off. 
Snapping helps you align items along the main ACID timeline, in the   Chopper window, on the Stretch tab   of the 
Track Properties   window, and in the Groove Editor window.
When snapping is enabled, the Grid only command   is available:

 l When Grid only (Ctrl+F8)   is selected, all elements that are designed to snap to the grid will snap   only to grid 
lines in the timeline. The grid is defined in segments of   time. 

 You can set the resolution of the grid by clicking the down arrow  next to   the Enable Snapping button  

and choosing a setting from the menu   or by choosing Grid Spacing   from the Options menu and choosing a 
command from the submenu.

 l When Grid only is not   selected, elements can snap to grid lines, regions boundaries, markers,   the cursor 
position, loop region in and out points, or the element's position   before you started dragging.

You   can temporarily override snapping by holding the Shift   key after you start dragging.

Cutting, Copying, and Pasting Events
Just like a word processor for audio, ACID software will allow you to   cut events, copy events, and paste them into 
new places.

Cut events             
Select the events you   wish to remove and click the Cut button  (or press Ctrl+X).   The selected events are 

removed from the track and placed on the clipboard.
If you want to shuffle existing events to fill the space   left by cut events when using a time selection, use ripple   edit 
mode.

Cutting a time selection

If you cut a time selection,   events across all tracks are removed from the timeline and placed on the   clipboard. Events 
that extend beyond the time selection are split at each   end of the time selection:

Time  selection Clipboard Events  after cut Events  after cut
(ripple mode)

Cutting selected events within a time selection

If you cut selected events   within a time selection, the selected events are removed from the timeline   and placed on 
the clipboard. Selected events that extend beyond the time   selection are split at each end of the time selection:

Editing Events on the Timeline 87



Time/event  selection Clipboard Events  after cut Events  after cut
(ripple mode)

Copy events             
Select the events you   want and click the Copy button  (or press Ctrl+C).   The selected events are copied to the 

clipboard. You may now paste the   copied events anywhere in the project.
Hold Ctrl   while dragging to create copies of selected events.

Copying a time selection

If you copy a time selection, the portions of events that   are within the selection (across all tracks) are placed on the 
clipboard:

Time  selection Clipboard

Copying selected events within a time selection

If you copy selected events   within a time selection, the portions of selected events that are within   the time selection 
are placed on the clipboard:

Time/event  selection Clipboard

Paste events             
Position the cursor and click the Paste button  (or press Ctrl+V).   Events from the clipboard are inserted at the 

cursor position.
Pasted events will sit on top of other events in the track   if they overlap. To make space for pasted events, you can use 
the Paste Insert command   or turn on ripple edit mode.
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In previous versions of ACID, you could only copy and paste   events within the same track. You can use clips   to copy 
events between tracks: if you select a different track before   you click the Paste   button, the event will be added to the 
selected track, and a new clip   will automatically be created. 

If you copy an event from track 1. . .
. . . and paste it into track the same track,   a new event is created on 
the same track. No clips are created.

If you copy an event from track 1. . .
. . . and paste it into track 2, the event from   track 1 is added to track 
2, and a new clip is created for the new event.

If you copy events from tracks 2 and 3. . .
. . . and paste them into track 2, the event   from track 1 is added to 
track 2, and a new clip is created for the new   event. A new track is 
created for the event from track 3.

 

Paste the contents of the clipboard multiple   times
From the Edit menu, choose Paste  Repeat (or press Ctrl+B) to insert events from the clipboard multiple   times at the 
current cursor position. 

 1. Copy events to the clipboard.
 2. Position your cursor where   you want to begin pasting the events.
 3. From the Edit menu, choose Paste Repeat.   The Paste Repeat dialog box appears.
 4. In the Number  of times to paste box, enter the number of times you want to paste   the event.
 5. Select your options and specify   the settings if applicable:
 6. End to End  — Pastes the   events one after another with no space between.
 7. Even Spacing    Pastes the events   with the time increments specified in the Paste every controls between the 

starting points of the pasted events. 
 If the Paste  every setting is shorter than the contents of the clipboard, the   pasted events will overlap.—

Paste insert events
To insert the contents of the clipboard at the current cursor   position and force existing events to move in time to 
accommodate the   pasted events, choose Paste Insert   from the Edit menu (or press Ctrl+Shift+V).

If the cursor is in the middle of an event, the event   will be split at the cursor position when the   new events are 
pasted.

This feature is useful   when rearranging a project by moving verses and choruses. 
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Deleting Events
From the Edit menu, choose Delete   to remove selected events or tracks   or without copying them to the clipboard.
If you delete a time selection, events across all tracks are removed   from the timeline. Events that extend beyond the 
time selection are split   at each end of the time selection:

Time  selection Events  after delete Events  after delete
(ripple mode)                     

If you delete selected events within a time selection, the selected   events are removed from the timeline. Selected 
events that extend beyond   the time selection are split at each end of the time selection:

Time/event  selection Events  after delete Events  after delete
(ripple mode)                     

To remove the unused media from your project, choose Remove  All Unused Clips from the Tools menu. To 
remove unused clips from   individual tracks, click the Remove  Unused Clips button  in the Clip   Pool 

window.

Undoing and Redoing Edit Operations
Undo and redo give you the freedom to experiment with your project.   Edit to your heart's content. If you change your 
mind, you can always   undo your changes. If you change your mind again, you can redo the undone   edits (whew!).
For example, if you accidentally deleted a track, simply choose Undo   to restore the track.

You   can perform an unlimited number of undos, so you can restore the project   to any state since the last Save   
command.

Undo the last action   performed             
From the Edit menu, choose Undo or click the Undo   button .

Undo a series of actions             

 1. Click the arrow  next to   the Undo button   . A list of the most recent actions   that you can undo is displayed.

 2. Select the action you want   to undo. If the action does not appear in the list, use the scroll bar   to scroll through 
the list. The selected action and all actions above   it are reversed.
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Reverse the last Undo   performed             
From the Edit menu, choose   Redo, or click the Redo button   .

If you later decide that you did not want   to reverse an undo, click the Undobutton .

Reverse a series of   Undo actions             
When you reverse an Undo, you also reverse   all Undo actions above it in the list.

 1. Click the arrow  next to   the Redo button   .   A list of the most recent actions that you can redo is displayed.

 2. Select the action you want   to redo. If the action does not appear in the list, use the scroll bar   to scroll through 
the list. The selected action and all actions above   it are redone.

 Undo all edits             
From the Edit menu, choose Undo  All to reverse all edits in the undo history.
You can view the edit history by clicking the arrow  next to   the Undo button   .

Clear the edit history             
From the Edit menu, choose Clear  Undo History to clear all of the entries in the Undo/Redo History   list for the 
current project.
The edit history is also cleared when you close your project.

You will not be able undo or redo any previous   changes after clearing the history. 

Ripple Edits
From the Options menu, choose Ripple  Edits if you want to shuffle existing events when you cut, delete,   and paste 
events in the specified track.
Ripple edit mode is not available unless you're using the Time Selection   tool .

Pasting   in ripple edit mode ripples only the events on tracks where events will   be pasted. If you want to ripple all 
tracks, you can use the Paste  Insert command.

Cut events in ripple   edit mode             
Depending on the type of selection you have made, the results   will differ. Following are graphic examples displaying 
events being cut   with and without ripple mode enabled:

Time selection Clipboard Events after cut without  
ripple mode

Events after cut with ripple  
mode
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Time/event selection Clipboard Events after cut without  
ripple mode

Events after cut with ripple  
mode

 1. From the Options menu, choose   Ripple Edits.
 2. Select the Time Selection   tool .

 3. Select the events you want   to cut. If you want all events within a time selection to be cut, do not   select any 
events and continue to step 4.

 4. Drag along the marker bar   to make a time selection. All events, and/or portions of events within   the region are 
highlighted.

 5. From the Edit menu, choose   Cut. The events   are removed and copied to the clipboard. The remaining events are 
moved   along the timeline to fill the empty time space.

Paste events in ripple edit mode             
Depending on the type of selection you have made, the results   will differ. Following are graphic examples displaying 
events being pasted   with and without ripple mode enabled:

Time  selection copied Pasting  time selection without 
ripple mode

Pasting  time selection with ripple 
mode

Time/event  selection copied Pasting  time/event selection 
without ripple mode

Pasting  time/event selection with 
ripple mode

 1. From the Options menu, choose   Ripple Edits.
 2. Position the cursor where   you want the events to be pasted.
 3. From the Edit menu, choose   Paste. The events   from the clipboard are inserted at the cursor position. The 

remaining   events are moved over on the track.

Events will always be pasted back in their own tracks.

Delete events in ripple edit mode
Depending on the type of selection you have made, the results   will differ. Following are graphic examples displaying 
events being deleted   with and without ripple mode enabled:
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Time  selection Events  after delete without ripple 
mode Events  after delete with ripple mode

Time/event  selection Events  after delete without ripple 
mode Events  after delete with ripple mode

 1. From the Options menu, choose   Ripple Edits.
 2. Select the Time Selection   tool .

 3. Select the events you want   to delete. If you want all to delete all events within a time selection,   do not select any 
events and continue to step 4.

 4. Drag along the marker bar   to make a time selection. All events, and/or portions of events within   the region are 
highlighted.

 5. From the Edit menu, choose   Delete. The   events are removed from the track and the remaining events are moved 
on   the track to fill the empty time space.

Splitting Events
From the Edit menu, choose Split  to divide selected events at the cursor position.
Splitting an event allows you to adjust a small part of an event independently.   For example, you may want to apply 
pitch shift to a few measures of an   event and then return the event to its original setting.

 1. Position the cursor where you want to split the events,   or select a range of time.
 2. Select the events   you want to split.
 3. From the Edit menu, choose Split.

If there is no time selection, the events will be split at the cursor   position. If a time selection exists, events will 
be split at each edge   of the time selection.

If   no events are selected, the events located at the current cursor position   will be split throughout all of the 
tracks.

Joining Events
Use the Join command   to merge selected events.

If   you do not have at least two events selected on a track, the command is   unavailable.

Join events on an audio track

 1. Select   the events you want to join.
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 2. From the Edit menu, choose Join.
The selected events on each track are joined. Any space between the   events will be filled. If you're joining events 
that use distinct clips,   events will be joined using the media from the first selected clip:

Events before joining                                 

Events after joining

Drag across events with the Paint   tool selected to join them.

Join events on a MIDI track    

 1. Select   the events you want to join.
 2. From the Edit menu, choose Join. 

The selected events on each track (and any events between them) are   joined. Any space between the events will 
be filled, and a new MIDI clip   will be created to contain the MIDI data exposed by the clips:

 Events before joining

 Events after joining; a new clip is created

If   you join clips that are in different keys (you can set a   MIDI clip's key on the Clip Pool tab of the MIDI Track 
Properties   window), the new MIDI clip will use the key of the first clip. Subsequent   clips will be transposed as 
needed to ensure that the note values you   see in the event will be preserved after joining. 

Trimming Events
From the Edit menu, choose Trim   to remove all data from an event outside of the current time selection.   Trimming 
does not copy data onto the clipboard.

The   command is available only when the Time Selection   tool is active.

 1. Select   the data you want to keep.
 2. From   the Edit menu, choose Trim.   All data outside of the selection is deleted. 
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Reversing an Event
Reversed events are perfect for backward guitar solos, creating the   illusion of turning back time, or whatever else you 
can dream up. The   event plays backward on the timeline without affecting the source media.

Events cannot be reversed on MIDI tracks.

 1. Select the audio events you want to reverse.
 2. Right-click a selected event. 
 3. Choose Reverse  from the shortcut menu (or press U to reverse the selected event).   The event is reversed on the 

timeline, and an arrow is displayed on the   event to indicate that it has been reversed:

This procedure has the same effect as selecting   the Reverse check   box in the Event Properties   dialog.

Grouping Events
After you've arranged your events so they're just where you want them,   you can create groups to lock the events 
together. Once grouped, you can   apply editing tasks to the entire group of events.

Cutting,   copying, or deleting   an event will affect all events in the same group.

Create a group of events

 1. Select the events you   want to group together.
 2. From the Edit menu,   choose Group,   and choose Create New   from the submenu (or press Ctrl+Alt+G).

Ungroup a group of events

 1. Click on any event in   the group.
 2. Right-click, point to   Group, and choose   Select All from   the shortcut menu. All events in the group are 

highlighted.
 3. From the Edit menu,   choose Group,   and choose Remove From   from the submenu (or press Ctrl+Alt+U).

Remove an event from a group
Right-click the event you want to remove, choose Group   from the shortcut menu, and choose Remove   From from 
the submenu. The event is removed from the group.

Temporarily ignore grouping
Select the Ignore   Event Grouping button  (or press Ctrl+Shift+U) to   override events groups without removing 
the groups.

The Chopper Window
The Chopper window allows you to select portions of media that can be   placed into tracks as events or used to 
create new loops.
From the View menu, choose Chopper   to toggle the display of the window.
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Use the Chopper window   to create events             

 1. Select an event. The waveform   for the selected event's clip   is displayed in the Chopper window.
 2. Select the part of the waveform   that you want to insert as an event.

If snapping is enabled, your selection will   snap to the current grid spacing.
 3. Select the Link Arrow to Selection button  if you want to insert events end-to-end, or turn off the Link 

button and drag   the arrow above your selection to specify an offset. See Set   an offset between selections in this 
topic for more information.

 4. Add the selection as an   event on the timeline.
 a. Click Insert  Selection  (or press A)  to insert the current selection as an event at the edit cursor. Click   

again to insert another event with its starting point offset by the amount   specified by the event increment 
arrow.

 b. Click the Insert  Selection at Play Cursor button  (or press Y) to add the current selection as an event   at 

the play cursor (during playback, the edit cursor remains fixed, and   the play cursor follows playback). 

If the track header has focus,   the track's current paint clip will be inserted   in its entirety at the play 
cursor when you press Y.

You can also drag a selection to the timeline or copy   and paste selections from the Chopper window to the 
timeline. If snapping is enabled, events   are created at the next snap point. 

Use the Chopper window   to clone new loops (chop to new track or clip)             

 1. Select an event. The waveform   for the selected event's clip   is displayed in the Chopper window.
 2. Select the part of the waveform   that you want to use to create the new loop.

 If snapping is enabled, your selection will   snap to the current grid spacing.
 l If the selection is an integral   number of beats, a loop will be created.
 l If the selection is shorter than   the Open files as loops  if between setting on the Audio   tab of the 

Preferences dialog, a one-shot will be created.
 l If the selection is longer than   the Open files as loops  if between setting on the Audio tab of the 

Preferences dialog,   a Beatmapped clip will be created.
 3. Perform either of   the following actions:

 l Right-click the selection and choose   Chop to New Clip from   the shortcut menu. 
or ——
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 l Right-click the selection and choose   Chop to New Track   from the shortcut menu (or drag the selection to 
the track list). 

 The Chop to New dialog is displayed. 
 4. Use the Chop to   New dialog to specify the format and location where you want to save the   new file. The original 

file name is used, and Chopped  [number] is appended to the   file name.
 5. When you click Save,   the new file is saved.

 If you chopped to a new clip, a new clip   is added to the original track.

 If you chopped to a new track, a new, blank track is added to your   project.

Make a selection in   the Chopper window
The selection in the Chopper window determines which part   of the media file will be added to the track list when you 
click the Insert Selection  button. Perform any of the following   actions to create a selection:

 l Drag within the Chopper window.
 l Position your cursor at the beginning   of the data you want to select. Then right-click in the Chopper window,   

choose Selection Length   from the shortcut menu, and then choose a length from the submenu.
 l Hold the   Shift key and press the right or left arrow keys.
 l Right-click   an event in the timeline and choose Select  in Chopper from the shortcut menu. The sound data 

contained in   the event will be selected in the Chopper window. For example, if an event   contains only one beat 
from a drum track, the Chopper window will display   the full drum track, and beat from the event will be selected 
in the Chopper   window.

From the Options menu, choose Snapping, and   then choose Enable  from the submenu if you want to snap 
your selection to markers   or ruler marks in the Chopper window.

The selection's start, end, and   length are displayed in M:B:T (measures: beats: ticks) in the bottom right-hand   corner 
of the window:

Selection Start Selection End Selection Length

When you create a selection in   the Chopper window, a bar is displayed in the selected track to indicate   where the 
event will be inserted when you click the Insert  Selection button:

Set an offset between   selections
You can use the Link  Arrow to Selection button  to specify the space between the start of   events inserted from 

the Chopper window.

 l To insert   events with no space between them, select the Link  Arrow to Selection button. The increment arrow is 
displayed in   the same color as the waveform, and the increment length is tied to the   selection length.

 l To insert   events with a space between them, turn off the Link  Arrow to Selection button and drag the end of the 
arrow to set   the event increment.   The increment arrow is displayed in black, and the length will remain   until you 
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resize it.

 To create a gap between inserted events, set the event increment   larger than the selection size. In the following 
example, one-beat events   are inserted with one beat of silence between them.

Chopper  Selection Inserted  Events

To overlap events and create   a stuttering effect, set the event   increment shorter than the selection   size. In the 
following example, one-beat events are inserted with   a half-beat overlap.

Chopper Selection Inserted  Events

Add markers or regions   to the Chopper window
You can add markers and regions to the Chopper to help you   identify parts of a sound file. For more information, see 
"Using Markers" on page 128   and Regions.
Markers and regions in the Chopper window will be saved   with your ACID project. If you want to save them to the 
track's source   media file, use the Save   button in the Track Properties   window.

Learn more about Chopper   window controls             

Control Description
Shortcut

Key

Insert Selection: click to insert the   current selection as an event at the cursor position. Click 
again to insert   another event with its starting point offset by the amount specified by   the 
event  increment arrow.

/ or a                         

Move Track View Cursor Left: click to   move the cursor in the timeline left by the current 
event increment.                         

Ctrl+,

Move  Track View Cursor Right: click   to move the cursor in the timeline right by the current 
event increment.                         

Ctrl+.

Link  Arrow to Selection: select to link   the selection size and event increment settings. When 
the button is enabled,   the selection and increment are always equal. When the button is not 
selected,   you can set the increment longer or shorter than the selection to create   gapping or 
stuttering effects.                         

n

Halve  Selection: click to reduce the   current selection by half. For example, if you have four 
measures selected   and choose Halve  Selection, only measures one and   two will be selected.                         

;                        
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Double  Selection: click to double the   current selection. For example, if you have four 
measures selected and   choose Double  Selection, an additional four measures   will be 
selected.                         

'

Shift  Selection Left: click to move the   current selection left by the length of the selection.                         ,   or <

Shift  Selection Right: click to move   the current selection right by the length of the selection.                         .   or >

Adjusting an Event's Length
Adjusting an event's length determines which portion of a media file   is played by an event and for how long. 

Trim the start or end   of an event
With the Draw  or Time Selection  tool selected, drag either end of an event.   The waveform stays in place, but 

the beginning or end of the event will   move.
The event edge will snap to grid lines if snapping   is on; you can hold the Shift key while dragging to temporarily 
override   snapping.

If you drag the end of the event past the end of the   media file, loops and MIDI clips (with the Looped   check box 
selected in the Clip   Pool) will paint continuously across the timeline. One-shots and Beatmapped   clips do not 
repeat.

Shift the contents   of (slip) an event             
With the Draw  or Time Selection  tool selected, hold   Alt while dragging an event. The mouse pointer is 

displayed as a .

As you drag the event, the contents of the event shift,   but the event will not move. You can use this technique when 
you want   to maintain an event's length and position, but have the event play a   different section of the source media 
file. 
This example demonstrates holding Alt while dragging an   audio event to the right:

Slip-trim an event             
With the Draw  or Time Selection  tool selected, hold Alt while dragging the right or left edge   of an event. The 

mouse pointer is displayed as a .

As you drag the event edge, the opposite edge of the event   will remain fixed, trimming the media from the edge you 
drag.
This example demonstrates holding Alt while dragging the   right edge of an event to the right:
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Slide an event           
Hold Ctrl+Alt while dragging an event. The mouse pointer   is displayed as a .

As you drag, the relative position of the media remains   fixed on the track, and the event position changes. You can 
use this technique   when you want to maintain an event's length, but have the event play a   different section of the 
source media file at a different point in your   project.
The following image represents holding Ctrl+Alt while dragging   an audio event to the right:

Event Envelopes
Event envelopes give you the ability to control an audio event’s volume,   fade-in, and fade-out.

If   you've upgraded from ACID 1.0 or 2.0 software, you'll notice that event   envelopes behave differently in 
version 11. Use track   envelopes for panning, effects levels, effect automation, and when   you want to create 
multiple envelope points.

Adjust an event's overall   level             

 1. Hover over the top of an   event with the Draw  or Time Selection  tool.

 2. When you see the envelope pointer (  ), drag the volume   line to the desired level. As you drag the volume line, 
the event’s gain   is displayed in dB.

When you have multiple events selected, the   gain of all selected events is adjusted simultaneously. Dragging 
the fade-in   or -out curve has no effect when multiple events are selected.

Fade an event in or out (fade offset)             

 1. Hover over upper-left or   upper-right corner of an event with the Draw  or Time Selection  tool. The 

mouse pointer is displayed as a   .

 2. Click   the corner of the event and drag to create a fade.                     

To   remove a fade, drag the end of the fade curve back to the end of the event.                     
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Change the fade curve type

 1. With the Draw    or Time Selection  tool selected, right-click in the faded area, and   choose Fade In Type  or 

Fade Out Type   from the shortcut menu.
 2. Choose a fade type from the   sub menu to set the speed of the fade. 

Modifying Event Properties
Event properties allow you to perform advanced event-level editing.   These properties are saved only with a project 
and are not saved into   the files when you save stretching   properties for a clip.
To modify event properties, right-click an event and choose Properties   from the shortcut menu.

Start offset             
The Start offset for an event specifies a playback starting position   that is different than the beginning of the file. This 
is especially useful   for loops; you can change the feel by simply starting a loop at a point   other than beat 1.
There are two ways to edit the Start  offset:

 l The most precise way is to type in   the number of samples (or ticks for a MIDI clip) by which you wish to   offset 
the Start  offset edit box.

 l In the timeline, select the Draw tool and hold  the Alt key while dragging   an event left or right. The waveform will 
scroll within the event boundaries   to show the new starting point.

Pitch shift             
The Pitch  shift value raises or lowers the pitch of the selected event. Event-based   pitch shift is calculated after the 
project key and any pitch shift assigned   to a track.

When the Preserve  pitch when stretching check box is cleared in a Beatmapped track's   Properties, you cannot   
change the pitch of a Beatmapped event.

Speed (one-shots only)             
The Speed   setting allows you to change the playback speed (and consequently the   pitch) of an event on a one-shot 
clip.

Quick fade edges to prevent clicks             
When an event does not end on a loop point, you can introduce   an audible click at the edges of the event. Select the 
Quick  fade edges to prevent clicks check box to apply a quick fade-in   or fade-out to prevent clicking when you split 
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events, pitch shift, or   perform other edits that do not occur at a loop point.

Because quick fades   are very short, you will have to zoom   in to see them. You can set the quick fade duration on 
the Audio   tab of the Preferences dialog.

Adjusting quick fades

To adjust a quick fade, zoom   in to the event and hover over upper-left or upper-right corner of an   event until the 
cursor is displayed as a . Drag   the edge of the fade to adjust its duration:

Adjusting the fade curve

 1. With   the Draw  or Time Selection  tool selected, right-click   in the faded area, and chooseFade   In Type or 

Fade   Out Type from the shortcut menu.                      
 2. Choose   a fade type from the submenu to set the speed of the fade.                      

Play reversed             
Would a reverse-tape effect add the perfect nuance to your   project? 
Select the Reverse check box to reverse an event. When you play the project,   the event is played backward, and an 
arrow is displayed on the event to   indicate that it has been reversed:

Press U or right-click an event and choose   Reverse from  the shortcut menu. You can reverse multiple selected   
events at once.

Muting and Locking Events
Right-click an event, choose Switches   from the shortcut menu, and then choose a command from the submenu to   
mute or lock the selected event.

Hold Ctrl or Shift while clicking to select multiple events.

Mute events
Muting an event excludes it from playback while preserving   its position on the timeline. 

 1. Select the events you want to mute.
 2. Right-click a selected event, choose   Switches from  the shortcut menu, and then choose Mute from the 

submenu.
If you want to unmute an event, choose Mute   again.
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Muted events are dimmed on the timeline. 

Lock events             
Locking an event prevents it from being edited on the timeline.   

Notes:

 l Locked events cannot be dragged   on the timeline.
 l When adding   events to the timeline, you cannot draw or paint past a locked event.   
 l Erasing in the timeline will not   erase a locked event.
 l Event   envelopes cannot be modified for locked events.
 l Ripple   edits and automatic crossfades will   not be applied to locked events.

 1. Select the events you want to lock.
 2. Right-click a selected event, choose   Switches from   the shortcut menu, and then choose Lock  from the 

submenu.

 If you want to unlock an event, choose Lock   again.
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Recording

How Do I Record Audio from an External Source?
This topic provides general guidelines to help you record sound from   an external source using ACID software. Your 
specific hardware may vary.   Please refer to your hardware documentation for more information.

If you're recording from a turntable, use a phono preamplifier   between your turntable's output and your sound 
card's line input. Most   turntables' outputs are phono-level (rather than line-level) outputs.   Phono-level outputs 
are quieter than line-level outputs and have special   equalization applied. A phono preamplifier will convert the 
phono-level   signal to a line-level signal that you can record.

Connect an audio source   to your sound card's input             
Basic setup

In this setup, an audio source   is connected to an input on your sound card, and your powered speakers   are 
connected to a Line  Out output. You could connect a computer microphone to your sound   card's Mic  In input, or 
you can connect line-level outputs from a tape deck   or other source to a Line  In input.

Basic setup with mixer/preamplifier

In this setup, your speakers   and audio source are connected to a mixer or preamplifier. The mixer/preamplifier   is 
then connected to Line In and Line  Out connections on your sound card.

If you're recording from a turntable, use   a phono preamplifier between your turntable's output and your sound 
card's   line input. Most turntables' outputs are phono-level (rather than line-level)   outputs. Phono-level outputs 
are quieter than line-level outputs and have   special equalization applied. A phono preamplifier will convert the 
phono-level   signal to a line-level signal that you can record.
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Digital input/output with MIDI synchronization

In this setup, an audio source   with digital input/output is connected to a sound card with digital input   and outputs. 
Dashed lines represent a sync connection from your audio   source to a MIDI timecode converter to a MIDI card.

Choose an input device and adjust levels             
Before you start recording, you'll need to verify that your   sound card's recording inputs are active.

 1. Ensure all cables are connected   and that your audio source is generating a signal.
 2. Select the Arm  for Record buttons  on the tracks where you want to record. Arming   a track enables it for 

recording.

 When a track is armed, the track meter displays the track's level.   If input monitoring is not on, the meter 
displays the level of your input   source. If input monitoring is turned on, the meter shows the level of   the input 
source plus the track effects chain.

 3. To choose your recording   input, click the Record  Device Selector button , choose an audio device from the 
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menu, choose   Mono or Stereo from the submenu, and then choose   an input.

 
 4. Adjust your recording   levels:

 l If your audio device provides a   console application to adjust levels, open the application and adjust   its gain 
controls while monitoring the peak meters on the Meters tab in   the recording dialog. Adjust the gain 
controls in the console application   so ACID receives a strong signal with no clipping.  For more information 
about using your sound card and its console application,   please refer to the manufacturer's documentation.

 l If you're using your Windows sound   card, perform the following steps to open the recording controls: 
 a. Double-click   the speaker icon  in your system tray to open the Volume Control   window.

 b. From the   Options menu, choose Properties.
 c. Click the   Recording radio button and click OK.
 d. Select   (or unmute) the device from which you want to record.
 e. Adjust   the Volume faders   for the selected device and for the Master Record level while monitoring   the 

recording meters in the ACID Record dialog.  For example, if you want to record from an audio CD in 
your CD-ROM   drive, the CD Mute check box should not be selected, and the CD and Master Record 
Volume   faders must be adjusted so ACID receives a strong signal with no clipping.

 5. If you have a sound card with   multiple inputs and outputs, you can record multiple tracks at once. Repeat   steps 
2 through 4 to choose an input device and set levels for each track.

 6. Click the Record  button  below the timeline when you're ready   to start recording. 

For more information about recording audio, please see "Recording Audio" below.

Recording Audio
 Ctrl+R

ACID can record audio into multiple mono or stereo tracks while simultaneously   playing back existing audio and 
MIDI. You are limited only by the performance   of your computer system and audio hardware. Audio is recorded to a 
media   file on your computer and into an event on the timeline.
You may record into an empty track, a time selection, an event, or a   combination of time and event selection. You 
can also record multiple   takes for an event as clips   so you can maintain multiple versions of an event that you may 
play back   and edit.
For information about recording MIDI, please see "Recording MIDI" on page 113.

Notes:

 l Recorded   files are saved in the folder specified on the Folders tab of the Preferences dialog by default.   If you 
want to choose a project-specific folder, you can use the Recorded files folder box on the Audio tab of the 
Project Properties dialog.

 l You   can use the ACID type  for recorded audio drop-down list on the Audio   tab of the Preferences dialog to 
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indicate whether you want to create Beatmapped   clips or one-shots when you record audio.
 l Use   the Record action when  nothing is armed drop-down list on the Audio   tab of the Preferences dialog to 

indicate whether you want to create an   audio track, a MIDI track, or do nothing if you click the Record   button 
 when no tracks are armed.

When   input monitoring is on during audio recording, audio effects chains that   contain non-in-place plug-ins 
are displayed in yellow ( ) to indicate that automatic plug-in delay   compensation is being used. Chains that 

cannot be used for live monitoring   are automatically bypassed and are displayed in red ( ).

Record audio             
By   default, the Microsoft Sound Mapper is used to record audio. However,   you can use the Audio Device   tab in the 
Preferences dialog to specify a different recording device.

 1. Connect an audio source   to your sound card's input.
 2. Position the cursor where   you want to start recording.
 3. Select the Arm  for Record buttons  on the tracks where you want to record. Arming   a track enables it for 

recording.

 When a track is armed, the track meter displays the track's level.   If input monitoring is not on, the meter 
displays the level of your input   source. If input monitoring is turned on, the meter shows the level of   the input 
source plus the track effects chain.

 4. Click the Record button  on the Transport bar to start recording.

 5. To stop recording, click   the Record button again or click the Stop   button  on the Transport   bar. The 

Recorded Files dialog is displayed.
 6. Use the Recorded Files dialog to confirm   the file name and location of your recorded audio. Click Delete or 

Delete All   if you do not want to save the recorded files, or click Rename   to change the file's name.

 7. Click Done   to close the Recorded Files dialog. Your recorded file is displayed as   a new event in the timeline.
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Record multiple clips              
If Loop  Playback  is turned on for your project, playback will loop   during recording and a clip will be created each 

time playback returns   to the start of the loop region. The last clip recorded is set as the   track's active clip.
A separate clip is created each time ACID records through   the loop region, and you can use the Clip Pool tab in the 
Track   Properties window to manage the clips.
The Clip Properties   window will display region markers to represent the selected event's clip   in the waveform.
For information about working with clips, please see Using Clips with Tracks.

Record a new clip for an audio event             
You may record into an audio event   by selecting it. The record time is determined by the event's length.

 1. Select the event and position   the cursor at the beginning of the event.
 2. Select the Arm  for Record button  on the track that contains the event.

 3. Click the Record button  on the Transport bar to start recording.

Select theLoop Playback   button  on the Transport bar to record   multiple clips within the selected event.

The last clip recorded is set   as the active clip for the track. For information about working with clips,   please see 
Using Clips with Tracks.

 4. To stop recording,   click the Record  button again or click the Stop   button  on the Transport   bar. The 

Recorded Files dialog is displayed.
 5. Use the Recorded Files dialog   to confirm the file name and location of your recorded audio. Click Delete or 

Delete All if you do not want to save the recorded files, or click Rename to change the   file's name.

 6. Click Done to close the Recorded Files dialog. Your  recorded file replaces the contents of the event in the 
timeline.

Record into a time selection or event (punch-in)             
You may record a new clip into a selected audio event using   a time selection. This option provides room for pre-roll 
and post-roll   during recording.
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 1. Select the event you want   to punch into:
 l If you   want to punch into the middle of an event, select the portion of the event   you want to replace and 

press S to split the event.
 l Select   multiple events to create multiple punch-in and -out points.

 2. Create a time selection to set the amount   of pre-roll and post-roll and press Home to position the cursor at the   
beginning of the time selection. The edges of the selected events   serve as the punch-in and punch-out points:

 3. Select the Loop  Playback button    if you want to record multiple clips of each event. A new clip will be   

created each time playback returns to the start of the loop region. The   last clip recorded is set as the track's 
active clip.

 For information about working with clips, please see Using   Clips with Tracks.
 4. Select the Arm  for Record button  on the track that contains the event.

 5. Click the Record button  on the Transport bar to start recording.   

 If input monitoring is turned on, the track's original audio is played   until the cursor reaches the selected event. 
When the cursor plays through   the selected event, you'll hear your recording input, and the track's   original audio 
is played again when the cursor moves past the selected   event.

 6. To stop recording, click   the Record button again or click the Stop   button  on the Transport bar. The 

Recorded Files dialog is   displayed.
 7. Use the Recorded Files dialog to confirm   the file name and location of your recorded audio. Click Delete or 

Delete All   if you do not want to save the recorded files, or click Rename   to change the file's name.

 8. Click Done   to close the Recorded Files dialog.
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When performing punch-in recording, recording occurs   underneath the pre- and post-roll. If your subject starts 
early, for example,   you can adjust the event to uncover the recording. Hold Alt while dragging   the event to slip 
the media under the event, or click one of the following   links for information about trimming and 
slipping/sliding   events.

You can also use the Clip Properties   dialog to adjust the clip take offset:

Right-click an event and choose Clip  Properties from the shortcut menu.

On the General tab of the Clip Properties dialog, a green region marks   the clip's location in the recorded file. 
Drag the region markers to adjust   the clip:

Change the recording device and attributes   for recording audio             
The Record  Device Selector button  in a track header chooses the audio input   that will be used to record to a 

track and allows you to configure input   monitoring.

Record Device  Selector with a compact 
track header.

Record Device  Selector with an expanded 
track header.

To choose your recording input, click the Record  Device Selector button , choose an audio device from the 

menu, choose   Mono or Stereo from the submenu, and then choose   an input.
To record from an input bus, click the Record Device Selector button , choose Input Busses from the menu, and 

then choose an input bus from the submenu.   For more information about recording using input busses, please see 
"Using Input Busses" on page 175. 
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Monitor audio levels             
While you're recording, a responsive meter is displayed   in the track header to monitor the incoming signal level of 
the selected   recording device. It is important that you record with the highest signal   possible without clipping. 
When a track is armed, the track meter displays the track's   input level. If input monitoring is not on, the meter 
displays the level   of your input source. If input monitoring is turned on, the meter shows   the level of the input source 
plus the track effects chain.

A reading of 0 dB is the maximum for a digital signal. Clipping   occurs when the incoming signal is too high to be 
represented as a digital   value. The result is distortion in the recording. A clipped signal will   be indicated by a red 
indicator at the end of the meter.
Right-click the meters and choose a command from the shortcut   menu to adjust the display of the meters.

Toggle record input monitoring             
If you're using a low-latency audio   device, ACID can perform record input monitoring so you can hear your   
recording signal with real-time track effects.   
To turn on input monitoring, click the Record  Device Selector button  ,   choose Input Monitor   from the menu, 

and then choose Input Monitor Mode: On  or Input  Monitor Mode: Auto  from the menu. During recording, 
your signal   will be played back with the current track effects chain, but a dry (unprocessed)   signal is recorded.

 l When Auto   is selected, you will hear the input monitor signal when playback   is stopped and during 
recording. If you're recording into selected events,   you'll hear the input monitor signal only when the cursor 
passes over   the selected events. 

 l When On  is selected, the behavior is similar to Auto   mode, but you will always hear the input monitor 
during recording—monitoring   is not toggled on and off when recording into a selected event.

Your ability to monitor   effects in real time is dependent on your computer's performance. Effect   automation 
envelopes are bypassed during record monitoring.

Record using the metronome            
From the Options menu, choose Metronome    before recording. When you start recording, the metronome will 

start playing   at the current project tempo.
Use the Preview fader in the Mixing   Console window to adjust the volume of the metronome.

The metronome’s sound   is not mixed in the final rendering of the project.
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Setting up a MIDI Keyboard for use in ACID
This topic will help you set up a MIDI keyboard for recording in ACID.

 1. Before starting ACID, connect your MIDI device.
 l If you're using a USB keyboard, connect   it to an available USB port on your computer and install drivers if 

necessary.
 l If you're using an external MIDI interface   (such as a USB-to-MIDI converter or an external sound card with 

MIDI ports),   connect the MIDI In   port on your MIDI interface to the MIDI Out port on your keyboard, and 
connect the MIDI Out port on your MIDI interface to the MIDI In port on your keyboard.

 l If you're using a MIDI cable connected   to the joystick port on your sound card, connect the MIDI In plug 
on the   cable to the MIDI Out port on your keyboard, and connect the MIDI In plug to the MIDI  Out port on 
your keyboard.

 2. Start ACID.
 3. Enable the port where your MIDI keyboard is connected:

 a. From the Options menu, choose Preferences > MIDI.
 b. In the Make  these devices available for MIDI input box, select the check box   for the port where your MIDI 

device is connected.
If you want to type a name to identify the   device that is connected to the port, double-click the Device   
box and type a new name to identify the MIDI device connected to each   MIDI input or output port. For 
MIDI tracks that use these input and output   ports, these device names will be used on the MIDI Input 
and MIDI  Output buttons on the track header.   

 c. Select the Auto  MIDI input routing check box. When this check box is selected,   the focus track will accept 
input from any MIDI input device when you   record MIDI.  When multiple tracks are selected, the focus 
track displays a blinking   indicator in its track number: .

 4. Add a software synthesizer (soft synth) to your project.      The soft synth will give a voice to the notes you play on 
your keyboard:
 a. From the Insert menu, choose Soft Synth to add a  soft synth bus control to the Mixing Console window 

(you can also click the Insert Soft Synth button in the Mixing Console window). The Soft Synth Chooser 
dialog is displayed. 

 b. On the Soft Synths tab, select the       synthesizer you want to use, and then click OK.       If you want to change 
your choice later, you can edit      the soft synth.

 5. Select the MIDI track you want to record into, or press   Ctrl+Alt+Q to add a new, blank MIDI track to your 
project.

 6. Choose a MIDI input and output port for your track:
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 a. Click the MIDI  Input button on the track header and choose an input port from   the menu. For this example, 
we can choose either Auto  Input or the port you selected in step 3b above.

 b. Click the MIDI Input button on the track header and ensure Send MIDI Input Thru to MIDI Output is 
selected so you can hear the   notes you play while recording.

 7. Click the MIDI  Output button on the track header and choose the soft synth or   MIDI device and channel you 
want to use to play MIDI data on the track.

 8. Select the Arm  for Record button  on the track where you want to record. Arming   a track enables it for 

recording.
 9. Click the Record   button  on the transport bar to start recording. 

 a. MIDI   messages from your controller are recorded as you play them.                  
 b. Notes are added to an event in the   timeline. 
 c. MIDI controller adjustments (such   as pitch wheel and modulation wheel movements) are recorded as track 

envelopes.   MIDI controllers are recorded in latch mode: envelope points are created   when you change a 
control setting, and recording continues until you stop   playback. When you stop adjusting the control, the 
control's current setting   overwrites the existing envelope points.

 10. To stop recording, click the   Record button again or click the Stop   button  on the transport bar. 

 For more information about recording from a MIDI device, please see   Recording MIDI.

Recording MIDI
You can use an external MIDI controller (or   the keyboard/drum list between the track header and timeline) to record   
MIDI into your ACID project.
You can record in real time during project   playback, use step recording, or use MIDI merge recording to build MIDI   
tracks.
Track-level "MIDI Input Filtering" on page 119 available   on the Input Filters tab in the Track Properties window allow   
you to control exactly which MIDI messages you want to record (or exclude)   or even split a MIDI keyboard into 
zones to record into two different   tracks at once.——

If you use the keyboard/drum list between   the track header and timeline to input MIDI notes, note that the 
buttons   are velocity sensitive: clicking toward the right side of a button plays   the note with a higher velocity 
setting than clicking toward the left   side. The keyboard/drum list is visible in inline   MIDI editing mode.
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Attempting to record MIDI controller data over an existing event   will overwrite existing note data. If you want to 
record controllers over   an existing event that contains note data, use MIDI merge recording (see   Use MIDI 
merge recording to build a part   in this help topic).

Set up a MIDI controller for recording into a track 
If you have a MIDI controller that includes buttons   and knobs that you map to external control functions, you 
can use the   device as an external control   device and as a MIDI input device for recording MIDI    for example, you 
can use the buttons, knobs, and sliders on the device   for external control, and still use the keyboard, pitch wheel, 
and modulation   wheel for recording MIDI. 

MIDI messages that are mapped to external control functions are filtered   when you record MIDI. If a note 
message is assigned to a control surface   function, both the note-on and note-off messages will be filtered. —

 1. Select the MIDI track you   want to record into, or press Ctrl+Alt+Q to add a new,   blank MIDI track to your 
project.

 2. Choose a MIDI input port:
 a. Click the MIDI  Input button on the track header.

 b. Choose a command from the menu:

Item                         Description

Auto 
Input

Uses automatic input routing. When this command   box is selected, the 
focus track will accept input from any MIDI input   device. 

Use Auto  Input when you want to record multiple   controllers 
simultaneously. For example, with Auto  Input selected, you could 
record   a MIDI keyboard and bass pedal to a single track.                         

Input Off Turns off MIDI input to the track.

Hardware 
Input Port 
List

Displays the devices that are selected in the   Make these devices 
available for MIDI  input list on the MIDI tab of   the Preferences dialog.
Choose the specific device you want to use to   send MIDI to the track.

You must choose a specific input port to use MIDI input filters.

Soft Synth 
Input Port 
List

Displays the available soft synths in your project.   
Choose the soft   synth you want to use to send MIDI to the track. Use 
this setting to record the output of MIDI plugins like step sequencers or 
arpeggiators. Read more under "Using MIDI plugins" on page 274.      

 3. Choose a MIDI input channel:
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 a. Click the MIDI Input button on the   track header.
 b. Choose MIDI Channel from the menu,   and choose the MIDI channel you want to send data to the track, or 

choose   All if you want the track to listen to all channels.
If you want to select multiple input channels, hold   Ctrl and select additional channels from the menu.

 4. Click the MIDI Input button on the track header and choose Send MIDI Input Thru to MIDI Output from the 
menu if you want to echo   notes from the MIDI controller to the track's MIDI   device or soft synth for 
monitoring.

 5. Click the MIDI Input button on the track header and choose MIDI  Input Filters from the menu if you want to 
specify which   MIDI messages you want to record (or exclude). For more information,   see Set up MIDI message 
input filters,   Set up a MIDI velocity input filter,   or Set up a MIDI quantize input filter   in Editing MIDI Track 
Properties.

Set up MIDI message, velocity, or quantize   filters
You can use the Input   Filters tab on the MIDI Track Properties window to choose which notes   or other MIDI 
messages you want to record or exclude from MIDI recordings.

Record MIDI in real time
With real-time recording, you can record MIDI in real time   while your project plays back.

 1. Connect a MIDI controller   to your computer.

 If you don't have a MIDI controller, you can use the keyboard in the   track view (when in MIDI timeline   editing 
mode) or the keyboard in the Soft       Synth Properties window.

Not all VSTi plug-ins can record using the keyboard       in the Soft Synth Properties window.

 2. Select the Arm  for Record buttons  on the tracks where you want to record. Arming a track enables   it for 

recording.
 3. Choose a MIDI input device   and channel for each armed track. For more information, see Set   up a MIDI 

controller for recording into a track in this help topic.

 If you're recording using the keyboard in the track view or the Soft   Synth Properties window, choose Auto 
Input. 

 Click the MIDI Input   button on the track header and choose Send  MIDI Input Thru to MIDI Output from the 
menu if you want to echo   notes from the MIDI controller to the track's MIDI   device or soft synth for 
monitoring.

 4. Set up any desired MIDI message,   velocity, or quantize filters for your armed tracks. For more information,   see 
Set up MIDI message input filters,   Set up a MIDI velocity input filter,   or Set up a MIDI quantize input filter   in 
Editing MIDI Track Properties.

 5. Position the cursor where   you want to start recording.
 6. Click the Record   button  on the transport   bar to start recording. 

 MIDI messages from your controller are recorded as you play them. 
 7. Notes are added to an event in the   timeline. 
 8. MIDI controller adjustments (such   as pitch wheel and modulation wheel movements) are recorded as track   

envelopes. MIDI controllers are recorded in latch mode: envelope points   are created when you change a control 
setting, and recording continues   until you stop playback. When you stop adjusting the control, the control's   
current setting overwrites the existing envelope points.
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Envelope points are not thinned when recording MIDI   controllers from a hardware device.

 9. To stop recording, click the   Record button again or click the Stop   button  on the transport   bar. 

A new clip is created for the recorded MIDI data on each armed track.   You can use the Clip Pool tab in the Track   
Properties window to manage clips.

You can also record into time selections, punch into   MIDI events, or record multiple clips (when recording into 
a selection   with Loop Playback  selected) in   the same way you record audio.

Use step recording
Click the MIDI  Step Record button  to open the MIDI Step Record dialog, where you can record by   specifying 

the interval between MIDI notes. Step recording allows you   to record notes with very precise timing.

 1. Connect a MIDI controller   to your computer.

 If you don't have a MIDI controller, you can use the keyboard in the   track view (when in MIDI timeline   editing 
mode) or the keyboard in the Soft   Synth Properties window.

Not all VSTi plug-ins can record using the keyboard   in the Soft Synth Properties window.

 2. Select the Arm for Record buttons  on the tracks where you want to record. Arming a track enables   it for 

recording.

 If you don't arm a track for recording, a new MIDI track will be created   when you click the MIDI Step Record   
button.

 3. Choose a MIDI input device   and channel for each armed track. For more information, see Set   up a MIDI 
controller for recording into a track in this help topic.

 If you're recording using the keyboard in the track view or the Soft   Synth Properties window, choose Auto 
Input. 

 Click the MIDI Input   button on the track header and choose Send  MIDI Input Thru to MIDI Output from the 
menu if you want to echo   notes from the MIDI controller to the track's MIDI   device or soft synth for 
monitoring.

 4. Set up any desired MIDI message,   velocity, or quantize filters for your armed tracks. For more information,   see 
Set up MIDI message input filters,   Set up a MIDI velocity input filter,   or Set up a MIDI quantize input filter   in 
Editing MIDI Track Properties.

 5. Position the cursor where   you want to start recording.
 6. Click the MIDI Step Record   button .

 7. Use the MIDI Step Record dialog   to set options for recorded MIDI notes.
 a. Click the Step size button and choose space between the beginnings of notes.

 Select the Tuplet   check box to set irregular step sizes. For example, to set an eighth-note   triplet step size, 
choose eighth notes from the Step size menu, select the Tuplet   check box, and choose 3 in time of 2.

 b. Click the Duration   button and choose length of the note's sustain. When you choose a duration   longer 

 c. To set the note-on velocity for recorded   notes, type a value in the Velocity   box. If you want to record note-
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on velocity from your controller, select   the As Played   check box.

MIDI Step Record Dialog Keyboard   Shortcuts

Command Shortcut

Set Step size   to whole note. 1

Set Step size   to half note. 2

Set Step size   to triplet. 3

Set Step size   to quarter note. 4

Set Step size   to 16th note. 5

Set Step size   to 32nd note. 6

Set Step size   to 64th note. 7

Set Step size   to dotted note. .

Set Duration   to whole note. Shift+1

Set Duration   to half note. Shift+2

Set Duration   to triplet. Shift+3

Set Duration   to quarter note. Shift+4

Set Duration   to 16th note. Shift+5

Set Duration   to 32nd note. Shift+6

Set Duration   to 64th note. Shift+7

Set Duration   to dotted note. Shift+.

Delete notes at cursor position. Delete

Step forward by step size and delete notes. Insert

Step forward by step size. Right Arrow

Step backward by step size. Left Arrow

Step backward by step size and delete notes. Backspace

For these shortcuts to work, the main window must have focus, not the step recording dialog.

 8. MIDI messages from your controller   are recorded as you play them, and notes are added to an event in the   
timeline.

Notes:

 l MIDI   controller adjustments (such as pitch wheel and modulation wheel movements)   are not recorded in step 
record mode.

 l If you   press a key before releasing the current key, both notes will be recorded   at the same timeline position. 
Release both keys to advance to the next   step.

 l To stop recording, close the   MIDI Step Record dialog or click the Stop   button  on the transport   bar. 

Use MIDI merge recording to build a part
Click the MIDI  Merge Record button  to build a MIDI part by recording repeatedly into   a loop region. MIDI 

merge data is recorded in real time, and you can add   more notes or MIDI controller data each time recording passes 
through   the loop region.
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 1. Connect a MIDI controller   to your computer.

 If you don't have a MIDI controller, you can use the keyboard in the   track view (when in MIDI timeline   editing 
mode) or the keyboard in the Soft   Synth Properties window.

Not all VSTi plug-ins can record using the keyboard   in the Soft Synth Properties window.

 2. Select the Arm  for Record buttons  on the tracks where you want to record. Arming a track enables   it for 

recording.

 If you don't arm a track for recording, a new MIDI track will be created   when you click the MIDI Step Record   
button.

 3. Choose a MIDI input device   and channel for each armed track. For more information, see Set   up a MIDI 
controller for recording into a track in this help topic.

 If you're recording using the keyboard in the track view or the Soft   Synth Properties window, choose Auto 
Input. 

 Click the MIDI Input   button on the track header and choose Send  MIDI Input Thru to MIDI Output from the 
menu if you want to echo   notes from the MIDI controller to the track's MIDI   device or soft synth for 
monitoring.

 4. Set up any desired MIDI message,   velocity, or quantize filters for your armed tracks. For more information,   see 
Set up MIDI message input filters,   Set up a MIDI velocity input filter,   or Set up a MIDI quantize input filter   in 
Editing MIDI Track Properties.

 5. Click and drag in the marker   bar or a blank area of the timeline to create a loop region.
 6. Select the Loop  Playback button .

 7. Select the MIDI  Merge Record button .

 8. Position the cursor at the   start of the loop region. If you want to record with pre-roll, you can   position the cursor 
before the loop region.

 9. Click the Record   button  on the transport   bar to start recording. 

 Each time recording passes through the loop region, you can add data   to the event. MIDI messages from your 
controller are recorded as you play   them. 

 10. Notes are added to an event in the   timeline. 
 11. MIDI controller adjustments (such   as pitch wheel and modulation wheel movements) are recorded as track   

envelopes. MIDI controllers are recorded in touch timeout mode: envelope   points are created or edited when 
you change a control setting. When you   stop adjusting the control, existing envelope points on the timeline are   
preserved.

 MIDI controllers that are switches (such as a damper pedal) are always   recorded in latched mode: envelope 
points are created when you change   a control setting, and recording continues until you stop playback. When   
you stop adjusting the control, the control's current setting overwrites   the existing envelope points.

 When recording returns to the beginning of the loop region, existing   MIDI controller envelopes are unaffected. 
For example, you could record   note data the first time recording passes through the loop region, record   pitch-
bend controllers the second time, and modulation the third time.

Envelope points are   not thinned when recording MIDI controllers from a hardware device.             

 12. To stop recording, click the   Record button again or click the Stop   button  on the transport   bar. 
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MIDI Input Filtering
You can use the Input Filters tab on the MIDI   Track Properties window to choose which notes or other MIDI 
messages   you want to record (or exclude), modify note-on or note-off velocity,   or quantize notes when recording 
MIDI from a track's input port.

   Set up MIDI message input filters
Use the Input Filters tab to choose which notes or other   MIDI messages you want to record or exclude from MIDI   
recordings.

 1. Select the track where you   want to apply the filter.
 2. In the Track Properties window,   click the Input Filters tab.
 3. Choose Message  Filter from the drop-down list at the top of the page.
 4. Select the Enable   check box.
 5. Select your recording options.

Item Description

Record all Select this radio button if you want to record   all MIDI messages from the input port.

Record selected 
items

Select this radio button if you want to choose   which MIDI messages you want to 
record.   

Record unselected 
items

Select this radio button if you want to choose   which MIDI messages you want to 
ignore when recording. 
In the following example, only note data will   be recorded:

 6. Choose a setting from the   MIDI Message Type   drop-down list. The box at the bottom of the page displays the 
available   MIDI messages.

 7. Select the check box for each   MIDI message that you want to filter. When editing note messages, you   can 
double-click the Min and Max boxes   to type the notes you want to filter.

Tips:   

 l If you're   recording into two tracks, you can use note message filters to split your   keyboard and create two 
separate parts.

 For example, set track 1 to record only notes A1 to B4, and set track   2 to record only notes C5 to C9. If you 
assign track 1 to a plucked string   bass soft synth and track 2 to a grand piano synth, the low notes you   play on 
your keyboard will be recorded only on track 1 and will be voiced   by the bass. The high notes you play will be 
recorded only on track 2   and will be voiced by the piano.

 l Filtering   continuous controller messages allows you to control exactly which continuous   controllers are 

Recording 119



recorded. 

 For example, if you wanted to make sure you didn't accidentally record   modulation automation by bumping 
your keyboard's modulation wheel, you   could select the Record unselected items radio button, choose 
Continuous Controllers from the MIDI Message Type drop-down list, and then select the Modulation   check 
box.

 l Excluding   system exclusive messages during recording can improve performance during   real-time recording 
and when using MIDI thru.

   Set up a MIDI velocity input filter             
Use the Input Filters tab to modify or limit note-on and   note-off velocity from a track's MIDI input device during 
recording.

 1. Select the track where you   want to apply the filter.
 2. In the Track Properties window,   click the Input Filters tab.
 3. Choose Velocity   from the drop-down list at the top of the page.
 4. Select the Enable   check box.
 5. Select a check box to indicate   whether you want to edit note-on or note-off velocities:

Item Description

Change Start Velocity Select this check box to edit note-on velocities.

Change Release Velocity Select this check box to edit note-off velocities.

 6. Select a radio button to indicate   how you want to change velocity:

Item Description

Invert Select this radio button to invert note velocities.   
When you invert a velocity, it is subtracted   from 127 (negative values are forced to positive) , so a 
note with a velocity   of 127 will be 0 after inversion, a velocity of 10 will be 117, and so   on.

Set to Select this radio button and drag the slider   to change note velocities to a specific value.

Add Select this radio button and drag the slider   to add (or subtract) a constant offset to note velocities.

Scale 
by

Select this radio button and drag the slider   to multiply note velocities by a percentage. For example, 
setting this   slider to 50% would reduce all note-on or note-off velocities by half.   

Limit Select this radio button and type values in   the Min and Max boxes to restrict note velocities   to the 
specified range.
For example, if you type 40 in the Min box and 90 in the Max box, velocities   below 40 will be set to 
40, velocities greater than 90 will be set to   90, and velocities between 40 and 90 will be unaffected.

Note-on velocities are bound between 1 and   127, and note-off velocities are bound between 0 and 127.

Set up a MIDI quantize input filter
Use the Input Filters tab to force notes from a track's   input port to align with musical beats during recording.

 1. Select the track where you   want to apply the filter.
 2. In the Track Properties window,   click the Input Filters tab.
 3. Choose Quantize  from the drop-down list at the top of the page.
 4. Select the Enable   check box.
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 5. Select your quantization options:

Item Description

Quantize 
start

Select this check box to force the beginning   (note-on messages) of MIDI events to a specified 
resolution on the grid.   

Quantize 
release

Select this check box to force the end (note-off   messages) of MIDI events to a specified 
resolution on the grid. 

Preserve 
duration

If you selected Quantize start or Quantize release,   you can select this check box to maintain the 
lengths of notes. 

Quantize 
grid

Click an icon to select the resolution of the   quantize grid.

Tuplet                         Select this check box to set irregular beat   boundaries for the quantize grid. 
For example, to quantize to eighth-note triplet   beat boundaries, select the  button, choose the 
Tuplet  check box and choose 3 in time of 2.   
To quantize to sixteenth-note quintuplet beat   boundaries, select the  button, choose the Tuplet 
check box and choose 5 in time of 4.

Offset 
by

Select the check box and type a value in the   box to offset the quantize grid by the specified number 
of ticks. You   can type negative values to shift the grid backward.

Swing Drag the slider to add a swing to the quantize   grid. 

When you set this slider to 0, notes are quantized directly to the grid.   Increasing the setting shifts 
every other grid boundary forward: set to   300% to shift every other grid boundary to the next grid 
division.

Strength Drag the slider to adjust how strictly you want   to quantize.
For example, to quantize directly to the grid,   set the slider to 100%. If you set the slider to 50%, a 
note that would   be shifted 40 ticks is moved only 20 ticks.

The quantize filter is not applied to the   MIDI thru data or the audio you hear while recording.
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Working with Groove Maps
From the View menu, choose Groove  Pool to toggle the display of the Groove Pool window. The top portion   of the 
Groove Pool window displays the available groove maps in your project.   The bottom portion shows the selected 
groove map so you can edit it.

The   grooves listed in the Groove Pool are specific to your project. If you've   deleted grooves and saved your 
project, those grooves will be unavailable   unless you import the grooves again.

A groove refers to the rhythmic pattern of a piece of music. Groove   maps in ACID software expand on the software's 
ability to match the rhythm   and timing of files nondestructively and in real time:

 l Breathe   new life into your collection of loops and MIDI files by creatively applying   grooves to change the 
rhythmic feel. 

 l Adjust the   timing of a track to add or remove a human feel.
 l Quantize   and map multiple tracks or loops to a common groove.
 l Extract   the groove from an existing audio file.
 l Create new   grooves from scratch. 
 l Different   grooves can be applied to an entire track or portions of a track so you   can easily match loops with 

incompatible feels and tighten/loosen grooves   nondestructively. 

Grooves cannot be applied to tracks that contain   Beatmapped clips.

Applying or Removing Grooves
From the View menu, choose Groove  Pool to toggle the display of the Groove Pool window.
Did you record a drum track that doesn't swing quite right? Before you   rerecord the drum part, try applying the Hard  
Swing setting from the Groove Pool.
With the Groove Pool and Groove tool , you can use groove   maps to adjust the timing of entire tracks or portions 

of tracks.
Tips:

 l If you want   to get really creative, try setting a clip's stretching method to Pitch shift segments   (on the Stretch 
tab of the Clip   Properties window). When a groove adjusts a beat so it plays early,   the pitch will be raised. 
When a beat is played late, its pitch will be   lowered. 

 l If a groove   map does not seem to work correctly on a loop, the beats in the file may   not be properly detected. 
Click the Redetect  Beats button on the Stretch tab of the Clip   Properties window to apply the ACID beat-
detection algorithm to the   loop. 

Notes:

 l Groove maps   are applied non-destructively. If you want to change a media file's inherent   groove, use the render 
to new track   command to render a new, grooved media file.

 l The grooves   listed in the Groove Pool are specific to your project. If you've deleted   grooves and saved your 
project, those grooves will be unavailable unless   you import the grooves again.

Grooves cannot be applied to tracks that contain   Beatmapped clips.

   Apply a groove to an entire track

 1. From the View menu, choose   Groove Pool to   display the Groove Pool window if it isn't already visible.
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 2. Drag a groove from the Groove   Pool window to a track. You can drop the groove in the track list or on   the 
timeline. 

 A groove event is displayed at the bottom of the track to indicate   that a groove has been applied to the track.

  To toggle the height of the groove strips, choose Show  Full-Size Groove Strips from the View menu.

Tips:

 l Drag   a groove from the Groove Pool to an existing groove event to change the   event's groove.
 l Right-click   and drag with the Groove tool to erase a groove event.
 l Hold   Ctrl and right-click a groove event with the Groove tool to erase the   entire event.
 l Hold   Ctrl and click a groove event with the Groove   Erase tool  to erase the entire event.

   Set a default groove for new tracks             
If you have a groove that you'd like to use to set the overall   feel of a project, you can set it as a default for your 
project.

 1. From the View menu, choose   Groove Pool to   display the Groove Pool window if it isn't already visible.
 2. Choose a setting from the   Default groove for new  tracks drop-down list. 

 When you add a new loop, one-shot, or MIDI track   to your project, the selected groove will be applied to the 
entire track.   Existing tracks are not affected. 

Apply multiple groove events to a track
Groove events allow you to apply grooves to portions of   tracks or apply different grooves to various portions of a 
track. The   groove is applied where the groove event overlaps the media event.
The edges of groove events are boundaries for grooves, and   audio cannot be grooved beyond the event edges. In the 
following example,   the groove will adjust the first beat of the event to play before 10.1   on the timeline:

In the following example, the edge of the groove event prevents   the event's first beat from being played before 10.1 
on the timeline:

 1. Select the Groove tool .

 2. Click the down arrow    next to the Groove toolbar button and choose a groove from the menu (or   double-click 
a groove in the Groove Pool).

 3. Click and drag over a track   to paint groove events in the same way you create other events on the   timeline. 

 4. Repeat steps 2 and 3 to paint   groove events as needed. 
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 To toggle the height of the groove strips, choose Show  Full-Size Groove Strips from the View menu.

Tips:

 l Drag   a groove from the Groove Pool to an existing groove event to change the   event's groove.
 l Drag   a groove from the Groove Pool to a space between two groove events to   create a new groove event to fill 

the space between the events.
 l Hold   Ctrl while clicking the space between two groove events to create a new   groove event to fill the space 

between the events.
 l Right-click   and drag with the Groove tool to erase a groove event.
 l Hold   Ctrl and right-click a groove event with the Groove tool to erase the   entire event.
 l Hold   Ctrl and click a groove event with the Groove   Erase tool  to erase the entire event.

 l Zoom   in to see groove markers in the groove events. The markers represent   the amount and direction of offset 
applied to beats:

Erase groove events

 1. Select the Groove Erase tool   .

 2. Click and drag the Groove   Erase tool to erase a groove, or hold Ctrl while clicking a groove event   to erase the 
entire event.

Tips:

 l Right-click   and drag with the Groove tool  to erase a groove event.

 l Hold   Ctrl and right-click a groove event with the Groove tool to erase the   entire event.
 l Hold   Ctrl and click a groove event with the Groove   Erase tool  to erase the entire event.

 l Zoom   in to see groove markers in the groove events. The markers provide   a visual cue to the mapped groove:
 l You can   also right-click a track header and choose Remove  Groove from Track from the shortcut menu to 

remove all groove events   from a track.

   Remove unused grooves from your project
Click the  Remove All Unused Grooves from Project button  to remove any grooves that have not been   used in 

your project.

Remove a groove from your project

 1. Select a groove in the Groove   Pool window.
 2. Click the  Remove Selected Grooves from Project button . The selected groove is removed from your   

project. 

 If the groove is in use, a confirmation will be displayed if the Confirm groove deletion when  still in use check 
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box is selected on the General   tab of the Preferences dialog.

Creating Grooves
You can add grooves to your project   by using an existing clip, duplicating existing grooves, importing grooves,   or by 
creating an entirely new groove from scratch.

The grooves listed in the Groove Pool are specific to your project.   If you've deleted grooves and saved your 
project, those grooves will be   unavailable unless you import the grooves   again.

   Use Groove Cloning to create a new groove using a clip in your project
ACID software can analyze a clip's audio to extract its   groove so you can apply its feel to other tracks.

Groove cloning can extract grooves from loop   clips only. 

 1. Perform either of the following   actions:
 l Right-click an event in the timeline   and choose Event Clip   from the shortcut menu.
 l Right-click a track header and choose   Paint Clip from   the shortcut menu.

 2. ChooseAdd  to Groove Pool. A new groove will be added to the Groove Pool window using the name  of the clip 
you selected in step 1.  from the submenu.                      

Grooves that you create from existing clips   will be available only in the project where they were created. If you   
want to make a groove available to other projects, export it to a .groove   file. See Export a groove in   this help 
topic for more information.

You can also click the Add  to Groove Pool button  in the Clip   Properties window to add the selected clip's 

groove to the Groove   Pool.

Duplicate a groove
Existing grooves can serve as templates for creating your   own grooves. 

 1. In the Groove Pool window,   select the grooves you want to duplicate. Hold Ctrl or Shift to select   multiple 
grooves.

 2. Click the Duplicate  Selected Grooves button . The duplicated grooves are added to the   Groove Pool.

 3. To change the name of a duplicated   groove, right-click a groove and choose Rename   from the shortcut menu.
 4. You can then edit   the duplicated grooves as needed.

Import a groove
You can use the Import Grooves button to add grooves from   .groove files or other media files to the Groove Pool of 
your project.

 1. Click the  Import Grooves button  in the Groove Pool window. The Import Groove   dialog is displayed.

 2. Select the .groove or media   file you want to add. Information about the file is displayed at the bottom   of the 
dialog.

 3. Click the Open   button to add the new groove to the Groove Pool.

You can extract a groove quickly by dragging   a file from the Explorer window to the Groove Pool.

Export a groove
Grooves are stored with your ACID project. Exporting a groove   allows you to save a groove in a file that you can use 

Working with Groove Maps 125



in other projects   or share with other ACID users.

 1. Select a groove in the Groove   Pool window.
 2. Click the  Export Selected Grooves button . The Export Groove to File dialog is displayed.

 3. Choose a drive and folder   from the Save in   drop-down list, or use the browse window to locate the folder where 
you   want to save your groove.

By default, grooves will be saved in the folder   specified in the Default  groove folder box on the Folders   tab 
of the Preferences dialog. Grooves in this   folder will be available in the Groove Pool window when you 
create a new ACID project.

 4. Type a name in the File  name box, or select a file in the browse window to replace an existing   groove.
 5. Click the Save   button to save your groove.

Create a new groove

 1. Click the New  Groove button  in the Groove Pool window. A new groove is added to   the Groove Pool.

 2. Type a name for your groove   in the edit box, and then press Enter.
 3. Use the Groove Editor at the   bottom of the Groove Pool window to adjust the length and feel of your   groove. For 

more information about editing grooves, see "Editing Grooves" below.   

Editing Grooves
You can use the bottom portion of the Groove Pool window to edit grooves.

Notes:

 l Your edits   are saved with your project. If you want to use the edited groove in other   projects, you'll need to 
export it   as a .groove file and import the edited groove in each project where you   want to use it.

 l The grooves   listed in the Groove Pool are specific to your project. If you've deleted   grooves and saved your 
project, those grooves will be unavailable unless   you import the grooves again.

 1. From the View menu, choose   Groove Pool to   display the Groove Pool window.
 2. Select a groove in the top   portion of the window. For information about creating or duplicating grooves,   see 

"Creating Grooves" on the previous page.
If you want to audition your edits in real-time,   apply the groove to an   event and start looped playback   
before you start editing the groove.

 3. The bottom half of the Groove   Pool window displays your groove as a timeline with beat anchors and groove   
markers to represent how beats will be adjusted. 

A beat anchor  represents the beat that will be adjusted, and a   groove marker  represents the point in time 
when that   beat will be played. A groove marker can occur before or after the beat   anchor. A line connects a 
groove marker to its associated beat anchor.   

 4. Use the Length   spin control to adjust the length of the groove. Decreasing the setting   will remove beat anchors 

126

www.magix-audio.com



and groove markers from the file; increasing   the setting will add anchors and markers. 
 5. Add or remove markers as needed:
 6. If you want to add a marker, press   M or double-click the beat ruler. A beat anchor and groove marker are   added 

to the nearest division on the beat ruler.
 7. If you want to delete a marker,   right-click it and choose Delete   from the shortcut menu.

Use a single beat anchor/groove marker to   adjust all beats forward or back equally. This produces an effect 
similar   to slipping an event.

 8. Adjust beat anchors and groove   markers as necessary. Adjusting anchors and markers during looped   playback 
helps you hear the results of your edits.

 9. Drag a beat anchor  (or insert a new one) to indicate which beat   you want to adjust. 

 If snapping is enabled, beat anchors snap   to the current grid spacing. Hold Shift   while dragging to bypass 
snapping.

 10. Drag a groove marker    to adjust when the beat will be played. Drag to the left if you want a   beat to be played 
early, or drag left if you want it to be played late.

 You cannot drag groove markers past each other, but multiple markers   can exist at the same point in time.

 When the Allow  snapping for Post-Groove Markerscheck box is selected on the General tab of the 
Preferences dialog, groove   markers will snap to the current grid spacing if snapping is enabled. Hold shift while 
dragging   to bypass snapping.

 11. Double-click a beat anchor or groove   marker to reset the marker to the beat anchor position.

Hover over a beat anchor or groove marker   to display a ToolTip that explains the effect of groove marker 
adjustments.

Working with Groove Maps 127



Using Markers, Regions, and Commands
Markers and regions serve as reference points along the timeline and   help you arrange events. You can use markers 
for annotations, to insert   metadata commands, or as snap points for positioning   the cursor or creating a time 
selection.

Using Markers
Markers can be used to indicate points of interest or to make notes   in a project.
To create a marker, choose Marker  from the Insert menu. A marker  will   be added at the cursor position.

Each   marker (up to 99) is assigned a number. Pressing this number on the keyboard   moves the cursor to the 
corresponding marker.

Name a marker             

 1. Right-click the marker tab   , and then choose   Rename from the shortcut menu. The marker   name changes to 
an edit box.

 2. Type a new name in the edit   box.
 3. Press Enter.

Move a marker             
Drag the marker tab to a new location.

Hold Shift while dragging   to override snapping.

 Delete a marker             
Right-click the marker tab and choose Delete   from the shortcut menu.

Move the cursor to   a marker             
Click the marker tab.

Adjust the project   tempo to align the cursor with a marker             

 1. Position the cursor.
 2. Right-click the marker tab, and then   choose Adjust Tempo  to Match Cursor to Marker from the shortcut 

menu.
The project tempo   will change so the cursor position matches the selected marker. 
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Time Markers
Time markers can be used to indicate points of interest or to make notes   in the project. Unlike standard markers,   time 
markers are tied to absolute time within your project and will shift   with tempo changes to remain in sync with your 
video (a standard marker   is tied to a beat, so its absolute time will vary with project tempo).   Time markers are useful 
when scoring video.
To create a time marker, position the cursor and choose Time  Marker from the Insert menu. A time marker will be 
added at the cursor position, and the time ruler is automatically   displayed when the first time marker is inserted.

You're   probably thinking "Now wait a minute. You just said these are time markers. Why is the shortcut key   an 
H?!" Well. . . you may sometimes hear these referred to as hit markers, which is a term used by   some video-
scoring professionals. Potato, po-tah-to.   . . .

Name a time marker             

 1. Right-click the marker tab    and choose Rename from the shortcut menu. The marker name changes to an edit 
box.

 2. Type a new name in the edit   box.
 3. Press Enter when you're   finished.

Move a time marker             
Drag the marker tab to a new location; if snapping   is enabled and Grid  Only turned off, the marker will snap to the 
divisions on the time   ruler.

Hold Shift while dragging   to override snapping.

Delete a time marker             
Right-click the marker tab and choose Delete   from the shortcut menu.

Move the cursor to   a time marker             
Click the marker tab.

Adjust the project tempo to align the cursor   to a time marker

 1. Position the cursor.
 2. Right-click the marker tab, and then   choose Adjust tempo  to match marker to cursor from the shortcut menu. 

The project tempo will change so the   cursor position matches the selected time marker.

Hold Alt while dragging   a time marker to a location on the beat ruler. The project tempo will   be adjusted so the 
time at the marker will occur on a specific beat. For   example, if you place a time marker at 10 seconds on the 
time ruler and   hold Alt while dragging the marker to 5.1 on the beat ruler, the project's   tempo is adjusted so the 
first beat of measure five occurs at ten seconds.   

Using Regions
Regions can be used to indicate sections of projects such as the chorus,   verse, and bridge.
To create a region, make a time selection   and choose Region  from the Insert menu. A region will   be added at the 
cursor position.
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Each   region (up to 99) is assigned a number. Pressing this number on the keyboard   selects the corresponding 
region.

Name a region             

 1. Right-click the first region   tab  and choose   Rename from the shortcut menu. The region   name changes to an 
edit box.

 2. Type a new name in the edit   box.
 3. Press Enter.

Move a region             
Drag either region tab to move the tab and change the region's   size.
or——             
Hold the Alt key while dragging either region tab to move   a region and preserve its length.

Move the cursor to   a region tab             
Click a region tab.
or——             
Right-click either region tab and choose Go  To Start from the shortcut menu to move the cursor to the beginning   of 
the region.
or——             
Press a number on the keyboard to move the cursor to the   beginning of the corresponding region.

Select a region             
Right-click a region tab, and then choose Select  Region from the shortcut menu.

Delete a region
Right-click a region tab, and   then choose Delete   from the shortcut menu. 

Inserting Commands
From the Insert menu, choose Command   to place a metadata command marker at the current cursor position.
Command markers indicate when an instruction (function) will occur in   a streaming media file. You can use 
command markers to display headlines,   captions, link to Web sites, or any other function you define.
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Insert a command marker             

 1. Place the cursor where you   want to insert the command marker.
 2. From the Insert menu, choose   Command. The   Command Properties dialog is displayed.
 3. From the Command   drop-down list, choose the type of command you want to insert, or type   a custom 

command in the box.
 4. In the Parameter   box, type the argument that should be passed to the command. For example,   if you're using 

an URL command, type the address of the Web page you want   to display.

Command Player 
type

Description

URL Windows  
Media and 
RealMedia

Indicates when an instruction is   sent to the user’s Internet browser to 
change the content being   displayed.                                 
In the   Parameter box, type the URL that will display at a specific   time 
during the rendered project’s playback.                                 

Text Windows  
Media

Displays text in the captioning   area of the Windows Media Player located 
below the video display area.                                 
In the Parameter box, type the text that will display during   playback.                                 

To view captions during   playback in Windows Media Player 9 or 10, 
choose Captions  and Subtitles from the Windows   Media Player Play 
menu, and then choose  On  if Available from the submenu.                                 

WMClosedCaption Windows  
Media

Displays   the text from theParameter box in the captioning window that 
is defined   by an HTML layout file.                                 

WMTextBodyText Windows  
Media

Displays   the text from the Parameter box in the text window that is 
defined by an   HTML layout file.                                 

WMTextHeadline Windows  
Media

Displays   the text from the Parameter box in the headline window that is 
defined   by an HTML layout file.                                 

Title RealMedia Displays the text from the Parameter   box to identify the file's title in a 
media player.                                 

When rendering Windows Media files, title   information is based on 
the settings on the Summary tab of the ACID Project  Properties 
dialog or the Index/Summary   tab of the Custom Template   dialog. 
The summary information from the Project Properties dialog will   be 
used if information has been specified in both places.                                 

To   view this information during playback, choose Now  Playing 
Options from the Windows   Media Player View menu and select the 
items you want to display.                                 

Author RealMedia Displays the text you type when   you choose About  this Presentation 
from the RealPlayer’s   shortcut menu orProperties from the Windows 
Media Player shortcut menu.                                 
In the Parameter box, type the text that you want to display.                                 

When rendering Windows Media files, author   information is based 
on the settings on the Summary tab of the ACID Project Properties 
dialog or the Index/Summary   tab of the Custom Template   dialog. 
The summary information from the Project Properties dialog will   be 
used if information has been specified in both places.                                 
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To   view this information during playback, chooseNow  Playing 
Options from the Windows   Media Player View menu and select the 
items you want to display.                                 

Copyright RealMedia Displays the text you type when   you choose About  this Presentation 
from the RealPlayer’s   shortcut menu or Properties from the Windows 
Media Player shortcut menu.                                 
In theParameter box, type the text that you want to display.                                 

When rendering Windows Media files, copyright   information is 
based on the settings on the Summary tab of the ACID Project  
Properties dialog or the Index/Summary   tab of the Custom 
Template   dialog. The summary information from the Project 
Properties dialog will   be used if information has been specified in 
both places.                                 

To   view this information during playback, choose Now  Playing 
Options from the Windows   Media Player View menu and select the 
items you want to display.                                 

Scott  EOM Scott  
Studios 
WAV file

Calculates when the next queued   clip starts playing in a Scott Studios 
system.                                 
For more   information, please refer to your Scott Studios documentation.                                 

Scott  Cue In Scott  
Studios 
WAV file

Set the beginning of a file in a   Scott Studios System without performing 
destructive editing.                                 
For more   information, please refer to your Scott Studios documentation.                                 

 5. In   the Comment box, type any comments you want to associate   with the command. A comment is generally 
used to remind you of what the   command is while you work on the project; its function is similar to naming   
markers and regions.                     

 6. In the Position   box, type the time you want the command to occur in your project. Commands   are inserted at 
the cursor position by default.

Delete a command marker
Right-click the command   marker tab  and choose   Delete from   the shortcut menu.

Edit a command marker
Right-click the command   marker tab  and choose   Edit from the shortcut menu.

or——             
Double-click the command   marker tab.

Move the cursor to a command marker
Click the command marker tab .

Use command templates
If you frequently insert   commands that use similar settings, you can create a template to insert   command settings 
automatically.
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Creating a template

 1. From the Insert menu, choose   Command to display   the Command Properties dialog.
 2. Type the settings you want   to use in the Command, Parameter, Comment, and Position boxes.
 3. In the Template   box, type the name you want to use to store the template.
 4. Click the Save   button .

Recalling a template

 1. From the Insert menu, choose   Command to display   the Command Properties dialog.
 2. Choose the template you   want to use from the Template drop-down list. The Command,   Parameter, 

Comment, and Position boxes are   filled using the information stored in the template.
 3. Edit the settings in the   Command, Parameter, Comment,  and Position   boxes as necessary.
 4. Click OK.

Editing metadata commands

Your metadata   command templates are saved in the cmdtemp.xml   file in the ACID program folder. You can edit this 
file directly to modify   your templates. 
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Using Automation
Automation allows you to control audio levels, panning, and effect parameters   over time. You can create fades, apply 
stereo panning, and add effects   with parameters that change throughout your project.
Automation is represented on the timeline as an envelope. You can create   automation by adding envelopes to your 
tracks (including bus tracks),   or you can record automation parameters by adjusting controls in the ACID   interface 
(or on a control surface)   during playback.

Gain, level, and panning controls can adjust automation (dynamic)   settings, or they can function as trim 
(nonautomated) controls.

 The trim setting is added to the automation settings so your envelope or   keyframe values are preserved, but 
with an offset applied. For example,   setting an audio track's trim control to -3 dB has the same effect as   
decreasing every envelope point by 3 dB.

If your automation is not behaving as expected, you may have applied a   trim value that is offsetting your 
automation settings.

When a control is set to adjust trim levels, its handle is displayed as   a . When   a control is set to adjust 
automation levels, it is displayed as a .

Adding Audio Track Envelopes
With audio track envelopes, you can create fades, apply stereo panning,   and add effects with parameters or send 
levels that change over time.
Track envelopes will always affect all events on the track. This means   that any event envelopes will be calculated   after 
the track envelopes.
To record track automation using the controls in the track header, select   the Automation Settings   button . When 

Automation Settings   is not selected, the controls adjust static (trim) levels.
Tips:

 l Use event   envelopes to control an event's level, fade-in, and fade-out.
 l You can   use the Display tab in the Preferences dialog   to change the colors used to draw track envelopes. Using 

custom envelope   colors can help you avoid getting lost in a maze of envelopes when you're   using track 
envelopes to control effects automation.

Apply mute automation             

 1. Select an audio track.
 2. From the Insert menu, choose   Envelopes, or   right-click in the track list and choose Insert/Remove  Envelope 

from the shortcut menu.
 3. From the submenu, choose   Mute. A check   mark is displayed next to the command, and an envelope is added to 

the   timeline.

  Mute automation is either on or off with no fade between the on and   off states. If you want to use fades, apply 
volume automation. 

 4. If you want to change the   track's mute state throughout the track, edit   the envelope in the timeline.
 5. If you want to change the   track's mute state by recording automation settings, select the Automation Settings   
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button  in the track header to   toggle between Mute and Mute Automation modes.

 6. Click the Mute   button   in the track header to change the track's mute automation state   at the cursor position.

 The button behaves differently depending on the track   automation recording mode:
 l When   the track automation mode is set to Off,   the button mutes the entire track.
 l When   the track has a mute envelope and the track automation mode is set to   Read, the button   changes 

state to reflect the envelope setting during playback but cannot   be adjusted.
 l When   the track has a mute envelope and the track automation mode is set to   Touch or Latch, the button 

edits   the envelope setting at the cursor position.

When you apply mute automation to a track,   it's possible to have a track that is muted and soloed 
simultaneously   if you use the Mute   and Solo    buttons in the track header. The mute state 

overrides the solo state: 

 o If a   track's Solo button   is selected, the track is included in the solo group, but it will be muted   
whenever the mute automation is set to mute the track.

 o If the   track's Mute button   is selected, the track is muted regardless of the mute automation settings.

Add a volume or pan envelope             

 1. Select   the track where you want to add or remove the envelope.
 2. Do one of the following:

 l From the Insert menu, choose Envelopes, and then choose Volume   or Pan from   the submenu.
 l Right-click the track header, choose   Insert/Remove Envelope from the shortcut menu, and then choose 

Volume   or Pan from   the submenu.
 l Press Shift+V for a volume envelope or Shift+P for   a pan envelope.

If you're working with a 5.1   surround project, surround panning keyframes are used instead of a   single 
envelope.

 3. If you want to change   the track's volume or pan setting throughout the track, edit   the envelope in the timeline.

Panning envelopes   will use the current panning mode for the Pan   slider in the track list.

 4. If you want to change volume   or pan settings by recording automation, select the Automation  Settings button 
 in the track header   to toggle automation mode. The Volume fader or Pan slider   handle is displayed as a  

in automation mode.
 5. Drag the Volume fader or Pan   slider to edit automation settings at the cursor position (you can also   adjust 

automation by editing the envelope   in the timeline). 

 The control behaves differently depending on the track's automation   recording mode:
 6. When the track automation mode is   set to Off, the   control adjusts the level of the entire track. In this mode, the 

automation   control acts as a second trim control.
 7. When the track has a volume or pan   envelope and the track automation mode is set to Read,   the control will 

follow the envelope during playback but cannot be adjusted.
 8. When the track automation mode is   set to Touch or Latch, the control edits the envelope setting at the cursor 

position.   If the track does not have an envelope, an envelope will be added when   you adjust the control. 

If   multiple tracks are selected, all selected tracks are adjusted.             

Add an assignable effects send envelope             
Assignable effects envelopes vary the level of a track sent   to an assignable effects chain. Before you can add an 
assignable effects   envelope, you'll need to add   an assignable effects chain to your project.
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 1. Select   the track where you want to add or remove the envelope.
 2. Do either of the following:

 l From the Insert menu, choose Envelopes, and then   choose the effects chain where you want to add or 
remove an envelope.

 l Right-click the track header, choose   Insert/Remove Envelope   from the shortcut menu, and then choose 
the effects chain where you want   to add or remove an envelope.

 3. Select the Automation  Settings button  in the track header   to toggle automation mode. The fader thumb is 

displayed as a    in automation mode (you can also edit automation by editing   the envelope in the timeline). 

 4. Click the label on the multipurpose   slider and choose an assignable effects chain from the menu.

 5. Drag the FX fader to control   the level of the track sent to each of the assignable   FX chains that you have created. 

 The fader behaves differently depending on the track's automation   recording mode:
 6. When   the track has an assignable effects envelope and the track automation   mode is set to Off,   the fader 

adjusts the send level of the entire track. In this mode, the   automation control acts as a second trim control.
 7. When   the track has an assignable effects envelope and the track automation   mode is set to Read,   the fader will 

follow the envelope during playback but cannot be adjusted.
 8. When   the track has an assignable effects envelope and the track automation   mode is set to Touch or Latch, the 

fader edits the envelope setting at the cursor position.   If the track does not have an envelope, one will be created 
when you adjust   the fader.

If multiple tracks are selected, all selected   tracks are adjusted.

Add a bus send envelope
Bus envelopes vary the level of a track sent to a bus. Before   you can add a bus envelope, you'll need to specify   the 
number of busses for your project.

 1. Select   the track where you want to add or remove the envelope.
 2. Do either of the following:

 l From the Insert menu, choose Envelopes, and then   choose bus where you want to add or remove an 
envelope.

 l Right-click the track header, choose   Insert/Remove Envelope   from the shortcut menu, and then choose 
the bus where you want to add   or remove an envelope.

 3. Select the Automation  Settings button  in the track header   to toggle automation mode. The fader thumb is 

displayed as a    in automation mode (you can also edit automation by editing   the envelope in the timeline). 
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 4. Click the label on the multipurpose   slider and choose a bus from the menu.

 5. Drag the fader to control   the level of the track sent to the selected bus. 

 The fader behaves differently depending on the track's automation   recording mode:
 6. When   the track automation mode is set to Off,   the fader adjusts the send level of the entire track. In this mode, 

the   automation control acts as a second trim control.
 7. When   the track has a bus envelope and the track automation mode is set to Read, the fader will   follow the 

envelope during playback but cannot be adjusted. 
 8. When   the track has a bus envelope and the track automation mode is set to Touch or Latch,   the fader edits the 

envelope setting at the cursor position. If the track   does not have an envelope, one will be created when you 
adjust the fader.

If multiple tracks are selected, all selected   tracks are adjusted.

Add an effect automation   envelope             
If a plug-in supports automation, you can use envelopes   to automatically adjust effect parameters over time.

Hide envelopes
From the View menu, choose Show  Envelopes and select the envelope you want to hide. Hiding an envelope   
removes the line while retaining the playback properties.
Press V for volume envelopes and P for pan envelopes.

Hiding an envelope type affects all tracks in your project.

If you've added effect automation envelopes to a track,   the track can get cluttered. Click the down arrow next to the 
Track  FX button  and choose an envelope from the drop-down list to select   which envelope you want to 

display.
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Lock envelopes to events
To move envelope points and position   with an event moved along the timeline, choose Lock  Envelopes to Events 
from the Options menu. 

MIDI Track Envelopes and Keyframes
With MIDI track envelopes, you can adjust volume, panning, controller   parameters, program changes, or Sysex 
commands dynamically over the duration   of a track. 
You can automate VSTi parameters using envelopes on the soft synth bus   track.
To record track automation using the controls in the track header, select   the Automation Settings   button . When 

the button is not selected, the controls adjust static   (trim) levels.
You can use the Display   tab in the Preferences dialog to change the colors used to draw track   envelopes. Using 
custom envelope colors can help you avoid getting lost   in a maze of envelopes when you're using track 
envelopes for MIDI controllers.         

   Add a mute envelope             

 1. Select a MIDI track.
 2. From the Insert menu, choose   Envelopes, or   right-click in the track list and choose Insert/Remove  Envelope 

from the shortcut menu.
 3. From the submenu, choose   Mute. A check   mark is displayed next to the command, and an envelope is added to 

the   timeline.

 Mute automation is either on or off with no fade between the on and   off states. If you want to use fades, apply 
volume automation. 

 4. If you want to change the   track's mute state throughout the track, edit   the envelope in the timeline.
 5. If you want to change the   track's mute state by recording automation settings, select the Automation Settings   

button  in the track header.

 6. Click the Mute   button  in the track header to change the track's mute automation state   at the cursor position.

 The button behaves differently depending on the track   automation recording mode:
 l When   the track automation mode is set to Off,   the button mutes the entire track.
 l When   the track has a mute envelope and the track automation mode is set to   Read, the button   changes 

state to reflect the envelope setting during playback but cannot   be adjusted.
 l When   the track has a mute envelope and the track automation mode is set to   Touch or Latch, the button 

edits   the envelope setting at the cursor position.

When you apply mute automation to a track,   it's possible to have a track that is muted and soloed 
simultaneously   if you use the Mute   and Solo    buttons in the track header. The mute state overrides 

the solo state:   

 l If a   track's Solo button   is selected, the track is included in the solo group, but it will be muted   whenever the 
mute automation is set to mute the track.

 l If the   track's Mute button   is selected, the track is muted regardless of the mute automation settings.
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Add a volume or pan envelope             

 1. Select   the track where you want to add or remove the envelope.
 2. Do one of the following:

 l From the Insert menu, choose Envelopes, and then  choose Volume   or Pan from   the submenu.
 l Right-click the track header, choose   Insert/Remove Envelope from the shortcut menu, and then choose 

Volume   or Pan from   the submenu.
 l Press Shift+V for a volume envelope or Shift+P for   a pan envelope.

If you're working with a 5.1   surround project, surround panning keyframes are used instead of a   single 
envelope.

 3. If you want to change   the track's volume or pan setting throughout the track, edit   the envelope in the timeline.
 4. If you want to change volume   or pan settings by recording automation, select the Automation  Settings button 

   in the track header to toggle automation   mode. The Volume fader or Pan slider   handle is displayed as a  

in automation mode.
 5. Drag the Volume fader or Pan   slider to edit automation settings at the cursor position (you can also   adjust 

automation by editing the envelope   in the timeline). 

 The control behaves differently depending on the track's automation   recording mode:
 l When the track automation mode is   set to Off, the   automation envelope is bypassed, and the control does 

nothing.
 l When the track has a volume or pan   envelope and the track automation mode is set to Read,   the control 

will follow the envelope during playback but cannot be adjusted.
 l When the track automation mode is   set to Touch or Latch, the control edits the envelope setting at the 

cursor position.   If the track does not have an envelope, an envelope will be added when   you adjust the 
control. 

If multiple tracks are selected,   all selected tracks are adjusted.

Not all VST instruments use standard MIDI   control mappings for volume and pan envelopes. You can use the 
Output Settings tab in the MIDI   Track Properties window to override the default envelope: right-click   the 
controller you want to use and choose Use as Track Volume or Use  as Track Pan from the shortcut menu.

Add a MIDI controller envelope             

 1. Select   the track where you want to add or remove the envelope.
 2. Perform one of the following   actions:
 3. Click the Insert/Hide  Envelope button    next to the controller's slider in the track header.

Right-click the track header, choose   Insert/Remove Envelope   from the shortcut menu, and then choose a 
controller type.

 Up to four controllers can be represented by sliders in the track header.   To change the controller that a slider 
modifies, click the label and choose   a different controller from the menu. 

 If the controller you want to adjust is not displayed in the menu,   choose Configure  Controllers from the menu. 
You can use the Output Settings tab   in the Track Properties      window to configure which controllers are available 
on the track.

 4. If you want to change   the controller setting throughout the track, edit   the envelope in the timeline.
 5. If you want to change controller   settings by recording automation, click the Automation  Settings button    in 
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the track header. The slider   handles are displayed as  in automation mode.

If you want to record MIDI controller envelopes into   a track using a hardware controller, you can use MIDI   
merge recording to record the envelopes.

 6. Drag a slider to edit automation   settings at the cursor position. 

 The track header controls behave differently depending on the track's   automation   recording mode:
 l When the track automation mode is   set to Off, the   controls adjust the level of the entire track. In this mode, 

the automation   envelope is bypassed, and the control does nothing.
 l When the track has a controller   envelope and the track automation mode is set to Read,   the control will 

follow the envelope during playback but cannot be adjusted.
 l When the track automation mode is   set to Touch or Latch, the control edits the envelope setting at the 

cursor position.   If the track does not have an envelope, an envelope will be added when   you adjust the 
control. 

If multiple tracks are   selected, all selected tracks are adjusted.             

Reset a MIDI controller envelope's points             
Perform either of the following actions to reset an envelope's   points to their default values:

 l Click the down arrow    next to the Insert/Hide  Envelope button  next to the controller's slider in the 

track header   and choose Reset All  Envelope Points.
 l Right-click the envelope and choose   Reset All from   the shortcut menu.

You can set the default value for each continuous controller   on the Output Settings tab in the Track   Properties 
window.

Delete a MIDI controller envelope             
Click the down arrow  next to the Insert/Hide  Envelope button  next to the controller's slider in the track 

header   and choose Delete Envelope.
If you want to show or hide an envelope without deleting   its settings, click the Insert/Hide  Envelope button .

You can also remove continuous controller envelopes on the   Output Settings tab in the Track   Properties window.

Configure MIDI track controller automation             
You can use the Output Settings tab in the MIDI Track   Properties window to configure which controllers can be 
automated;   add, remove, or hide envelopes; set default values; and set each envelope's   default fade curve.

 1. Right-click the track header,   choose Insert/Remove Envelopes, and then choose Configure  Controllers from 
the menu. The Output Settings tab in the Track   Properties window is displayed.

 2. Select the check box for each   controller you want to automate with an envelope. 
 If the controller you want to automate isn't displayed, select the   Show all controllers   check box at the bottom 
of the dialog.

Not all VST instruments use standard MIDI        control mappings for volume and pan envelopes. You can use 
the Output Settings tab to override the default envelope: right-click       the controller you want to use and 
choose Use as Track Volume or Use as Track Pan from the shortcut menu.

 3. Click the down arrow  in the Envelope   box and choose a command from the menu:
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Item Description

Insert 
Envelope

If the controller does not have an automation   envelope, No is displayed. 
Click the down arrow  and choose  Insert Envelope to add an automation envelope to the 
timeline.

Show/Hide 
Envelope

If the controller has an automation envelope,   Visible or Hidden   is displayed. 
Click the down arrow  and choose  Hide Envelope or Show Envelope   to toggle its display.

Click the Hide all  Envelopes button at the bottom of the window to hide all controller   
envelopes on the track.

Reset All 
Envelope 
Points

If the controller has an automation envelope,   you can click the down arrow  and choose 
Reset All Envelope  Points to restore all points to the default value.

Click the Reset all  Envelopes button at the bottom of the window to set all points   on all 
controller envelopes on the track to the default value.

Delete 
Envelope

If the controller has an automation envelope,   you can click the down arrow  and choose 
Delete Envelope  to remove the envelope and all envelope points from the timeline.

Click the Remove all  Envelopes button at the bottom of the window to delete all 
controller   envelopes on the track.

 4. Double-click the Def   box and type a new value to change the default setting for a controller.   This value is used 
when you reset envelope points.

 5. Click the down arrow  in the Curve  Type box to set the default fade   curve for each controller's automation 
envelope. The new curve type will   be applied to all segments on the envelope. You can right-click a segment   and 
choose a new fade curve to override the default curve type.

 6. Click   the Save button  if you want to save the current settings as a mapping file, or click Load to browse to a   
mapping file that will replace the current settings.

Create envelopes from controller data in a   MIDI clip             
If you use MIDI clips that contain MIDI controller data,   the controller data will not be displayed in the timeline by 
default.
Right-click the event on the timeline and choose Create  Envelopes from Clip from the shortcut menu to represent 
MIDI controllers   as envelopes on the timeline.

The Create  Envelopes from Clip command is not available in inline   MIDI editing mode.

When Lock  Envelopes to Events is selected from the Options menu, envelope   points will move with an event 
as you move it along the timeline. When   Lock Envelopes to Events   is not selected, you can move events and 
envelopes independently.

Add a program change keyframe             
The Program  button  in the track header displays the voice or patch that will be   used to play MIDI data on 
the track. You can set the voice used to play   the entire track, or you can add keyframes to add program changes.

Changing the track voice

 1. Click the Program  button .

 2. Choose a program from the   menu, or choose Select  Program Change to display the Output Settings tab in the 
Track   Properties window, where you can select a program.

 If the track does not contain program change keyframes, the selected   program is used to play the entire track. 
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 If the track contains keyframes, the selected program is assigned to   the keyframe that occurs before the current 
cursor position.

Adding a program change keyframe

 1. Click the Program button  and choose Insert Program Change Keyframe. The program change keyframe 

row is displayed   at the bottom of the track.
 2. Using the Draw    or Envelope  tool, double-click in the track's keyframe row to add a keyframe.

 3. To edit a keyframe, double-click   it to display the Output Settings tab in the Track   Properties window, and then 
select the program you want to assign   to the keyframe.

   Add a Sysex keyframe             

 1. Right-click the track header,   choose Insert/Remove Envelope, and then choose Insert  Sysex from the 
submenu.

 2. Using the Draw    or Envelope  tool, double-click in the track's keyframe row to add a keyframe.

 3. To edit a keyframe, double-click   it to display the System Exclusive Editor dialog.

To hide the Sysex keyframe row without removing   keyframes, right-click the track header, choose 
Insert/Remove Envelope, and then choose Hide  Sysex from the submenu. You can view the keyframe row 
again by   right-clicking the track header, choosing Insert/Remove Envelope, and then choosing Show Sysex.

Automate VSTi parameters
You can use the soft synth bus track to control parameter   automation for VST instruments using   envelopes.
For more information about adding and adjusting parameter   automation envelopes, please see Automating   VSTi 
Parameters.

Bus Tracks
From the View menu, choose Show  Bus Tracks to toggle the display of bus tracks at the bottom of   the track view. A 
bus track exists for each bus,   input bus, assignable   effects chain, and soft synth   in your project.
You can use bus tracks to automate volume, panning, and effect parameters   using envelopes. If a bus track   has 
envelopes applied, its icon will include a fader  in the bus track and in the Mixing Console   window.

For example, if you wanted to adjust the volume of all tracks in your   project, you could apply a volume envelope to 
the Master bus track instead   of adjusting each track individually.
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Add envelopes to a   bus track             
Adding volume, panning, and effect automation envelopes   to a bus track is just like adding an envelope   to a standard 
track.

Add effects to a bus track             
Click the Bus  FX button  in the bus track header to add or   edit bus effects. If there are no effects on the bus, 

clicking this button   displays the Plug-In Chooser. If a bus already has effects assigned, clicking   this button displays 
the Audio Plug-In window.

If the bus effects chain includes plug-ins with automatable   parameters, the Bus FX   button is displayed as a 
.

Mute a track
Click the Mute   button  to prevent a bus track from being played in the mix.   Click the Mute   button on additional 

tracks to add them to the mute group. To unmute   a track, click the Mute   button again.

Muting or unmuting a bus track

 1. Deselect the Automation  Settings button    to toggle trim mode.

 2. Click the Mute   button .

When you have a group of tracks muted, hold Ctrl while   clicking the Mute   button on an unmuted track to 
remove all other tracks from the mute group.   Hold Ctrl while clicking the Mute button on a muted track to reset 
all Mute   buttons.

Adjusting mute automation

When you select the Automation  Settings button ,   the mute button is displayed as a , and you can use the 

control to edit volume automation.

Solo a track             
Click the  Solo button  to solo all selected audio bus tracks. Click   the Solo button   on additional tracks to add them 

to the solo group. To remove a track   from the solo group, click its Solo   button again.
Hold Ctrl while clicking a Solo   button to solo a single track and remove all other tracks from the solo   group.

Monitor bus track output levels             
During playback, a responsive meter is displayed in the   bus track header to monitor the bus's output. 

Horizontal meters

Vertical meters
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When clipping is detected, the peak meter displays a red   Clip indicator.

Right-click the meters and choose a command from the shortcut   menu to adjust the display of the meters. This 
shortcut menu allows you   to reset clip indicators, choose a display scale, toggle vertical display,   or turn output 
meters off.

Automate VSTi parameters
You can use the soft synth bus track to control parameter   automation for VST instruments using   envelopes.
For more information about adding and adjusting parameter   automation envelopes, please see Automating   VSTi 
Parameters.

Resize bus tracks           
You can drag the horizontal splitter between the track list   and bus tracks to increase or decrease the space allocated 
to bus tracks.   Perform any of the following actions to resize individual bus tracks:

 l Drag a bus track's bottom border to   set its height.
 l Click Minimize  to minimize a   track vertically.
 l Click Maximize  to zoom in vertically   so a bus track fills the lower portion of the timeline.
 l After minimizing or maximizing a bus   track, click the Minimize or Maximize button again to return a bus track 

to its previous height.
 l Press Ctrl+Shift+Up/Down Arrow when   the bus track area has focus to resize all bus tracks at once.

Automating Audio Effect Parameters
When you add an effect that supports automation, you can use automation   to dynamically adjust effect parameters.
Automation for audio track effects is applied on the audio track. Automation   for bus effects and assignable   effects is 
applied on the appropriate bus track.

Add effect automation

 1. Click the down arrow next to the Track FX button  and choose FX  Automation to display the FX 

Automation Chooser. Click one of the   following links for more information about using track   effects, bus 
effects, and assignable   effects.

If no track effects exist, clicking the Track FX button will   display the Plug-In Chooser. DirectX Effects that 
can be automated are indicated   by the   icon in the chooser. The first time you select a plug-in,   the 

application will determine whether it can be automated and will update   the plug-in's icon and add it to the 
Automatable   folder in the Plug-In Chooser. VST Effects are always automatable.

 2. Click an effect button at the top of   the FX Automation Chooser. A list of the effect's automatable parameters   is 
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displayed:

 3. Select   the check box for each parameter that you want to control with an envelope.
If you're working with a 5.1 surround project, you   can select the Enable   check boxes to determine which 
channels will be affected by the plug-in.   An automation envelope is added to the timeline for each selected 
channel   so you can enable or bypass the plug-in during the project.

If you want to use distinct plug-in settings for each channel (separate   EQ settings for the front and 
surround speakers, for example), you can   add multiple instances of the plug-in to the track effects chain 
and select   the Enable check   boxes for the channels you want each instance of the plug-in to affect.

 4. Click OK  to close the FX Automation Chooser. An envelope is added to the   track for each parameter that you 
selected in the FX Automation Chooser.

Adjust effect automation parameters
You can adjust automated effect parameters by editing   the envelopes in the timeline or by recording   automation with 
the controls in the Audio Plug-In Window.If you've enabled the Bypass   parameter for a plug-in, you can click the 
Bypass  button in the plug-in's banner to toggle the Bypass envelope at   the cursor position.

When you automate an effect’s frequency parameter    such as the frequency   parameters in the track EQ effect    you 
may notice that the frequency changes are more apparent when moving   through the lower frequencies. This is 
because frequency scales in track   EQ and other plug-ins use a logarithmic scale, but effect automation uses   linear 
interpolation.——
To make the automated frequency changes   sound more natural, change the fade   curve types to change the 
interpolation rates between envelope points.   For high-to-low frequency sweeps, use a fast fade curve; for low-to-
high   frequency sweeps, use a slow curve.

Bypass effect automation 
Toggle the Bypass  FX Automation button  in the Audio Plug-In window to enable or bypass automation 

envelopes:
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 l After you've added effect automation   envelopes, the Bypass  FX Automation button is deselected, and effect 
parameters are automated   using the envelope settings.

 l When the button is selected, effect   automation envelopes are ignored and the effect's initial state is used   for the 
duration of the track.

 l If you delete all automation envelopes   from a plug-in, the Bypass  FX Automation button is unavailable.

Remove effect automation

 1. Click the down arrow next to the Track FX button  and choose FX  Automation to display the FX 

Automation Chooser.
 2. Click an effect button at the top of   the FX Automation Chooser. A list of the effect's automatable parameters   is 

displayed:

 3. Clear the check box for   the automation you want to remove.
 4. Click OK  to close the FX Automation Chooser. The envelope is removed from   the timeline for each check box 

that you cleared in the FX Automation   Chooser.

Adjusting Envelopes
When the Draw , Envelope , or Time Selection  tool is selected, you can add, remove, or   adjust envelope 

points.

Events   cannot be moved or edited when the Envelope  tool   selected.

Adjust an envelope             
By default, A new envelope will contain a single envelope   point. If you want to adjust the overall level of an envelope, 
drag the   envelope up or down. A floating ToolTip will show you the envelope's current   setting:
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If an envelope has multiple points, you can drag each point,   or you can drag envelope segments up or down.
Tips:

 l If   snapping is enabled, envelope points will snap to   snap points. Hold Shift to temporarily suspend snapping 
(press Shift after   clicking).                     

 l Hold   Ctrl while dragging an envelope point or segment to adjust the value in   fine increments without changing 
the envelope points' timeline positions.                     

 l Hold   Ctrl+Alt while dragging an envelope point or segment to adjust the value   in normal increments without 
changing the envelope points' timeline positions.                     

 l Hold   Alt while dragging an envelope point to move the point's timeline position   without changing its value                     
 l With   the Envelope tool ,   you can drag along the timeline to select multiple envelope points in   the selected 

track.                     

Add envelope points
To create more complex envelopes, you will need to add points.   To add an envelope point, double-click the envelope. 
A new envelope point   will be added which can be dragged and positioned as necessary.
To delete a point, right-click it and choose Delete   from the shortcut menu.

                    Draw envelope points
To create an envelope quickly, you can draw freehand envelope   curves in the timeline.

 1. With the Draw ,   Envelope , or Time Selection  tool active, hover over an envelope.

 2. Hold Shift, and then click   and drag over the envelope. The cursor is displayed as a .   

 As you drag, a trail of envelope points is created.
 3. Release the mouse button when you're finished   drawing.

If the Smooth and  thin automation data after recording or drawing check box is selected   on the External 
Control &   Automation tab of the Preferences dialog, the number of envelope points   will be reduced when you 
release the mouse.

Unthinned envelope

Thinned envelope

Flip an envelope             
You can flip an envelope to invert the envelope around its   center. Volume, panning, bus, and assignable effects 
envelopes can be   flipped.

Using Automation 147



Flipping all points

 1. Right-click an envelope   or a point. A shortcut menu is displayed.
 2. Choose Flip  All Points from the shortcut menu.

Flipping selected points

 1. Create a time selection   with the Time Selection  or the Envelope tool .

 2. Right-click an envelope   in the time selection. A shortcut menu is displayed.
 3. Choose Flip  Selected Points from the shortcut menu.

Set fade properties
You can adjust the fade curve for each envelope segment   individually. To change the fade curve, right-click an 
envelope segment   and choose a command from the shortcut   menu.

Fade  Type Fade  In/Out Envelope

Linear  Fade

Fast  Fade

Slow  Fade

Smooth  Fade

Sharp  Fade

Hold

Cut, copy, and paste   envelope points             

 1. Select the Envelope tool .

 2. Select the envelope points you want   to copy:
 a. Create a time   selection that contains the envelope points you want to copy.
 b. Click the envelope you want   to copy.

If   the envelope isn't displayed, you can right-click the track, choose Show Envelopes from   the shortcut 
menu, and then choose an envelope from the submenu.

 3. From the Edit menu, choose   Copy.
 4. Select the envelope where you want   to paste the envelope points:
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 a. Click within a track   to select it.
 b. Insert an envelope if needed.
 c. Click to select the envelope   where you want to paste the selected points. 
 d. Click to position the cursor   where you want the envelope to start.

 5.  a. From the Edit menu, choose Paste.

Copy an envelope to another track             

 1. Select the Envelope tool .

 2. Select  the envelope you want to copy:
 a. From the Edit menu,   choose Select All   to create a time selection that matches the length of your project.
 b. Click the envelope you want   to copy.

If   the envelope isn't displayed, you can right-click the track, choose Show Envelopes from   the shortcut 
menu, and then choose an envelope from the submenu.

 3. From the Edit menu, choose   Copy.
 4. Select the envelope where you want   to paste the envelope points:

 a. Click within a track   to select it.
 b. Insert an audio   or MIDI envelope if needed.
 c. Click to select the envelope   where you want to paste the selected points. 
 d. Click Go  to Start  if you want the envelope to appear exactly   as it was in the original track, or click to 

position the cursor where   you want the envelope to start.
 5. From the Edit menu, choose Paste.

Recording Track Envelope Automation 
Automation recording allows you to edit envelope and keyframe settings   by using the controls in the ACID interface. 
When combined with a control   surface, you can create fades and adjust control parameters with a   level of control 
that only a tangible control can provide.
Automation recording is available for the following settings:

 l Audio track envelopes (using the controls   in the track header)
 l MIDI track envelopes (using the controls   in the track header)
 l Audio track effect parameters for automatable   effects (using the controls in Audio Plug-In window)
 l Bus, soft   synth, and assignable effects output and panning levels (using the controls   in the Mixing Console 

window or bus track header)
 l VSTi   parameters (using the controls in the Soft Synth Properties window)
 l Surround   panning keyframes

Tips:

 l If you want   to record MIDI controller envelopes into a track using a hardware controller,   you can use MIDI 
merge recording to record   the envelopes.

 l If you want   to thin envelope points after recording automation, you can select the   Smooth and thin automation  
data after recording check box on the External   Control & Automation tab of the Preferences dialog.

Record automation settings

 1. Add an envelope   or automatable effect to a track. 
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 For automatable audio track effects, you must add and effect   automation envelope for each parameter you want 
to automate.

 2. Select the   Automation Settings   button .

To toggle automation controls for all tracks,   press Ctrl+A before selecting the Automation  Settings button.

 3. Click the  next to the Automation  Settings button and choose Automation Write (Touch) or Automation  
Write (Latch) from the menu

Automation 
Recording 
Mode

Track 
Icon

Description

Automation 
Write 
(Touch)

Envelope points or keyframes are created only   while a control is being adjusted. When 
you stop adjusting the control,   automation recording stops and the existing envelope 
points/keyframes   are unaffected.

Automation 
Write 
(Latch)

Envelope points or keyframes are created when   you change a control setting, and 
recording continues until you stop playback.   When you stop adjusting the control, the 
control's current setting overwrites   the existing envelope points/keyframes.

 4. Click to position the cursor   in the timeline, and click the Play   button    to start playback.

 5. Adjust the control that corresponds   to the envelope point or keyframe you want to adjust. 

 During playback, adjusting a control will create envelope points or   keyframes at the cursor position. As long as 
you're adjusting the control,   new envelope points/keyframes will be created for each change of the play   cursor's 
position.  

 6. Click Stop    to end playback and stop recording automation.

Edit sections of your recorded settings in   Touch mode
In Touch recording mode, envelope points or keyframes are   created only while a control is being adjusted. When you 
stop adjusting   the control, automation recording stops and the existing envelope points/keyframes   are unaffected.
Use Touch mode for touching up sections of your recorded   automation settings. 

 1. Select the Automation  Settings button .

To toggle automation controls for all tracks,   press Ctrl+A before selecting the Automation  Settings button.

 2. Click the  next to the Automation  Settings button and choose Automation Write (Touch) from the menu.   
The icon in the track header is displayed as a .

 3. Click to position the cursor   in the timeline, and click the Play   button    to start playback.

 4. When you're ready to start   editing, adjust the control that corresponds to the envelope point or   keyframe you 
want to adjust. 

 Envelope points/keyframes are updated at the cursor position, and when   you stop adjusting the control, the 
original settings are preserved.

 5. Click Stop    to end playback and stop recording automation.

Overwrite recorded settings in Latch mode
In Latch mode, envelope points or keyframes are created   when you change a control setting, and recording continues 
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until you stop   playback. When you stop adjusting the control, the control's current setting   overwrites the existing 
envelope points/keyframes.
Use Latch mode to overwrite automation settings with new   values. 

 1. Select the Automation  Settings button .

To toggle automation controls for all tracks,   press Ctrl+A before selecting the Automation  Settings button.

 2. Click the  next to the Automation  Settings button and choose Automation Write (Latch) from the menu.   The 
icon in the track header is displayed as a .

 3. Click to position the cursor   in the timeline, and click the Play   button    to start playback.

 4. When you're ready to start   editing, adjust the control that corresponds to the envelope point or   keyframe you 
want to adjust. 

 Envelope points/keyframes are updated at the cursor position until   you stop playback.
 5. Click Stop    to end playback and stop recording automation.

Edit individual envelope points or keyframes
Editing individual envelope points gives you fine control   over your recorded settings.

 1. Select the Automation  Settings button .

 2. Click the  next to the Automation  Settings button and choose Track Automation: Write (Touch) or Track 
Automation: Write (Latch)  from the menu. 

 3. Select the envelope tool  and   click the envelope point you want to edit. 

 You can right-click a point and choose Properties   from the shortcut menu to display an effect's property page.
 4. Adjust the control that corresponds   to the envelope point you want to adjust. The selected envelope point   is 

edited, and all others are unaffected. 

 For track envelopes, you can also edit   the envelope directly in the timeline.

Set the automation recording mode for a track

 1. Select the Automation  Settings button .

 2. Click the  next to the Automation  Settings button and choose a command from   the menu to choose the 
automation mode.

To set the automation mode for all tracks,   press Ctrl+A before choosing a mode on any track.

Mode Track 
Icon

Description

Off Automated parameters   are ignored during playback.                         
When you switch to Off mode, the control setting   from the cursor position is used as a 
static setting, and the envelope/keyframe   is dimmed to indicate that it is unavailable.

Read The envelope/keyframe   value is applied during playback, and the control reflects the 
envelope/keyframe   settings at the cursor position.                          
Adjustments to the control are not recorded.

Write 
(Touch)

The envelope/keyframe value is applied during   playback, and the control follows the 
envelope/keyframe settings during   playback and when you position the cursor.
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Envelope points or keyframes are created only   while a control is being adjusted. When you 
stop adjusting the control,   automation recording stops and the existing envelope 
points/keyframes   are unaffected.

Write 
(Latch)

The envelope/keyframe value is applied during   playback, and the control follows the 
envelope/keyframe settings during   playback and when you position the cursor.
Envelope points or keyframes are created when   you change a control setting, and recording 
continues until you stop playback.   When you stop adjusting the control, the control's last 
setting overwrites   the existing envelope points/keyframes.
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Adding Effects
You can use DirectX and VST audio plug-ins at the event and track level, on busses,   soft synths, or as assignable 
effects chains. 

If the plug-in   you want to use isn't displayed in the Plug-In Chooser, you can use the   Plug-In   Manager window 
to indicate where your plug-ins are installed and scan   for plug-ins.         

Be   aware that using non-in-place   plug-ins (such as Time Stretch, Pitch-Shift without preserving duration,   and 
some Vibrato settings) will cause audio to play out of synchronization   with the waveform display in the timeline 
and with other tracks. If an   effects chain includes non-in-place plug-ins, the effects chain icon will   be displayed 
in yellow ( ).

When using ACID software as a ReWire   device, any effects chain that includes non-in-place plug-ins will   be 
automatically bypassed to prevent synchronization problems with the   ReWire mixer application. The effects 
chain icon will be displayed in   red ( ). Apply the plug-ins within the ReWire mixer application.

Track Effects
From the Tools menu, choose Track  FX to apply or edit DirectX or VST plug-ins at the track level.   Track-level plug-
ins are applied to every event on the selected track.

Be   aware that using non-in-place   plug-ins (such as Time Stretch, Pitch-Shift without preserving duration,   and 
some Vibrato settings) will cause audio to play out of synchronization   with the waveform display in the timeline 
and with other tracks. If an   effects chain includes non-in-place plug-ins, the effects chain icon will   be displayed 
in yellow ( ) to indicate that automatic plug-in delay   compensation is being used.

When input monitoring is on during audio   recording, plug-in chains that cannot be used for live monitoring   are 
automatically bypassed and are displayed in red ( ).

When using ACID software as a ReWire   device, any effects chain that includes non-in-place plug-ins is 
automatically   bypassed to prevent synchronization problems with the ReWire mixer application.   The effects 
chain icon is displayed in red ( ). Apply the plug-ins within the ReWire mixer   application.

Add effects to a track             

 1. Click the Track  FX button  on the track where you want   to add effects. The Audio Plug-In window is   

displayed.
The Track  FX button is displayed in gray when a track does not have track   effects assigned. When no effects 
exist on a track, clicking the Track FX button displays   the Audio Plug-In Chooser.

 2. Click the Edit  Chain button  in the Audio Plug-In window.   The Plug-In Chooser is displayed.

 3. Select each plug-in you   want to add and click the Add   button or browse to a packaged effects chain. The plug-
ins appear at the   top of the window in the order you added them.

To reorder the plug-ins within the chain, drag a plug-in   button to a new location or click the Shift Plug-In 
Left  or Shift  Plug in Right  buttons.

 4. Once you have added   all of the plug-ins and specified the plug-in chain order, click on the   OK button to   close 
the Plug-In Chooser and return to the Audio Plug-In window.

 5. Adjust the settings for   the effects. For more information about using specific plug-ins, click   the Plug-In Help   
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button .

You can also use the Insert FX control region   in the Mixing Console window to add, remove, or configure track 
effects.   For more information, please see "Add or edit track (insert) effects"   in Audio Track   Channel Strips.

Edit a track effects   chain

 1. Click the Track  FX button  on a track to open the Audio   Plug-In window.

 2. Use the Audio   Plug-In window to enable/bypass effects, edit effect parameters, and   add/remove effects from a 
chain. For more information about using specific   plug-ins, click the Plug-In  Help button .

You can also use the Insert FX control region   in the Mixing Console window to edit the effects chain. For more 
information,   please see "Add or edit track (insert) effects" in Audio   Track Channel Strips.

Automate effect parameters
If a plug-in supports it, you can use envelopes to automatically   adjust effect parameters over time. For more 
information about using automation envelopes on   tracks, read more under "Automating Audio Effect Parameters" 
on page 144.

Adding/Editing Audio Event Effects
Click the Event FX   button  on an event to apply or edit DirectX or VST plug-ins   at the event level. Event-level 

plug-ins are applied only to the event   where they are applied.
Be   aware that using non-in-place   plug-ins (such as Time Stretch, Pitch-Shift without preserving duration,   and 
some Vibrato settings) will cause audio to play out of synchronization   with the waveform display in the timeline 
and with other tracks. If an   effects chain includes non-in-place plug-ins, the effects chain icon will   be displayed 
in yellow ( ) to indicate that automatic plug-in   delay compensation is being used. When input monitoring is 

on during audio recording, plug-in chains that   cannot be used for live monitoring are automatically bypassed 
and are   displayed in red ( ).

Create an event effects chain

 1. Click the Event   FX button  on the event where you want to add effects.   The Audio Plug-In window is 

displayed.
The Event   FX button is displayed in gray when an event does not have effects   assigned. When no effects exist 
on an event, clicking the Event   FX button   displays the Plug-In Chooser.

 2. Click the Edit   Chain button  to display the Plug-In Chooser.

 3. Select each plug-in   you want to add and click the Add   button, or browse to an FX package. The plug-ins appear 
at the top of   the window in the order in which you added them.

To   reorder the plug-ins within the chain, drag a plug-in button to a new   location, or click the Move   Plug-In 
Left  or Move   Plug-In Right  buttons.

 4. Once you have added   all of the plug-ins and specified the plug-in chain order, click the OK button. The Audio   
Plug-In window is displayed to allow you to edit the chain.

Edit an event effects chain
When you click the Event   FX button 
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 on an event, the Audio   Plug-In window is displayed to enable/bypass effects, edit effect   parameters, and 

add/remove effects from a chain.

Learn more about a specific plug-in
For more information about using specific plug-ins, click   the Plug-In Help   button  in the Audio Event FX window 
to display the plug-in's   help file.

Adding Effects to a Bus
Bus effects will be applied to all tracks assigned to that bus.   If a track contains track and bus effects, track effects will 
be processed   before the bus effects. For more information about the audio signal flow,   see "Signal Flow Diagrams" 
on page 310.

If   you want to add effects to all audio in your project, you can add effects   to the Master bus.

When   input monitoring is on during audio recording,   audio effects chains that contain non-in-place plug-ins 
are displayed   in yellow ( ) to indicate that automatic plug-in delay compensation is being   used. Chains that 

cannot be used for live monitoring are automatically   bypassed and are displayed in red ( ).

When using ACID software as a ReWire   device, any effects chain that includes non-in-place plug-ins is 
automatically   bypassed to prevent synchronization problems with the ReWire mixer application.   The effects 
chain icon is displayed in red ( ). Apply the plug-ins within the ReWire mixer   application.

Add effects to a bus             
Using the bus track header

 1. Click the Bus  FX button  on a bus track.   The Plug-in Chooser window appears.

The Bus  FX button is displayed in gray when a bus does not have effects   assigned. When no effects exist on a 
bus, clicking the Bus  FX button displays the Audio Plug-In Chooser.

 2. Select each plug-in you want   to add and click the Add   button or browse to a packaged effects chain.
To reorder the plug-ins within the chain, drag a plug-in   button to a new location or click the Shift Plug-In 
Left  or Shift  Plug in Right  buttons.

 3. Once you have added   all of the plug-ins and specified the plug-in chain order, click on the   OK button to   close 
the Plug-In Chooser and return to the Audio Plug-In window.

 4. Adjust the settings for the   effects. For more information about using specific plug-ins, click the   Plug-In Help   
button .

Using the Mixing Console

You can also use the Insert FX   control region in the Mixing Console to edit the effects chain for each   bus. 
For more information, please   see Bus Channel Strips in the Mixing console help file.

Edit bus effects             

 1. Click the Bus  FX button  on a bus track to open the Audio Plug-In window.

 2. Use the Audio   Plug-In window to enable/bypass effects, edit effect parameters, and   add/remove effects from a 
chain. For more information about using specific   plug-ins, click the Plug-In  Help button .
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For more information about using   the Insert FX control region in the Mixing Console to edit the effects   chain, please 
see Bus   Channel Strips in the Mixing console help file.

Automate effect parameters
If a plug-in supports automation, you can add envelopes   to a bus track to automatically adjust effect   parameters over 
time.
For more information about using   automation envelopes on tracks, see "Adding Audio Track Envelopes" on 
page 134.   

Adding Plug-Ins to a Soft Synth
You can apply standard DirectX or VST audio plug-ins to MIDI tracks   by adding effects to the soft   synth channel 
strip where the track is routed.

When   input monitoring is on during audio recording,   audio effects chains that contain non-in-place plug-ins 
are displayed   in yellow ( ) to indicate that automatic plug-in delay compensation is being   used. Chains that 

cannot be used for live monitoring are automatically   bypassed and are displayed in red ( ).

When using ACID software as a ReWire   device, any effects chain that includes non-in-place plug-ins is 
automatically   bypassed to prevent synchronization problems with the ReWire mixer application.   The effects 
chain icon is displayed in red ( ). Apply the plug-ins within the ReWire mixer   application.

Add effects to a soft   synth             
Using the bus track header

 1. Click the Synth  FX button  on the soft synth bus   track. The Plug-in Chooser window appears.

The Synth  FX button is displayed in gray when a soft synth does not have   effects assigned.
 2. Select each plug-in you want   to add and click the Add   button or browse to a packaged effects chain.

To reorder the plug-ins within the chain, drag a plug-in   button to a new location or click the Shift Plug-In 
Left  or Shift  Plug in Right  buttons.

 3. Once you have added   all of the plug-ins and specified the plug-in chain order, click the OK button to close   the 
Plug-In Chooser and display the Audio Plug-In   window.

 4. Adjust the settings for the   effects. For more information about using specific plug-ins, click the   Plug-In Help   
button .

Using the Mixing Console

You can also use the Insert FX   control region in the Mixing Console to edit the effects chain for each   soft synth. 

Edit effects             

 1. Click the Synth  FX button  on a soft   synth bus track to open the Audio   Plug-In window.

 2. Use the Audio   Plug-In window to enable/bypass effects, edit effect parameters, and   add/remove effects from a 
chain. For more information about using specific   plug-ins, click the Plug-In  Help button .

You can also use the Insert FX control region   in the Mixing Console window to edit the effects chain. 
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Automate effect parameters
If a plug-in supports automation, you can add envelopes   to a soft synth's bus track to automatically   adjust effect 
parameters over time.
For more information about using   automation envelopes on tracks, please see "Adding Audio Track Envelopes" on 
page 134. 

The Audio Plug-In Window
From the View menu, choose Audio  Plug-In to toggle the display of the Audio Plug-In window. This   window 
displays effects chains for the events, tracks,   busses, assignable   FX chains, and soft synths in   your project. Use the 
Audio Plug-In window to enable/bypass effects, add/remove   DirectX and VST effects, edit effect parameters, and 
configure effects   automation.

Be   aware that using non-in-place   plug-ins (such as Time Stretch, Pitch-Shift without preserving duration,   and 
some Vibrato settings) will cause audio to play out of synchronization   with the waveform display in the timeline 
and with other tracks. If an   effects chain includes non-in-place plug-ins, the effects chain icon will   be displayed 
in yellow ( ).

When using ACID software as a ReWire   device, any effects chain that includes non-in-place plug-ins will   be 
automatically bypassed to prevent synchronization problems with the   ReWire mixer application. The effects 
chain icon will be displayed in   red ( ). Apply the plug-ins within the ReWire mixer application.

Enable or bypass effects             
Select the check box for each plug-in you want to apply   to the track, or clear a check box to bypass an effect without 
removing   it from the chain.

The effect of plug-ins on a chain is cumulative, so   you may need to rearrange the plug-ins so that one plug-in's 
processing   does not adversely affect other plug-ins in the chain. To reorder the   plug-ins within the chain, drag a 
plug-in button to a new location.

You can bypass, enable, or delete all plug-ins in the   chain by right-clicking the  button in the track list or   

Mixing Console window and choosing a command from the shortcut menu.

Edit effect parameters             
Click the plug-in's button to select it, and use the bottom   half of the window to adjust the effect's parameters. For 
more information   about using a specific plug-in, click the Plug-In  Help button .

Add or remove effects             

 1. Click the Edit  Chain  button to display   the Plug-In Chooser.

 2. Select a plug-in button,   and then click the Add  or Remove button.   The modified chain is displayed at the top of 
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the window.
 3. DirectX Effects that can be automated are   indicated by the   icon in the Plug-In Chooser.

 4. VST plug-ins are indicated by the      icon in the Plug-In Chooser.

 5. Click the OK button. The Audio   Plug-In dialog is displayed.

Tips:

 l You can   bypass, enable, or delete all plug-ins in the chain by right-clicking   the  button in the track list or 

Mixing   Console window and choosing a command from the shortcut menu.
 l You can   remove a plug-in from the Audio Plug-In dialog by selecting the plug-in   and clicking the Remove  

Selected Plug-In button  .

Load an effects chain or plug-in preset             
Loading a plug-in chain preset

Choose a setting from the Chain drop-down list.   The preset chain is loaded using the saved settings for each DirectX 
and   VST plug-in in the chain.

Loading a preset for an individual DirectX plug-in

Choose a setting from the Preset drop-down list.   The plug-in settings stored in the preset are loaded.

Loading a preset for an individual VST plug-in

 1. Click the Open  VST Preset button . 

The Open VST Preset dialog is displayed.

 3. Click the Open   button. 
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 The current VST preset is replaced with the settings stored in the   .fxp file.
 3. Click the Open   button. 

 The current VST preset is replaced with the settings stored in the   .fxp file.

Loading a bank of VST plug-in presets

 1. Click the Open  Effect Bank button . 

The Open VST Preset Bank dialog is displayed.
 2. Browse to the .fxb file   that you want to use.
 3. Click the Open   button. 

 All presets for the current VST plug-in are replaced with the settings   stored in the .fxb file, and the first preset in 
the bank is loaded by   default.

Create or delete an effects chain or plug-in   preset             
Create a plug-in chain preset

 1. Add the effects that you   want to use and adjust the settings for each plug-in.
 2. Type a name in the Chain Preset box.
 3. Click the Save  Chain Preset button . The order of the effects in the chain and the settings for   each plug-in 

are saved.

Create a preset for an individual DirectX plug-in

 1. Adjust the settings for   the plug-in.
 2. Type a name in the Preset box.
 3. Click the Save  Preset button .   The settings for the current plug-in are saved.

Saving a preset for an individual VST plug-in

 1. Type a name in the Preset box.
 2. Click the Save  VST Preset As button .  The Save VST Preset dialog is displayed.

 3. Browse to the folder where   you want to save the .fxp file and type a name in the File  name box.
 4. Click the Save   button. The current plug-in settings are saved in the .fxp file.

Saving a bank of VST plug-in presets

 1. Click the Save  VST Bank As button .  The Save VST Preset Bank dialog is displayed.

 2. Browse to the folder where   you want to save the .fxb file and type a name in the File  name box.
 3. Click the Save   button. All presets for the current plug-in are stored in the bank.
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Delete a preset

Choose a preset from the Chain or Preset  drop-down list and click the Delete   button .

Notes:

 l You cannot delete built-in presets.
 l VST plug-in settings are loaded   or saved using .fxp and .fxb files as described above. Individual presets   and 

banks cannot be deleted from the Audio Plug-In window.

Automate effect parameters
If a plug-in supports it, you can use envelopes to automatically   adjust effect parameters over time. Automation 
envelopes can be added   to tracks and bus tracks to control individual effect parameters for track   effects, bus effects, 
and assignable effects.
For more information about using automation envelopes on   tracks, see "Adding Audio Track Envelopes" on 
page 134.
When you add a plug-in that supports automation, the Bypass  FX Automation button  is displayed in the Audio 

Plug-In window:

 l After you've added effect automation   envelopes, the Bypass  FX Automation button is deselected, and effect 
parameters are automated   using the envelope settings.

 l When the button is selected, effect   automation envelopes are ignored and the effect's initial state is used   for the 
duration of the track.

 l If you delete all automation envelopes   from a plug-in, the Bypass  FX Automation button is unavailable.

The Plug-In Manager Window
From the View menu, choose Plug-In Manager to   toggle the display of the Plug-In Manager window.
This window organizes your DirectX   and VST plug-ins (VST effects and instruments), and ReWire devices.
You can use this window to access   effects and effects packages that can be applied to events, tracks, busses, 
assignable   effects chains, and soft synth busses. You can also rename and reorganize   plug-ins. 
For information about adding effects   to your project, see "Adding Effects" on page 153. 

To   add an effect quickly, drag a plug-in from the Plug-In Manager window   to a track, bus, assignable effects 
chain, or soft synth bus.         

Scan your computer for plug-ins
Scanning your computer for VST plug-ins is a two-stage process:   first, you need to tell ACID where your plug-ins 
are installed, and then   you can scan those folders for plug-ins.

You don't need to scan for DirectX or ReWire plug-ins. These   plug-ins are registered with Windows and are 
detected automatically.

 1. From the View menu, choose Plug-In Manager if the   window isn't already visible. 
 2. Click the Configure  VST button  at the top of the Plug-In Manager window. The Plug-In   Configuration 

dialog is displayed. The dialog displays a list of folders   where ACID looks for VST plug-ins.
 3. Indicate where your plug-ins are   installed:
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 l If you want to add a new folder,   click the Add  button and then browse to the folder where   your plug-in is 
installed.

 l If you want to edit an existing   folder path, select a folder in the Search Folder column, click the Edit  button, 
and then browse to the folder where your plug-in is installed.

 l If you want to remove an existing   folder, select a folder in the Search Folder column and click the Remove  
button.

 4. Click the Scan   button to start scanning your folders for plug-ins.

View plug-ins
When you open the Plug-In Manager window, an Explorer view   is displayed with separate folders for your plug-ins.

Folder Description

Audio 
FX

Displays all your DirectX and VST audio plug-ins.
You can drag plug-ins to tracks or Mixing Console   channel strips to add effects to your project.
Select the All   folder to display all audio plug-ins. 

 l The   Failed folder contains plug-ins   that did not scan correctly or timed out during scanning. These 
plug-ins   cannot be used in ACID. You can right-click a plug-in and choose Rescan from the 
shortcut menu to attempt   to rescan the plug-in for use in ACID.

 l The   Ignored folder contains plug-ins   that you want to prevent ACID from using without 
uninstalling the plug-in.   You can right-click a plug-in and choose Ignore  from the shortcut menu 
or drag it to the Ignored   folder.

 l The Unavailable   folder contains   plug-ins that you have uninstalled since running ACID. ACID 
preserves   information about uninstalled plug-ins so settings can be restored if   the plug-ins are 
reinstalled.                                 

The Audio FX   folder also contains additional folders you can use to organize and categorize   your plug-
ins. Please see "Organize plug-ins with folders" in   this help topic for more information.

ReWire 
Devices

Displays your ReWire device (client) applications.
Select the All   folder to display all ReWire clients.
The Ignored   folder contains plug-ins that you want to prevent ACID from using without   uninstalling 
the plug-in. You can right-click a plug-in and choose Ignore  from the shortcut menu or drag  it to the 
Ignored folder.
The ReWire  Devices folder also contains a Favorites folder you can use to   keep your most-often-used 
ReWire clients handy. You   can right-click a plug-in and choose Add   to Favorites from the shortcut   
menu or drag it to the Favorites folder.
To create custom folders for organizing your   plug-ins, you can right-click a folder and choose New  
Folder from the shortcut menu.

Soft 
Synths

Displays all your  VST instrument (VSTi) plug-ins.
Select the All   folder to display all soft synths. 

 l The   Failed folder contains plug-ins   that did not scan correctly or timed out during scanning. These 
plug-ins   cannot be used in ACID.

 l The   Ignored folder contains plug-ins   that you want to prevent ACID from using without 
uninstalling the plug-in.   You can right-click a plug-in and choose Ignore from the shortcut menu 
or drag it to the Ignored   folder.

 l The Unavailable   folder contains   plug-ins that you have uninstalled since running ACID. ACID 
preserves   information about uninstalled plug-ins so settings can be restored if   the plug-ins are 
reinstalled.                                 
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The Soft Synths  folder also contains subfolders you can use to organize and categorize   your plug-ins by 
instrument type and vendor. Please see "Organize   plug-ins with folders" in this help topic for more 
information.

The toolbar at the top of the window helps you navigate   the Plug-In Manager window and adjust its display.

Item Name Description

Address 
Bar

Displays the current folder. You can choose   a folder from this drop-down list or 
click a folder in the tree view to   navigate the Plug-In Manager.

Tree  
View

Displays all of the folder that you can use   to organize your plug-in.

Contents  
Pane

Displays the contents of the selected folder.

Up Opens the folder one level above the selected   folder.

Refresh Refreshes the contents of the active folder.

New 
Folder

Adds a new folder where you can drag plug-ins.

Delete Deletes a user-created   folder or removes the selected plug-in from a user-created 
folder. When   you delete a folder, only the folder is deleted. The plug-ins remain on   
your system.                         
Only user-created folders can be deleted.

Views Click the   down arrow next to the Views button and choose a command from the   
menu to change the way the plug-ins are displayed.                         

Tree View Displays all of the available folders on the   left side of the window.

Details Displays detailed information about each plug-in.

Organize plug-ins with folders
The Audio FX , ReWire Devices, and Soft Synths folders   contain subfolders to help you organize your plug-ins. 
Several folders   are displayed by default, and you can add your own folders. Each plug-in   can be assigned to multiple 
folders, but audio plug-ins and soft synths   can be assigned to only one category.
If you want to create a folder to group your plug-ins, select   a folder and click the New  Folder button    on the 

toolbar (or right-click a folder and choose New  Folder from the shortcut menu). 
To add a plug-in to a folder, drag the plug-in from the   right-hand pane to a folder.
To remove a plug-in from a folder, navigate to the folder,   select the plug-in, and click the Delete   button  on the 

toolbar.

Displaying audio plug-in folders in the Mixing Console   window

You can use folders and categories   to organize plug-ins in the Mixing Console window.
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When you click the Insert  FX button in the Mixing Console, plug-ins are grouped into 
submenus.   
If you want to use folders and categories to organize plug-ins in the   Mixing Console 
window, right-click a folder in the Plug-In Manager and   choose Show in Insert FX 
Submenu from the shortcut menu.
If you want to remove a folder or category from the Mixing Console window,   right-
click a folder in the Plug-In Manager and choose Show  in Insert FX Submenu  from 
the shortcut menu to deselect the Show in Insert FX Submenu command.

Show or hide folders
To simplify the Plug-In Manager, you can choose to hide   specific folders.
You can hide the following folders (default folders cannot   be hidden):

 l User-created folders 
 l Failed, Unavailable, and Ignored folders
 l DirectX, VST, and Track Optimized   folders

Hiding a folder

Right-click a folder in the Plug-In   Manager and choose Hide from the shortcut menu.

Showing hidden folders

 1. Right-click a folder and choose   Properties from   the shortcut menu.
 2. Click the Show  all Hidden Subfolders button. All hidden folders below the selected   folder are shown.

Classify audio plug-ins and soft synths with categories
Categories help you organize your plug-ins by type. The   Audio FX folder contains several default categories, and the 
Soft Synths   folder contains an Instruments folder with default instrument categories.   You can also create your own 
categories to help you organize your plug-ins.   
Each plug-in can be assigned to only one category.
If you want to create a new category, select the Categories   folder and click the New  Folder button  on the 

toolbar. To add a plug-in to   a category, perform either of the following actions:

 l Drag the plug-in from the right-hand   pane to a category.
 l Right-click a plug-in in the right-hand   pane, choose Assign to Category from the shortcut menu, and then 

choose a category from the menu.   

To change a plug-in's category, perform either of the following   actions:

 l Navigate to the folder, select the   plug-in, and drag it to a different category folder.
 l Right-click a plug-in in the right-hand   pane, choose Assign to Category from the shortcut menu, and then 

choose a category from the menu.

If you want to edit a category, right-click its folder and   choose Properties   from the shortcut menu. You can edit the 
category's name (only for user-created   categories), short name, and description. Default categories are locked,   but 
you can clear the Locked   check box to edit them.
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Rename a plug-in
If you want to change a plug-in's name, right-click the   plug-in in the Plug-In Manager window and choose Rename   
from the shortcut menu. You can then type a new name in the edit box.
To reset a plug-in's default name, right-click the plug-in   and choose Reset Name   from the shortcut menu.

Ignore a plug-in
If you want to prevent ACID from using a plug-in, but you   don't want to uninstall the plug-in, you can ignore it: just 
right-click   a plug-in and choose Ignore  from the shortcut menu.
To re-enable an ignored plug-in, right-click a plug-in and   choose Ignore from   the shortcut menu to deselect the 
Ignore  command.

Edit plug-in or folder properties
Right-click a plug-in and choose Properties   from the shortcut menu to display a Properties dialog. You can use the   
plug-in properties dialog to change the name, vendor, or category of a   plug-in or to add it to the Favorites folder.
Right-click a folder and choose Properties  from the shortcut menu to display a Properties dialog. You can   use the 
folder properties dialog to change the name or description of   a folder, show hidden folders, lock/unlock a folder, or 
show the folder   on Insert FX submenu in the Mixing Console.

Use audio plug-ins
When viewing plug-ins in the Audio  FX folders, the following icons are used to represent your plug-ins:

Icon Description

Represents a DirectX audio plug-in.

Represents a DirectX audio plug-in that supports   automation.

Represents a VST audio plug-in.

Represents a locked VST plug-in. 
When you use a VST plug-in in your project,   ACID will lock it for the remainder of your ACID session. A 
lock is displayed   to indicate that the plug-in cannot be removed until you close and restart   the application.

To add plug-ins to your project, you can drag them from   folders in the Plug-In Manager window to tracks or channel 
strips in the   Mixing Console window.

Use ReWire devices
When viewing ReWire devices in the ReWire  Devices folders, the following icons are used to represent your   plug-
ins:

Icon Description

Represents a ReWire device that is not currently   in use.

Represents a ReWire device that is currently   in use by a soft synth bus.

When you select a ReWire device, its outputs   are displayed on the right side of the Plug-In Manager 
window. This icon   represents an unused ReWire output.

Represents a ReWire output that is in use.
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To add a ReWire device to your project, select a ReWire   device  in the left-hand pane to display its   outputs in the 

right-hand pane. You can then right-click an output  and   choose  Insert  Rewire Device Bus  from the   shortcut 

menu to add a soft synth bus to the Mixing Console window.

Use soft synths             
When viewing soft synths in the Soft  Synths folders, the following icons are used to represent your   plug-ins:

Icon Description

Represents a soft synth.

Represents a locked   VSTi plug-in.                          
When you use a VSTi plug-in in your project,   ACID will lock it for the remainder of your ACID session. A 
lock is displayed   to indicate that the plug-in cannot be removed until you close and restart   the application.

To add a soft synth to your project, right-click a soft   synth  in   the right-hand pane and choose  Insert Soft Synth 

from   the shortcut menu. A soft synth bus is added to the Mixing Console window.

Bypassing All Audio Effects
From the Options menu, choose Bypass  All Audio FX to omit all audio effects (track, bus, and assignable   effects) 
during playback.
Bypassing effects allows you to quickly compare your project with and   without effects and conserve processing 
power to avoid playback problems.

When effects are bypassed, you can choose whether bypassed   effects remain open. When the Keep  bypassed 
FX running check box on the General   tab of the Preferences dialog is selected, effects remain open so you   can 
bypass/enable effects with no pause for A/B testing. When the check   box is cleared, effects are fully bypassed, 
conserving processing power.   
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Mixing Audio
You can add an unlimited number of audio tracks to your project, and   you can mix the tracks in two ways:

 l The audio   track controls in the track list allow you to adjust relative track volumes,   panning, assignable FX send 
levels, and bus send levels for individual   tracks.

 l The Mixer   window allows for advanced multichannel mixing using busses and assignable   effects.

The Mixing Console Window
From the View menu, choose Mixing  Console to display the Mixing Console window. 
The Mixing Console window provides an integrated view of all tracks   and busses in your project using the 
appearance of a traditional hardware-based   mixer.

Using Busses
You can use busses   to group and mix tracks. The most common uses of busses are for routing   tracks and effects 
outputs to specific hardware outputs or simply to use   a bus as a master control for a set of tracks.
For example, if you wanted to control the master level of all your drum   tracks to a relative level, you could create a 
bus and assign all drum   tracks to that bus. After your drums are mixed, you can adjust the overall   volume of the 
drum tracks by adjusting the bus volume.
To see the audio signal flow, see "Signal Flow Diagrams" on page 310.

Adding or Deleting Busses
From the Insert menu, choose Bus   (or click the Insert  Bus button    in the Mixing Console window) to add a bus 

to your project.
The number of busses in your project will be determined by several factors,   such as the number of outputs that your 
hardware contains or how you will   be using and applying effects throughout your project.

You can add up to 26 busses, and you can change   the number of busses at any time.

By default, all busses are assigned to the Master bus. In this configuration,   you can use them for creating subgroups 
of tracksfor   example, you could route all your drum tracks to a bus so you can adjust   their levels together without 
changing their relative levels. However,   you can also route busses to hardware outputs   so you can use busses for 
sending tracks to external effects processors   or for mixing on an external mixer.—

Add a bus             

From the Insert menu, choose Bus  to add a bus to your project. 
If the Mixing Console   Window is visible, click the  Insert Bus button .

Rename a bus             

To rename a bus, double-click the label at the bottom of   the channel strip and type a new name in the box (or press 
F2 to rename   the selected bus). The channel strip in the Mixing Console is updated   when you press Enter:
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Delete all characters   in a custom bus name to reset a custom bus name to its default.

Delete a bus

Right-click a bus channel strip and choose Delete   from the shortcut menu, or select a bus channel strip in the 
Mixing Console   window and press the Delete key.

When you remove a   bus from a project, any tracks assigned to that bus will be reassigned   to the Master bus. 

Routing Busses
You can create up to 26 (plus the Master) virtual busses   that you can route to hardware attached to your computer 
or to other busses.
By default, all busses are assigned to the Master bus. In this configuration,   you can use them for creating subgroups 
of tracksfor   example, you could route all your drum tracks to a bus so you can adjust   their levels together without 
changing their relative levels. When you   assign busses to hardware outputs, you can use busses for sending tracks   
to external effects processors or for mixing on an external mixer.—

When   you route busses to hardware outputs, those busses will not be included   in the mix when you render 
your project.

Route a bus to another bus

Using bus track headers

 1. Add   busses to your project.
 2. If bus tracks aren't   already visible, choose Show  Bus Tracks from the View menu.
 3. Click the Playback  Device Selector button on the audio bus track and choose a bus   from the menu:

 l The   button is displayed as a  when a bus is routed to the master bus.

 l The bus   letter is displayed ( , , and so on) when a bus is routed to another bus.

 l The button   is displayed as a  when a bus is routed to a hardware   output (not available for soft synth bus 

controls).
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To prevent feedback, you cannot perform circular   routing. For example, if your project has two busses and bus A 
is routed   to B, bus B can only be routed to the Master bus. 

Using the Mixing Console window

 1. Add   busses to your project.
 2. If the window isn't   already visible, choose Mixing  Console from the View menu.
 3. If the I/O control region   isn't already visible, click the I/O   button in the View pane.
 4. To choose an output device,   click the Output   button and choose a bus from the menu.

Route a bus to a hardware output

Before you get started, verify that you are using Windows   classic wave drivers or an ASIO driver:

 1. From the Options menu, choose   Preferences and click the Audio  Device tab.
 2. From the Audio device type drop-down list, choose Windows  Classic Wave Driver or an ASIO driver.
 3. Click OK   to close the Preferences dialog.

If you have selected Microsoft Sound Mapper in the Audio  device type drop-down list on the Audio   Device tab 
in the Preferences dialog, you will not be able to assign   the bus to a different device.

Using bus track headers

 1. Add   busses to your project.
 2. If bus tracks aren't   already visible, choose Show  Bus Tracks from the View menu.
 3. Click the Playback  Device Selector button on the audio bus track and choose an ouput   device from the menu:

 l The   button is displayed as a  when a bus is routed to the master bus.

 l The bus   letter is displayed ( , , and so on) when a bus is routed to another bus.

 l The button   is displayed as a  when a bus is routed to a hardware   output.

Using the Mixing Console window

 1. Add   busses to your project.
 2. If the window isn't   already visible, choose Mixing  Console from the View menu.
 3. If the I/O control region   isn't already visible, click the I/O   button in the View pane.
 4. To choose an output device,   click the Output   button and choose an ouput device from the menu.
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Assigning Tracks to Busses
Assigning tracks to busses allows you to apply settings to a series   of tracks or route tracks to a hardware output. 
For example, if you wanted to apply the same three effects to several   tracks, you could apply the effects to   a bus and 
assign the tracks to that bus. If you wanted to send several   tracks to a single hardware output, you could assign the 
tracks to a bus   and then route the bus to a hardware   output.

Assign a track to a bus

 1. Click the bus button on the   track. 

 The button is displayed as a  when the track is routed to the master bus, and the bus letter   is displayed ( ,   

, and so on) when   a track is routed to another bus.

 2. Select the desired bus from   the menu. The Bus   button changes to display the selected bus.

If the Bus   button does not appear on the track, you have not specified more than   one bus in your project 
settings.

You can also use the I/O control region in the Mixing console   window to assign a track to a bus. For more 
information, please see Audio Track Channel   Strips in the Mixing console help file.

Bus sends are pre-volume by default. In Post  Volume mode, the following settings are applied to the track 
before   it is sent to the bus: track volume, track volume envelopes, track panning,   and track panning envelopes.

To change to post-volume, right-click the fader handle and choose Post Volume from the   shortcut menu. 

Adjust a bus send level             

 1. Click the label on the multipurpose   slider and choose the desired bus from the menu. The label changes to   
reflect the name of the bus.
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If you can't see the multipurpose slider,   drag the bottom edge of the track header to increase its height.

 2. Drag the fader to adjust the   level of the track sent to the bus.

You can also use the Sends control region in the Mixing   console window to configure bus sends. For more 
information, please see Audio Track Channel   Strips in the Mixing console help file.

Tips:

 l Bus sends   are pre-volume (and pre-mute) by default. When bus sends are pre-volume,   you can create a cue   mix 
that is independent of your main mix. To change to post-volume,   right-click the bus fader and choose Post  
Volume from the shortcut menu.

 l If you   want to apply track panning to bus sends (including pan position and panning mode), right click the bus   
fader and choose Link  to Main Track Pan from the shortcut menu. 

 When Link to Main  Track Pan is not selected, the track sends a center-panned stereo   signal using the track's 
current panning mode. 

 l Select   the Use legacy track  send gain check box on the Audio page of the Preferences dialog   if you want to 
configure audio track sends to behave as they did in ACID   6.0 and earlier. When the check box is selected, you 
can open projects   created with earlier versions of ACID and be assured they will sound the   same as they did in 
earlier versions of ACID.

Creating a Submix Using Busses
When you start a new project, all audio tracks are routed to the master   bus. In this configuration, you can adjust the 
volume of your individual   audio tracks to establish the mix, and you can adjust the master bus to   raise or lower the 
overall volume of your projects.
If you're creating more complicated audio projects, you will likely   want more control over your project. For example, 
imagine your horns were   recorded to several tracks. If you decided that your mix was nearly perfect,   but you wanted 
to bring out the horns just a bit, you could adjust the   Volume fader on   each horn track. However, it would be much 
faster to submix your horn   tracks to a dedicated bus: with a submix, you can adjust the overall level   of the submixed 
tracks without changing their overall levels, add effects,   and mute or solo the submix.
In this sample project, notice that we have eight tracks that are all   routed to the Master bus and that the levels of 
tracks 4-8 have been adjusted   to mix the horns.
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 1. First, let's click the Insert  Bus button  in the Mixing Console window to create a new bus for   our submix. 

 2. By default, the bus is named Bus A. Let's double-click   the bus label in the Mixing Console window and type 
"Horns"   in the box to give our submix bus a more descriptive name. 

 3. Now we need to route our horn tracks to the new submix   bus.
 a. Hold Shift and click the track icon   on track 4.
 b. Continue holding Shift and click the   track icon on track 8. Tracks 4-8 are now selected.
 c. Click the bus icon on any selected   track and choose Bus  A (Horns) from the menu. The selected tracks are 

now all assigned   to the submix bus.

When you look at the project now, you'll see that the track   headers for tracks 4-8 display an  to indicate that 

they're routed to bus A:   
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In the Mixing Console window, the I/O control region shows   that Bus A is routed to the master bus: the horn tracks 
are still part   of the master mix because they're routed from the track to Bus A and then   back to the Master bus.
If you want to automate volume, panning, and effects parameters   over time, you can use envelopes on the submix 
bus   track. For example, if you wanted to make all the horn tracks quieter   during a verse and louder during a bridge, 
you could apply a volume envelope   to the submix bus track.

Using Input Busses with Hardware-Based Effects
Plug-ins are great, but there are times when you may want the sound   of a specific piece of hardware for your tracks. 
This help topic will   show you how to use auxiliary busses and input busses to send a track   to an external processor.

 1. Connect your effects processor   to your audio interface:
 a. Connect the input of your   effects processor to an output from your sound card (for this example,   we'll use 

LineOut 1
 b. Connect the output of your effects   processor to an input on your sound card (for this example, we'll use   

Inst 1).
 2. Add   a bus to your project. This bus will be used as a destination to send   a track to your effects processor.
 3. Configure your bus to send its output   to your effects processor:

 In the I/O control region of the bus's channel   strip, click the Output   button and choose the output that is 
connected to your effects processor's   input (LineOut 1/LineOut  2 for this example).
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This auxiliary bus provides a signal path to   your effects 
processor's input.

 4. Add   an input bus to your project. This input bus will receive the signal   from your effects processor.
 5. Configure your input bus to take its   input from the effects processor and send its output to your main mix:

 a. In the I/O control region   of the input bus's channel   strip, click the Input  Source button and choose the 
sound card input that is connected   to your effects processor's output (Inst  1 for this example).

 b. Click the Output   button and choose the output where you want to send your processed signal.   We’ll send 
this signal to the master bus so it is included with   your main mix and will be included when performing a 
real-time   render.

This input bus provides a signal path from your   effects processor's output to your project.

 6. Send your track to the effects   processor:

 Click the bus button on the track header and choose the bus you created   in step 2.

The bus button on the track header lets you   send 
the track's audio to your effects processor.

 7. Click Play  . 

 When you play your project, the track is sent to your auxiliary bus,   into the effects processor, out of the effects 
processor into the input   bus, and out to the master bus. 

 8. When you're ready to render your project,   you can use real-time rendering   to include the output from your 
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effects processor with your project.

  Using Input Busses with Hardware-Based Synthesizers
If you'd like to use your vintage synth with your ACID project, this   help topic will show you how to use input busses 
to send a MIDI track   to a hardware synthesizer.

 1. Connect the MIDI Out port on your   MIDI interface to the MIDI In port on your synthesizer.
 2. Connect the audio output of your synthesizer   to an input on your sound card (for this example, we'll use Inst  1).
 3. Add   an input bus to your project. This input bus will receive the audio   signal from your synthesizer.
 4. Configure your input bus to take its   input from the synthesizer and send its output to your main mix:

 a. In the I/O control region of the input   bus's channel   strip, click the Input  Source button, and choose the 
sound card input that is connected   to your synthesizer's output (Inst  1 for this example.

 b. Click the Output   button and choose the output where you want to send your synthesizer's   signal. We’ll 
send this signal to the master bus so it is included with   your main mix and will be included when 
performing a real-time   render.

This input bus provides a signal path from your   synthesizer's audio output to your project.

 5. Send a MIDI track to the synthesizer:

 Click the MIDI Output   button on the track header and choose the MIDI port where you connected   your 
synthesizer in step 1.

The MIDI Output on the track header lets you   send 
the track's MIDI to your synthesizer.

 6. Click Play  . 

 When you play your project, the track is sent to your synthesizer,   out of the synthesizer into the input bus, and 
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out to the master bus.
 7. When you're ready to render your project,   you can use real-time rendering   to include the output from your 

synthesizer with your project.

Monitoring an External Source without Mixing it with Your Project
You may not want every signal that goes through the Mixing Console to   be mixed with your project. For example, 
you could set up a cue (talkback)   microphone to communicate between the control room and recording booth.
This help topic will show you how to use an input bus to set up a cue   microphone.

 1. Add   an input bus to your project.
 2. Connect a microphone to an input on   your sound card (for this example, we'll use Mic/Inst  1). 
 3. In the recording booth, connect a   pair of powered speakers or a headphone amplifier to an output on your   

sound card (for this example, we'll use LineOut  3L/LineOut 4R).
 4. Set up your input bus:

 a. In the I/O control region of the input   bus channel strip, click the Input  Source button and choose the 
sound card input where your cue microphone   is connected:

 b. Click the Output  button and choose the sound card output where your speaker or headphone   amplifier is 
connected:

When you speak into the cue microphone, its output is sent   to the recording booth without being mixed into your 
project output.

Using Input Busses
You can use input busses to input, process, record, and mix external   audio sources with your ACID project. 
Following are some examples of how   you can use input busses in your projects: 

 l Use an input   bus as a recording input, allowing you to apply effects and record a wet   signal.
 l Use an input   bus as a mixer input for an external device, such as a synthesizer.
 l Use an input   bus as a return for hardware-based effects.
 l Use an input   bus to monitor a source such as a talkback microphone.

Adding or Deleting Input Busses
From the Insert menu, choose Input Bus (or click the Insert Input Bus button   in the Mixing Console window) to 

add an input bus to your project.
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You can add up to 26 input busses, and you can change the number   of busses at any time.

Add a bus             

From the Insert menu, choose Input  Bus to add an input bus to your project.
If the Mixing   Console Window is visible, click the  Insert Input Bus button .

Rename a bus             

To rename a bus, double-click the label at the bottom of   the channel strip and type a new name in the box (or press 
F2 to rename   the selected bus). The channel strip in the Mixing Console is updated   when you press Enter:

Delete all characters   in a custom bus name to reset a custom bus name to its default.

Delete a bus

Right-click an input bus channel strip and choose Delete from the shortcut   menu, or select an input bus channel 
strip in the Mixing Console window   and press the Delete key.

Recording Using an Input Bus
When you use an input bus to record audio, you can include input bus   effects with the recorded signal. For example, 
imagine that you need to record an electric guitar with   an amplifier-modeling plug-in. 
Scenario 1: Plug   your guitar into your sound card's instrument input and choose that input   as your recording input: 

In this scenario, you could then add your amplifier-modeling plug-in   as a track effect and record with input 
monitoring on. Your guitar would   be recorded directly (without the plug-in), and the plug-in would be processed   
each time you play or render your project. This method allows you to adjust   the plug-in settings as you work on your 
project. 
Scenario 2: Set up   an input bus that uses your amplifier-modeling plug-in as an insert effect,   and choose that input 
bus as your recording input: 
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In this scenario, your amplifier-modeling plug-in is cooked into the   recorded signal. This method allows you to 
record your processed signal   but doesn't allow you to change your amplifier settings without re-recording   the guitar 
part. 

 1. Add   an input bus to your project.
 2. Set up your input bus:

 a. Click the Add  New Insert FX button  in the Insert FX control region of the input bus 

channel   strip to add plug-ins to your input bus. 
 b. In the I/O control region of the input   bus channel strip, click the Input  Source button and choose the 

sound card input you want to record:

 c. Click the Output   button in the I/O control region of the input bus channel strip and choose   Off. The bus 
output   is left off so we can monitor the input through the track.

 3. Set your track to record from   your input bus:
 a. Click the Record Input button, choose Input  Busses from the menu, and choose your input bus.

 b. Click the Record Input button and choose Input Monitor Mode: On or Input  Monitor Mode: Auto so you 
can hear your input signal during recording.
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 l When Auto   is selected, you will hear the input monitor signal when playback   is stopped and 
during recording. If you're recording into selected events,   you'll hear the input monitor signal only 
when the cursor passes over   the selected events. 

 l When On  is selected, the behavior is similar to Auto   mode, but you will always hear the input 
monitor during recording — monitoring   is not toggled on and off when recording into a selected event.
Your ability to monitor effects in real time is dependent   on your computer's performance. Effect   
automation envelopes are bypassed during record monitoring.

 4. Position the cursor where   you want to start recording.
 5. Select the Arm  for Record buttons  on the track where you want to record. Arming   a track enables it for 

recording.

 When a track is armed, the track meter displays the track's level.   If input monitoring is not on, the meter 
displays the level of your input   source. If input monitoring is turned on, the meter shows the level of   the input 
source plus the track effects chain.

 6. Click the Record   button  on the Transport bar to start recording.

 7. To stop recording, click the Record button again or click the Stop   button  on the Transport   bar. The 

Recorded Files dialog is displayed.
 8. Use the Recorded Files dialog to confirm   the file name and location of your recorded audio. Click Delete or 

Delete All   if you do not want to save the recorded files, or click Rename   to change the file's name.

 9. Click Done   to close the Recorded Files dialog. Your recorded file is displayed as   a new event in the timeline.

Real-Time Rendering
From the File menu, choose Real-Time  Render to render your project in real time.
Real-time rendering is a playback mode that renders your project to   .wav  format. Real-time rendering allows you to 
include the output   from an external input source such   as a hardware   synth or effects processor   with your project. 
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Notes:

 l When you   start real-time rendering, any track that is armed for recording   will be unarmed. You cannot arm a 
track for recording or start recording   in real-time rendering mode.

 l When rendering   a project that does not use external audio hardware, real-time rendering   and normal rendering 
will produce the same   output. Real-time rendering will take longer to complete, allowing you   to monitor the 
rendered file as it is created.

 l If metronome   count in is enabled, it will be turned off before real-time rendering   begins. If the metronome is 
enabled for playback, it will not be included   in the rendered output.

 1. From the File menu, choose Real-Time  Render.
 2. Choose a drive and folder from the Save  in drop-down list, or use the browse window to locate the folder   where 

you want to save your file.

When using real-time rendering, render your project to a local   hard drive. Rendering to a network folder or 
removable drive can result   in gapping.

 3. Type a name in the File  name box, or select a file in the browse window to replace an existing   file.
 4. Click Save   to start rendering your project from the beginning of the timeline.

Using Assignable Effects
Use assignable effects chains when you want to route multiple tracks   to a chain of DirectX or VST plug-ins while 
setting the effects send level   for each track independently.
To see the audio signal flow, see "Signal Flow Diagrams" on page 310.

When   input monitoring is on during audio recording,   audio effects chains that contain non-in-place plug-ins 
are displayed   in yellow ( ) to indicate that automatic plug-in delay compensation is being   used. Chains that 

cannot be used for live monitoring are automatically   bypassed and are displayed in red ( ).

When using ACID software as a ReWire   device, any effects chain that includes non-in-place plug-ins is 
automatically   bypassed to prevent synchronization problems with the ReWire mixer application.   The effects 
chain icon is displayed in red ( ). Apply the plug-ins within the ReWire mixer   application.

Adding an Assignable Effects Chain
From the Insert menu, choose Assignable FX (or click the Insert  Assignable FX button   in the Mixing Console 

window) to create an effects chain to which you   can route tracks in   your project.

You can add up to 32 assignable effects chains, and you can change   the number of chains at any time. Each 
chain can have up to 32 plug-ins.    

When   input monitoring is on during audio recording,   audio effects chains that contain non-in-place plug-ins 
are displayed   in yellow ( ) to indicate that automatic plug-in delay compensation is being   used. Chains that 

cannot be used for live monitoring are automatically   bypassed and are displayed in red ( ).

When using ACID software as a ReWire   device, any effects chain that includes non-in-place plug-ins is 
automatically   bypassed to prevent synchronization problems with the ReWire mixer application.   The effects 
chain icon is displayed in red ( ). Apply the plug-ins within the ReWire mixer   application.

Create an assignable   effects chain             

 1. From the Insert menu, choose   Assignable FX.   The FX Plug-In Chooser window appears.
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 2. Select each plug-in you   want to add and click the Add   button or browse to a packaged effects chain. The plug-
ins appear at the   top of the window in the order you added them.

To reorder the plug-ins   within the chain, drag a plug-in button to a new location or click the   Shift Plug-In 
Left  or Shift  Plug in Right    buttons.

 3. Once you have added   plug-ins and set the chain order, click the OK   button. The new assignable effects chain is 
added to the Mixing Console   window, and the Audio Plug-In window appears.

 4. Adjust the settings for   the effects. For more information about using specific plug-ins, click   the Plug-In Help   
button .

Edit an assignable effects chain             

 1. Click the Assignable  FX button    on an bus track to open the Audio Plug-In   window.

 2. Use the Audio   Plug-In window to enable/bypass effects, edit effect parameters, and   add/remove effects from a 
chain. For more information about using specific   plug-ins, click the Plug-In  Help button .

For more information about using the Insert FX control region   in the Mixing Console to edit the effects chain, please 
see Assignable   Effects Strips.

Automate effect parameters

If a plug-in supports automation, you can add envelopes   to an assignable effect chain's bus track   to automatically 
adjust effect parameters over time.
For more information about using   automation envelopes on tracks, see "Adding Audio Track Envelopes" on 
page 134.   

Delete an assignable effects chain

Right-click an assignable effects channel strip in the Mixing   Console window and choose Delete   from the shortcut 
menu, or select an assignable effects channel strip   and press the Delete key.

Routing Tracks to an Assignable Effects Chain
Routing tracks to an assignable effects chain allows you to assign multiple   tracks to a plug-in chain.

In   order to route tracks to an assignable effects chain, you must first add an assignable effects   chain to your 
project.

 1. Click the label on the multipurpose slider label and choose the   desired assignable effects chain from the 
submenu. The label changes to   reflect the name of the assignable effects.

If you can't see the   multipurpose slider, drag the bottom edge of the track header to increase   its height.
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 2. Drag the fader to adjust the level of the track sent to the assignable   effects chain.
If you set the Dry  Out faders in your effects chain to -inf, you can adjust the wet/dry   balance using the Volume 
and FX settings   on the multipurpose slider: Volume  will adjust the dry signal and FX  will control the effect 
signals.

You can also use the Sends control region in the Mixing   console window to configure bus sends. For more 
information, please see   Audio Track   Channel Strips.

Tips:         

 l FX sends are post-volume by default.   To change to pre-volume, right-click the fader handle and choose Pre 
Volume from the shortcut menu.

 l If you want to apply track panning   (including pan position and panning mode) to FX sends, right-click the   FX 
fader and choose Link to Main Track Pan from the shortcut menu. 

 When Link to Main  Track Pan is not selected, the track sends a center-panned stereo   signal using the track's 
current panning mode. 

 l Select the Use  legacy track send gain check box on the Audio   page of the Preferences dialog  if you want to 
configure   audio track sends to behave as they did in ACID 6.0 and earlier. When   the check box is selected, you 
can open projects created with earlier   versions of ACID and be assured they will sound the same as they did in   
earlier versions of ACID.

Using Assignable Effects Envelopes
Adding assignable effects envelopes to a track allows you to change   the level of a track sent to assignable effects 
chains over time. Each   track can contain an envelope for each assignable   effects chain that exists in your project.
For more information about adding and adjusting envelopes, see "Adding Audio Track Envelopes" on page 134. 

Audio Panning Modes
When you pan stereo audio tracks,   5.1 surround tracks, or busses,   you can right-click the fader handle (or surround 
panner) and choose a   pan type to change the panning model.

If you want to set the default pan type for new tracks, set a   track's pan type, and then use the Set   Default Track 
Properties dialog to set that track's pan type as the   default.

The selected panning mode is also used for track-level   pan envelopes.

Mode Description

Add  
Channels

This mode is most useful for panning   stereo files. As you pan across the stereo field, the stereo image 
appears   to move across the speakers. As you pan toward either side, the signal   from the opposite 
channel is added to the channel you are panning toward   until at the extreme both channels are sent to 
a single channel at full   volume.                     
This mode uses a linear panning curve.                     

You can introduce   clipping when channels are added. Monitor the meters in the track headers   or 
Mixing Console Window and adjust   the track volume accordingly.

Balance                         
(0 dB 
center)
 Balance
(-3 dB 
center)
Balance
(-6 dB 

In a stereo project, this mode can help you   adjust the relative signal levels of the channels in stereo 
source material.   As you pan from the center to either side, the opposite channel begins   at the specified 
center value (0 dB -3 dB, or -6 dB), and decays to -infinity.   The signal in the side you are panning 
toward progresses from the specified   center value (0 dB -3 dB, or -6 dB)to   0 dB. 
This   panning mode uses a linear panning curve.                     
For example, when you pan fully right, the right   channel is played at 0 dB and the left channel is not 
audible. As you   pan to the center, each channel is attenuated to the specified center   value (0 dB -3 dB, 
or -6 dB). As you pan to the left, the left channel   is played at 0 dB, and the right channel is not audible.
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center) With the Balance  (0 dB center) setting, no gain or cut is applied 
when you're panned   to the center, which can make the center seem 
louder.

With the Balance  (-3 dB center) setting, a -3 dB cut is applied 
when you're panned   to the center.

With the Balance  (-6 dB center) setting, a -6 dB cut is applied 
when you're panned   to the center.

Panning in a 5.1 surround project follows the   same rules: as you pan from the center to any channel in 
a 5.1 surround   project, the signal in the channel you are panning toward progresses from   the specified 
center value to 0 dB. The signal in the channel you are   panning away from begins at the specified 
center value and decays to -infinity.

Constant  
Power

This mode is most useful for panning monaural   source material. In this mode, sound will maintain its 
volume when you   pan across channels.
If you pan a stereo file 100% R, only the right channel of your   media file is played, and this channel is 
sent to both output channels.   If you continue to pan to the left, the left channel is gradually added   to 
the output, and the right channel is gradually faded out until only   the left channel will be heard through 
both output channels when the slider   is at 100% L.

If you pan a file fully right   midway between the front and rear channels in a 5.1 surround project,   only 
the right channel of your media file is played, and this channel   is sent to the right-front and -rear 
output channels. If you pan to the   left, the left channel is gradually added to the output, and the right   
channel is gradually faded out until only the left channel is sent to   the left-front and -rear output 
channels.

Film This mode allows you to pan between pairs of   adjacent speakers in 5.1   surround projects using a 
constant power model. This mode is optimized   for theater-style speaker placement. In stereo projects, 
Film mode functions   identically to Constant Power.
As you drag the pan point to the center speaker,   the sound becomes diffused through the front and 
rear speakers. When the   track is panned fully to the center speaker, there is no output from the   front 
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and rear speakers.
Dragging the pan point to the center of the   surround panner sends the signal to all speakers.

If you're panning fully to a single speaker,   you may notice that some signal is mixed to the 
opposite speaker. This   is because the ideal placement for surround speakers does not match the   
representation in the surround panner. For example, panning to the front-left   speaker produces a 
low-level signal in the rear-left speaker. 

This is because your front-left speaker should be positioned 30° left of   center and the speaker in 
the surround panner is located 45° left of center.   To produce a true 45° left-of-center pan, the 
signal is panned between   the front- and rear-left speaker. 
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5.1 Surround Projects
Create a 5.1-channel mix to wrap a listener in your remixes or prepare   audio for DVD-Video or 5.1-channel music 
projects.
5.1 surround is a standard audio format consisting of five full-range   channels and a low-frequency effects (LFE) 
channel.The five full-range channels are reproduced by left, right, and center   speakers positioned in front of the 
listener and left and right surround   speakers positioned behind the listener. The LFE channel can be routed   to the 
main speakers or to a subwoofer that can be positioned almost anywhere.
The center channel is typically used to lock dialogue or sounds to a   video screen. The LFE channel is generally routed 
to a subwoofer to enhance   low audio frequencies for effects such as explosions or crashes. Audio   in this channel is 
limited to a range of approximately 25 Hz to 120 Hz.

ACID   software plays, mixes, and renders 5.1-channel audio. Authoring software   such as DVD Architect 
software is required to burn the audio   to DVD.

5.1 Surround Setup
Use the Project Properties dialog to set up your project for 5.1 surround.
To preview a 5.1 surround project, you'll need the following hardware:

 l An audio   interface capable of six-channel output (either a 5.1-compatible   sound card, a sound card with six   
outputs, or three stereo sound cards).

 l Six powered   speakers or six passive speakers with a six-channel amplifier.

Set your project to   5.1 surround mode

 1. From the File menu, choose   Properties.
 2. Select the Audio tab.
 3. From the Master bus mode drop-down list, choose 5.1  Surround.
 4. Select the Enable  low-pass filter on LFE check box if you want to apply a low-pass filter   to each track that is 

assigned   to the LFE channel. Choose a setting from the Cutoff  frequency for low-pass filter  drop-down   list or 
type a value in the box to set the frequency above which audio   will be ignored by the LFE channel. 
Applying   a low-pass filter approximates the bass-management system in a 5.1 decoder   and ensures that you're 
sending only low-frequency audio to the LFE channel.                     

 5. Click OK.
The track headers and mixer switch to   5.1 surround mode.

Route the ACID mixer   outputs
When you're working in 5.1 surround mode, you'll need to   indicate where to send the output from your 5.1-channel 
mix.

Setting your default routing

Use the Audio   Device tab of the Preferences dialog to set default routing for 5.1   surround projects.
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 1. From the Options menu,   choose Preferences.   The Preferences dialog is displayed.
 2. Select the Audio Device tab.

 3. Choose a device from the   Audio device type   drop-down list. Choosing a device type other than Microsoft 
Sound Mapper or Direct Sound Surround Mapper will allow you to choose specific devices   for playback of 
each of the three stereo pairs.

Please refer to your sound card's documentation   to determine the type of driver you need to use for 
surround output.

 4. From the Default Stereo and Front playback device drop-down list, choose the device where your front   
speakers are connected.

 5. From the Default Rear playback device drop-down list, choose the device where your   rear speakers are 
connected.

 6. From the Default Center and LFE playback device drop-down list, choose the device   where your center speaker 
and subwoofer are connected.

Overriding default device routing

If you've selected a setting   other Microsoft Sound Mapper or Direct Sound Surround Mapper from the Audio  
device type drop-down list, you can override the default device   routing at any time.

Please refer to your   sound card's documentation to determine the type of driver you need to   use for surround 
output.

 1. Open the Mixing Console window.
 2. In the I/O control region, click the   Output button   and choose an output device for the Front channels.

 3. Repeat step 2 for the Rear   and Center/LFE channel pairs.

Connect your amplifier   and speakers             
Using a 5.1-compatible sound card

 l Connect powered speakers to your sound   card's outputs as indicated by your sound card's documentation.

or——
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 l Connect your sound card's front, rear,   and center/subwoofer outputs to the appropriate inputs on a 6-channel   
amplifier/home theater receiver. Connect front, rear, center, and LFE   speakers to the amplifier.

Using a sound card with six outputs

 l Connect powered speakers to your sound   card's outputs. The left channel of the Center/LFE pair is the center   
channel; the right channel is the LFE channel.

or——

 l Connect your sound card's outputs   to the appropriate inputs on a 6-channel amplifier/home theater receiver.   
Connect front, rear, center, and LFE speakers to the amplifier.

The audio cables you'll   need will depend on your specific hardware.

Using three stereo sound cards

 l Connect powered speakers to your sound   cards' outputs where you have routed each of the pairs of channels. 
The   left channel of the Center/LFE pair is the center channel; the right channel   is the LFE channel.

or——

 l Connect your sound cards' outputs   to the appropriate inputs on a 6-channel amplifier/home theater receiver.   
Connect front, rear, center, and LFE speakers to the amplifier.

Multiple sound card   setups may not work with ASIO drivers. You can only use a single ASIO   driver at a time, 
and some ASIO drivers can conflict with other audio   driver models (such as WDM and wave drivers).

The audio cables you'll   need will depend on your specific hardware. For a typical application,   you'll need three 
cables: each will have a 3.5 mm stereo plug on one end   and dual RCA connectors on the other. 

5.1 Surround Panning and Mixing
After you've set up your project   for 5.1 surround mixing, the track headers and mixer switch to 5.1 surround   mode, 
and you're ready to start panning.
From the View menu, choose Surround  Panner to toggle the display of the Surround Panner window. Use   the 
Surround Panner window to pan tracks, busses, assignable effects chains,   and soft synths.

Only   the Surround Master bus accepts 5.1 channel inputs. If you assign   a track to another bus, a stereo output is 
sent to the bus, and you can   perform surround panning at the bus level.

When you apply effects to a 5.1 surround project, you can use   distinct plug-in settings for each channel 
(separate EQ settings for the   front and surround speakers, for example) using effect   automation. Add multiple 
instances of the plug-in to the track   effects chain and select the Enable   check boxes in the FX Automation 
Chooser for the channels you want each   instance of the plug-in to affect.

Surround   panning is not available for tracks or busses that are routed   to a hardware output.

Mute or solo channels             
Muting a channel ensures that no audio will be played through   that channel. For example, you could mute the center 
channel if you want   to produce a stereo image at the center listening position, or you might   want to solo the center 
channel when you're working with dialogue.
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 1.  Double-click the surround   panner  on the track   or bus you want to pan. The Surround Panner window is 

displayed.
 2. Click the speaker icons   to mute or include channels.

Hold Ctrl while clicking   a speaker icon to solo the channel.

Adjust volume and send levels
Adjusting track volume

You can adjust track volume using   the Vol fader   in the track header the same way you do in stereo projects. The 
fader   in the track header can function as a trim control that adjusts the overall   volume of the track, or it can adjust 
track volume automation settings.   
The trim level is added to the   volume automation settings so   your envelope is preserved, but with a boost or cut 
applied. For example,   setting the trim control to -3 dB has the same effect as decreasing every   envelope point by 3 
dB.
Deselect the Automation  Settings button  in the track header if you want to adjust trim levels,   or select the button 

if you want to adjust volume automation.

Adjusting assignable effects send or bus send levels

You can adjust send levels for   busses or assignable effects chains using the multipurpose fader in the   track header 
the same way you do in stereo projects. Click the fader label   and choose an assignable effects chain or bus from the 
menu. The fader   in the track header can function as a trim control that adjusts the overall   send level of the track, or it 
can adjust send level automation settings.   
Deselect the Automation  Settings button  in the track header if you want to adjust trim levels,   or select the button 

if you want to adjust volume automation. 

Adjusting channel levels

Use the Surround Master bus control   in the Mixing Console window to adjust the individual levels of the 5.1   
channels. The faders in the track bus control can function as trim controls   that adjust the overall level of each 
channel, or you can automate the   master volume of the Surround Master bus (individual channel levels cannot   be 
automated). 
Click the Automation  Settings button  in the bus control or bus track and verify Show  Automation Controls is 

not selected if you want to adjust trim   levels, or select Show  Automation Controls if you want to adjust volume 
automation.

Adjust the center channel volume             
Adjusting the volume of the center channel can help emphasize   dialogue or balance the mix. You can adjust the 
center channel volume   trim level or automation settings.
The trim level is added to surround panning keyframes so   your keyframe settings are preserved, but with a boost or 
cut applied.   For example, setting the trim control to -3 dB has the same effect as   decreasing the center channel level 
by 3 dB in every keyframe.
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Adjusting the center channel trim level

 1. Deselect the Automation  Settings button  in the track header to adjust trim levels.

 2. Double-click the surround   panner  on the track   or bus you want to pan. The Surround Panner window is 

displayed.
 3. Drag the Center   fader to boost or attenuate the volume of the center channel. When the   fader is set to 0.0 dB, 

no gain is applied.

Automating the center channel level with keyframes

 1. Select the Automation  Settings button  in the track header to adjust automation levels.

 2. Double-click the surround   panner  on the track   or bus you want to pan. The Surround Panner window is 

displayed.
 3. Select a keyframe to adjust   its center channel level or click to position the cursor where you want   to create a new 

keyframe.
 4. Drag the Center   fader to boost or attenuate the volume of the center channel. When the   fader is set to 0.0 dB, 

no gain is applied. The fader thumb is displayed   as a  in automation mode.

Pan a track or bus             
You can perform surround panning in two ways:

 l Pan tracks individually using the   Surround Panner window (or the mini surround panner in the track header).
 l Route   tracks to mixer controls (busses, assignable effect chains, or soft synths)   and pan the mixer controls 

using the Surround Panner window for the appropriate   bus track. From the View menu, choose Show  Bus 
Tracks to display bus tracks at the bottom of the track view.

 When a track is routed to a bus other than the surround master, you   can use the Pan   slider on the track header 
to adjust the stereo track's contribution to   the surround panner on the bus.

The surround panner can function as a trim control that   adjusts the overall panning of the track, or it can adjust track 
panning   automation settings. Select the Automation  Settings button    in the track or bus to adjust surround 

panning keyframes, or deselect   the button to adjust trim levels.
The trim level is added to the pan automation settings so   your keyframes are preserved, but with a boost or cut 
applied. For example,   setting the trim control to -9% left has the same effect as moving every   keyframe 9% to the 
left.

Panning controls can adjust automation (dynamic) settings,   or they can function as trim (nonautomated) 
controls. If your automation   is not behaving as expected, you may have applied a trim value that is   offsetting 
your automation settings.

When the surround panner is set to adjust trim levels, it is displayed   as a . When it   is set to adjust 

automation levels, it is displayed as a .
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Adjusting panning trim levels

 1. Deselect the Automation  Settings button    in the track header to adjust trim levels.

 2. Double-click the surround panner    on the track or bus to display the Surround Panner   window:

 3. Drag the pan point in the   Surround Panner window to position the sound within the sound field. Shading   is 
drawn to indicate the output from each channel.

 4. Double-click the pan point to reset   it to the front-center listening position.
 5. Double-click in the Surround Panner   window to move the pan point to the point you click.
 6. To constrain the motion of the pan   point, click the    button to toggle through Move  freely ,   Move 

left/right only  and Move  front/back only    modes.

You can also use the track surround panner in the track   header to pan your track. Keyboard and mouse shortcuts 
can help you position   the pan point quickly and accurately. For more information, see "Keyboard Shortcuts" on 
page 300.

Automate panning with keyframes

You can automate panning by adding   keyframes. Keyframes are similar to envelope points in that they mark   specific 
locations in the track where settings change. However, unlike   envelope points, keyframes are displayed below a 
track:
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Notes:

 l Use bus   tracks to add panning keyframes to busses. From the View menu, choose   Show Bus Tracks   to display 
bus tracks at the bottom of the track view.

 l Center-channel gain cannot be automated.
 l Muting and soloing channels cannot   be automated.

 1. Select the track (or bus track)   you want to pan.
 2. Select the Automation  Settings button    in the track or bus to adjust surround panning keyframes.

 3. From the Insert menu, choose Envelopes, and then   choose Surround Pan  Keyframes from the submenu. An 
additional row appears below the   track with a single keyframe positioned at the beginning of the project.   This 
keyframe represents the current panning settings for the track.

To hide panning keyframes without removing them from   your project, choose Show  Envelopes from the 
View menu, and then choose Surround  Pan Keyframes from the submenu.

 4. Click to position the cursor   where you want to begin panning the track.
 5. Pan your track:

 a. Double-click the surround   panner  on the track or bus to display the Surround Panner   window:

 b. Drag the pan point in the Surround   Panner window to position the sound within the sound field. Shading is   
drawn to indicate the output from each channel, and a keyframe is added   below the track.

 l Double-click   the pan point to reset it to the front-center listening position.
 l Double-click   in the Surround Panner window to move the pan point to the point you click.
 l To constrain   the motion of the pan point, click the  button to toggle through Move  freely ,   Move 

left/right only  and Move  front/back only    modes.

You can also use the surround panner in the track header   to pan your track. Keyboard and mouse shortcuts 
can help you position   the pan point quickly and accurately. For more information, please see   "Keyboard 
Shortcuts" on page 300.

 6. Repeat steps 4 and 5 to add as many panning   keyframes as necessary. The Surround Panner window draws the 
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panning path:

 7. If you have two or more keyframes, you   can drag the Smoothness   slider to adjust the interpolation curve 
between them. Adjusting the curve   affects perceived motion of sound within the sound field: a setting of   0 
produces linear motion from one keyframe to the next. Increasing the   setting produces a curved path.
If you want to adjust temporal interpolation    how the pan occurs   over time  right-click   a keyframe and choose a 
new keyframe type from the shortcut menu.——

Adjust panning keyframes             
If you automated panning for a track or bus, a keyframe   is displayed in the timeline (directly below the track) for each 
pan setting.   You can move, copy, and change fade types from the timeline.

Panning controls can adjust automation (dynamic)   settings, or they can function as trim (nonautomated) 
controls. If your   automation is not behaving as expected, you may have applied a trim value   that is offsetting 
your automation settings.

When the surround panner is set to adjust trim levels, it is displayed   as a . When it is set to adjust 

automation levels, it is displayed   as a .

Editing a keyframe

 1. Double-click a keyframe   to open the Surround Panner window.
 2. Drag the pan point to position   the sound within the sound field.
 3. Adjust the Smoothness   slider as necessary to adjust the curve between keyframes.

You can also edit   a keyframe by selecting the keyframe and dragging the pan point in the   track or bus surround 
panner.

Adding keyframes

Double-click in the keyframe   bar to add a keyframe to the track view. The new keyframe will use the   same settings 
and interpolation curve as the previous keyframe.

Deleting keyframes

Right-click a keyframe and   choose Delete   from the shortcut menu.

Moving keyframes

Drag the keyframe to a new   position on the timeline.

Copy keyframes

Hold Ctrl while dragging a   keyframe to copy it.
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Change the fade curve between keyframes

If you want to adjust temporal   interpolation  how   the pan occurs over time    right-click a keyframe and choose a new 
keyframe type from the shortcut   menu.——
If you want to adjust the perceived   motion of sound within the sound field, drag the Smoothness  slider to adjust the 
interpolation curve between keyframes. a Smoothness   setting of 0 simulates linear motion from one keyframe to the 
next. Increasing   the setting produces a curved path.

Command Description Looks Like

Hold No interpolation   will take place. The keyframe's settings will be maintained until the   
next keyframe.                         

Linear Panning is   interpolated in a linear path.                         

Fast Panning is   interpolated in a fast logarithmic path.                         

Slow Panning is   interpolated in a slow logarithmic path.                         

Smooth Panning is   interpolated along a smooth, natural curve.                         

Routing audio to the low-frequency effects   (LFE) channel             
Perform either of the following actions to send audio to   the low-frequency effects (LFE) channel:

 l Click the LFE  Only button  in the Surround Panner window to toggle between surround   and LFE mode.

or——             

 l Right-click the surround   panner  on the track   or mixer control and choose LFE  Only from the shortcut menu.

To return to normal surround panning, click the  button in the Surround   Panner window again or right-click the 

surround panner and choose Surround Pan from   the shortcut menu.
Select   the Enable low-pass  filter on LFE check   box on the Audio tab of the Project Properties   dialog if you want 
to apply a low-pass filter to each track or bus that   is assigned to the LFE channel. Enter a frequency in the Cutoff 
frequency  for low-pass filter box   to set the frequency above which audio will be ignored by the LFE channel,   
and choose a setting from the Low-pass  filter quality drop-down list to determine the sharpness of filter's   
rolloff curve. Best   produces the sharpest curve.

Applying a low-pass filter   approximates the bass-management system in a 5.1 decoder and ensures that   you're 
sending only low-frequency audio to the LFE channel.

Before rendering   your surround project, check your surround authoring application's documentation   to 
determine its required audio format. Some encoders require a specific   low-pass filter cutoff frequency and 
rolloff, or your encoder may require   that no filter be applied before encoding.             

Change the pan mode             
Right-click within the Surround Panner window (or right-click   a surround panner    on a track or bus), choose Pan  

Type from the shortcut menu, and then choose a pan type from the   submenu. For more information about panning 
modes, please see "Audio Panning Modes" on page 181.

The selected panning   mode is also used for surround panning keyframes.
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Use the grid to monitor panning
The grid in the Surround Panner window provides a visual   indication of how your panning will sound. The grid 
spacing changes to   match the current panning mode.
The vertical lines represent the points where the left-to-right   signal ratio is 6 dB, 0 dB, and -6 dB respectively: at the 
far-left line,   the left channel is 6.0 dB louder than the right channel.
The horizontal lines represent the points where the front-to-rear   signal ratio is 6 dB, 0 dB, and -6 dB respectively. As 
you adjust the   Center fader,   the lines will move forward or back to compensate for the center-channel   gain.

The grid assumes that   you're using a correctly set-up surround system (matched speakers and   ideal 
positioning). Variations in your monitoring system will cause inconsistencies   between the graph and perceived 
output. 

Rendering Your 5.1 Channel Mix
Rendering a surround project creates six mono files (AIFF, WAV) or a single 5.1-channel file (AC-3, WMA, and 
WMV) that your authoring   application can use to create DVD-Video or 5.1-channel music projects.

Before rendering   your surround project, check your surround authoring application's documentation   to 
determine its required audio format. Some encoders require a specific   low-pass filter cutoff frequency and 
rolloff, and your encoder may require   that no filter be applied before encoding. Use the Audio tab of   the Project 
Properties dialog to   configure a low-pass filter.

 1. From the File menu, choose Render  As to display the Render As   dialog.
 2. Choose a drive and folder from the Save  in drop-down list, or use the browse window to locate the folder   where 

you want to save your file.
 3. Type a name in the File  name box. A separate file will be created for each channel using   this name as a base.

For example, if you type My Project in the File name   box and render your project using wave files, the following 
files would   be created: My Project Left.wav,   My Project Right.wav, My Project Center.wav,   My Project LFE.wav, 
My Project Left Surround.wav,   and My Project Right Surround.wav.

 4. Choose a file type from the Save  as type drop-down list. If you have the Sony AC-3 Encoder, you   can choose 
AC-3   from the list.

 5. Choose 44,100  Hz, 16 Bit, Mono, PCM from the Template drop-down list if you want to render six mono files, 
or choose   an appropriate 5.1-channel template if the selected file type supports   it.

 6. Select the Render  loop region only check box if you want to save only the portion   of the project that is 
contained within the Loop   Region. Loop Playback  does not need to be selected for this option to work.

 7. If the selected file type supports it, you can   select the Save project  markers with media file check box to 
include markers,   regions, and time markers   in the rendered media file. If the information cannot be saved to your   
media file, an .sfl file will be created (using the same base name as   your media file).

 8. Click the Save   button. A dialog is displayed to show rendering progress.
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Working with Video
You can add a single video track to your ACID project to use the ACID   timeline as a scoring tool.

The Video Track
Video will always be added to the top track in the track list. Depending   on your horizontal zoom level, each frame 
displayed in the video track   may represent multiple frames from the source video. As you zoom   in, marks will be 
displayed to represent each frame, and you can zoom   further to view individual frames.

You   can also add a still image (.bmp, .jpg,  or  .png format)   to the video track.

Add or replace a video   file             
Use the Explorer window to find   the file you want to use, and then add it to the timeline by double-clicking   it or 
dragging it into the timeline. The video will be placed in the top   track, and if the file has an audio track, the audio will 
be placed as   a one-shot in the timeline.
If your project already contains a video track, you will   be prompted to replace the existing video if you open another 
video file.

Show or hide the video track
From the View menu, choose Show  Video Track to toggle the display of the video track in your ACID   project.
Turning the command off does not remove the video track   from your project.

Right-click the video track and choose Hide  Video Track from the shortcut menu.

Remove the video track             
Right-click anywhere in the video track and choose Remove Video from   the shortcut menu. The video track is 
deleted, but the audio is preserved.

Remove the video's   audio             
Right-click the audio track in the track list and choose   Delete Track   from the shortcut menu. The audio track is 
deleted, but the video is preserved.

Move or trim video             
If you want to maintain the video event's length but change   when it plays within your project, drag the event to a 
new location on   the timeline.
If you want to change the length of the event or change   its starting and ending points, drag either end of the event. 
For more   information about trimming events, see "Adjusting an Event's Length" on page 99.   

Change frame numbering             
You can display frame numbers in the event for each frame   in the video track.
To change the numbering format (or turn off frame numbering),   select the Video tab in the Preferences   dialog and 
choose a setting from the Show  source frame numbers on event thumbnails as drop-down list.
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Synchronizing Audio and Video
As you add multiple audio tracks to your project, you'll need to make   sure the audio and video are synchronized.

Score a video             
You can use tempo changes to ensure that your video remains   synchronized with audio tracks throughout your 
project. For example, you   might want scene changes or other key scenes to be aligned with specific   beats on the beat 
ruler.

 1. Add your audio tracks and   video.
 2. Mark a point in the video   where you want to synchronize audio:

 a. From the View menu, choose   Video Preview   to display the Video Preview window.
 b. Click the Play   button  to start   playback.

 c. Press H to place a time   marker at the frame you want to emphasize (a scene change, for example).
Press Alt+ right or left arrow to step through your   video when playback is paused or stopped. When you 
find the frame you   want to emphasize, you can drag the time marker to the cursor position.   Press F8 to 
enable snapping and press Ctrl F8 to turn off Grid  Only;   and the marker will snap to the cursor position.

 3. Mark the point to   which you want to synchronize your time marker:
 a. From the Options menu, choose   Snapping, and  then choose Enable   from the submenu.
 b. Press M to place a marker   on the beat ruler. For example, you might want the frame that you marked   in step 

2c to coincide with a downbeat.
 c. Select the marker on the beat ruler.
 d. Right-click the time marker and choose   Adjust Tempo to Match  Marker to Cursor from the shortcut 

menu.
 e. Press T to insert a tempo   change marker. The adjusted tempo and is detected and inserted in   the tempo 

marker's edit box. The tempo change marker will preserve synchronization   between the time marker and 
location on the Beat Ruler as you perform   further editing.

 4. Repeat steps 2 and   3 to synchronize the rest of your video.

Restore synchronization between audio and video   events
As you edit your project, you may lose synchronization between   your video track and the events on its audio track 
because of tempo changes   or event trimming.
To restore synchronization, right-click an event and choose   Synchronize with Video   from the shortcut menu.

This command will   not work if you change a video file's audio track type to a loop. 

The Video Preview Window
The Video Preview window displays a project’s video output at   the current cursor position in the timeline.
From the View menu, choose Video  Preview to toggle the display of the Video Preview window. Right-click   
anywhere in the window to display a shortcut menu with Video Preview window   options.

Item Name Description

Copy  Frame Copies the   current frame to the clipboard.                     

External  Monitor Sends your video output to the device specified   on the Video tab of the 
Preferences   dialog.
If you have not specified a device,   the Video tab will be displayed when you click 
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the External  Monitor button.                     
For more information   about using an external monitor, see "Using an External 
Video Monitor" below.                     

Shortcut 
Menu

Default  
Background

Sets the background   color of the Video window to the default color.                     

Black  
Background/White  
Background

Sets the background       color of the Video window to black or white.

Simulate  Device 
Aspect Ratio

Displays square pixels in the Video   window even if the current media file is using 
nonsquare pixels (DV).                     
This switch   will turn on/off square/nonsquare interpolation, allowing faster 
playback   and viewing flexibility when drawing video frames to the Video 
window.                     

Display  at Media 
Size

Displays the   Video window to match the size of the current media file.                     

Show  Toolbar Toggles the   display of the Video window toolbar.                     

Show  Status Bar Toggles the   display of the Video window Status Bar. The status bar displays 
information   about the video's frame size, frame rate, and current preview size.                     

Using an External Video Monitor
You can send video directly from the timeline to a television monitor.   With this feature, you can make your final 
editing decisions on a broadcast   monitor, which differs significantly from a computer monitor. To use an   external 
monitor, you must have the following:

 l OHCI-compliant   IEEE-1394 DV card
 l DV camcorder   or DV-to-analog converter

Set up an external   monitor             
The diagram below shows the preferred setup for sending   video from the ACID timeline to an external television 
monitor.

The video is converted to DV format and sent through the   IEEE-1394 card to the DV device (camcorder or DV-to-
analog media converter).   The DV device sends analog output to the television monitor.
Use the Video tab in   the Preferences dialog to configure your IEEE-1394 card.
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The DV device must   support pass through in order to use an external monitor.

Preview audio             
When you preview on an external monitor, no audio is sent   through the IEEE-1394 card. 
As shown in the illustration in the previous heading, audio   is sent to the sound card and then on to the mixer (if 
present) and speakers   so you can mix your audio on better speakers than are typically found   in television monitors.
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Using a Control Surface
A control surface is a hardware device that uses knobs, faders, and   buttons to control user interface elements that 
are normally controlled   with a mouse. Using a control surface lends a tactile feel to your editing   sessions.
Unlike keyboard shortcutswhich   determine the shortcut's behavior based on the portion of the ACID window   that 
has focusa control   surface's mapped functions work no matter what part of the application   has focus. ——
When your control surface is enabled, an indicator is displayed in the   track list and the Mixing Console to show 
which channels are under external   control. Multiple bars are displayed if a channel is under the control   of multiple 
devices.

In the track   list, vertical bars in tracks 1-4 
indicate that those tracks are under   

external control.

In the Mixing Console window, horizontal bars   at the top of channels 
1-4 indicate which channels are under external   control.

Connect your control surface
You can use one Mackie Control Universal (with up to four   Mackie Control Universal Extenders), one Frontier 
TranzPort, and up to   five generic control surfaces with ACID. 
If you’re using Mackie Control Extenders, you'll need a   multiport MIDI interface with MIDI In/Out ports for each 
device.
Perform the following steps for each device.

 1. Connect the MIDI Out port   on your MIDI interface to the MIDI In port on your control surface.
 2. Connect the MIDI In port on   your MIDI interface to the MIDI Out port on your control surface.
 3. If you're using Mackie Control   Extenders, repeat Steps 1 and 2 for each Mackie Control Extender.

If you're using a USB interface such as the   Frontier TranzPort, just plug in the USB cable.

Configure ACID to use your control surface
Use the MIDI tab in the   Preferences dialog to select the device to which your control surface   is connected. 

 1. From the Options menu, choose   Preferences to   display the Preferences dialog.
 2. Enable your MIDI input and   output ports:

 a. Select the MIDI tab in the Preferences   dialog.
 b. In the Make  these devices available for MIDI track playback box, select the   check box for the MIDI port 

that is connected to your control surface's   In port.
 c. In the Make  these devices available for MIDI input box, select the check box   for the MIDI port that is 
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connected to your control surface's Out port.
 d. Click Apply.

MIDI ports that are in use by a Mackie Control or Extender       display a  icon to       indicate that they are not 
available for MIDI track input or playback.

 3. Choose your control surface:
 a. Select the External   Control & Automation tab in the Preferences dialog.
 b. Choose a device from the Available   devices drop-down list and click the Add   button. Adding a device loads 

its default profile. If you want to customize   the behavior of the control surface, double-click its entry in the 
Active   control devices list.

 4. Click OK   to apply your changes and close the Preferences dialog.
 5. From the Options menu, choose   External Control   to enable your selected control surfaces.

Configure or customize your control surface
Use the External   Control & Automation tab in the Preferences dialog to select the   control surfaces you want to use 
and adjust their configuration. 

 1. From the Options menu, choose   Preferences to   display the Preferences dialog.
 2. Select the External Control   & Automation tab.
 3. Choose a device from the Available devices drop-down list and click the Add   button. The device is added to the 

Active control devices list. 
 4. Double-click the entry in   the Active control devices   list to display the configuration dialog.
 5. For information about setting up   a Mackie control, see "Using a Mackie Control" below.   
 6. For information about setting up   a generic MIDI control, see "Using a Generic Control Surface" on page 211.

Use your control surface             
This section describes how to use your control surface in   general terms. 
For information about your specific device, please refer   to the manufacturer's documentation.

 1. From the Options menu, choose   External Control   to enable your selected control surfaces.
 2. If necessary, press the Automation button on   your control surface.
 3. Click the Automation  Settings button  for each track you want to edit with the control surface   and choose 

Automation Write (Touch) or Automation  Write (Latch) to enable automation   recording.

 To enable automation recording for audio busses and soft synths, use   audio bus tracks.
 4. Use the functions on your   control surface to edit your project.

Using a Mackie Control
The Mackie Control is fully supported by ACID software. 
An overlay is available from Mackie that you can use to label the Mackie Control   buttons and controls with their 
mapped functions in Vegas software. Many   though not all of these functions are also available in ACID. 
When you use the default mapping, the Mackie Control is divided into   several functional areas. All functionality 
described in this topic refers   to the default control mapping. You can also customize the buttons and   controls on the 
Mackie control. 
For information about your Mackie Control, please refer to the manufacturer's   documentation.
For more information about configuring ACID to use a control surface,   please see Using a Control Surface.
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The Mackie Control Universal can control either   trim or automation settings. In order to control automation 
settings,   the Automation   button in the Audio/Video section must be selected, and the track or bus   you want to 
edit must be set to Automation Write (Touch) or Automation  Write (Latch). Hold the F1 button while turning 
the V-Pot (or use   the Automation Settings   button ) to change the automation recording mode for each track 

and   bus track. 

Configure channel mappings for Mackie Control Extenders 
If you're using Mackie Control Extenders. you'll need to   set up your channel mapping. 
For example, if your Mackie Control Universal is on the   left of your Mackie Control Extender, you could configure the 
Mackie Control   to adjust channels 1 through 8 and use the Mackie Control Extender to   adjust channels 9 through 
16. 
If you have a Mackie Control Universal positioned between   two Mackie Control Extenders, you could adjust 
channels 1 through 8 on   the left Extender, adjust channels 9 through 16 on the Mackie Control   Universal, and adjust 
channels 17 through 24 on the right Extender.

 1. From the Options menu, choose   Preferences to   display the Preferences dialog.
 2. Select the External Control   & Automation tab.
 3. Double-click your Mackie Control   in the Active control  devices list to display the Configure Mackie Control 

dialog.

 The current channel mapping is displayed on each device's LCD.
 4. Choose the channels you want   to control with the Mackie Control Universal:

 a. From the Device Type drop-down list, choose Mackie  Control.
 b. From the Channel  Mapping drop-down list, choose the channels you want to adjust   with the Mackie 

Control Universal.
 5. Choose the channels you want   to control with the Mackie Control Extender:

 a. From the Device Type drop-down list, choose Mackie  Control Extender.
 b. From the Channel  Mapping drop-down list, choose the channels you want to adjust   with the Mackie 

Control Extender.
 6. Repeat Step 5 for each Mackie   Control Extender.
 7. Click OK   to apply your changes and close the Configure Mackie Control dialog.
 8. Click OK  to apply your changes and close the Preferences dialog.

Configure or customize your control mappings
Use the External   Control & Automation tab in the Preferences dialog to select the   control surfaces you want to use 
and adjust their configuration. 

When you customize your control mappings, button functions   may not match the labels on the overlay. You 
can click the  Default All button in the Configure Mackie Control dialog to restore   the default settings.

 1. From the Options menu, choose   Preferences to   display the Preferences dialog.
 2. Select the External Control   & Automation tab.
 3. Double-click your Mackie Control   in the Active control  devices list to display the Configure Mackie Control 

dialog.
 4. To add or change a function   do the following:

200

www.magix-audio.com



 a. Select an item in the User  defined surface control mappings list.
 b. Select an item in the Available  host functions list.
 c. Click the Assign   button.

 5. To remove a function, select   an item in the User defined surface control mappings list and click the Clear  
button.

 6. To remove all functions, click   the Clear All   button.
 7. To replace all custom functions   with the default settings, click the Default  All button.

Channel section (not shown)
The channel section includes V-Pots (knobs), buttons, and   faders that you can use to edit your tracks and busses.

Area Description

V-Pot Adjusts values for panning, volume (when Flip button is selected), and effect   parameter values.

Audio  track 
volume

Adjusts track volume when the Pan or Sends button is selected and   the Flip  
button is selected.

Audio track 
panning

Adjusts audio track panning when the Pan button is selected.

Bus send levels Adjusts bus send levels when the Sends   button is selected.

Effect 
parameters

Adjusts effect parameters when the Inserts   button is selected.

The V-Pot is velocity sensitive, so rotating   quickly changes values quickly, and you can press the 
button to choose   a selection.
When the Pan or Sends button is selected, press   the V-Pot to edit the track or bus effects chain.

Rec/Rdy   
button

Arms audio tracks for recording.

Signal 
LED

Indicates whether an audio track or bus is outputting   a signal.

Solo 
button

Press to solo a track or remove it from the   solo group.

Mute 
button

Press to mute or unmute a   track.

Select 
button

Press to select a track.

Fader Adjusts the track or bus level (unless the Flip button is selected). 
When the Automation   button is selected, the fader adjusts the automation envelope if the track   is in 
Automation Write (Touch) or Automation Write (Latch) mode.   
The fader can also adjust settings for the following   items when you select other buttons in the Channel 
section.

Audio track panning Adjusts audio   track panning when the Pan and  Flip buttons are selected.                                     

Bus send levels Adjusts bus send levels when the Sends and Flip buttons are selected.                                     

The fader is touch sensitive, so if you're recording   automation parameters, recording will begin when 
you touch the fader and   stop when you release it. The current setting is displayed in the Mackie   Control 
display.
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Footswitches (not shown)
The Mackie Control has two switched inputs (labeled User Switch A and User Switch B) that   you can use to 
connect footswitches.
By default, footswitch A toggles playback, and footswitch   B starts and stops recording. 
You can customize the footswitches in the Configure Mackie   Control dialog. Double-click Mackie Control in the 
Active  control devices list on the External   Control & Automation tab of the Preferences dialog to display   the 
Configure Mackie Control dialog.

Control buttons
The buttons in the   Control section determine the operation of the V-Pots and faders in the   channel section of your 
Mackie Control. In every mode, the fader adjusts   track volume, and the V-Pot adjusts the selected control mode. You 
can   press the Flip   button to reverse the V-Pot and fader function.

Button Description

Output                          Press the Output  button to set the output device for   each track or bus. Turn the V-Pot in the channel 
section to choose an   output device and press the V-Pot to select it.

Input Press to set the recording input device for   each track. Turn the V-Pot in the channel section to choose an 
input device   and press the V-Pot to select it. 

Pan Press to adjust track panning using the V-Pot   in the channel section.
In 5.1 surround   projects, pressing the Pan button toggles left-to-right panning, front-to-rear   panning, 
and center-channel level adjustment using the V-Pot.                         

Sends Press to adjust bus and assignable effects send   levels. Press the Sends button   to scroll through the 
available busses and assignable effects chains,   and then turn the V-Pot to adjust the send level.

Inserts Press to adjust   effects settings.                         
Press the button once to display PL in the Mackie Control Assignment   display. The Mackie Control LCD 
displays the effects that are assigned   to each track or bus. The following example shows a three-track 
project:

Turn the V-Pot to scroll through the effects,   and press the V-Pot to edit the current effect. In editing 
mode, PE is displayed in the Assignment   display. The following example shows the   settings for the 
Noise Gate plug-in on track one:

PE mode uses the following   controls: 

V-Pots 1 
- 4

Turn to edit   the effect's parameters. For switch parameters such as Bypass, press the   V-
Pot to change the setting.                                     

V-Pot 5 Turn to scroll   through an effect's property pages.                                     

V-Pot 6 Turn to choose   from a plug-in's available presets. Press the V-Pot to choose a preset.                                     

V-Pot 7 Turn to edit   the current effect for a different channel                                     

V-Pot 8 Turn to choose   other effects for the current channel.                                     

Press the Inserts button again to view effects chains. PS   is displayed in the Assignment display. The   
following example shows the effects chain on track one:
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PS mode uses the   following controls:                          

V-Pots 
1, 3, and 
5

Turn to choose other effects for the current   channel. Press to edit the selected effect and 
enter PE   mode.

V-Pots 
2, 4, and 
6

After choosing an effect with V-Pot 1, 3, or   5, press V-Pot 2, 4, or 6 to add it to the 
channel.

V-Pot 7 If a channel has multiple pages of effects   in the chain, turn to display additional effects. In 
the previous example,   Aud 1 1/2 means that track one   has two pages of effects.

V-Pot 8 Turn to choose effects chains for other channels.

When <No  Insert> is displayed above a V-Pot, you can turn the V-Pot to   view effects that you can add 
to the chain. New effects are displayed   with a *. Press the next V-Pot (to the right) to add the effect.

Settings Press to adjust track or bus settings using   the F1 through F6 buttons.

F1 Hold the button and turn the V-Pot to change   the automation   recording mode for each track and 
bus track.

F2 Hold the button and turn the V-Pot to change   the current panning mode.

F3 Hold the button and press the V-Pot to change   the track phase.

F4 Hold the button and turn the V-Pot to change   record input monitoring settings when   you're 
using an ASIO audio device.

F5 When the Pan button is selected, press the Settings   button and then hold F5 while pressing the 
V-Pot to change the bus or   assignable effects output fader to Pre FX or Post FX.
When the Sends button is selected, press the Settings   button and hold F5 while pressing the V-
Pot to change a track's bus or   assignable effects send level to Pre Volume or Post Volume. Press 
the   Sends button to scroll through   the available bus and effects sends.

F6 Press the Settings   button and hold F6 while pressing the V-Pot on a channel to return the   
channel's settings to the track   defaults.

Fader Banks buttons
The Fader Banks buttons control the behavior of the channel   section controls.

Button Description

Bank Press the left or right arrow button to scroll   the channels 8 units at a time.
For example, if tracks 1-8 are currently displayed,   pressing the right arrow will change to tracks 9-16.

Channel Press the left   or right arrow button to scroll the channels 1 unit at a time.                         
For example, if tracks 1-8 are currently displayed,   pressing the right arrow will change to tracks 2-9.
Hold the Option   button while pressing either Channel button to change track order. For   example, if track 
two is selected and you press Option+ < Channel, track two becomes   track one. Conversely, if track 
one is selected and you press Option  + Channel >, track one becomes   track two. 

Flip Press to exchange the behavior of the fader   and V-Pot when allowed.

Display buttons
The Display buttons control the Mackie Control LCD display.

Button Description

Meters/Values When you're working with audio tracks or busses,   press to display meters or numeric values. 
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Even in Meters mode, numeric   values are displayed when you edit a value.
Hold the Shift button in the Modifiers section while pressing the Meters/Values   button to 
toggle control of tracks, busses, or tracks and busses.

 l Press   once to show audio and MIDI tracks.
 l Press   again to show audio tracks.
 l Press   again to show MIDI tracks.
 l Press   again to show busses.
 l Press   again to show all tracks and busses.

Time Fmt
Zero

Press and hold to display the current time format.   Turn V-Pot 8 while holding the button to 
change the format.

Markers buttons
The Markers buttons control additional track and channel   settings. 

Button Description

Marker 1/9
Automation 

Mode

Press to place the cursor at marker 1, or hold   Shift and press to place the cursor at marker 9.
When the Settings   button is selected, hold the button and turn the V-Pot to change the automation 
recording   mode for each track and bus track.

Marker 
2/10

Pan Mode

Press to place the cursor at marker 2, or hold   Shift and press to place the cursor at marker 10.
When the Settings   button is selected, hold the button and turn the V-Pot to change the current   
panning mode.

Marker 3 Press to place the cursor at marker 3.

Marker 4
Input 

Monitor

Press to place the cursor at marker 4.
When the Settings button is selected, hold the   button and turn the V-Pot to change record   input 
monitoring settings when you're using an ASIO audio   device. 

Marker 5
Pre/Post

Press to place the cursor at marker 5.
When   the Pan button is selected, press  the Settings button and then hold   F5 while pressing the V-
Pot to change the bus or assignable effects output   fader to Pre FX or Post FX.                         
When the Sends button is selected, press the Settings   button and hold F5 while pressing the V-Pot 
to change a track's bus or   assignable effects send level to Pre Volume or Post Volume. Press the   
Sends button to scroll through   the available bus and effects sends.

Marker 6
Default

Press to place the cursor at marker 6.
Press   the Settings button and hold F6   while pressing the V-Pot on a channel to return the channel's 
settings   to the track defaults.                         

Marker 7 Press to place the cursor at marker 7.

Marker 8 Press to place the cursor at marker 8.

Add New buttons
The Add New buttons add busses or tracks to your project.

Button Description

Track Press to add a new audio track. 

Bus Press to add an audio bus to your project.
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Windows buttons
The Windows buttons control the display of various ACID   windows.

Button Description

Mixer Press to show the Mixing   Console window. If the window is not docked, pressing the button 
shows/hides   the window. 

Video 
Preview

Press to show the Video   Preview window. If the window is not docked, pressing the button 
shows/hides   the window. 

Plug-Ins Press to show the Plug-In   Manager window. If the window is not docked, pressing the button 
shows/hides   the window.

View buttons
The View buttons control the display of various sections   of the ACID window.

Button Description

Bus Tracks Press to show or hide bus tracks in the timeline. 

Dock Area Press to show or hide the Window Docking Area at the bottom of the ACID   window.

Track List Press to show or hide the track list in the   timeline.

Modifiers buttons
The Modifiers buttons extend the functionality of other   buttons on the Mackie Control.

Button Description

Shift Hold the Shift   button while pressing a button labeled with inverse text to perform the   shift function. 
For example, hold Shift while pressing the Undo/Redo button   to reverse an undo action.

Option/
Track 
Order

Hold the Option/Track Order button while pressing a button in the Settings, Add New,   or Windows 
group for alternative functions. 
Hold the Option/Track Order button while pressing a the Channel  < orChannel > button   to change 
track order.
Hold the Option/Track  Order button while pressing F1 to F16 to perform custom functions   you can 
define. See the Configure or customize   your control mappings   heading in this help topic for more 
information. 
Use the External   Control & Automation tab in the Preferences dialog to select the   control surfaces you 
want to use and adjust their configuration. 

 1. From the Options menu, choose   Preferences to   display the Preferences dialog.
 2. Select the External Control   & Automation tab.
 3. Double-click your Mackie Control   in the Active devices   list to display the Configure Mackie 

Control dialog.
 4. To add or change a function   do the following:

 a. Select an item in the User  defined surface control mappings list.
 b. Select an item in the Available  host functions list.
 c. Click the Assign   button.

 5. To remove a function, select   an item in the User defined surface control mappings list and click 
the Clear  button.

 6. To remove all functions, click   the Clear All   button.

Using a Control Surface 205



 7. To replace all custom functions   with the default settings, click the Default  All button.

Ctrl Hold the Ctrl   button while using a control for alternative functions.

Alt Hold the Alt  button while using a control for alternative functions. 

Audio/Video buttons
The Audio/Video buttons control various audio settings for   your project.

Button Description

Automation Press to place the controls on the Mackie Control   in automation mode. The controls in the channel 
section of the Mackie   Control will affect the automation   parameters on the track or bus if 
Automation Write (Touch) or Automation Write  (Latch) mode is selected.
When the button is not selected, the buttons   control trim (static) values.

Bypass FX Press to bypass/enable   all audio effects.                         

Metronome Press to turn the metronome   on or off.
Hold Shift and press to toggle metronome countoff.

Surround Press to toggle the project   properties between stereo and 5.1 surround mode.

Downmix Press to toggle the state of the Downmix  Output button in the Mixing   Console window.

Dim Press to toggle the state of the Dim  Output button in the Mixing   Console window.

Project buttons
The Project buttons perform various project-level commands.

Button Description

Save Press to save your project.

Undo/
Redo

Press to reverse edit operations. Hold Shift while pressing the button to reverse   an undo operation.

OK Not used.

Cancel Not used.

Timeline buttons
The Timeline buttons perform various commands for the project   timeline.

Button Description

Marker Press to place a marker   at the cursor position. 
Hold the Ctrl button while pressing the Marker button   to remove a marker.

Region Press to convert the current selection to a   region. 
Hold the Ctrl button while pressing the Region   button to remove a region.

Loop/
Select

Press to toggle   looped playback mode.                          
Hold the Shift button while pressing the Loop/Select  button to create a time selection from the loop 
region.

Mark In/
Go to In

Press to set the   beginning of the loop region at the cursor position.                          
Hold the Shift button while pressing the Mark  In/Go to In button to move the cursor to the 
beginning of the loop   region.
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Mark Out/
Go to Out

Press to set the   end of the loop region at the cursor position.                          
Hold the Shift button while pressing the Mark  Out/Go to Out button to move the cursor to the end 
of the loop   region.

Event 
Trim/
Center 
Cursor

Hold the Shift button while pressing the Event  Trim/Center Cursor button to center the cursor in 
the timeline   view.

RTZ/
End

Press to move the cursor to   the beginning of the project.
Hold the Shift button while pressing the RTZ/End   button to move the cursor to the end of the 
project.

Transport buttons (not shown)
The Transport buttons allow you to navigate the timeline   and preview your project.

Button Description

Rewind Press and hold to move backward through the   timeline at 20x speed.

Fast 
Forward

Press and hold to move forward through the timeline   at 20x speed.

Stop Press to stop   playback and return the cursor to its position before playback started.                            

Play Press to start   playback. Press again to stop playback and leave the cursor at its current   position.                          

Record Press to start   recording. Press again to stop recording and leave the cursor at its current   position.                          
Hold the Shift button while pressing the Record  button to render the current selection to a new   
track. 

Arrow buttons (not shown)
The arrow buttons allow you to navigate the timeline and   preview your project.

Button Description

Left/Right Press the left or right arrow button to move   left or right 1/32 note.
Hold Ctrl   while pressing the left or right arrow button to go to the beginning or   end of the project. 
Hold Alt   while pressing the left or right arrow button to go to the beginning of   the next or previous 
measure.

Up/Down Press to zoom in or out. 

Jog dial (not shown)             
The jog dial allows you to navigate the timeline when playback   is stopped.
Hold Alt   and turn the dial to go to the beginning of the next or previous measure.

Using a Frontier TranzPort
Using a Frontier TranzPort, you can control ACID wirelessly.    
For more information about configuring ACID to use a control surface,    please see Using a Control Surface.

View the control mappings             
The map for the TranzPort assigns the controls as follows.
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Control Function Shift Function

Track Focus to previous track or 
mixer control. 

Insert audio track.

Track Focus to next track or mixer 
control. 

Insert MIDI track.

Rec                         Arm track for record.

Mute Mute track.

Solo Solo track.

Undo Undo. Redo.

In Set loop start.

Out Set loop end.

Punch Toggle metronome. Toggle MIDI merge        recording when displaying volume or panning for a 
MIDI track.

 1. Press            Track  or Track  to select a MIDI track.                                 
 2. Press          Shift + Loop until volume or panning information is 

displayed on the TranzPort.
 3. Hold          Shift and press Punch.

Loop Toggle looped playback. Toggle jog wheel control of volume, panning,        input, or output device for 
tracks or Mixer controls.

 1. Press           Track  or Track           to select the track you want to adjust.
 2. Press          Shift + Loop until the item you want to edit is displayed on 

the TranzPort.
 3. Hold          Shift while rotating the jog wheel to adjust the selected 

control.

Shift Toggle alternate functions.

Markers
Prev

Move to previous marker.

Markers
Add

Insert marker at cursor.

Markers
Next

Move to next marker.

Jog        
Wheel

Scroll cursor. Adjust volume or pan for current track.

Rewind. Go to start.

Fast forward. Go to end.

Stop playback or recording.

Play/pause.

Punch in or start recording.

Adjust track or bus volume

 1. Press Track  or Track  to select the track or mixer control       you want to adjust.
 2. Press Shift+Loop       until the TranzPort displays volume.
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 3. Hold Shift while rotating       the jog wheel to adjust the volume of the selected track or mixer control.

Adjust track or bus panning

 1. Press Track  or Track  to select the track or mixer control       you want to adjust.
 2. Press Shift+Loop       until the TranzPort displays panning.

Not all mixer controls allow panning adjustment.

 3. Hold Shift while rotating       the jog wheel to adjust panning for the selected track or mixer control.

Edit a track's input device

 1. Press Track  or Track   to select the track you want to adjust.
 2. Press Shift+Loop       until the TranzPort displays the track's input device.
 3. Hold Shift while rotating        the jog wheel to scroll through the available inputs. When you change        the input device, 

an asterisk is displayed before the device name on the       TranzPort.
 4. Press Shift+Punch       to set the input device.

Edit a track or mixer control's output device

 1. Press Track  or Track  to select the track or mixer control       you want to adjust.
 2. Press Shift+Loop       until the TranzPort displays the track's output device.
 3. Hold Shift while rotating        the jog wheel to scroll through the available output devices. When you        change the 

output device, an asterisk is displayed before the device name       on the TranzPort.
 4. Press Shift+Punch       to set the output device.

Using a PreSonus FaderPort
You can use a PreSonus FaderPort to control ACID Music Studio. 
For more information about configuring ACID Music Studio to use a control surface,   please see Using a Control 
Surface.

View the control mappings             
The map for the FaderPort assigns the controls as follows.

Control Function Shift Function

Fader Adjusts volume for the active channel.  

Pan Adjusts panning for the active channel.  

Mute Mutes the active channel.  

Solo Solos the active channel.  

Rec Arm the active track for recording.  

Channel Scroll to previous track or mixer control. 
Scrolls by 8 channels when Bank   is selected.

 

Bank Toggles scroll channel/bank mode.  

Channel Scroll to next track or mixer control. 
Scrolls by 8 channels when Bank   is selected.

 

Using a Control Surface 209



Output Master Fader mode.  

Read Enables channel automation in to Read mode.    Press again to turn 
automation off.

 

Write Enables channel automation in to Write mode.    Press again to turn 
automation off.

 

Touch Enables channel automation in to Touch mode.    Press again to turn 
automation off.

 

Off Turns the fader off.  

Mix Displays the Mix Console. Dim mixer output.

Proj Switches behavior of fader and rotary knob.  

Trns Toggles automation for the active channel.  

Undo Reverses the last action performed.  

Shift Toggle alternate functions.  

Punch Toggles the Metronome   on or off. Moves left to the next 
marker.

User Toggles metronome count-in. Move right to the next 
marker.

Loop Toggles looped playback. Add a marker at the cursor 
position.

Rewind. Go to start.                         

Fast forward. Go to end.                         

Stop playback or recording.  

Play/pause.  

Punch in or start recording.
The LED blinks to indicate tracks are armed   for recording and 
illuminates solidly during recording.

Render selected track to a 
new track.

Footswitch Toggles playback. Punch in/out recording.

Adjust track or bus volume             

 1. Press Channel  or Channel  to select the track or mixer control   you want to adjust.
 2. Move the fader to adjust the   volume of the selected track or mixer control.

If   you want to use the FaderPort knob to adjust channel volume, select the   Proj button.

Adjust track or bus panning             

 1. Press Channel  or Channel  to select the track or mixer control   you want to adjust.
 2. Turn the FaderPort knob to   adjust panning for the selected track or mixer control. 

Tips:

 l Not all mixer controls allow panning   adjustment.
 l If you want to use the FaderPort   fader to adjust channel panorama, select the Proj   button.
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Start recording             

 1. Arm the tracks you want to   arm:
 a. Press Channel  or Channel  to select the track you want to record   into.
 b. Press Rec to arm the selected track for recording.

 2. Repeat steps a and b for all   tracks you want to arm.
 3. Press Record  to begin recording into all armed tracks.   
 4. When you're done recording,   press Record  again to stop.

Using a Generic Control Surface
You can configure up to five generic MIDI control surfaces to work with   the ACID interface.
For information about your specific device, please refer to the manufacturer's   documentation.
For more information about setting up a control surface, please see   Using a Control Surface.

Notes:

 l If you have   a MIDI controller that includes buttons and knobs or faders, you can use   the device as an external 
control device and as a MIDI input device for   recording MIDI    for example, you can use the buttons, knobs, and 
sliders on the device   for external control, and still use the keyboard, pitch wheel, and modulation   wheel for 
recording MIDI. 

 MIDI messages that are mapped to external control functions are filtered   when you record MIDI. If a note 
message is assigned to a control surface   function, both the note-on and note-off messages will be filtered. —

 l Effects   parameters cannot be adjusted with a generic controller.

A generic control surface can control either   trim or automation settings. In order to control automation settings,   
you must assign a button to place the control surface in automation mode,   and the Automation  Settings button 

 on the track or bus you want to edit must   be set to Automation Write (Touch) or Automation Write 

(Latch). 

Customize your control mappings
Use the External   Control & Automation tab in the Preferences dialog to select the   control surfaces you want to use 
and adjust their configuration. 

 1. From the Options menu, choose   Preferences to   display the Preferences dialog.
 2. Select the External Control   & Automation tab.
 3. Double-click the Generic Control entry in the Active control devices list to display the Configure Generic 

Control dialog.
 4. To add or change a function   do the following:

 a. Choose a setting from the View  function group drop-down list.
 b. Select the Learn   check box.
 c. Select an command in the Host  Command list and activate the control on your control surface.
 d. You can click the Edit  button to fine-tune the MIDI message settings.  
 e. Repeat step 4 for each command   you want to make available on your control surface.

 5. To remove a function, select   an item in the Host Command   list and click the Reset  button.
 6. To remove all functions,   click the Reset All   button.
 7. Click the Save  As button to save your updated configuration file.
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Load a control mapping file

 1. From the Options menu, choose   Preferences to   display the Preferences dialog.
 2. Select the External Control   & Automation tab in the Preferences dialog.
 3. Double-click the Generic Control entry in the Active  control devices list to display the Configure Generic 

Control dialog.
 4. Click the Open  button and browse to the mapping file you want to use.
 5. Click OK   to apply your changes and return to the Preferences dialog.
 6. Click OK   to close the Preferences dialog.

See an example of how you can set up MIDI keyboard as a generic control   surface
If you have a MIDI device that has knobs, faders, and buttons,   you can use assign those controls to adjust the tracks 
in your project.   

For this example, let's set up a MIDI keyboard with 8 knobs to adjust track   volume.

Notes:

 l You can   use this same process to assign a controller to any configurable parameter.   To adjust track volume, 
we're selecting Channel x Fader in the Host  Command list in step 10 below. However, if you wanted to adjust   
panning, you could choose Channel x Pan, or if you wanted to adjust the bus send level, you could   choose 
Channel x Send.

 l Effect   parameters cannot be controlled with a generic controller.

 1. From the Options menu, choose   Preferences to   display the Preferences dialog.
 2. Select the MIDI tab, and verify   that the port where your controller is connected is selected in the Make these 

devices available  for MIDI input list.
 3. Select the External Control   & Automation tab.
 4. From the Available devices drop-down list, choose Generic Control, and then click the Add   button. The 

Generic Control is added to the Active control devices list.
 5. Double-click the Generic Control entry in the Active  control devices list to display the Configure Generic 

Control dialog.
 6. Verify that the port where   your controller is connected is selected from the MIDI  input drop-down list at the 

bottom of the dialog.
 7. Because the MIDI keyboard   in our example has 8 knobs, type 8 in the Number  of channels box.
 8. Now, let's assign buttons   to shift the channel banks up and down so you can control all the tracks   in your 

project. 

 For example, when you start using the controller, the knobs will adjust   tracks 1-8. When you shift the banks 
down, you can control tracks 9-16,   and so on.
 a. From the View function group drop-down list, choose Channels.
 b. Select the Learn   check box. 
 c. Select Channel Bank Down from the Host  Command list.
 d. Press the button or key you want to   use to switch to the next group of 8 tracks. 
 e. Select Channel Bank Up from the Host  Command list.
 f. Press the button or key you want to   use to switch to the previous group of 8 tracks. 

 9. Choose Audio Channels from the View  function group drop-down list. 
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 10. Program each knob:
 a. Verify that the Learn   check box is still selected. 
 b. Select Channel 1 Fader   from the Host Command   list.
 c. Turn knob 1 on your MIDI keyboard.   You'll notice that the Channel, MIDI Message,   and MIDI Data   

columns are updated.
 d. Repeat steps 10a and 10b to program   knobs 2 through 8 on your keyboard.

 11. Now, let's assign a button   to toggle the controller in and out of automation mode so we can use the   knobs to 
adjust the track's volume (trim) or record volume automation:
 a. From the View function group drop-down list, choose Assign.
 b. Select Toggle Automation Mode from the Host          Command list.
 c. Verify that the Learn            check box is still selected, and then press the button or key you want            to use to switch 

your control surface in and out of automation mode. 

 You'll notice that the Channel, MIDI Message,            and MIDI Data           columns are updated.
 12. Click OK   to close the Configure Generic Control dialog, and then click OK  to close the Preferences dialog.
 13. From the Options menu, choose   External Control   to enable your controller.

 You're ready to start using your controller. 
 14. Turn   each knob on your controller and notice that turning knob 1 adjusts the   volume (trim) of track 1, turning 

knob 2 adjusts the volume of track 2,   and so on.
 15. Press   the button that you assigned to scroll the channel bank down in step 8.

 Turn each knob on your controller and notice that turning knob 1 now   adjusts the volume (trim) of track 9, 
turning knob 2 adjusts the volume   of track 10, and so on.

 16. Press   the button that you assigned to scroll the channel bank up in step 8 so   you can control tracks 1-8 again.
 17. Press   the button that you assigned to toggle automation mode in step 11.

 Select the Automation  Settings button  on each track to enable automation recording.

 Start playback, and turn each knob on your controller, and notice that   turning knob 1 records   volume 
automation on track 1, turning knob 2 records automation on   track 2, and so on.

 18. Press   the automation mode toggle button once more, and you can use the knobs   to adjust track trim levels 
again.
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Working with MIDI
In addition to using loops, one-shots, and Beatmapped tracks, you can   record MIDI tracks and use MIDI files in your 
projects.

To   edit MIDI files within ACID software, you can use inline   MIDI editing to edit in the timeline, or you can use 
the List   Editor or Piano   Roll tab in the MIDI Track Properties window. To edit a MIDI file   with an external editor, 
right-click the track and choose Edit  in [editor name] to open the file using the editor specified on   the Editing 
tab of the Preferences   dialog.

MIDI Basics: Using MIDI Files in Your Project
ACID contains comprehensive MIDI support, but you don't have to be a   MIDI wizard to spice up your projects with 
MIDI.
You can use MIDI files in much the same way you use loops and one-shots   in your projects. However, unlike loops 
and one-shots, MIDI files do not   contain audio. MIDI files contain information about which notes to play   and how 
to play them. You'll need a synthesizer (software or hardware   based) to play the MIDI data.

+  or + = Music!

MIDI       File Synthesizer Sound       Card

Following is a basic workflow for using MIDI files in an ACID project:

 1. Use the Explorer window to   find the file you want to use.
 2. Double-click the file to add   it to your project. Tracks and events will be created automatically.   

 For more control, you can right-click a MIDI file in the Explorer window   and choose a command from the 
shortcut menu   to indicate how you want to add it to your project.

 3. By default, your new MIDI tracks will be routed to the MAGIX VITA2 Synth. If you want to change the sounds, 
you can add other   VSTi   software synthesizers.

 4. If you've added another VSTi soft synths to your   project, you'll need to assign   your MIDI track to the soft synth 
you want to play the track.

 5. Click the Play button in the transport toolbar to hear   your project.
 6. When you're finished with your project, you can render   it as you would any other project. 

In order to render projects that contain MIDI tracks, MIDI tracks must   be routed to VSTi soft synths. Tracks 
that are routed to external MIDI devices   will not be included in the rendered file. 

Once you have the basics down, you can start recording   your own MIDI parts.

Adding MIDI Files to a Project
Adding MIDI files to your ACID project is just like adding audio: you   can double-click a MIDI file to create new 
tracks and events, or you can   drag a MIDI file to an existing track's Paint  Clip Selector button to add a new clip.   
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When you select a MIDI file in the Explorer   window, its length, tempo, type, and number of tracks are displayed 
at   the bottom of the window:

When you right-click a MIDI file in the Explorer window, you can choose   how you want to add it to your project:

Command Description

Add to 
Project

Adds the file to the current ACID project and   adds tracks to the track list. No events are created. 

 l For   Type 0 MIDI files, a separate track is created for each channel in the   MIDI file, and all tracks 
are organized within a folder track. 

 l For   Type 1 MIDI files, a separate track is created for each track in the MIDI   file, and all tracks are 
organized within a folder track.

 l ACID   will set the clip's key   based on the MIDI file. If a MIDI file has multiple key signatures, 
only   the first is used. 

When you draw events after adding a file to   your ACID project, MIDI controller data is not 
added to the timeline.   Right-click an event and choose Merge  Envelope Data from the 
shortcut menu to represent MIDI controllers   as envelopes on the timeline.

Add  to 
Project with 
Events
 

Adds the file to the current ACID project at   the cursor position, adds tracks to the track list, and 
creates events   for the MIDI note data on each track. Envelopes   are added to the tracks to represent 
MIDI controller data. 

 l For   Type 0 MIDI files, a separate track is created for each channel in the   MIDI file, and all tracks 
are organized within a folder track. 

 l For   Type 1 MIDI files, a separate track is created for each track in the MIDI   file, and all tracks are 
organized within a folder track.

 l ACID   will set the clip's key   based on the MIDI file. If a MIDI file has multiple key signatures, 
only   the first is used. 

Add  to 
Project with 
Events 
Rippled
 

Adds the file to the current ACID project at   the cursor position, adds tracks to the track list, and 
creates events.   Existing events are shifted downstream to make room for your MIDI file.   Envelopes 
are added to the tracks to represent MIDI controller data.

 l For   Type 0 MIDI files, a separate track is created for each channel in the   MIDI file, and all tracks 
are organized within a folder track.

 l For   Type 1 MIDI files, a separate track is created for each track in the MIDI   file, and all tracks are 
organized within a folder track. 

 l ACID   will set the clip's key   based on the MIDI file. If a MIDI file has multiple key signatures, 
only   the first is used. 

Open as 
New 
Project

Starts a new project, adds tracks to the track   list, and creates events for the MIDI note data on each 
track:

 l For   Type 0 MIDI files, a separate track is created for each channel in the   MIDI file. 
 l For   Type 1 MIDI files, a separate track is created for each track in the MIDI   file.
 l The   ACID project key will be   updated to match the MIDI project. Each clip (except drum clips) 

will   have its key set accordingly.
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When you draw events after opening a MIDI   file as a new project, MIDI controller data is not 
added to the timeline.   Right-click an event and choose Create  Envelopes from Clip from the 
shortcut   menu to represent MIDI controllers as envelopes on the timeline.                     

Routing Tracks to Soft Synths or MIDI Devices
Each MIDI track can be played through any external MIDI port or any   VSTi or ReWire 2.0 soft synth   bus control in 
the Mixing Console window.

 1. Click the MIDI  Output button. A list of all the available MIDI devices and software   synthesizers is displayed.

 l If the soft synth you want to use   does not appear in the menu, choose Insert  Soft Synth to add a soft synth 
bus control to the project and route   the track to the new synth. 

 l If a MIDI device does not appear in   the menu, choose External  MIDI Device Preferences to open the 
MIDI   tab of the Preferences dialog and verify that the check box for the device   is selected. If a device is 
selected for generating MIDI timecode on the   Sync Preferences tab, it will be unavailable as a playback 
device.

 For more information about using hardware-based synthesizers with your   ACID project, please see Using   
Input Busses with Hardware-Based Synthesizers.

 2. Choose a device from the list to send the current   track to that device. To route to a specific port in a ReWire 2.0 
device,   choose your ReWire device application from the list, and then choose a   port (indicated by the    icon) 
from the submenu.

In order to render   projects that contain MIDI tracks, MIDI tracks must be routed to   VSTi or ReWire 2.0 soft 
synths. Tracks that are routed to external MIDI   devices will not be included in the rendered file.

 3. To choose which MIDI channel will be used to send MIDI   data, choose MIDI Channel,   and then choose a 
channel from the submenu .

When you add   a MIDI track, its output is automatically assigned to the next available   channel (channel 10 
is skipped since some devices reserve channel 10 for   drums).

Using Synthesizers
From the Insert menu, choose Soft  Synth to add a soft synth bus control to the Mixing Console window.
Each soft synth bus control can represent a VST instrument   or ReWire device application.
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A VSTi soft synth bus control is like a virtual synthesizer module   where you can route tracks. In the same way you 
can route a MIDI keyboard   to an outboard synthesizer module, you can route each MIDI track to any   soft synth you 
have set up for your project or play a soft synth with   an external MIDI controller.
A ReWire soft synth bus control connects a ReWire device application   with ACID software, which serves as a 
ReWire mixer application. When ACID   software hosts a ReWire device application, playback is synchronized 
between   the two programs, and the ReWire device application's audio is output   through the ACID mixer. With 
ReWire 2.0 devices, you can also route MIDI   tracks to synths in the ReWire device applications.
Use the soft synth bus control in the Mixing Console window to mute, solo, add   effects to, and adjust the volume of 
each soft synth.

You can add up to 32 soft synth bus controls to your project.   If the project includes VST instruments   with 
multiple outputs, each output is added as a separate soft synth bus.

Using VST Instruments
A Virtual Studio Technology instrument (VST instrument or VSTi) is a   software-based synthesizer you can use to 
create audio from your MIDI   tracks. You use a software synthesizer much like a hardware-based synthesizer:   in the 
same way you can route a MIDI keyboard to an outboard synthesizer   module, you can route MIDI tracks to a VSTi   
soft synth or ReWire 2.0   device application.
VST instruments are added to your project as soft synth bus controls   in the Mixing Console window. Routing   a 
MIDI track to a soft synth bus control will cause the track to be played   through the VST instrument, and you can use 
the Soft Synth Properties   dialog to choose presets and adjust instrument settings.

You can add up to 32 soft synth bus controls to your project.   If the project includes VST instruments   with 
multiple outputs, each output is added as a separate soft synth bus.

If you change the number of outputs from within a multiport VST   instrument after adding the soft synth to your 
ACID project, the ACID   Mixing Console window will not reflect the change if the VST instrument   does not 
notify host applications of dynamic port changes.

Add a VST instrument   to your project             

 1. From the Insert menu, choose   Soft Synth,   or click the Insert  Soft Synth  button in the Mixing Console 

window. The Soft Synth   Chooser is displayed.
 2. Select the VST instrument   from the list and click the OK  button.

If the VST instrument   you want to use isn't displayed in the Soft Synth Chooser dialog, you   can use the Plug-In 
Manager window   to indicate where your plug-ins are installed and scan for plug-ins.

The soft synth bus control is added   to the Mixing Console window using the default settings, and the Soft   
Synth Properties window is displayed. You can load new presets or banks   or use the instrument's interface in 
the Soft Synth Properties dialog   to adjust its settings.
When you insert a VST instrument that supports multiple output ports,   ACID creates a soft synth bus for the 
VSTi's main output   in the Mixing Console window.
You can add soft synth bus controls for each of the VSTi's   output ports to mute, solo, add effects, and adjust 
volume for each soft   synth bus control individually. For more information, see "Add or   remove soft synth 
busses for multiport VST instruments" in this help   topic. 

If you change the number of outputs from within   a multiport VST instrument after adding the soft synth to your 
ACID project,   the ACID Mixing Console window will not reflect the change if the VST   instrument does not 
notify host applications of dynamic port changes.

Add or remove soft   synth busses for multiport VST instruments             

When you insert a VST instrument that supports multiple   output ports, ACID creates a soft synth bus for the VST 
instrument's main   output in the Mixing Console window.
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You can add soft synth bus controls for each of the VSTi's   output ports to mute, solo, add effects, and adjust 
volume for each soft   synth bus control individually.

 1. Right-click the VST instrument's   soft synth icon    in the Mixing Console window. 

 2. Choose Insert/Remove  <Synth   Name> Outputs   from the shortcut menu, and then choose a command from 
the submenu. 

Deleting the main output's soft synth bus   control will remove all of the VST instrument's ports.
 

Load or save VST instrument   effect presets             

When you're using a VST instrument as a soft synth, you   can use the Soft Synth Properties   window to load or save 
settings for an individual instrument.

Some VST instruments   may not support loading or saving presets through the ACID interface.   These 
instruments may have their own methods of saving presets and banks,   or saving may not be available in a 
demonstration or limited version of the   instrument.

Loading an instrument preset

 1. Click the Open  Effect Preset button . The Open VSTi Effect Preset dialog is displayed.

 2. Browse to the .fxp file   that you want to use.
 3. Click the Open   button. The current VST instrument settings are replaced with the settings   stored in the preset.

Saving the current settings as a preset

 1. Click the Save  Effect Preset button . The Save VSTi Effect Preset dialog is displayed.

 2. Browse to the folder where   you want to save the .fxp file and type a name in the File  Name box.
 3. Click the Save   button. The current VST instrument settings are stored in the preset.

Load or save VST instrument   effect banks             

When you're using a VST instrument as a soft synth, you   can use the Soft Synth Properties   window to load or save 
banks of settings.

Loading a saved bank

 1. Click the Open  Effect Bank button . The Open VSTi Effect Bank dialog is displayed.

 2. Browse to the .fxb file   that you want to use.
 3. Click the Open   button. The current VST instrument settings are replaced with the settings   stored in the bank.

Saving the current settings as a bank

 1. Click the Save  Effect Bank As button . The Save VSTi Effect Bank dialog is displayed.

 2. Browse to the folder where   you want to save the .fxb file and type a name in the File  Name box.
 3. Click the Save   button. The current VST instrument settings are stored in the bank.

Enable or bypass a   VST instrument             

Select the Enable   button  on the Soft Synth Properties window to enable   a VST instrument so you can hear its 
output, or click again to bypass   the instrument.

When you change the   soft synth bus control to use a different VST instrument, it will be enabled   automatically.

Route a MIDI track   to a VST instrument             

Routing MIDI tracks uses the same   process whether you're routing to a VST instrument, ReWire   2.0 device 
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application, or MIDI port. For more information, see "Routing Tracks to Soft Synths or MIDI Devices" on page 216.   

Play a soft synth with   a MIDI device             

 1. Double click a soft synth   icon  in the Mixer   window. The Soft Synth Properties   window is displayed.

 2. In the Soft Synth Properties   window, click the External MIDI Input Port button  and choose a port from the 

menu.
If the port you want to use isn't selected, you can choose External  MIDI Device Preferences to display the 
MIDI   tab in the Preferences dialog, where you can make devices available for   MIDI input.

Notes:

 1. Step   2 is necessary only if the Auto  MIDI input routing check box on the MIDI tab of the Preferences   dialog is 
not selected.

 2. If you're   using a VSTi soft synth, select the Enable   button  on the Soft   Synth Properties window to allow 
real-time MIDI playback.

 3. Play   your MIDI controller, and it will use the current program settings from   the Soft Synth Properties window.

For more information about using external MIDI devices,   see "Using External MIDI Devices" on page 222.

Automate VSTi parameters

You can use the soft synth bus track to control parameter   automation for VST instruments using   envelopes.
For more information about adding and adjusting parameter   automation envelopes, please see Automating   VSTi 
Parameters.

Automating VSTi Parameters
You can use envelopes on soft synth bus tracks to control parameter   automation for VST instruments.

Automate VSTi parameters

 1. If bus   tracks aren't already visible, choose Show  Bus Tracks from the View menu. 
 2. Select the bus track header   for the VSTi soft synth you want to edit.
 3. Perform either of the following   actions:

 l Click   the Configure Soft Synth  Parameter Automation button  in the VSTi's Soft Synth Properties   

window.
or——

 l From   the Insert menu, choose Envelopes,   and then choose Soft  Synth Automation from the submenu. 

  The Soft Synth Parameter Automation dialog is displayed.
 4. The Soft Synth Parameter Automation   dialog displays a list of the VST instrument's automatable parameters.   

Select the check box for each parameter you want to automate.
 5. Click the down arrow  in the Envelope   box and choose a command from the menu:

Item Description

Insert 
Envelope

If the parameter does not have an automation   envelope, No is displayed. 
Click the down arrow  and choose  Insert Envelope to add an automation envelope to the 
timeline.

Show/Hide 
Envelope

If the parameter has an automation envelope,   Visible or Hidden   is displayed. 
Click the down arrow  and choose  Hide Envelope or Show Envelope   to toggle its display.
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Click the Hide all  Envelopes button at the bottom of the dialog to hide all envelopes   on 
the bus track.

Reset All 
Envelope 
Points

If the parameter has an automation envelope,   you can click the down arrow  and choose 
Reset All Envelope  Points to restore all points to the default value.

Delete 
Envelope

If the parameter has an automation envelope,   you can click the down arrow  and choose 
Delete Envelope  to remove the envelope and all envelope points from the timeline.

Click the Remove all  Envelopes button at the bottom of the dialog to delete all parameter   
envelopes on the bus track.

 6. Click the down arrow  in the Curve  Type box to set the default fade   curve for each parameter's automation 
envelope. The new curve type will   be applied to all envelope segments. You can right-click a segment and   
choose a new fade curve to override the default curve type.

 7. You   can now edit the parameter automation data by editing   the envelopes on the bus track or adjusting the 
VSTi's controls in   the in the Soft Synth Properties   window. 

Edit parameter automation envelopes or record automation

After you've added VSTi parameter automation envelopes to   the soft synth's bus track, each envelope represents an 
automatable parameter,   and the envelope points represent parameter values. 
You can edit parameter automation data by editing the envelopes on the bus track,   or you can use the VSTi's 
controls   in the in the Soft Synth Properties   window to record automation data:  

 1. Double-click the soft synth   icon in the Mixing Console window  to display the Soft Synth Properties 

window   for the VSTi you want to automate. 
 2. Click to position the cursor   in the timeline where you want to edit a parameter.
 3. Adjust the control in the Soft Synth   Properties window that corresponds to the envelope you want to edit. An   

envelope point is created or the envelope point at the cursor position   is updated to match the control setting.

 If you want to record automation settings during playback, the controls   in the Soft Synth Properties window 
behave differently depending on the   track automation   recording mode. 

 Click the  next to the Automation  Settings button  and choose a setting from the menu to set the 

automation   recording mode: 

Mode Track 
Icon

Description

Off Automated   parameters are ignored during playback.                                 
When you switch to Off mode, the control   setting from the cursor position is used as a 
static setting, and the   envelope is dimmed to indicate that it is unavailable.

Read The envelope value is applied during playback,   and the control in the Soft Synth Properties 
window reflects the envelope   settings at the cursor position. 
Adjustments to the control are not recorded.

Write 
(Touch)

The envelope value is applied during playback,   and the control in the Soft Synth Properties 
window follows the envelope   during playback and when you position the cursor.
Envelope points are created only while a   control is being adjusted. When you stop 
adjusting the control, automation   recording stops and the existing envelope points are 
unaffected.
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Write 
(Latch)

The envelope value is applied during playback,   and the control in the Soft Synth Properties 
window follows the envelope   settings during playback and when you position the cursor.
Envelope points are created when you change   a control setting, and recording continues 
until you stop playback. When   you stop adjusting the control, the control's last setting 
overwrites   the existing envelope points/keyframes.

Editing Soft Synth Properties
From the View menu, choose Soft  Synth Properties to display the Soft Synth Properties window for   the selected 
track. You can use this window to route soft synths to  VST   instruments or ReWire 2.0   devices, and you can 
configure soft synths for external input from   a MIDI controller.

Double-click the  icon on a soft   synth channel strip in the Mixing Console window or select a track   that is 

routed to that soft synth to display the Soft Synth Properties   window for the soft synth. 

Route a soft synth   bus control to  a VST instrument or ReWire 2.0 synth   application             

 1. Double click a soft synth   icon  in the Mixing Console window. The Soft Synth Properties   window is 

displayed.
 2. Click the Edit  Soft Synth button . The Soft Synth Chooser dialog is displayed.

 3. Select the VST instrument you want to use, or select the ReWire Devices tab and   choose a ReWire 2.0 device.
If the VST instrument you want to use isn't displayed   in the Soft Synth Chooser dialog, you can use the 
Plug-In   Manager window to indicate where your plug-ins are installed and scan   for plug-ins.

If the ReWire device application you want to use isn't displayed in the   Soft Synth Chooser dialog, you can 
use the Plug-In   Manager window to re-enable the plug-in. 

In the Plug-In Manager, navigate to the ReWire  Devices > Ignored folder to view the ReWire devices 
you've excluded.   Right-click a plug-in and choose Ignore  from the shortcut menu to clear the check mark 
and re-enable the   plug-in.

 4. Click OK   to return to the Soft Synth Properties window.
If you selected a VST instrument, the   VSTi synth is displayed in the Soft Synth Properties window, and you can   
adjust the controls as necessary.
If you selected a ReWire 2.0 device,   the Soft Synth Properties window displays information about the synth's   
MIDI ports. Click the Open  ReWire Device button  to start the device (some applications cannot   be started 
by a ReWire mixer), or select the Lock  MIDI Port Configuration button  to lock MIDI ports so the software 
does not   lose port assignments due to dynamic changes from ReWire devices.

Route a soft synth bus control to another bus             

By routing soft synths to busses, you can create subgroups   or use the bus to apply a single set of plug-ins to the 
subgroup of soft   synths.

 1. Add   busses to your project.
 2. Click the Playback  Device Selector button on the soft   synth bus control or bus track and choose   a bus from the 

menu. 
 3. The button is displayed as a    when a bus is routed to the master bus.

 4. The bus letter is displayed ( ,   ,   and so on) when a bus is routed to another bus.

Configure a soft synth for external input             

Each soft synth bus control in the Mixing   Console window can accept input from MIDI   tracks and external MIDI 
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devices. You can use your favorite controller   to play a VST instrument for recording   MIDI.
For more information about using external MIDI controllers,   see "Using External MIDI Devices" below.

 1. Double click a soft synth   icon  in the Mixer   window. The Soft Synth Properties window is displayed.

 2. Click the External  MIDI Input Port button  and choose a port from the menu.

If the port you want to use isn't displayed,   choose External MIDI  Device Preferences from the menu. The 
MIDI   tab in the Preferences dialog is displayed so you can select a port in   the Make these devices  available for 
MIDI input section of the dialog.

This step is necessary   only if the Auto MIDI  input routing check box on the MIDI tab of the Preferences   dialog 
is not selected.

If you're using a   VSTi soft synth, select the Enable   button  on the Soft   Synth Properties window to allow 
real-time MIDI playback.

Solo external MIDI inputs

Your external MIDI devices can be routed to multiple soft   synth bus controls and MIDI thru devices. Soloing an 
external input prevents   your device from playing through other soft synths and MIDI thru devices.

 1. Double-click a soft synth   icon  in the Mixer   window. The Soft Synth Properties window is displayed.

 2. Click the Solo  Listen to MIDI Input button .

You can select the Solo  Listen to MIDI Input button on additional soft synth bus controls   to add them to the 
solo group.

This button is unavailable   if the Auto MIDI input  routing check box on the MIDI   tab of the Preferences dialog is 
selected.

Edit VSTi or ReWire soft synth properties

The contents of the Soft Synth Properties window will vary   depending on the type of soft synth bus. 

 l To learn more about editing VSTi soft   synth properties, see "Loading an instrument preset" on page 218. 
 l To learn more about editing ReWire   soft synth properties, see "Using ACID Software as a ReWire Mixer" on 

page 231.

Using External MIDI Devices
If you have external MIDI devices such as MIDI controllers or hardware   synthesizers, ACID software can use those 
devices for playing back or   recording MIDI tracks.

Real-time MIDI monitoring must be enabled to allow ACID software   to communicate with the MIDI port. Real-
time MIDI monitoring is enabled   by default, but if you've turned it off, you can turn it on again by choosing   
Enable Real-Time MIDI  from the Options menu. 

When the Enable Real-Time MIDI command is selected, audio plug-ins continue running even   when playback 
is stopped. Turning the command off can conserve processing   power, but input from external MIDI controllers 
will be ignored.

Enable MIDI devices             

 1. Install your device and   any required drivers according to the manufacturer's instructions.
 2. From the Options menu, choose   Preferences.   The Preferences dialog is displayed.
 3. Select the MIDI tab.

222

www.magix-audio.com



 4. In the Make these devices available for MIDI track playback and Generate MIDI Clock box,   select the check 
box for each MIDI   device that you want to use as a MIDI output for MIDI tracks   and generating MIDI   clock.

 5. In the Make  these devices available for MIDI input box, select the check box   for each MIDI device that you 
want to be available for recording   MIDI and controlling soft synths.

Set a track's input device             

Click the MIDI  Input button in a MIDI track header and choose the MIDI device   and channel you want to use. 
For more information about setting a MIDI track's input   device, please see Recording MIDI.

Route a track to a MIDI device             

Click the MIDI  Output button in a MIDI track header to choose the MIDI device   and port you want to use. 
For more information about routing MIDI tracks, please see   Routing Tracks   to Soft Synths or MIDI Devices and 
Using   Input Busses with Hardware-Based Synthesizers.

 

Play a soft synth with a MIDI device

 1. Double click a soft synth   icon  in the Mixer   window. The Soft Synth Properties   window is displayed.

 2. In the Soft Synth Properties   window, click the External MIDI Input Port button  and choose a port from the 

menu.

 If the port you want to use isn't selected, you can choose External  MIDI Device Preferences to display the 
MIDI   tab in the Preferences dialog, where you can make devices available for   MIDI input.
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Notes:

 l Step   2 is necessary only if the Auto  MIDI input routing check box on the MIDI tab of the Preferences   dialog is 
not selected.

 l If you're   using a VSTi soft synth, select the Enable   button  on the Soft   Synth Properties window to allow 
real-time MIDI playback.

 l Play   your MIDI controller, and it will use the current program settings from   the Soft Synth Properties window.

Set MIDI thru ports           

If you want notes received from a MIDI input port to be   echoed to a MIDI output port for monitoring, you can set up 
MIDI thru   for any enabled ports:

 l A single MIDI output can   have a single MIDI input routed to it.
 l A single MIDI input can   be routed to multiple MIDI output ports that will receive MIDI thru data.
 l Sysex messages are not sent   to a MIDI thru device.

You can also click the MIDI Input button on the track header and choose Send  MIDI Input Thru to MIDI 
Output from the menu if you want to echo   notes from the MIDI controller to the track's MIDI device or soft 
synth   for monitoring during MIDI recording.

 1. From the Options menu, choose   Preferences.   The Preferences dialog is displayed.
 2. Select the MIDI tab.
 3. Select at least one port   in each of the Make these devices available for MIDI track playback and Generate 

MIDI Clock and in the Make  these devices available for MIDI input boxes.
 4. Right-click the MIDI  Thru From text box for any selected output port and choose the   input port from which you 

want to receive MIDI thru data from the shortcut   menu.

Only ports that are selected in the Make these devices available  for MIDI input box will be available.

 5. If you want a MIDI   input port to send MIDI thru data to multiple output ports, right-click   the MIDI Thru To   text 
box for any selected input port and choose the ports to which you   want to send MIDI thru data from the 
shortcut menu.

Only ports that are selected in the Make theses devices available for MIDI track playback  and Generate 
MIDI Clock box will be available.

Softsynths included with ACID Music Studio

DN-e1
The DN-e1 is a virtual analog synthesizer that is suitable for all conceivable styles and application areas. It works in a 
subtractive way, i. e. first a basic sound is selected that is then filtered with the aid of a filter.
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Sound selection

Select the sounds and sound configurations at the top.
Bank: Here you can switch between three banks with various complete configurations.
Category: Here you can select a sound category.
Rndm (Random): Here you can activate a random selection of the parameter settings in order to experiment with the 
sound.
Patches/Name: Here you can select a sound that will then be modulated.

Output

The end of the signal chain is edited in this area.
Volume: Sets the total volume.
Voices: Controls the number of voices generated (polyphony).
Glide: Controls the glide function. You can access sliding pitch transitions between the individual notes.
Unisono: Switches to monophonic, but generates a number of slightly varied voices for "thickening” the sound.

Filter en.

In this area the filter curve used to filter the output sound is modulated.
Attack: Sets the time duration that the filter curve requires in order to reach its maximum.
Decay: Sets the time duration that the filter curve requires in order to go from its maximum to the sustain level.
Sustain: Here you can set the degree of filtering that should take place after the decay phase. This filtering remains 
the same until the key on the keyboard is released; in contrast to the other three parameters, it does not also control a 
time duration, but a specific level.
Release: Sets the time duration which the filter curve requires in order to go from the sustain level to the zero point 
after the key is released.

Reverb

An additional reverb effect can be set here.
Type: Sets the sound coloration of the reverb effect.
Pre Del: Sets the time that passes between the direct signal and the arrival of the early reflections. The reverberation 
time comes only after this time span.
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Damp: The corner frequency at which a damping of the highs should be implemented for each delay is defined here. 
This is useful, for  example, for making the delays reverberate more naturally or for creating special effects 
(reggae/dub-style effects).
Decay: Sets the complete reverb time.
Low Cut: Sets the filter frequency of a high-pass filter. All signal components below this frequency will be filtered 
out.
Amount: Here you can set the mixing ratio between the effect and the pure sound, i.e. the original sound without any 
effect applied.

Delay

An additional echo effect can be set here.
Type: Different types of echo can be selected here: normal echo, ping-pong echo (where the sound swings through 
the stereo panorama) and various other forms.
Color: Sets the sound coloration of the echo.
Feedback: Sets the number of echo repeats.
L Rate: Sets the time duration for individual echoes for the left channel.
R Rate: Sets the time duration for individual echoes for the right channel.
Amount: Sets the mixing ratio between the effect and the pure sound, that is to say, the original sound without any 
effect applied.

MAGIX Vita
MAGIX Vita Synthesizer specializes on realistic playback of "real" instruments for which it uses sampling 
technology. This means that short samples of real instruments in different pitches, playing techniques and volumes 
are used, combined, and played again at the correct pitch.

The Vita interface
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1. Layer selection/Peak meter: The Vita sounds, also known as layers, can be selected here using the arrows. Right-
clicking on the display opens the layer menu.
2. Main parameter: Here the volume, panorama position, pitch characteristics ("transpose") and the fundamental 
frequency ("master tune") can be set.
3. AMP: This is the volume envelope. With this you can control the timing of a sound's volume. A(ttack) stands for 
the volume increase at the start, D(ecay) for the length of time the decrease in volume takes on a section set with S
(ustain) at the maximum volume. R(elease) is the length of time it takes for the sound to fade out.

4. FILTER: Here you can switch on a filter which influences the sound. With FILTER TYPE you can select the kind of 
filter you want to use. Cutoff controls the filter frequency and "Resonance" controls the strength of the emphasized 
filter frequency. "Velocity" indicates how much the velocity influences the filter frequency, using "Gain" you can 
balance the volume. The filter envelope (ADSR slider) influences the filter frequency depending on the time.
5. DELAY: Here you can switch on an echo effect. "Time" controls the delay time and "Level" controls the strength of 
the echo sound.
6. REVERB: Here you can switch on a reverb effect. "Time" controls the delay time and "Level" controls the strength 
of the echo sound.
7. TUBE DISTORTION: This is a tube distortion effect like those found in guitar amplifiers. This is normally used for 
electric guitars but you can also get creative and use it for other things. "Drive" controls the strength of the distortion. 
"High-cut" and "Low-cut" filter out the high and low frequencies.
8. VALUE DISPLAY: This always displays the exact values of the parameter that was just adjusted.
9. DYNAMIC RANGE: Usually the relationship between the created volume and the MIDI velocity is proportional. 
You can compensate for the fact that some MIDI keyboards need to be pressed forcefully to produce loud sounds 
(or conversely produce loud sounds with a soft touch) using the "MIDI Input Curve". Using "Dynamic and 
"Dynamic curve" you can manipulate the dynamics of a sound, i.e. the relationship between the loudest and quietest 
sounds.
10. Voices: Here you can control the number of voices played simultaneously. If notes are no longer played, as is the 
case in some fast passages, you can increase the number of voices at the expense of performance.
11. Keyboard: Here you can preview the Vita sounds.  12. lets you hide the keyboard.

Additional Vita Solo Instruments
ACID Music Studio includes some more synthesizers that are based on the VITA Sampling engine. The Vita Solo 
Instruments are special sample players with customized interfaces for each of the instruments.
The basic controls are identical for all these Vita Solo Instruments. 

One click on the arrow symbol opens a drop-out menu where you can determine the general sound of the 
instrument. If "ECO" appears in the description, this refers to especially performance-improving settings which may 
not sound so "smooth". In addition, you can also save your settings and add them to a favorites list for later use. 
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You can control the overall volume of the instrument. 

You can turn the instrument keyboard on or off with this controller. 
The samplers are enhanced by effects like Chorus or Reverb, special tailored for the specific instrument. If you would 
like to know which result certain effects have, you will find explanations in the Essential FX help files.

Articulation
Some Vita Solo Instruments have a special feature: In the bass octave (on the keyboard (C0-H0), there are special 
notes, which let you control the playing style (articulation). An alternative sample set is loaded, which lets, for 
instance, a bass guitar sound even more realistic using various playing styles such as note bending and flageolet.
Articulation is switched on and continues until normal articulation is switched on again through the corresponding 
note.  

On the keyboard at the bottom of the synthesizer interface are the buttons to switch articulation, displayed in a 
different color. In the Piano Roll Editor appearing above, you can see a practical application of articulation. The last 
notes of the bar will be played back with varying articulation. At the end of the bar, normal articulation will be 
switched on again through C2.
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Automation of Vita and Vita Solo instruments
In ACID Music Studio it is possible to automate Vita Solo instruments. This allows you to change a specific value 
during playback using an Automation Envelope. See "Automating VSTi Parameters" on page 219 for more 
Information. 

Automate Vita Solo Instruments via MIDI Controller

 1. Right-click on a  knob knob or fader in the instruments user interface. This opens a context menu where you can 
select the MIDI controller number to use for this knob. 

 2. Select the controller from the midi ctrl # sub menu. A few standard controller settings are already preset, e.g. 7 
for volume, 10 for panorama, 91 for reverb. You recognize already used controllers by the asterisk behind the 
number.

 3. If you have a keyboard or MIDI controller connected to your computer there is also another way: Chose midi 
learn and move a knob at your keyboard or controller, ACID Music Studio listens for the controller number the 
knob is generating and assigns the number to the knob on screen.

 4. Now you can automate the instrument by using an MIDI controller envelope (see "MIDI Track Envelopes and 
Keyframes" on page 138

Automate Vita Solo Instruments via VST Parameter

You can also automate the instruments via VST parameters. The advantage: Its resolution is not limited to the 127 
values of the MIDI controller. Unless the most other VSTi which offer their parameters with a descriptive name 
directly, the VITA instruments offer 127 numbered parameters for this purpose, which you must first assign to the 
VST controls to be available for automation. This is because all the very different VITA Instruments use the same 
engine so it makes no sense to give the parameters dedicated names. And you can assign the parameters you really 
need to the first couple of parameter numbers and don't have to find them in a sometimes very long list of 
parameters.

 1. Right-click on a  knob knob or fader in the instruments user interface.
 2. In the context menu, choose a host controller number from the host ctrl # sub menu.
 3. Now you can insert an envelope for this numbered parameter in the soft synth bus track to automate this 

parameter. See "Automating VSTi Parameters" on page 219 for more information.

With host learn you can  also do the mapping the other way around: First insert an envelope for a parameter number 
and then do the mapping to the actual control: 

 1. Insert an envelope via the Soft Synth Parameter Automation window.
 2. Right click the control in the synths user interface and choose host learn.
 3. Move the envelope in the timeline by clicking and dragging the single default envelope point with the mouse. 

The synths parameter is now linked to the according host ctrl parameter number.
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Vita Sampler
The Vita Sampler is a simple sampler, which you can use to play sections of samples via MIDI, for example 
individual drum sounds from drum loops. This function as a so-called "beat slicer", which means that it 
automatically finds the individual elements in samples (e.g. kick drum in a drum loop), which in turn are available as 
destinations for eight drum pads.

Wave form: Your own samples in the file formats .wav. .aiff, .ogg, and .mp3 may be loaded into the Vita 
Sampler via drag & drop simply by dragging them there. In this case, the sample segments ("slices") are 
detected automatically and marked in the sample.

Assigned slice: Of all the detected slices, 8 are selected randomly, assigned to the drum pads, and specified 
as random playback modes (5,6).

.Drum pads: Slices may be played using the mouse with the drum pads and via MIDI with the white buttons 
starting at C3 (MIDI note number 60, 62, 64, etc.)

Selected slice: Slices may be selected for advanced listening by clicking them. The associated drum pad is 
also displayed at the same time.
To change the slice assignment for this drum pad, drag the colored frame around another wave form slice.
To change the size of the assigned slice, drag the edges of the frame using the round handles. The edges will 
snap onto the specified slice borders. Pressing the ALT key shuts off the snapping grid. This enables 
imprecise positions in the slice detection to be corrected.

Note: Slices may not be assigned to multiple drum pads, which is why sometimes, the selection cannot 
be dragged as desired. 

Clicking the symbol changes the playback direction of the slice:

Forward

Reverse
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Clicking the symbol changes the playback mode of the slice:

No loop.  The slice is played back for as long as the drum pad or the MIDI note is active, but only 
until the end.

Loop. The slice is played back in a loop for as long as the MIDI note is active.

One shot. The slice is played back independently of the length of the MIDI note until the end

Lock pad: Lock the pad out of the random function (see below).

Not locked

Locked

Random: A new, random selection of slices is added to the drum pads and random playback modes (5,6) 
are assigned. Locked pads are not included. You can use the random function repeatedly to discard 
unwanted results and keep the good ones.

Zoom: The zoom buttons enable you to enlarge the wave form display, to recognize more details,which is 
practical for correctly slice edges with the ALT button (see above)

Using ReWire
Using ReWire, you can stream audio between applications in real time,   synchronize playback, and use either 
application's transport controls   to control playback in the synchronized applications. The cursor position   and loop 
region will be shared in the synchronized applications.
ACID software can be used as a ReWire mixer (host) or a ReWire device   (client):

 l When ACID   software is used as a ReWire mixer, a soft synth bus in the ACID mixer   connects the ReWire 
device application with the ACID audio engine. During   playback, song position data is sent from the ACID 
window to the ReWire   device application, and the device will send its audio data back to the   ACID soft synth 
bus control. 

 l When ACID   software is used as a ReWire device, the ReWire mixer sends song position   data to the ACID 
project, and ACID software sends its audio to the ReWire   mixer. ACID acts as a ReWire 1.0 device.

Using ACID Software as a ReWire Mixer
When you add a ReWire soft synth bus to the ACID mixer, the bus connects   the ReWire device application with the 
ACID audio engine. During playback,   song position data is sent from the ACID window to the ReWire device 
application,   and the device will send its audio data back to the ACID soft synth bus   control. To see an example, click 
.
As a ReWire mixer, ACID software supports ReWire 2.0, which allows you   to use a ReWire device application as a 
soft synth where you can route   MIDI tracks.

The   ReWire data will not be included in playback or rendering if the device   application is not open.

For more information about using your ReWire device application, please   refer to that application's documentation.
If   you receive an error that a MIDI port is currently in use when you try   to play back your project, check the MIDI   
tab in the Preferences dialog and verify that your ReWire device applications   are not trying to access the same 
MIDI ports ACID software is configured   to use.
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Add a ReWire soft synth   bus to your project             

 1. From the Insert menu, choose   Soft Synth,   or click the Insert  Soft Synth  button in the Mixing Console 

window. The Soft Synth   Chooser is displayed.
 2. Select the ReWire Devices   tab in the Soft Synth Chooser dialog.
 3. Select a ReWire device application   and audio output from the list and click the OK  button.

If the ReWire device   application you want to use isn't displayed in the Soft Synth Chooser   dialog, you can 
use the Plug-In Manager   window to  re-enable the plug-in. 

In the Plug-In Manager, navigate to the ReWire  Devices > Ignored folder to view the ReWire devices 
you've excluded.   Right-click a plug-in and choose Ignore  from the shortcut menu to clear the check mark 
and re-enable the   plug-in.

The soft   synth channel strip is added to the Mixing Console window using the   default settings, and ACID 
software attempts to start the device. If the   ReWire device application does not open, you can start it manually.

 4. Use the ReWire device   application's interface to open a project and adjust its settings.

Start or stop a ReWire device application             

When you add a ReWire soft synth bus to your project, ACID   software attempts to start the device. You can also do 
any of the following   to start the application:

 l Double-click the soft synth   bus control label .

 l Right-click the soft synth   bus control and choose Open  ReWire Device Application from the shortcut menu.
 l Start the application manually   (some devices cannot be started by a ReWire mixer).

To stop a ReWire device, close the device application.

Start playback of the ACID project and synchronized   ReWire devices             

ReWire device and mixer applications communicate song position   data back and forth with sample-level accuracy.
Position the cursor (or create a loop region) in the ACID   timeline to indicate where you want playback to begin, and 
then click   Play . For more information   about project playback, see "Listening to Your Creation" on page 28.

Route a MIDI track to a port in a ReWire 2.0   device             

Routing MIDI tracks uses the same process whether you're   routing to a VST instrument, ReWire 2.0 device, or MIDI   
port. For more information, see "Routing Tracks to Soft Synths or MIDI Devices" on page 216.

MIDI tracks cannot   be routed to a ReWire 1.0 device. Check your ReWire device application's   documentation to 
determine which version of ReWire it supports.

 Display the Soft Synth   Properties window for a ReWire 2.0 device             

When you add a ReWire 2.0 synth's master bus as a soft synth   bus, you can double-click the bus control label  

to display the Soft Synth Properties window,   where you can view the device's MIDI ports, start the application, or   
lock MIDI ports.
Click the Open  ReWire Device Application button  to start the device (some synths cannot be started   by a 
ReWire mixer application).
Select the Lock  MIDI Port Configuration button  to lock MIDI ports so your ACID project does   not lose port 
assignments due to dynamic changes from ReWire devices.
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Using ACID Software as a ReWire Device
When ACID software is used as a ReWire device, the output from your   ACID mixer is output to a ReWire mixer 
application.
After you add the ACID synth to a ReWire mixer application, the mixer   application sends song position data to the 
ACID synth, which sends its   audio back to the ReWire mixer. 
ACID acts as a ReWire 1.0 device.

Notes:

 l You must   start your ReWire mixer application before starting ACID software.
 l When ACID   software is connected to a ReWire mixer application, the ACID project   will automatically use the 

mixer application's bit depth and sample rate.   Saving the ACID project in ReWire mode will not overwrite the 
project's   original bit depth and sample rate.

 l If a ReWire   mixer application starts ACID software, that ACID window will start in   ReWire mode and cannot be 
switched from ReWire mode. If a ReWire mixer   connects to an existing ACID window, that window will run in 
ReWire mode,   and you can switch out of ReWire mode if necessary. If you exit that instance   of the software 
and start ACID software again, the new instance will start   in ReWire mode, and you can switch out of ReWire 
mode if necessary. You   can switch out of ReWire mode by choosing a new setting from the Audio device type 
drop-down   list on the Audio Device   tab of the Preferences dialog.

 l The ACID   Tempo control   below the track list is not available in ReWire Device mode. Tempo information   is 
provided by the ReWire mixer application.

 l If a ReWire   mixer application includes a tempo map, video and long one-shot tracks   in your ACID project will 
lose synchronization with looped material. Using   ACID software as a ReWire mixer   (or in an ACID project 
without ReWire) will resolve the issue.

 l Any effects   chain that includes non-in-place   plug-ins will be automatically bypassed to prevent synchronization 
problems   with the ReWire mixer application. The effects chain icon will be displayed   as a . Apply the plug-

ins within the ReWire mixer application.
 l Before   rendering from a ReWire mixer application, turn off the ACID metronome,   or the metronome will be 

included in the rendered output.
 l If the   mixer has a Render in  Real-Time option, this mode may reduce the possibility of drop-outs   from the 

ACID ReWire device while rendering.

Setup information follows for several common ReWire mixer applications.   This information is intended to help 
you get up and running with ACID   software as a ReWire device. For the most up-to-date information about   
using each ReWire mixer application, please refer to the manufacturer's   documentation.

Use the ACID ReWire device with Steinberg Nuendo or Cubase

 1. Start Nuendo or Cubase software.
 2. Open a project.
 3. Add a ReWire channel to the   project:

 a. From the Devices menu, choose ACID Music Studio11. A dialog   is displayed to list the available ACID 
mixer outputs.

 b. Select the Power   button for each ACID mixer output you want to send to Nuendo.
Use the Advanced   Audio Configuration dialog for the ReWire Device Driver to specify   the number of 
stereo and mono ports the ACID ReWire device will expose   to the ReWire mixer.

 4. Start ACID software. 

 The software will detect that Nuendo is running as a ReWire mixer and   will start in ReWire device mode.
 5. Open an ACID project.
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 6. Use the ACID or Nuendo/Cubase   transport controls to start playback.

 Your ACID project will follow playback position and tempo information   from the Nuendo/Cubase project.

Use the ACID ReWire device with Tracktion

 1. Start Tracktion software.
 2. Verify that ReWire support   is enabled:

 a. Select the Settings tab at the top   of the Tracktion window.
 b. Click the plugins   heading on the left side of the tab.
 c. Ensure the enable  rewire radio button is selected.

 3. Open a project.
 4. Add a ReWire filter to the   project:

 a. Drag the new filter button (at the   top of the Tracktion window) to a filter box on the right side of a track.   A 
menu is displayed to list the available filters.

 b. Click ReWire Device heading on the   left side of the tab.

 The ReWire filter is added to your track.
 5. Use the ReWire Filter tab   at the bottom of the Tracktion window to set up your ReWire filter:

 a. Click the choose  device button and choose ACID Music Studio11from the menu.
 b. Use the output  channels to use controls to choose which ACID mixer outputs will   be sent to Tracktion. 

Click ReWire  Device heading on the left side of the tab.
 6. Use the Advanced   Audio Configuration dialog for the ReWire Device Driver to specify   the number of stereo 

and mono ports the ACID ReWire device will expose   to the ReWire mixer.

 7. Leave the input  channels for MIDI controls at their default settings. The ACID Music Studio11 ReWire device 
will not accept MIDI input.

 8. Click the launch  editor button in the ReWire Filter tab to start ACID software   in ReWire device mode.
 9. Switch to the ACID window   and open the project you want to use.

 10. Switch to the Tracktion window   and use the Tracktion track controls to adjust the levels of the ACID   mixer 
outputs.

 11. You can use Tracktion or ACID   transport controls to start and stop playback or set a loop region.

 Your ACID project will follow playback position and tempo information   from the Tracktion project.

Use the ACID ReWire device with Cakewalk Sonar

 1. Start Sonar software.
 2. From the Sonar Insert   menu, choose ReWire Device,   and then choose ACID Music Studio11 from the 

submenu. The Insert DXi Synth Options dialog is   displayed. 
 3. In the Insert DXi Synth Options dialog,   select the appropriate check boxes to indicate how you want to use the   

ACID Music Studio ReWire device in your Sonar project:

Item Description

Create These Tracks:   MIDI 
Source Output

This check box has no effect because the   ACID ReWire device does not send 
MIDI data to the ReWire mixer.

Create These Tracks:   First 
Synth Output (Audio)

Select this check box if you want to add   a single audio track to your Sonar 
project that contains the master outputs   from the ACID mixer.

Create These Tracks:   All Select this check box if you want to add   a separate audio track to your Sonar 
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Synth Outputs (Audio) project for each of the outputs from   the ACID mixer.

Open These Windows: 
Synth   Property Page

Select this check box if you want to start   ACID software when you close the 
dialog.

Open These Windows: 
Synth   Rack View

Select this check box if you want to open   the Sonar Synth Rack View window 
when you close the dialog.

 4. Use the Advanced   Audio Configuration dialog for the ReWire Device Driver to specify   the number of stereo 
and mono ports the ACID ReWire device will expose   to the ReWire mixer.

 5. Click the OK   button. 

 Sonar adds ACID ReWire device tracks to your Sonar project and starts   ACID software in ReWire device mode.
 6. Switch to the ACID window   and open the project you want to use.
 7. Switch to the Sonar window   and expand the ACID ReWire device tracks in your Sonar project.
 8. Use the ACID ReWire device   tracks to configure the ACID ReWire device:

 a. Click the Output  To drop-down list and choose the output where you want to send   the ACID ReWire 
device track output. 

 b. Use the track FX controls to add effects   to the ACID sequencer tracks.
 c. Use the track volume controls to adjust   the level of the ACID project.

 9. You can use Sonar or ACID   transport controls to start and stop playback or set a loop region. 

 Your ACID project will follow playback position and tempo information   from the Sonar project.

Use the ACID ReWire device with Ableton Live

 1. Start Ableton Live software.
 2. Click the Session  View button to switch to session view.
 3. Add an audio track to your   Live project. This track will receive the audio output from the ACID sequencer.
 4. Click the Show/Hide  In/Out Section button to display the in/out section in the Live   mixer.
 5. Use the Audio  From controls in the in/out section on the new track to configure   the ACID ReWire device:

 a. Click the Input Type drop-down list and choose ACID Music Studio 11.
 b. Click the Input Channel drop-down list and choose which ACID mixer outputs will   be sent to the Live 

track.
 6. Use the Advanced   Audio Configuration dialog for the ReWire Device Driver to specify   the number of stereo 

and mono ports the ACID ReWire device will expose   to the ReWire mixer.

 7. Start ACID software. 

 The software will detect that Ableton Live is running as a ReWire mixer   and will start in ReWire device mode.
 8. Open an ACID project.
 9. Switch to the Live window   and use the Live track controls to adjust the levels of the ACID mixer   outputs.

 10. Use the Live transport controls   to start playback.

 Your ACID project will follow playback position and tempo information   from the Live project.

Use the ACID ReWire device with Orion version 5

 1. Start Orion software.
 2. From the Orion Insert menu,   choose ReWire,   and then choose ACID Music Studio11 from the submenu. 

 Orion starts ACID software in ReWire device mode and adds the ACID   mixer outputs to the Orion Mixer 
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window.
Use the Advanced   Audio Configuration dialog for the ReWire Device Driver to specify   the number of stereo 
and mono ports the ACID ReWire device will expose   to the ReWire mixer.

 3. Switch to the ACID window   and open the project you want to use.
 4. Switch to the Orion 5.0 window   and use the Orion Mixer window to control the levels of the ACID mixer   

outputs.
 5. Use Orion 5.0 to start and   stop playback or set a loop region (Orion software ignores playback, tempo,   and loop 

region requests from ReWire devices).

 Your ACID project will follow playback position and tempo information   from the Orion project.

Use the ACID ReWire device with ProTools LE or TDM systems

 1. Start ProTools software.
 2. Create a new auxiliary input   track:

 a. From the ProTools File menu, choose   New Track. The   New Track dialog is displayed.
 b. Choose Aux.  Input from the Track Type drop-down list. (On ProTools TDM systems, choose Audio  

Track.)
 c. Click the Create   button.

 3. In the Mix window, click the   Inserts button  on the auxiliary input or audio track, choose Plug-In   from the menu, 
choose Instrument   from the submenu, and then choose ACID Music Studio11 from the submenu. On ProTools 
TDM systems, the ReWire RTAS   plug-in can only be added to an audio track.

 ProTools starts ACID software in ReWire device mode and adds the   ACID Music Studio ReWire device as an 
input on the ProTools Mix window.

 4. Select the ACID Music Studio ReWire   device on the ProTools Mix window. The RTAS Plug-In dialog displays 
<no output> for   the ACID Music Studio ReWire device. Click the button and choose which ACID   mixer 
outputs will be sent to the ProTools track.

Use the Advanced   Audio Configuration dialog for the ReWire Device Driver to specify   the number of stereo 
and mono ports the ACID ReWire device will expose   to the ReWire mixer.

 5. Switch to the ACID window   and open the project you want to use.
 6. Switch to the ProTools window   and use the Mix window to control the levels of the ACID mixer outputs.
 7. You can use ProTools or ACID   transport controls to start and stop playback or set a loop region. 

 Your ACID project will follow playback position and tempo information   from the ProTools project.

Inline MIDI Editing
Click the Enable Inline  MIDI Editing button  to edit MIDI events directly on the timeline. In this mode, you   can 

edit existing MIDI data or create new clips by drawing and erasing   notes in a piano roll or drum grid view.
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A piano roll   allows you to edit MIDI 
notes for most patches.

A drum grid   allows you to edit 
MIDI notes 
for soft synths that have drum 
maps defined.

MIDI notes   are unavailable for frozen 
MIDI   tracks.

When you edit a MIDI event, all events that use the same clip   will be updated. If you want to edit a single event, 
right-click the event   and choose Copy to New  Clip from the shortcut menu.
When a MIDI clip's key is set on the Clip Pool tab of the MIDI   Track Properties window, the project key and key 
change markers are   applied to MIDI clips, and the MIDI event data will display notes as WYSIWYH   (what you see is 
what you hear).
When a MIDI clip's key is set to None, the project key and key change markers are   not applied to MIDI clips.         
You can also edit MIDI clips using the Piano Roll or List Editor tabs   in the Clip Properties   window.

Tips:

 l Hold Ctrl+Shift   while double-clicking a MIDI event to enter inline MIDI editing mode.
 l While in   inline MIDI editing mode, drag over a blank area of the timeline with   the Draw tool  to create a new 

clip and draw an empty event. 
 l While in   inline MIDI editing mode, you can hover over a note or velocity stem to   view its value in the bottom-

right corner of the timeline:

 l If you want   to move a MIDI event while in inline MIDI editing mode, drag the top of   the event with the Draw 
 or Selection  tool:

Choose a drum map or kit for a track
MIDI tracks can display a piano roll or a drum grid. 

Choosing a drum map or kit

 1. Click the Program  button  on the track header.

 2. Choose Drum Maps from the menu, and then choose Select  Drum Map from the submenu. The Output 
Settings page of the Track   Properties window is displayed.

 3. Choose the drum map or kit   you want to use.

Displaying the piano roll

If your track is routed to a   MIDI device or VSTi soft synth, you can switch from a drum grid view to   the piano roll. 
Click the Program button , choose Drum Maps, and then choose None.
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Navigate the piano roll or drum grid
In inline MIDI editing mode, adjusting the height of the   track will allow you to see more or less of the piano roll or 
drum grid.   After you set the height of the track, you can use the following methods   to navigate.

Scroll vertically

Perform any of the following   actions to scroll vertically within a track:

 l Use the scroll buttons at the left edge of the track   to scroll up or down:

Piano roll Drum grid

 l With the Draw  or Selection  tool, hover over the timeline and hold Ctrl   while rolling the mouse wheel 

forward or back.
 l Hold Ctrl while dragging the keyboard/drum   list up or down.
 l Hover over the keyboard/drum list   and roll the mouse wheel forward or back.

Zoom note height

Perform either of the following   actions to zoom note height:

 l With the Draw  or Selection  tool, hover over the timeline and hold Ctrl+Alt   while rolling the mouse 

wheel forward or back.
 l Hover over the keyboard or drum grid   and hold Shift while rolling the mouse wheel forward or back.

Zoom note width

Note width is based on the horizontal   zoom level of the timeline. Use the zoom controls   in the lower-right corner of 
the timeline (or hover over the timeline   and roll the mouse wheel forward or back) to zoom in or out.

Audition notes with the keyboard/drum grid
You can use the keyboard/drum grid between the track header   and timeline to audition the track's MIDI output or 
record   MIDI. When you click the keys, the note is played using the appropriate   program at the cursor position.
These buttons are velocity sensitive: clicking toward the   right side of a button plays the note with a higher velocity 
setting than   clicking toward the left side.

Select notes
Selecting individual notes

Click individual notes with the   Draw  or Selection  tool to select them. Hold Ctrl while clicking to add   or 

remove notes from the selection.

238

www.magix-audio.com



Selecting groups of notes

Drag with the Selection tool    to draw selection boxes around the   notes you want to include. The Selection tool 

can draw three types of   selection boxes:

Free  
Selection

The default behavior of the tool:                         
Click to select individual notes (hold   Shift or Ctrl to select multiple notes).                         
Drag to draw   a rectangular region that begins where you start drawing and ends where   you release 
the mouse button. All notes inside the region will be selected.   This method is good for selecting a 
group of notes that are close together.                         

Vertical Can be used to easily select all notes that   occur within a time range. The vertical selection box 
automatically selects   all of the notes between your first mouse click and where you draw the   
selection box; even notes that are not visible at the current magnification   are selected.

Horizontal Can be used to easily select all notes on   a single or multiple adjacent rows. The horizontal selection 
box automatically   selects all notes on a row that is touched by the selection box; even   notes that are 
not visible at the current magnification are selected.

To change the   type of selection box you are using, right-click the mouse while holding   down the left mouse button. 
Clicking the right mouse button will toggle   through the three types of selection boxes.

Add or delete notes             

 1. Click the Enable  Inline MIDI Editing button    .

 2. 

Use the scroll buttons at   the left edge of the track to navigate the piano roll/drum grid:

 
Drag the bottom border of the track header   to increase the height of the track.

 3. Select an editing tool.

Tool Description

Draw Allows you to insert,   edit, select, and move notes.

In drum-grid mode, the Draw and Paint tools   both draw fixed-length note events.

Paint Allows you to insert notes of a   specific length.                                 
The Paint tool is different from the Draw   tool in that it can cross note row boundaries. Use the 
Paint tool to add   a random element to your ACID projects.

In drum-grid mode, the Draw and Paint   tools both draw fixed-length note events.                                 

Using the Paint tool
 a. Click the down arrow next to the Paint tool button and choose a note length           from the 

menu.
 b. Click the Paint tool button to select the tool. The Paint tool is selected,           and notes will be 

painted using the selected note length.
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Right-click   with the Paint tool to erase notes.

Erase Allows   you to remove existing notes.                                 

 4. Inside an event, drag in   the row for the pitch you want to create to create a new note, or click   an existing note 
with the Erase tool  to remove   it.

 If you draw or paint notes beyond the event edge, the event is automatically   extended.

 Hold Shift while dragging to override horizontal snapping.

In inline MIDI editing mode, drag in the top   portion of the track to create a new event using the active clip:

Cut, copy, and paste notes

 1. Select the notes you want   to cut or copy. 

 Click notes with the Draw  or Selection  tool to select them. Hold Ctrl while clicking   to add or remove 

notes from the selection. You can also drag with the   Selection tool  to draw selection boxes   around the 

notes you want to select.
 2. Click the Cut   button  to remove the notes from the event and move them to the clipboard,   or click the Copy   

button  to duplicate the events on the clipboard.

 3. Click to position the cursor   where you want to paste the notes in the timeline and click the Paste button .   

Notes will always be pasted into the same row from which they were cut   or copied.

Tips:

 l Hold   Ctrl while dragging MIDI to create copies of the selected MIDI notes at   the location where you drop them.
 l From   the Edit menu, choose Paste  Repeat if you want to paste multiple copies of the clipboard at   the cursor 

position.

Edit note position             

 1. Click the Enable  Inline MIDI Editing button    .

 2. Use the scroll buttons at   the left edge of the track to navigate the piano roll/drum grid:
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 3. Select the notes you want   to edit:
 l Click a note with the Draw tool    to select it. You   can hold Ctrl while clicking to select multiple notes.

or——
 l Use the Selection tool    to select multiple events by clicking and dragging to create a selection   box 

around the notes you want to edit. 
 4. Drag notes left   or right to change their position on the timeline, or drag up or down   to assign a note to a 

different pitch. 
 

Tips:

 l Hold   Shift while dragging to override horizontal snapping.
 l Hold   Alt while dragging to constrain to horizontal or vertical movement.

Edit note duration             

 1. Click the Enable  Inline MIDI Editing button    .

 2. Select the Draw tool .

 3. Use the scroll buttons at   the left edge of the track to navigate the piano roll/drum grid:

 4. Drag either edge of a note.   The edge of the note moves, changing its duration:

 Hold Shift while dragging to override horizontal snapping.

Edit note velocity
Note velocity is represented in the timeline by velocity   stems. To show or hide velocity stems in inline MIDI editing 
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mode, choose   Show Inline MIDI Editing   from the View menu, and then choose Show Note-On Velocities orShow 
Note-Off Velocities from the submenu.

 1. Click the Enable  Inline MIDI Editing button    .

 2. Select the Draw tool .

 3. If velocity stems aren't   already displayed, choose Show Inline MIDI Editing from the View menu, and then 
choose Show Note-On Velocities or Show Note-Off Velocities from the submenu.

Press F while in inline   MIDI editing mode to toggle the display of velocity stems.

 4. Drag the   top of the stem (  for note-on velocity or  for note-off velocity) up to increase the   note's velocity, or 
drag down to decrease velocity. If multiple notes   are selected, the velocities of all selected notes are adjusted at 
the   same time.

Tips:

 l Double-click   the top of a velocity stem to set the note's velocity to the default value   (64).
 l Right-click   a note and choose Velocity   from the shortcut menu. You can then choose a command from the 

submenu   to set the note-on velocity.
 l If multiple   notes are selected, you can edit the velocities of all selected notes   simultaneously.

MIDI Track Controls
The controls in the track list allow you to adjust track volume, panning,   and MIDI controller values.

Tips:

 l MIDI track   controls are duplicated on MIDI   track channel strips in the Mixing Console window.
 l To move   faders and sliders in fine increments, hold Ctrl while dragging the control.

Change a track's color             
Right-click the track   header, choose Color   from the submenu, and then choose the color you want to use to display   
the track and MIDI data on the timeline.
If you've changed the   color of any of a track's clips,   changing the track color will not update the color of those clips.
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Change a track's height             
Drag a track's bottom   border to set its height. If you want to set a track's height as the default   height for new tracks, 
right-click within the track list and choose Set Default Track Properties   from the shortcut menu.
Click Minimize  to minimize a track vertically.
Click Maximize    to zoom in vertically so a track fills the track view.
After minimizing or   maximizing a track, click the Minimize or Maximize button again to return a track to its previous 
height.

Track height keyboard shortcuts

 l Press Ctrl+Shift+Up   Arrow or Down Arrow to change the height of all tracks at once.
 l Press `   to minimize all tracks. Press again to restore tracks to their previous   height.
 l Press Ctrl+`   to return all tracks to the default height.

Rename a track             

 1. Double-click the track name   and type a new name.
 2. Press Enter   to save the name.

Pitch shift a track             
Right-click a track header, choose Pitch  Shift Track from the shortcut menu, and then choose a command from   the 
submenu to change the pitch of all events on a track. The event-specific   pitch shift is calculated after the project key 
and the track’s pitch   shift.

When a track is selected,   press + and - on the numeric keypad to change track pitch. 

Arm a track for recording             
Click the Arm  for Record button  on a MIDI track to prepare it for recording.

When you click the Record   button  on the main   transport bar, all armed MIDI tracks will begin recording.

For more information about recording MIDI, see "Recording MIDI" on page 113.

Freeze a track             
Click the Toggle  Freeze button    on a MIDI track to convert a MIDI track to .wav file, effectively taking   your soft 

synths offline and conserving processing and disk resources.
For more information about freezing MIDI tracks, please   see "Freezing MIDI Tracks" on page 249.

Mute a track             
Click the Mute   button  to prevent   a track from being played in the mix. Click the Mute   button on additional tracks 

to add them to the mute group. To unmute   a track, click the Mute   button again.

Muting or unmuting a track

 1. Deselect the Automation  Settings button  to toggle trim mode.

 2. Click the Mute   button .
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When you have a group   of tracks muted, hold Ctrl while clicking the Mute   button on an unmuted track to 
remove all other tracks from the mute group.   Hold Ctrl while clicking the Mute button on a muted track to reset 
all Mute   buttons.

Adjusting mute automation

When you select the Automation Settings button , the Mute   button is displayed as , and you can use the 

button to edit mute automation.

Solo a track             
Click the Solo button  to mute  all unselected tracks. Click the Solo   button on additional tracks to add them to the 

solo group. To remove a   track from the solo group, click its Solo   button again.
Hold Ctrl while clicking   a Solo   button to solo a single track and remove all other tracks from the solo   group.

Monitor track output levels             
During playback, a meter is displayed in the track header   to monitor note-on velocities. 

Horizontal meters

Vertical meters

Right-click the meters and choose a command from the shortcut   menu to adjust the display of the meters. This 
shortcut menu allows you   to set the meter's response, hold peaks and valleys, toggle vertical display,   or turn output 
meters off.

Adjust a track's volume             
The Volume   fader in the track header can function as a trim control that adjusts   the overall volume of the track, or it 
can adjust track volume automation   settings.
If the track doesn't have a volume envelope, the fader sets   the volume of the channel (0 to 127).
If the track has a volume envelope, the fader behaves as   a trim control that is added to the volume automation   
settings so your envelope is preserved, but with a boost or cut applied.   For example, setting the trim control to -6 
has the same effect as decreasing   every envelope point by 6. The control range is -127 to 127, but the overall   volume 
of the MIDI track is bound at 0 and 127.

When adjusting the mix of your tracks, remember to   look at the meters on the Mixing Console.   Because you are 
adding the volumes of all of the tracks together, it is   easy to clip the audio output. Make sure that the meters 
never display   the red Clip indication during playback.
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Not all VST instruments use standard MIDI   control mappings for volume and pan envelopes. 

You can use the Output Settings tab in the MIDI   Track Properties window to override the default envelope: 
right-click   the controller you want to use and choose Use as Track Volume or Use  as Track Pan from the 
shortcut menu.

Adjusting the volume trim level

 1. Deselect the Automation  Settings button    to toggle trim mode. 

 2. Drag the Vol  fader to control how loud a track is in the mix. 
A value of 0 means that the track is played with no boost or cut. Dragging   the fader to the left cuts the volume; 
dragging to the right boosts the   volume. 
 You can hold Ctrl while dragging a fader to adjust the setting in finer   increments, or double-click the fader to 
return it to 0   dB. If multiple tracks are selected, all selected tracks are adjusted.   

Adjusting the volume automation level

When you select the Automation  Settings button ,   the fader thumb is displayed as a , and you can use the 

control to edit volume automation.

Pan a track             
The Pan   slider in the track header can function as a trim control that adjusts   the overall position of the track in the 
stereo field, or it can adjust   track pan automation settings.
If the track doesn't have a pan envelope, the slider sets   the pan for the channel (100% L to 100% R).
If the track has a pan envelope, the slider behaves as a   trim control that is added to the pan automation   settings so 
your envelope is preserved, but with a boost or cut applied.   For example, setting the trim control to -6 has the same 
effect as decreasing   every envelope point by 6. The control range is -127 to 127, but the overall   pan value is bound at 
0 and 127.

Not all VST instruments use standard MIDI   control mappings for volume and pan envelopes. 

You can use the Output Settings tab in the MIDI   Track Properties window to override the default envelope: 
right-click   the controller you want to use and choose Use as Track Volume or Use  as Track Pan from the 
shortcut menu.

Adjusting track panning trim levels

 1. Deselect the Automation  Settings button    to toggle trim mode. 

 2. Drag the Pan   slider to control the position of the track in the stereo field: dragging   to the left will place the track 
in the left speaker more than the right,   and dragging to the right will place the track in the right speaker.

 You can hold Ctrl while dragging the slider to adjust the setting in   finer increments, or double-click the slider to 
return it to the center.

 If multiple tracks are selected, all selected tracks are adjusted.   

Adjusting the track panning automation level

When you select the Automation  Settings button ,   the Pan slider   handle is displayed as a , and you can use 

the control to edit pan automation.

Set a track's MIDI input port and channel 
Click the MIDI  Input button and choose a command from the menu to set the track's   input device and channel for 
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recording MIDI. 
If you want to select multiple input channels,   hold Ctrl and select additional channels from the MIDI  Channel 
submenu.

This track is set to accept input from any MIDI device.  

Item                         Description

Auto 
Input

Uses automatic input routing. When this command   box is selected, the focus track 
will accept input from any MIDI input   device. 

Use Auto  Input when you want to record multiple   controllers simultaneously. 
For example, with Auto  Input selected, you could record   a MIDI keyboard and 
bass pedal to a single track.                         

Input Off Turns off MIDI input to the track.

Hardware 
Input Port 
List

Displays the devices that are selected in the   Make these devices available for 
MIDI  input list on the MIDI tab of   the Preferences dialog.
Choose the specific device you want to use to   send MIDI to the track.

You must choose a specific input port to use MIDI input filters.

Soft Synth 
Input Port 
List

Displays the available soft synths in your project.   
Choose the soft   synth you want to use to send MIDI to the track. Use this setting 
to record the output of MIDI plugins like step sequencers or arpeggiators. Read 
more under "Using MIDI plugins" on page 274.      

For more information about recording MIDI, see "Recording MIDI" on page 113.

Set a track's MIDI output port and channel             
Click the MIDI  Output button on the track header and choose the soft synth or   MIDI device and channel you want to 
use to play MIDI data on the track.

This track is sending MIDI to port 1 on the DN-e1 soft synth.
Each MIDI track can be played through any VSTi or   ReWire 2.0 soft synth bus control   in the Mixing Console 
window, or external MIDI port.
For more information about routing MIDI tracks, see "Routing Tracks to Soft Synths or MIDI Devices" on page 216.
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If your track is routed to an external MIDI   port, you can load a device-specific program   map. When you use a 
program map, the MIDI Output button will display the device name, and the Program   button   will display 

the device's patches.

Set the track voice or add a program change keyframe             
The Program  button  in the track header displays the   program (voice or patch) that will be used to play MIDI data on 
the track.   You can set the voice used to play the entire track, or you can add keyframes   to add program changes.

If your track is routed to an external MIDI   port, you can load a device-specific program   map. When you use a 
program map, the MIDI Output button will display the device name, and the Program   button will display the 
device's patches.

Changing the track voice

 1. Click the Program  button .

 2. Choose a program from the   menu, or choose Select  Program Change to display the Output Settings tab in the 
MIDI   Track Properties window, where you can select a program.

 If the track does not contain program change keyframes, the selected   program is used to play the entire track. 

 If the track contains keyframes, the selected program is assigned to   the keyframe that occurs before the current 
cursor position.

Changing the program for a hardware synth

If your track is routed   to a hardware synth, there are several ways to change programs:

 l Click the Program  button  and choose Synth Control of Program Change if you want to change programs 

using   the synth's controls.
 l Click the Program button  and choose Use Program Change and Bank if you want to change programs by 

specifying   the program, MSB, and LSB values. Double-click the values in the track   header to edit them: 
.

 l If you've created a program map for   your device, click the Program button  and choose Use Device Program 

Map to return to the   device's program map. You can then choose a program by clicking the Program   button and 
choosing a program from the menu.

 For more information about creating program maps and assigning them   to hardware devices, see "Creating or 
Editing Program Maps" on page 269.

Adding a program change keyframe

 1. Click the Program button  and choose Insert Program Change Keyframe. The program change keyframe 

row is displayed   at the bottom of the track.
 2. Using the Draw    or Envelope  tool, double-click in the track's keyframe row to add a keyframe.
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 3. To edit a keyframe, double-click   it to display the Output Settings tab in the Track   Properties window, and then 
select the program you want to assign   to the keyframe.

Adjust a track's MIDI controllers             
The sliders and faders in the track header can function   as trim controls that adjust the overall setting for a continuous 
controller,   or they can adjust automation settings.
The trim level is added to the automation   settings so your controller envelope is preserved, but with an offset   
applied. For example, setting the Pan   trim control to -9% left has the same effect as moving every envelope   point 
9% to the left.

Adjusting MIDI controller trim levels

 1. Deselect the Automation  Settings button . 

 2. Choose the controller you   want to adjust:
 3. If the track's channel selector   is set to All,  you can click the  on the Volume   and Pan controls   to choose the 

channel you want to adjust.

To change a track's channel, click the MIDI Outputbutton, choose MIDI Channel   from the submenu, and 
then choose the channel you want the track to send   MIDI data (or choose All   to send on all channels).

 l Click the  on the other sliders to choose the continuous   controller you want to adjust.

 If the controller you want to adjust is not displayed in the menu,   choose Configure Controllers   from the 
menu. You can use the Output Settings tab in the Track   Properties window to configure which controllers 
are available on   the track.

 4. Drag the slider to   edit the controller value.

 You can hold Ctrl while dragging the slider to adjust the setting in   finer increments, or double-click the slider to 
return it to 0.

 If multiple tracks are selected, all selected tracks are adjusted.   

Adjusting MIDI controller automation levels

When you select the Automation  Settings button , the controller slider handles are displayed as ,   and you 

can use the controls to edit automation.
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Adjust trim levels             
The controls in the track header can function as trim controls   or automation controls for track volume, panning, and 
continuous controller   values. Adjusting the trim control affects the level of the entire track   as it did in previous 
releases of ACID software.
The trim level is added to the track   automation setting so your automation settings are preserved, but   with a boost or 
cut applied. For example, setting the trim control to   -3 dB has the same effect as decreasing every envelope point by 
3 dB.    
To adjust trim levels, deselect the Automation  Settings button . When the button is selected, the track controls 

adjust   automation settings.   

Set the track's paint clip

 1. Click the Paint  Clip Selector button in the track header. A menu is displayed to   list the track's current clips.

 2. Choose a clip from the menu.   The selected clip will be used for creating   events with the Draw  or Paint tool 

.

For more information about using clips, please see "Using Clips with Tracks" on page 70.

Freezing MIDI Tracks
Projects that use soft synths can tax your computer's processing and   disk resources. Freezing MIDI tracks allows 
you to convert each MIDI track   to a .wav file, effectively taking your soft synths offline.

MIDI Track Frozen MIDI Track

MIDI Track   Data Audio   Wave Data                     

MIDI   Messages                     

Soft   Synth                     

Audio Buffer
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Soft Synth   Bus Soft   Synth Bus                     

Sub/Master   Bus Sub/Master   Bus                     

Hardware Output Hardware   Output                     

Freeze your tracks when you're finished editing them. After freezing,   you can adjust track volume and panning only.

Notes:

 l Only tracks   that are routed   to soft synths can be frozen. Track freeze is unavailable for tracks that   are routed to 
MIDI   devices or ReWire devices,   muted, or armed for recording.

 l Any VSTi   parameter envelopes you have applied to a soft synth bus   track are also saved into the frozen .wav file.
 l The soft   synth bus in the Mixing Console window is not frozen. You can continue   to work with effects, volume, 

and panning on the soft synth bus.

If you freeze your MIDI tracks and save your project as an ACID   project with embedded media (.acd-zip), the 
frozen .wav files will be   saved with your project. You can use this method to archive a MIDI project   or share 
your project with a collaborator who doesn't have all your soft   synths.

Freeze selected tracks

 1. Select the tracks you want to freeze.
 2. Click the Freeze  Track button  on a selected track (or right-click a selected track   and choose Freeze Track   

from the shortcut menu).
The tracks are rendered to .wav format. Please note that render speed   is dependent on the soft synth plug-in.

If you freeze a track that is   routed to a multiport VST instrument,   you'll be prompted to choose which port you want 
to freeze. VSTi technology   does not allow you to freeze multiple ports.

MIDI track before freezing

MIDI track after freezing—all controls other   than 
Mute, Solo, Volume, Pan, and Automation 
Settings are unavailable.

Edit frozen tracks
After you freeze a MIDI track, you can adjust track volume   and panning only. Trim and automation controls are 
available in the track   header and Mixing Console. 
These controls behave as they do on an audio track. For   more information, please see "Adjust a track's volume" and 
"Pan   a track" in "Audio Track Controls" on page 45.
A frozen MIDI track does not allow you to edit the following:
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 l Moving, splitting, deleting, and drawing   events are not available.
 l MIDI data — such as inline   MIDI editing, continuous controller messages, SYSEX data, volume and   pan 

messages, and voice changes — is frozen.
 l MIDI filtering is not available.
 l MIDI   track properties cannot be edited.
 l The Chopper   window is not available.

Unfreeze tracks

 1. Select the tracks you want to unfreeze.
 2. Click the Freeze  Track button  on a selected track (or right-click a selected track   and choose Freeze Track   

from the shortcut menu to clear the check box).

Editing MIDI Track Properties
From the View menu, choose Track  Properties to display the Track Properties window. The contents   of the Track 
Properties window reflect the currently selected track.
For MIDI tracks, you can use the Output Settings tab to adjust   MIDI controllers, voices, and drum maps. You can 
use the Input Filters   tab set up MIDI message, velocity, or quantize filters. You can use the   Clip Pool tab to organize 
each track's media and enable looped or one-shot   drawing for MIDI events.
For information about editing track properties for audio tracks,   please see Editing Audio   Track Properties.

If you want to use the Piano Roll or List Editor plug-ins   to edit MIDI data, use the Clip   Properties window.

Tips:         

 l If   the Track Properties window isn't visible, you can also double-click a   track number  to display that track in 

the Track Properties window. 
 l Right-click   a track and choose Properties   from the shortcut menu to display its properties.
 l When   the Track Properties window is visible, properties for the selected track   are displayed. Click a track to view 

its properties.

Configure MIDI track   controller automation (output settings)             
You can use the Output Settings tab to configure which controllers   can be automated; add, remove, or hide 
envelopes; set default values;   and set each envelope's default fade curve.
For more information about editing MIDI track envelopes,   please see MIDI Track Envelopes and   Keyframes.

Set up MIDI input filters
Use the Input Filters tab to choose which notes or other   MIDI messages you want to record (or exclude), modify 
note-on or note-off   velocity, or quantize notes when recording   MIDI.
For more information about setting MIDI input filters, please   see MIDI Input Filtering.

Set the track's paint clip             
To set the active clip, click the space next to a   clip's name on the Clip Pool tab. The  icon indicates which clip will 

be used for creating   events with the Draw  or Paint tool .
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You can also click the Paint  Clip Selector button in the track header and choose a clip from   the menu:

Filter the contents of the track's Paint Clip Selector             
Clear a clip's check box on the Clip Pool tab to remove   it from the Paint Clip  Selector menu in the track header 
without removing it from the   track. To make the clip available again, select its check box.

If a track has many clips, removing clips from   the Paint Clip Selector menu can make the track list easier to 
navigate.

Add clips to the Clip Pool             
Click the Open  button to display   the Open dialog, where you can browse to clips you want to add to the   track.

Tips:

 l Drag a file from the Windows Explorer,   Explorer Window to the Clip Pool tab to add a   clip to a track and set it 
as the active clip for creating   events with the Draw  or Paint    tool.

 l Drag a file from the Windows Explorer,   Explorer Window to an existing track in the timeline   to add a clip to the 
track and add an event where you drop the clip.

 l You can also use the Chopper   window to create new clips from a track's existing media.
 l If you want to add a clip to a track   without creating an event, drag a file from the Windows Explorer, Explorer   

Window and drop it on the Paint  Clip Selector button.

Export a MIDI clip             
Click the Save  button   to export the selected clip to a new folder or with a new file name.

For more information about exporting MIDI, please   see Exporting MIDI.

Remove clips from the Clip Pool
You can use either of the following methods to remove   clips from the Clip Pool:

 l Click the Remove  Unused Clips button  to remove all unused clips from the track.

 l Select a clip in the clip list and   click the Delete   button  to remove   it from the track. 

Right-click a clip in the Clip Pool and choose Remove from Project   if you want to remove it from your 
project. Any events that use the clip   will be removed from your project.
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Cut, copy, and paste clips across tracks             
You can use the Cut ,  Copy , and Paste  buttons on the Clip   Pool tab to cut, copy, and paste clips across 

tracks.
For more information about cutting, copying, and pasting   clips, please see Using Clips with   Tracks.

Preview clips             
Select a clip in the clip list, and then click the Play button  to play it. 

Click the Stop   button  to stop playback.

Toggle looped or one-shot painting for a MIDI clip             
Select the Loop   button  on the Clip   Pool if you want a MIDI clip to repeat when painted on the timeline. Events   

that use loop clips are displayed with a  icon in the timeline.
Deselect the Loop   button if you want a MIDI clip to be treated as a one-shot. Events that   use one-shot clips are 
displayed with a  icon.
For more information about ACID types, please see "ACID Types" on page 24. 

Edit a MIDI clip's key
You can use the Key   column in the Clip Pool to set the key of a MIDI clip. A clip's key affects   playback and how 
MIDI notes are drawn in events.

 l When you create a new MIDI clip via   recording or inline   MIDI editing, the key is set to None.
 l When you open   a MIDI file, ACID will set the clip's key based on the MIDI file.   If a MIDI file has multiple key 

signatures, only the first is used. 
 l When you open a MIDI file as a project,   the ACID project   key is updated to match the MIDI file. Each clip 

(except drum   clips) will have its key set accordingly.

When a clip's key is set, the project key and key change   markers are applied to MIDI clips, and the MIDI   event data 
will display notes as WYSIWYH (what you see is what you   hear).
When a clip's key is set to None,   the project key and key change markers are not applied to MIDI clips.
To edit a MIDI clip's key, right-click a clip on the Clip   Pool tab, choose Key   from the shortcut menu, and then choose 
a key from the submenu. 

Edit a MIDI clip's time signature             
To change a MIDI clip's time signature, right-click a clip   on the Clip Pool tab, choose Time  Signature from the 
shortcut menu, and then choose a time signature   from the submenu. 
The time signature you choose will be used to display the   grid on the  piano roll editor and to display M.B.T 
(measure.beat.tick)   values on the   list editor.

Editing MIDI Clip Properties
From the View menu, choose Clip  Properties to display the Clip Properties window. The contents   of the Clip 
Properties window will change to display properties for the   currently selected clip in the timeline.
You can use the Clip Properties window to preview a MIDI file and edit   MIDI data using the list   editor or piano   roll.
For information about audio clip properties, click "Changing ACID type" on page 76.
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When the Clip Properties window is undocked,   you can double-click its title bar to toggle its size    especially 
handy when you're using the piano roll.—         

Manage a track's clips
Each track in your ACID project can contain multiple, distinct   media files, called clips. Use   the Clip Pool tab in the 
Track   Properties window to add, remove, and preview clips.
For more information about using clips with tracks, please   see Using Clips with Tracks.

Save changes to clip properties             
Click the Save  File As button    to save the current clip and clip properties to a new file.

Edit a MIDI clip with the Piano Roll
The Piano Roll tab is a plug-in that you can use to create   and edit note events within the ACID Clip Properties 
window.
A piano roll view of a MIDI file displays note information   on a grid, just like inline   MIDI editing mode.
For more information about using the Piano Roll, please   see Using the   Piano Roll.

Edit a MIDI clip with the List Editor
The List Editor tab is a plug-in that you can use to perform   detailed filtering and editing within the Clip Properties 
window for a   MIDI track.
Events within the MIDI file for the selected track are displayed   in a table. Each event occupies one row, and the rows 
are sorted in chronological   order. The columns in the List Editor tab display the contents of the   events.
For more information about using the List Editor, please   see Using the   List Editor.

Create envelopes from controller data from   a MIDI clip
If you use MIDI clips that contain MIDI controller data,   the controller data will not be displayed in the timeline by 
default.
Right-click the event on the timeline and choose Create  Envelopes from Clip from the shortcut menu to represent 
MIDI controllers   as envelopes on the timeline.

The Create  Envelopes from Clip command is not available in inline   MIDI editing mode.

When Lock  Envelopes to Events is selected from the Options menu, envelope   points will move with an event 
as you move it along the timeline. When   Lock Envelopes to Events   is not selected, you can move events and 
envelopes independently.

Using the Piano Roll

Using the Piano Roll
With the piano roll editor you create and   edit note events within the ACID Clip   Properties window.
A piano roll view of a MIDI file displays note information on a grid,   just like a sequencer or a roll from a player piano 
(hence the name).
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Each note event is represented by a block in the top pane. The piano   keys along the left side of the window indicate 
the pitch of each note   event, and the beat ruler across the top of the window indicates the position   and duration of 
each note.
The vertical bars below the piano roll represent note-on velocity information   for each note.

Set up the Piano Roll view

Add or edit note information

Edit velocity, pitch bend, and continuous controller information

Play from the piano roll

Setting Up the Piano Roll View
A MIDI track can contain a mind-boggling array of MIDI note and controller   information. To make your editing 
easier, you can set up the piano roll   in the Clip   Properties window to display just the information you want.

Zoom in or out

Zoom horizontally

To zoom in and out in time by small increments,   press the Up Arrow/Down Arrow keys or use the  and  
buttons in the lower right-hand corner of the piano roll:

Zoom vertically

To zoom in and out the piano roll by small increments,   press the Left Arrow/Right Arrow keys or use the  and  
buttonsat the right side of the piano roll:

Zoom to a selection

Use the Zoom tool  to magnify a region without   losing your selection. Drag the mouse over an area to zoom in. A 
dotted   rectangle is drawn around the area, and the area is magnified when the   mouse button is released.
While holding the left mouse button, click the right mouse   button to toggle through the three magnification modes:
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 l Zoom Time only: magnifies horizontally   without changing the vertical zoom level.
 l Zoom Level only: magnifies   vertically without changing horizontal zoom level.
 l Time/Zoom Level: magnifies   horizontally and vertically.

Scroll the display of the piano roll

Use the scroll bars at the bottom and right side of the   piano roll to scroll through the piano roll.
Hold   Shift while using the mouse wheel to scroll horizontally, or hold Ctrl   while using the mouse wheel to scroll 
vertically.

Change the spacing of the grid

When you create or move events, the event edges will snap   to the grid. To override snapping, hold Shift while 
drawing or dragging   events, or click the Enable   Snapping button  to toggle snapping on or off.

 1. Click the down arrow   next to the Enable   Snapping button .
 2. Choose a spacing from the menu.

When you choose Ruler   Marks, the grid spacing will adjust to match your current level   of magnification.

Adding or Editing Notes
The piano roll in the Clip    Properties window can edit note on, note off, and velocity information.

When you create or move events, the event     edges will snap to the grid. To override snapping, hold Shift while 
drawing     or dragging events, or click the Enable     Snapping  button to toggle snapping on or off.    For 
information about changing the grid spacing, click "Zoom horizontally" on the previous page.

If you want to hear notes when you draw notes,     select notes, or click the keys on the Piano Roll tab, select the 
Monitor button  on the Piano Roll Editor tab. If you're using a different     host application, please refer to that 
application's documentation for    information about enabling real-time MIDI monitoring.

Add or delete notes

 1. Right-click an event       on the timeline and choose Clip      Properties from the shortcut menu.
 2. Click the Piano Roll      Editor tab.
 3. Select an editing       tool.

Item Description

Draw Allows           you to insert, edit, select, and move notes in the piano roll.

Paint Allows you to insert and select           notes.
The Paint tool is different from            the Draw tool in that it can cross note row boundaries. Use the 
Paint           tool to add a random element to your ACID projects.
Using the Paint            tool: 
 a. Click the down arrow next to the Paint tool button and choose a note length            from the 

menu. 
 b. Click the Paint tool button to select the tool. The Paint tool is selected,           and notes will be 

painted using the selected note length.
Right-click           with the Paint tool to erase notes.

Erase Allows           you to remove existing notes.

 4. Drag in the row for       the pitch you want to create to create a new note, or click an existing       note with the Erase tool 
 to remove it.

 If the Enable Snapping       Notes to Specified Scale button  is selected, you       can only draw notes within the 
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selected musical scale. Click the down       arrow  next to the button to choose a root note and scale.       You can use 
this feature to transpose a song to another key.

 Hold Alt while dragging to override scale snapping.

 If the Enable Snapping       button  is selected, you can only draw notes on grid       divisions. Click the down arrow 
 next to the button to       choose a snapping resolution.

Hold Shift while dragging to override horizontal snapping.

Select notes

 1. Right-click an event       on the timeline and choose Clip      Properties from the shortcut menu.
 2. Click the Piano Roll       Editor tab.      

Press       Ctrl+A to select all notes on the currently selected track.

 3. Select an editing tool:

Tool Description

Draw Click          to select individual notes, or hold Shift or Ctrl to select multiple notes.

Selection Drag to draw selection boxes around the notes you want to include. The Selection tool can 
draw three types of selection boxes:

Free 
Selection

The default behavior of the tool:
 l Click to select individual notes              (hold Shift or Ctrl to select multiple notes).
 l Drag to               draw a rectangular region that begins where you start drawing 

and ends               where you release the mouse button. All of the notes that are 
inside the               region will be selected. This method is good for selecting a 
group of              notes that are close together.

Vertical Can be used to easily select all notes              that occur within a time range. The 
vertical selection box automatically              selects all of the notes between your first 
mouse click and where you              draw the selection box; even notes that are not 
visible at the current             magnification are selected.

Horizontal Can be used to easily select all notes              on a single or multiple adjacent rows. 
The horizontal selection box automatically              selects all notes on a row that is 
touched by the selection box; even             notes that are not visible at the current 
magnification are selected.

To change           the type of selection box you are using, right-click the mouse while holding           down 
the left mouse button. Clicking the right mouse button will toggle          through the three types of 
selection boxes.

 4. Select the notes you      want to edit.

Edit note position

 1. Right-click an event       on the timeline and choose Clip      Properties from the shortcut menu.
 2. Click the Piano Roll      Editor tab.
 3. Select notes you want      to move.
 4. Drag the selected       notes left or right to change their position on the timeline, or drag       up or down to assign a note 

to a different pitch. 
 If the Enable Snapping       Notes to Specified Scale button  is selected, you       can only drag notes within the 
selected musical scale. Click the down       arrow  next to the button to choose a root note and scale.       You can use 
this feature to transpose a song to another key. Hold Alt while dragging to override snapping. If the Enable 
Snapping       button  is selected, you can only drag notes to grid       divisions. Click the down arrow  next to the 
button to       choose a snapping resolution. Hold Shift while dragging to override horizontal snapping.      
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You        can also select notes and use the Cut , Copy , and Paste  buttons to manipulate notes in the 
piano roll. Notes       will always be pasted into the same row from which they were cut or copied.

Edit note duration    

 1. Right-click an event       on the timeline and choose Clip      Properties from the shortcut menu.
 2. Click the Piano Roll      Editor tab.
 3. Select the Draw tool      .
 4. Drag either edge of      a note. The edge of the note moves, changing the duration of the note.

Toggle scale snapping

Click the Enable      Snapping Notes to Specified Scale button  to toggle     snapping. 

If the button is selected, you can only draw or drag notes      within the selected musical scale. Hold Alt while drawing 
or dragging     notes to override snapping.
Click the down arrow  next to the button to     choose a root note and scale.

Quantize events

So we can't all play with a drummer who has perfect timing.      . . . Let's face it: even if we could, that might not help 
some of us     play in time.
You can use the MIDI Quantize dialog to force notes to align     with musical beats based on the parameters you 
specify.

 1. Select the notes you       want to quantize.
Hold        Ctrl or Shift while clicking to select multiple events, or press Ctrl+A       to quantize the entire track.

 2. Click the Quantize      button . The MIDI Quantize dialog is displayed.
 3. From the Quantize       resolution drop-down list, choose the beat to which you want the      selected notes to be 

quantized.
 4. Select       the Start times check box if you want note start times to snap       to the beat selected in the Quantize      

resolution drop-down list.
 5. Select       the Note durations check box if you want note durations to snap       to the beat selected in the Quantize      res

olution drop-down      list.
 6. Click      Apply. 

Editing Velocity, Pitch Bend, and Controller Information
You can use the area below the piano roll to edit note-on   velocity, pitch bend, and continuous controller information.

Use the Draw tool to draw velocity data

 1. Click the drop-down in the lower portion   of the Piano Roll tab and choose Velocity   from the menu.

 2. Select the Draw tool    and drag in the lower portion of the Piano Roll tab to   adjust the velocity bars:
 3. Zoom in and drag a bar up   or down to change its value.
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 4. Drag across multiple bars   to edit them simultaneously.

Enter specific velocity values for selected notes

If you need more precise control over velocity adjustments,   you can use the note shortcut menu to adjust velocity for 
all selected   notes.

 1. Select the notes you   want to edit.
 2. Right-click a note   and choose Velocity   from the shortcut menu (or double-click a note).
 3. Choose a command from the submenu.

Item Description

Set   to Maximum Sets the   velocity to 127.

Set   to Default Sets the   velocity to 64.

Set   to Minimum Sets the   velocity to 0.

Set   to. . . Displays   an edit box where you can type a specific value.

The velocity for all selected notes   is updated.

Edit pitch bend information

 1. Click the drop-down in the lower portion   of the Piano Roll tab and choose Pitch   Bend from the menu.

 2. Drag the Paint tool    in the lower portion of the Piano Roll tab to paint a   pitch bend curve, or right-click and 
drag to erase a curve.                     

If   Enable Snapping  is turned on, the data will snap to the grid. Hold Shift   to override snapping.

Edit continuous controller information

 1. Click the drop-down in the lower portion   of the Piano Roll tab and choose a controller from the menu. If the con
troller   you want to edit is not displayed, choose All   Continuous Controller,   and then choose a controller from 
the submenu.
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 2. Drag the Paint tool    in the lower portion of the Piano Roll tab to paint controller   data, or right-click and drag to 
erase a curve.                     

If Enable   Snapping  is turned on, the data will snap to the   grid. Hold Shift to override snapping. 

Playing from the Piano Roll
The transport controls on the Piano Roll Editor tab in the Clip   Properties window allow you to audition your changes 
instantly through   the output where your ACID track is routed. For more information about   routing MIDI tracks, see 
"Routing Tracks to Soft Synths or MIDI Devices" on page 216.
To control volume during playback in the piano roll, drag the Preview fader in the   Mixer window.

Before you paint a note, you can click a key   on the keyboard to preview its sound. You can also preview notes as 
you   draw, paint, or select them. Select the Monitor   button  on the Piano Roll Editor tab. If you're using a 
different   host application, please refer to that application's documentation for   information about enabling real-
time MIDI monitoring.

Item   Description

Loop   
Playback

Click to toggle looped playback mode.   When the button is selected, only the portion of the 
current project within   the loop region  will be played back.
To move the   loop region without changing its length, drag the selection bar to a new   location. 
To edit the length of the loop region, drag either of the endpoints.

Play   
from 
Start

Plays the   entire MIDI file from the beginning, regardless of cursor position.

Play Plays from   the current cursor position.

Pause Halts playback   and leaves the cursor at its current position.

Stop Halts playback   and returns the cursor to its position before playback.

Go   to 
Start

Moves the   cursor to the beginning of the file.

Go   to 
End

Moves the   cursor to the end of the file.
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Solo   
Track

Plays the   currently selected track by itself. To hear the entire MIDI file, turn   off the Solo   Track 
button.

Using the List Editor

Using the List Editor
Sometimes, a piano roll view of a MIDI file just doesn't cut it. If   you want to see exactly what's going on in your 
complex MIDI file, you   can use the list editor. With the List Editor you perform detailed   filtering and editing within 
the Clip Properties window for a MIDI clip.
Events within the MIDI file are displayed in a table. Each event occupies   one row, and the rows are sorted in 
chronological order. The columns in   the List Editor tab display the contents of the events.

Filtering MIDI Events
A MIDI file can contain a mind-boggling   array of events. The List Editor tab allows you to filter MIDI   data to help you 
display only the events you want.

 1. Click the Filter   button  to display   the MIDI Event Filter dialog.

 2. Select the check box   for each event type that you want to exclude from the event list. Clear   a check box to 
include events of that type.

Adding, Editing, and Deleting MIDI Events
You can use the List Editor tab to edit a MIDI file by adding, editing,   and deleting MIDI events.

Edit an event

Editing an existing event allows you to change parameters   for an existing event.

You   cannot change the event type for an existing event. If you need to change   the event type, select an event in 
the list and click the Delete   button . You can then insert a new event by clicking the   Insert Event   button .

 1. Select an event in   the List Editor tab and click the Edit   Event button  to open the Edit MIDI Event dialog.

Each   event type has different parameters that you can adjust. Depending on   the type of event that you're 
editing, the contents of the Edit Event   dialog will vary. For a list of parameters for each event type, see   
"Editable Event Parameters" on page 263.

 2. Edit the settings   in the Edit MIDI Event dialog.
 3. Click OK   to close the Edit MIDI Event dialog and apply your changes.

Add an event

You can use the List Editor tab to add new events to the   list.

 1. Click the Insert   Event button  to display the Insert MIDI Event   dialog.

Each   event type has different parameters that you can adjust. Depending on   the type of event that you're 
editing, the contents of the Edit Event   dialog will vary.For a list of parameters for each event type, see   
"Editable Event Parameters" on page 263.

 2. Edit the settings   in the Insert MIDI Event dialog as desired.
 3. Click OK   to close the Insert MIDI Event dialog and apply your changes.
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Delete events

 1. Select the events   you want to delete.
Hold   Ctrl or Shift while clicking to select multiple events.

 2. Click the Delete   button . The events are removed from the list.

Quantize events

So we can't all play with a drummer who has perfect timing.   . . . Let's face it: even if we could, that might not help 
some of us   play in time.
You can use the MIDI Quantize dialog to force events to   align with musical beats based on the parameters you 
specify.

 1. Select the events   you want to quantize.
Hold   Ctrl or Shift while clicking to select multiple events.

 2. Click the Quantize   button . The MIDI Quantize dialog is displayed.
 3. From the Quantize   resolution drop-down list, choose the beat to which you want the   selected events to be 

quantized.
 4. Choose the MIDI events you want to quantize:

Item Description

Start   times Select   this check box if you 
want MIDI event start times to 
snap to the beat   selected in the 
Quantize   resolution drop-
down list.

Note   durations Select   this check box if you 
want note durations to snap to 
the beat selected   in the 
Quantize   resolution drop-
down list.

Notes   only Select this check box if you 
want   to quantize only note 
events.
Aftertouch,   control change, 
meta, NRPN, RPN, pitch bend, 
poly pressure, and program   
change events will not be 
quantized when this check box 
is selected.

Apply   to current selection only Select   this check box if you 
want to quantize only the 
selected events. Clear   the check 
box to quantize all events 
within the list.

 5. Click   Apply. 

Previewing in the List Editor
The list editor's transport controls allow you to audition your changes   instantly through the output where your ACID 
track is routed.
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Preview a single event

When monitoring is enabled, the list editor will play events   when you select them.

 1. Select the Monitor   button  on the List Editor tab.
 2. Click anywhere in   an event row to play the event.

Play your MIDI file

Item Description                         

Loop   
Playback

Click to toggle   looped playback mode. When the button is selected, only the events between   the 
mark in  and mark out  points will be   played.

Play   
from 
Start

Plays the   entire MIDI file from the beginning, regardless of cursor position.

Play Plays from   the current cursor position.

Pause Halts playback.   The next time you click Play, playback will begin with the last event played.

Stop Halts playback.   The next time you click Play, playback will begin with the first event in   the list.

Go   to 
Start

Moves the   cursor to the beginning of the list.

Go   to 
End

Moves the   cursor to the end of the list.

Set a loop region

When the Loop   Playback button    is selected, you can set a portion of the edit list to play repeatedly.   The 
beginning, end, and length of the loop region are displayed in the   Loop boxes in   the lower-right corner of the List 
Editor tab.

 1. Select the first event   you want to play.
 2. Click the Mark   Loop Start    button.
 3. Select the last event   you want to play.
 4. Click the Mark   Loop End    button.
 5. Click the Play   button  to start playback.

Editable Event Parameters
Each event in the List Editor has different parameters that you can   adjust. If you're sending   MIDI to an external 
device, refer to your MIDI device's documentation   for more information about the required parameters.

Aftertouch

Parameter Description

Start   Time Time (in measures.beats.ticks)   that you want the event to begin.

Channel MIDI channel   (1-16) where you want to send the event.

Pressure Amount   of vibrato (0-127) you want to apply to each voice on the channel.

Control change

Parameter Description

Start   Time Time (in measures.beats.ticks)   that you want the event to begin.

Channel MIDI channel   (1-16) where you want to send the event.
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Controller   
Change 
Number

Displays the   number of the current controller change type. Choose a controller change   type 
from the drop-down list to the right of the Event   type drop-down.

Controller   
Change Value

The controller   value.

Note

Parameter Description

Start   
Time

Time (in measures.beats.ticks)   that you want the event to begin.

Channel MIDI channel   (1-16) where you want to send the event.

Note The note you want to play as a numeric   value (60) or pitch (C3). For example, you could type either 
60   or C3 in the box.

On   
Velocity

The speed   of the note's attack (0-127). Low values produce a soft attack; high values   produce a 
strong attack.

Off   
Velocity

The speed   of the note's release (0-127). Low values produce a soft release; high   values produce a 
staccato release.

Duration The length   of the note's sustain in measures:beats.ticks.

Packed NRPN

Packed   non-registered parameter numbers are used to adjust settings such as vibrato   and filtering, but are not part of 
the General MIDI specification. Refer   to your MIDI device's documentation for more information about the required   
parameters.

Parameter Description

Start   Time Time (in measures.beats.ticks)   that you want the event to begin.

Channel MIDI channel   (1-16) where you want to send the event.

NRP   MSB The parameter's   most significant byte.

NRP   LSB The parameter's   least significant byte.

Data   MSB The value   for the most significant byte.

Data   LSB The value   for the least significant byte.

Packed RPN

Packed   registered parameter numbers are used to adjust common settings such as   pitch wheel range.

Parameter Description

Start   Time Time (in measures.beats.ticks)   that you want the event to begin.

Channel MIDI channel   (1-16) where you want to send the event.

NRP   MSB The parameter's   most significant byte.

NRP   LSB The parameter's   least significant byte.

Data   MSB The value   for the most significant byte.

Data   LSB The value   for the least significant byte.

Patch

Parameter Description
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Start   Time Time (in measures.beats.ticks)   that you want the event to begin.

Channel MIDI channel   (1-16) where you want to send the event.

Bank   LSB The least   significant byte value for the bank.

Bank   MSB The most significant   byte value for the bank.

Patch The number   of the patch you want to play.

Pitch bend

Parameter Description

Start   Time Time (in measures.beats.ticks)   that you want the event to begin.

Pitch   +/- The number   of cents by which you want to bend the pitch.

Poly pressure

Parameter Description

Start   
Time

Time (in measures.beats.ticks)   that you want the event to begin.

Channel MIDI channel   (1-16) where you want to send the event.

Note The note to   which you want to apply pressure.

Pressure The pressure   (0-127) you want to apply to the note. Most devices will apply more vibrato   to a note as 
the pressure increases.

Program change

Parameter Description

Start   Time Time (in measures.beats.ticks)   that you want the event to begin.

Patch The number   of the new patch you want to play.

Processing and Filtering MIDI Events
From the Edit menu, choose MIDI  Processes and Filters to apply destructive editing to MIDI events   on the timeline. 
You can quantize data in events, edit velocity values,   change the duration of an event, or transpose MIDI data.

Quantize a MIDI event

 1. From the Edit menu, choose   MIDI Processes and Filters.   The MIDI Processes and Filters dialog is displayed.
 2. Select the Quantize tab.
 3. Select your quantization options:

Item Description

Quantize 
start

Select this check box to force the beginning   (note-on messages) of MIDI events to a specified 
resolution on the grid.   

Quantize 
release

Select this check box to force the end (note-off   messages) of MIDI events to a specified 
resolution on the grid. 

Preserve 
duration

If you selected Quantize start or Quantize release,   you can select this check box to maintain the 
lengths of notes. 

Quantize Click an icon to select the resolution of the   quantize grid.
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grid

Tuplet Select this check   box to set irregular beat boundaries for the quantize grid.                          
For example, to quantize to eighth-note triplet   beat boundaries, select the  button, choose the 
Tuplet  check box and choose 3 in time of 2.   
To quantize to sixteenth-note quintuplet beat   boundaries, select the    button, choose the Tuplet 
check box and choose 5 in time of 4.

Offset by Select the check box and type a value in the   box to offset the quantize grid by the specified 
number of ticks. You   can type negative values to shift the grid backward.

Swing Drag the slider to add a swing to the quantize   grid. 

When you set this slider to 0, notes are quantized directly to the grid.   Increasing the setting shifts 
every other grid boundary forward: set to   300% to shift every other grid boundary to the next grid 
division.

Strength Drag the slider to adjust how strictly you want   to quantize.
For example, to quantize directly to the grid,   set the slider to 100%. If you set the slider to 50%, a 
note that would   be shifted 40 ticks is moved only 20 ticks.

 4. Select the tracks or events   you want to quantize:
 l If a selected event has note events   selected, only the selected notes will be quantized.
 l If you want to quantize multiple   events on multiple tracks, hold Ctrl or Shift while clicking the events   to 

select them, and then select the tracks.
 l Select a track to quantize all events   on the track. Hold Ctrl or Shift while clicking a track header to select   

multiple tracks. 

 The Apply to selected notes only, Apply to all notes in selected events, and Apply  to all notes on 
selected tracks radio buttons at the bottom of   the dialog will track the current selection. If you want to 
override the   current selection, you can click a different radio button.

 5. Muted tracks will not be quantized.

 6. Click the Apply   button.

Edit velocity             

 1. From the Edit menu, choose   MIDI Processes and Filters.   The MIDI Processes and Filters dialog is displayed.
 2. Select the Velocity tab.
 3. Select a check box to indicate   whether you want to edit note-on or note-off velocities:

Item Description

Change Start Velocity Select this check box to edit note-on velocities.

Change Release Velocity Select this check box to edit note-off velocities.

 4. Select a radio button to indicate   how you want to change velocity:

Item Description

Invert Select this radio button to invert selected   note velocities. 
When you invert a velocity, it is subtracted   from 127 (negative values are forced to positive), so a 
note with a velocity   of 127 will be 0 after inversion, a velocity of 10 will be 117, and so   on.
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Set to Select this radio button and drag the slider   to change note velocities to a specific value.

Add Select this radio button and drag the slider   to add (or subtract) a constant offset to selected note 
velocities.

Scale 
by

Select this radio button and drag the slider   to multiply selected note velocities by a percentage. For 
example, setting   this slider to 50% would reduce all note-on or note-off velocities by   half. 

Limit Select this radio button and type values in   the Min and Max   boxes to restrict selected note 
velocities to the specified range.
For example, if you type 40 in the Min box and 90 in the Max box, velocities   below 40 will be set 
to 40, velocities greater than 90 will be set to   90, and velocities between 40 and 90 will be 
unaffected.

Change 
over 
time

Select this radio button and type values in   the From and To   boxes to change velocity values 
gradually over time.
The velocity for the first note in the selection   is set to the From value, and  the velocity for the last 
note in the selection is set to the To   value.
Select the By  percentage check box to change velocity over time based on the   current values. For 
example, to fade a selection in, select the By percentage check box and type 1 in  the From box and 
100 in the To box. To fade a selection out, type   100 in the From box and 1 in the  To box.
Drag the Curve   slider to choose the fade curve that will be used to generate velocity   for notes 
between the first and last note.

Note-on velocities are bound between 1 and 127, and   note-off velocities are bound between 0 and 127.

 5. Select the tracks or events   you want to edit:
 l Select a track to edit all events   on the track. Hold Ctrl or Shift while clicking a track header to select   multiple 

tracks. 
 l If you want to edit multiple events   on multiple tracks, hold Ctrl or Shift while clicking the events to select   

them, and then select the tracks.
 l If a selected event has note events   selected, only the selected notes will be edited.

The Apply to selected notes only, Apply to all notes in selected events, and Apply to all notes on 
selected tracks radio buttons at the bottom of   the dialog will track the current selection. If you want to 
override the   current selection, you can click a different radio button.

Muted tracks will not be edited.

 6. Click the Apply   button.

Edit duration             

 1. From the Edit menu, choose   MIDI Processes and Filters.   The MIDI Processes and Filters dialog is displayed.
 2. Select the Duration tab.
 3. Select a radio button to indicate   how you want to change note duration:

Item Description

Change 
by

Select this radio button, and then choose a   setting from the drop-down list:

Setting 
duration to

Allows you to set notes to a specific duration.
Click the down arrow  next to the selected note size and choose the   desired note 
duration from the menu. Choose User  size to type a duration in beats.ticks in the 
edit box: for example,   type 2.000 for two beats, or type 0.200 for 200 ticks.
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Adding to 
duration

Allows you to   add a constant value to existing note durations.                                     
Click the down   arrow  next to the   selected note size and choose the amount you 
want to add to notes.

Subtracting 
from 
duration

Allows you to   subtract a constant value from existing note durations.                                     
Click the down   arrow  next to the   selected note size and choose the amount you 
want to subtract from notes.

Scale 
by

Select this radio button and drag the slider   to multiply selected note durations by a percentage. For 
example, setting   this slider to 200% doubles note durations.
Select the Change  start times check box if you want to change the start times of   notes while 
changing duration.
For example, if you set the Scale by slider to 50% and select the Change  start times check box, 
you can compress notes so they play in double   time. If you set the Scale by   slider to 50% and clear 
the Change start times check box, note durations will be shorter, but their positions   on the timeline 
will not change.

Limit Select this radio button and choose Min and Max values to restrict note   durations to the specified 
range.
For example, if you choose an eighth note as   the Min setting and a half note  as the Max setting, 
sixteenth   notes will be changed to eighth notes, and whole notes will be changed   to half notes. 
Notes between the Min and Max settings are unaffected.

 4. Select the tracks or events   you want to edit:
 l Select a track to edit all events   on the track. Hold Ctrl or Shift while clicking a track header to select   multiple 

tracks. 
 l If you want to edit multiple events   on multiple tracks, hold Ctrl or Shift while clicking the events to select   

them, and then select the tracks.
 l If a selected event has note events   selected, only the selected notes will be edited.

 The Apply to selected notes only, Apply to all notes in selected events, and Apply to all notes on 
selected tracks radio buttons at the bottom of   the dialog will track the current selection. If you want to 
override the   current selection, you can click a different radio button.

Muted tracks will not be edited.

 5. Click the Apply   button.

Using Controller Maps
A controller map allows you to edit the continuous controller (CC) messages   that are used by synthesizers    either 
hardware-based synths or soft synths. —
You can configure which controllers can be automated; add, remove, or   hide envelopes; set default values; and set 
each envelope's default fade   curve.

 1. Right-click the track header, choose Insert/Remove Envelopes, and then choose Configure  Controllers from 
the menu. The Output Settings tab in the MIDI   Track Properties window   is displayed.

 2. The GM2 Controllers map is used by default. If you want   to load a different map, click the Load   button and 
browse to a new mapping file (.xml).  ACID installs default templates to the ..\My  Documents\MAGIX\ACID 
Music Studio\11.0\MIDI Templates\Controller Maps\ folder   (..\Documents\MAGIX\ACID Music 
Studio\11.0\MIDI Templates\Controller Maps on Windows Vista).

 3. In the Track Properties window, select the check box   for each controller you want to automate with an envelope.
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If the controller you want to automate isn't displayed, select the   Show all controllers   check box at the bottom of 
the dialog. If you want to rename a controller, double-click its name and type   a new name in the edit box.

Not all VST instruments use standard MIDI   control mappings for volume and pan envelopes. 

You can use the Output Settings tab in the MIDI   Track Properties window to override the default envelope: 
right-click   the controller you want to use and choose Use  as Track Volume or Use as Track Pan from the 
shortcut menu.

 4. Click the down arrow  in the Envelope   box and choose a command from the menu:

Item Description

Insert 
Envelope

If the controller does not have an automation   envelope, No is displayed. 
Click the down arrow  and choose  Insert Envelope to add an automation envelope to the 
timeline.

Show/Hide 
Envelope

If the controller has an automation envelope,   Visible or Hidden   is displayed. 
Click the down arrow  and choose  Hide Envelope or Show Envelope   to toggle its display.

Click the Hide  all Envelopes button at the bottom of the window to hide all controller   
envelopes on the track.

Reset All 
Envelope 
Points

If the controller has an automation envelope,   you can click the down arrow  and choose  
Reset All Envelope Points to restore all points to the default   value.

Click the Reset  all Envelopes button at the bottom of the window to set all points   on all 
controller envelopes on the track to the default value.

Delete 
Envelope

If the controller has an automation envelope,   you can click the down arrow  and choose  
Delete Envelope to remove the envelope and all envelope points   from the timeline.

Click the Remove  all Envelopes button at the bottom of the window to delete all   
controller envelopes on the track.

 5. Double-click the Def   box and type a new value to change the default setting for a controller.   This value is used 
when you reset envelope points.

 6. Click the down arrow  in the Curve  Type box to set the default fade   curve for each controller's automation 
envelope. The new curve type will   be applied to all segments on the envelope. You can right-click a segment   and 
choose a new fade curve to override the default curve type.

 7. Click   the Save button   if you want to save the current settings as a mapping file.

Creating or Editing Program Maps
From the Tools menu, choose Program  Map Editor to display the Program Map Editor dialog. 
You can use the Program Map Editor dialog to create or edit program   maps for external MIDI devices. Program maps 
assign user-friendly names   to patches/programs so you don't have to use patch:bank messages.
When you use a program map, the device's name and program (patch) names   are displayed in the MIDI Output and 
Program    buttons in the track header and   on the Output Settings tab of the Track   Properties window. 

Create a program map

 1. From the Tools menu, choose   Program Map Editor   to display the Program Map Editor dialog. 
 2. Click the New   button    to create a new program map. 

 You'll be prompted to choose a file name and location where you want   to save the new map.
Tips:
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 l The   base file name will be used as the device name. For example, if you save   My Synth.xml, the device 
name will be My Synth. If you want to associate   a drum map with a program   map, be sure to use the same 
device name for both maps: when you select   a drum program for your synth on a MIDI track, the correct 
drum map will   be loaded automatically. 

 l If you   want to create a program map based on an existing map, load a program   map and then click the 
Save  As button   to save a copy of the program map with a new name.

 l Click the Add New Program  or Add New Drum Program  button to add a program to the table in 

the first   available slot.

If a group is selected from the Program  Group drop-down list, the table lists only programs that belong   to 
the selected group. Any programs you add will automatically be associated   with the selected group.

 3. Type a description of the   program in the Program  Name box.

 You can double-click an existing name to edit it.
 4. If you want to assign the   program to a group, right-click the Group   box and choose a group from the shortcut 

menu. 

 If you want to create a new group, choose Add  New Group and type a name in the box. 
 5. Double-click the Prog,MSB, and LSB   values to edit them and type the values that correspond to the appropriate   

program. 

 Please refer to your device or its documentation to determine the correct   values for each program.

Notes:

 l Within   ACID, MIDI values range from 0-127. If your device uses 1-128, subtract   1 when editing the 
program.

 l Devices   that use Sysex messages to change programs are limited to 128 programs.   
 6. Click OK   to close the dialog and save your changes.

Edit a program map

 1. From the Tools menu, choose   Program Map Editor   to display the Program Map Editor dialog. 
 2. Load the program map you want   to edit:
 3. Choose a setting from the MIDI Device drop-down   list.
 4. Click the Load   button and browse to the map you want to edit.

Tips:

 l If   you want to associate a drum   map with a program map, be sure to use the same device name for both   
maps: when you select a drum program for your synth on a MIDI track, the   correct drum map will be 
loaded automatically. 

 l If you   want to create a program map based on an existing map, load a program   map and then click the 
Save  As button   to save a copy of the program map with a new name.

 l To add programs to the map,   click the Add New Program  or Add New Drum Program    button to 

add a program to the table in the first available slot.

If a group is selected from the Program  Group drop-down list, the table lists only programs that belong   to 
the selected group. Any programs you add will automatically be associated   with the selected group.

 5. To remove a program from the   map, select a program and click the Delete   button .
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 6. To edit a program name, double-click   the name and type a new value in the box.
 7. To change a program  to a   drum program , right-click the program name and choose Drum  Kit from the 

shortcut menu.

 To change a drum program to a program, right-click the program name   and choose Drum Kit   from the shortcut 
menu to clear the check mark.

 8. If you want to assign the   program to a group, right-click the Group   box and choose a group from the shortcut 
menu. 

 If you want to create a new group, choose Add  New Group and type a name in the box. 
 9. Double-click the Prog ,MSB,  and LSB   values to edit them and type the values that correspond to the appropriate   

program. 

 Please refer to your device or its documentation to determine the correct   values for each program.

Notes:

 l Within   ACID, MIDI values range from 0-127. If your device uses 1-128, subtract   1 when editing the program.
 l Devices   that use Sysex messages to change programs are limited to 128 programs.   
 l Click OK   to close the dialog and save your changes.

Assign a program map to a MIDI device

 1. From the Options menu, choose   Preferences.
 2. Click the MIDI tab.
 3. In the Make  these devices available for MIDI track playback section of the   dialog, verify the check box is 

selected for your MIDI device.
 4. Right-click the Device   value for your MIDI device and choose Load  Device Template from the shortcut menu.
 5. Browse to the program map   you want to use and click Open.

 The selected program map will be used for any track that is routed to the MIDI device.

Creating or Editing Drum Maps
From the Tools menu, choose Drum  Map Editor to display the Drum Map Editor dialog. 
You can use the Drum Map Editor dialog to create or edit drum maps.   A drum map assigns a drum sound to a 
specific note (so you don't have   to remember that C3 is Bass Drum 1, for example). When a drum map is defined   for 
a soft synth, you can use the drum grid in the timeline to edit   MIDI data. 

A piano roll   allows you to edit MIDI 
notes for most patches.

A drum grid   allows you to edit MIDI notes 
for soft synths that have drum maps defined.
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Choose a drum map or kit for a track
MIDI tracks can display a piano roll or a drum grid. 

Choosing a drum map or kit

 1. Click the Program  button  on the track header.

 2. Choose Drum Maps from the menu, and then choose Select  Drum Map from the submenu. The Output 
Settings page of the Track   Properties window is displayed.

 3. Choose the drum map or kit   you want to use.

Displaying the piano roll

If your track is routed to a   MIDI device or VSTi soft synth, you can switch from a drum grid view to   the piano roll. 
Click the Program button , choose Drum Maps, and then choose None.

Edit a drum map

 1. From the Tools menu, choose   Drum Map Editor   to display the Drum Map Editor dialog. 
 2. Choose the drum map you want   to edit.
 3. Select a drum map in the MIDI Drum   Map Template list or click the Open   button   to browse   to an XML 

drum mapping file.
Drum maps that belong to the GM2 kits are displayed   with a  and cannot   be edited.

 4. If you want to edit the name   of the drum map, double-click the name in the MIDI  Drum Map Template column 
and type a new name in the box.

 5. If you want to associate the   drum map with a MIDI device, double-click the Device   box and type the name of a 
MIDI device. 

 When you associate a drum map with a MIDI device, the drum maps will   be displayed automatically on the 
Output Settings tab of the Track   Properties window when you choose Drum  Map from the drop-down list at 
the top of the page.

Be sure to type the device name identically in the   Drum Map Editor and the Program   Map Editor. 

 6. If you want to change the   description of the map, edit the text in the Drum  Map Description box.
 7. Add keys as needed:

 a. Click the Insert  Key button    to add a key to the drum map.

 If a key is selected, the next available key will be inserted. For   example, if you select C5 and click Insert  
Key, C#5 will be added if it does not exist in the current drum   map. If C#5, D5, and D#5 already exist, E5 
will be added.

 b. Double-click   the name in the Instrument   column and type the name of the instrument associated with the 
selected   key.

 8. Select a key in the table   on the right side of the dialog and click the Delete  Key button     to remove it from the 

drum map.
 9. If you want to copy key assignments   from other drum maps, perform the following steps:
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 a. In the MIDI Drum Map Template list,   select the drum map that contains the keys you want to copy.
 b. Select the keys you want to copy.   Hold Ctrl or Shift to select multiple keys.
 c. Click the Copy  Selected Keys button .

 d. In the MIDI Drum Map Template list,   select the drum map that you want to edit.
 e. Click the Paste  Copied Keys into Map button . Select the keys you want to copy. Hold Ctrl or Shift to 

select   multiple keys.

 If a key is selected, the next available key will be inserted. For   example, if you select C5 and click Insert  
Key, C#5 will be added if it does not exist in the current drum   map. If C#5, D5, and D#5 already exist, E5 
will be added.

 f. Double-click   the name in the Instrument   column and type the name of the instrument associated with the 
selected   key.

 10. Click OK   to close the dialog and save your changes.

Exporting MIDI
From the File menu, choose Export  MIDI to export the MIDI tracks in your project to a new MIDI file.

Export a MIDI clip
You can use the Clip Pool tab in the Track   Properties window to save the selected clip to a new folder or with   a new 
file name.

MIDI clips are always exported as MIDI type   0.

 1. Click the Save   button  on the Clip Pool tab in the Track Properties window. The Save   MIDI Clip dialog is 

displayed.
 2. Choose a drive and folder   from the Save in   drop-down list, or use the browse window to locate the folder where 

you   want to save your file.
 3. Type a name in the   File name box,   or select a file in the browse window to replace an existing file.
 4. Type a value in the Resolution   box to set the resolution of file. The default is 960, but you can specify   any value 

between 24 and 960.

Not all MIDI devices can read arbitrary resolutions.   

 5. Click   the Save button.

Export your project as a MIDI file
When you export to a MIDI file, the MIDI tracks in your   project are saved to a standard MIDI file. Track names, track 
device names,   and track voices are saved in the exported file.

Muted tracks are not included in the exported file.

 1. From the File menu, choose   Export MIDI. The Export Project as Standard MIDI File dialog  is displayed.
 2. Choose a drive and   folder from the Save  in drop-down list, or use the browse window to locate the folder   where 

you want to save your file.
 3. Type a name in the   File name box,   or select a file in the browse window to replace an existing file.
 4. Choose   a setting from the MIDI  file type drop-down list to indicate the type of file you want   to save:
 5. Choose Standard  MIDI File Type 1 to preserve tracks when exporting. This mode preserves   the MIDI data in 

your ACID project.
 6. Choose Standard  MIDI File Type 0 to save your project as a single-track, multichannel   MIDI file.
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When you add   a Type 0 MIDI file to your project, a separate track will be created for   each channel in the 
file. If you have tracks routed to separate soft synths   or MIDI devices, they will be preserved as separate 
tracks only if their   MIDI outputs use different channels. For more information about choosing   a track's 
output port and channel, please see Routing   Tracks to Soft Synths or MIDI Devices.

 7. Type   a value in the Resolution   box to set the resolution of the file. The default is 960, but you can   specify any 
value between 24 and 960.

Not all MIDI devices can read arbitrary resolutions.   

 8. Click   the Save button.

Using MIDI plugins
There is a special category of VST instruments that don't produce it's own sound but instead generate MIDI output, 
either of its own, like Step sequencers or derived from its own MIDI input like arpeggiators, chord assistants or even 
complete composing tools. To use these plug-ins in ACID Music Studioproceed as follows:

 1. Insert a MIDI track, click on the MIDI Output button and chose Insert Soft Synth to load your MIDI plug-in.
 2. Insert a MIDI track that should receive the MIDI output from the MIDI plug-in and insert a soft synth there.
 3. In this track, click on the MIDI Input button and chose the MIDI plugin as track MIDI input

 4. The soft synth of the second track now receives the MIDI from the first one
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In this example, the step sequencer on track 1 transforms the long single notes into arpeggios that then were 
recorded on track 2.

Resetting All MIDI Ports
From the Tools menu, choose Reset  All MIDI Ports to send a global note-off command to all MIDI ports.
You can use this command to stop stuck notes from playing, much like   the Panic button on MIDI hardware devices

Timecode Synchronization
ACID software can generate MIDI timecode and MIDI clock as well as trigger   from MIDI timecode. These features 
allow you to synchronize ACID projects   with other audio applications and external audio hardware.

Generating MIDI timecode

Triggering playback   from MIDI timecode

Generating MIDI clock

Generating MIDI Timecode
From the Options menu, choose Timecode,   and then choose Generate  MIDI Timecode from the submenu if you 
want to generate MIDI timecode   (MTC) when you click Play .

MIDI timecode (MTC) is a standard timecode that most applications and   some hardware devices will use to 
synchronize themselves. ACID software   will generate stable MTC at all available frame rates for other applications   to 
chase.

Generate MIDI timecode             

 1. Specify a MIDI Output  device to which you will send the timecode and a Frame  rate for the timecode. These 
options can be found on the Sync page of the Preferences dialog.

The   MTC generation device will not be available for MIDI track playback.

 2. From the Options menu, choose Timecode, and   then choose Generate  MIDI Timecode from the submenu.
MTC is generated starting wherever you   click Play .

Generate MTC with an   offset             

In some cases, you may want to start sending timecode with   an offset (e.g., 01:00:00:00) to allow time for multiple 
devices to synchronize.   You can create an offset on the ACID time   ruler to accomplish this.
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View outgoing timecode

To view the outgoing timecode, right-click   the Time Display  and choose MIDI  Timecode Out from the shortcut 
menu. The Time Display will   now show the outgoing MTC time.

Triggering from MIDI Timecode
From the Options menu, choose Timecode,   and then choose Trigger  from MIDI Timecode from the submenu if 
you want playback to be   initiated by receiving timecode from another device.

Trigger playback from   MIDI timecode

 1. Connect a word clock signal between   your computer and triggering device to lock synchronization.
If the MIDI trigger device can output   MIDI timecode, a timecode converter is not necessary; you can connect   
the trigger device directly to your computer.

 2. Configure your trigger device   to send MIDI timecode (MTC) to your computer.
 3. Configure ACID software   to receive MTC:

 a. From the Options menu, choose   Preferences and select the Sync tab.
 b. From the Input  device drop-down list, choose the port from which you will   receive MTC.
 c. From the  Frame rate drop-down list, choose the frame rate that your   trigger device will use to send MTC 

to ACID software.
 d. Click OK   to close the Preferences dialog.

 4. From the Options menu, choose Timecode, and  choose Trigger  from MIDI Timecode from the submenu.
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When an incoming MTC signal is received,   the ACID project will begin playing from the position indicated by 
the   timecode. If ACID software is not receiving MTC, you can play and edit   normally.

View incoming timecode             

To view the incoming timecode, right-click the Time Display  and choose MIDI  Timecode In from the shortcut 
menu. The Time Display will now   show the incoming MTC time.

This display will also show status and error information.   If Trigger  from MIDI Timecode  is enabled but no MTC is 
detected, the display   will show Waiting...   If the wrong frame rate of MTC is being detected the display will show   
Wrong format.

Generate MIDI Clock
From the Options menu, choose Timecode,   and then choose Generate  MIDI Clock from the submenu if you want 
to generate MIDI clock   when you click Play .

MIDI clock differs from MIDI timecode in that it contains tempo as well   as positional information. MIDI clock is 
essentially measured in ticks   from the beginning of the project. MIDI clock sends 24 ticks per quarter   note.
The advantage of using MIDI clock is that ACID software can send its   tempo changes to the chasing application and 
they will be preserved.

Generate MIDI clock             

 1. Specify the MIDI Output  device to which you will send the clock signal. This option   can be found on the Sync 
page of the   Preferences dialog.

 2. From the Options menu, choose Timecode, and  then choose Generate  MIDI Clock from the submenu.
MIDI clock is generated when you click   Play .

View outgoing MIDI clock

To view the outgoing clock, right-click the Time Display   and choose MIDI  Clock Out from the shortcut menu. The 
Time Display will now   show the outgoing MIDI clock time.
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Customizing the ACID Interface
You can customize the ACID interface to suit your needs and working   preferences.

Customizing the Toolbar
The ACID toolbar is fully customizable.   To change the appearance of the toolbar, double-click an empty space on   the 
toolbar, or choose Customize  Toolbar from the Options menu.

To   quickly move toolbar buttons, hold Shift while dragging a button to a   new location. Hold Shift while 
dragging a button off the toolbar to remove   it. Hold Ctrl and Shift while clicking the left edge of a button to add   
a separator.

Add a button to the toolbar             

 1. From the Options menu, choose   Customize  Toolbar.
 2. In   the Available  toolbar buttons   column, choose the button you   want to add.                     
 3. Click   the Add button.
 4. Click   Close to close the Customize Toolbar dialog.

Remove a button from the toolbar             

 1. From the Options menu, choose   Customize  Toolbar.
 2. In   the Current  toolbar buttons   column, choose the button you   want to remove.                     
 3. Click   the Remove   button.
 4. Click   Close to close the Customize Toolbar dialog.

Move a button             

 1. From the Options menu, choose   Customize  Toolbar.
 2. In   the Current  toolbar buttons   column, choose the button you   want to move.                     
 3. Move   the button:                     

 l Click   Move  Up to move the button up one   space in the Current  toolbar buttons list and left   one space on 
the toolbar.                     

 l Click   Move  Down to move the button down   one space in the Current  toolbar buttons list and right   one 
space on the toolbar.                     

 4. Click   Close to close the Customize Toolbar dialog.

Reset the toolbar             

 1. From the Options menu, choose   Customize  Toolbar.
 2. Click   the Reset   button.
 3. Click Close to close the Customize Toolbar dialog and  reset the toolbar to its default appearance. 

Customizing Keyboard Shortcuts
From the Options menu, choose Customize  Keyboard to customize the keyboard shortcuts available in the ACID   
interface.
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The Keyboard map   box displays the currently assigned shortcut keys. Click a tab in the   middle of the dialog to 
choose which shortcuts you want to see.

Edit or create new shortcuts

 1. Click a tab in the middle   of the dialog to indicate the type of command you want to assign to a   keyboard 
shortcut.

 2. Select a command in the list.   
You can type a word in the Show  commands containing box to filter the list of commands to display   only 
commands that contain the word you typed.

 3. Click the Shortcut  keys box and press the key combination you want to assign to the   selected command.
 4. Click the Add   button to assign the key combination in the Shortcut  keys box to the selected command.

Save a keyboard map 
Click the Save as button and type a name to save your current keyboard shortcuts   to an .ini file in the C:\Documents 
and Settings\[user   name]\Local Settings\ApplicationData\MAGIX\ACID Music Studio\11 folder (C:\Users\
[username]\AppData\Local\MAGIX\ACID Music Studio\11 on Windows Vista). 

The Application Data   folder is not visible unless the Show  hidden files and folders radio button   is selected on 
the View tab of the Windows Folder Options control panel.             

You can use this file as a backup or to share your keyboard   shortcuts with other ACID users.

Delete a keyboard map 
Choose a mapping from the Keyboard map drop-down list and click the Delete   button to remove the selected 
keyboard mapping.

You cannot delete the default ACID keyboard   mapping.

Import or rename a keyboard map 
Copy an ACID keyboard mapping .ini file to the C:\Documents  and Settings\[user   name]\Local 
Settings\ApplicationData\MAGIX\ACID Music Studio\11 folder (C:\Users\
[username]\AppData\Local\MAGIX\ACID Music Studio\11 on Windows Vista).

The Application Data   folder is not visible unless the Show  hidden files and folders radio button   is selected on 
the View tab of the Windows Folder Options control panel.             

The next time you start ACID, the new keyboard mapping will   be available from the Keyboard  map drop-down list 
in the Customize Keyboard dialog.

If you want to edit a the name used to identify a keyboard   mapping in the Customize Keyboard dialog, open the 
.ini file in a text   editor and change the <Display  Name>portion of the Name=<Display   Name> entry. Save the 
.ini file and restart ACID to use the   new name.

Reset the default keyboard map             
Choose [Default] from the Keyboard map drop-down list and click OK   to restore the default configuration. 
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Customizing ASIO Port Naming
When you use an ASIO sound card, default names are displayed in ACID   for each of the device's ports. If you have a 
simple setup, the default   names probably work well enough for you. However, if you have a complex   setup, 
customizing the port names can help you keep track of your routing   with meaningful labels.
For example, if you have your control room monitors connected to outputs   1 and 2 on your sound card, you could 
replace the default MainOut 1L and MainOut 1R port names with CtrlRm Left and CtrlRm Right. If your lead vocal 
microphone is connected to Mic/Inst 1, you could name the port LeadVocal,   and a harmony microphone connected 
to Mic/Inst 1 could be labeled Harmony.

 1. From the Options menu, choose Preferences,   and then click the Audio Device tab.
 2. Choose your ASIO audio interface from the Audio device type drop-down list, and then click Apply.
 3. Click the Advanced   button to display the Advanced Audio Configuration dialog.
 4. If you want to edit the name of an input or output port,   click the label in the Name   column, and then press F2. 

You can then type a new name in the edit box.

Item Description

Name The name of the port as it will be displayed   in ACID. 

Default naming.
Input pairs and outputs can be 
mono, or multiple   mono, or stereo. 

 l Mono : A single-channel input 
or output.                                          

 l Stereo   : A pair of two mono 
inputs or outputs. For 
example, you might connect   
the right and left outputs of a 
stereo device to a stereo input. 

 l Multi   mono: A grouping of 
two monaural channels as a 
multichannel port. The   
content in the channels is 
from distinct monaural 
sources and not intended   to 
be mixed as a stereo signal. 
For example, you might 
connect two microphones   to 
separate inputs to record 
harmony vocals. 

After renaming the multiple mono 
port Mic/InstIn 1/Mic InstIn 2 to 
Guitar,   the port is switched to 
stereo, and the left and right 
channels are renamed   Guitar Left 
and Guitar Right.

If you rename either of a stereo 
port's channels,   the port is 
switched to a multiple mono 
channel, and labels are updated   
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accordingly. 
If you want to switch back to a 
stereo channel,   you can rename the 
Multi Mono channel.

Notes:

 l ASIO port   names are not saved per project.
 l In stereo   pairs, odd-numbered ports represent the left channel; even-numbered ports   

represent the right channel.
 l Stereo pairs   must consist of sequential channels. You cannot make stereo pairs from   

arbitrary channels.
 l If you want   to restore a port's default name, delete the label in the Name column, and the 

Internal Name   is restored.
 l If you want   to restore all port names, click the Reset  Names button (or press Alt+N).

I/O Indicates whether the port is an input or output   port.

Internal 
Name

The default name of the port.

Channel Indicates whether a port is a stereo, mono,   or multiple mono. 

The Time Ruler
From the View menu, choose Time Ruler, and choose Show Time Ruler from the submenu to toggle the display of 
the time ruler.
The time ruler is displayed along the bottom of the timeline. To change   the format of the display, right-click on the 
timeline and choose an option   from the shortcut menu. This timeline will change with tempo since the   number of 
bars and beats per second of real time will change with tempo.

Beat ruler

Time ruler

Change the format of   the time ruler             
From the View menu, choose Time  Ruler and choose a format from the submenu.

Format Description

Samples Displays the   time ruler in samples.                         

Time Displays the   time ruler in hours:minutes:seconds.milliseconds.                         

Seconds Displays the   time ruler in seconds.                         

Time & Frames Displays the   time ruler in hours:minutes:seconds.frames.                         

Absolute Frames Displays the   time ruler with all frames numbered sequentially from the 
beginning of   your project.                         

Feet and Frames  16mm (40 fpf) Displays the   time ruler in feet+frames at a rate of 40 frames per foot.                         
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Feet and Frames  35mm (16 fpf) Displays the   time ruler in feet+frames at a rate of 16 frames per foot.                         

SMPTE Film Sync (24 fps) Displays the   time ruler in hours:minutes:seconds:frames with a frame 
rate of 24 frames   per second for synchronizing with film.                         

SMPTE EBU (25 fps, Video) Displays the   time ruler in hours:minutes:seconds:frames with a frame 
rate of 25 frames   per second. This is known as SMPTE EBU (European 
Broadcasting Union) because   European television systems run at 25 
fps.                         

SMPTE Non-Drop (29.97 fps,  Video) Displays the time ruler in hours:minutes:seconds:frames   with a frame 
rate of 29.97 frames per second.                         
In video,   the frame rate of exactly 30 fps is never used. Instead, the 
timecode   runs at a rate of 29.97 fps. This leads to a discrepancy 
between real   time (as you would see on a clock) and the SMPTE time. 
SMPTE Drop was   created to compensate for this discrepancy.                         

SMPTE Drop (29.97 fps, Video) Displays the time ruler in hours:minutes:seconds;frames   with a frame 
rate of 30 frames per second.                         
This format   runs at 29.97 fps, just like SMPTE Non-Drop. However, to 
keep the SMPTE   clock from drifting from real time, certain frame 
numbers have been removed   from the counting system. The time is 
adjusted forward by two frames on   every minute boundary except 0, 
10, 20, 30, 40, and 50. Thus, when SMPTE   Drop time increments from 
00:00:59.29, the next value will be 00:01:00.02.   In SMPTE Non-Drop, 
the time would indicate 00:01:00.00, but it would be   two frames 
behind real time.                         

SMPTE 30 (30 fps, Audio) Displays the time ruler in hours:minutes:seconds:frames   with a frame 
rate of 30 frames per second.                         
This rate   is exactly 30 fps and is commonly used when synchronizing 
audio applications   such as multitrack recorders or MIDI sequencers.                         

Audio CD Time Displays the ruler in hours:minutes:seconds:frames   with a frame rate of 
75 frames per second for creating Red Book CDs.

Create a time ruler offset
A time ruler offset allows you to change the time ruler   to start at a specific time. Typically, this feature is used in 
conjunction   with SMPTE and MIDI projects when their timelines are the main reference.   
A time ruler offset allows you to set the time ruler in   an ACID project based on another project’s timeline for 
reference   purposes.

 1. From the View menu, choose   Time Ruler and   choose a Set Time at  Cursor from the submenu. An edit box is 
displayed in the time ruler.

To create a simple   offset, click Go to  Start  to   move the cursor to the beginning of your project.

 2. Type a time in the edit box and press   Enter.
The time ruler is shifted so the cursor   position matches the time you specified. For example, if the cursor is   
positioned at the 2:00 minute mark and you enter 15:00 minutes, the start   of the project will be set to 13:00 
minutes.

Grid Spacing
From the Options menu, choose Grid  Spacing and choose a command from the submenu to specify the spacing   of 
the vertical grid lines along the timeline.
You can use grid lines as snap points when   Snap  to Grid is enabled. 
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The grid spacing setting is independent from   the beat ruler format. 

The Time Display
The Time Display shows the current cursor position, MTC input, MTC output,   or MIDI clock output time. The right-
hand field always displays the cursor   position in measures.beats.ticks format, and the left-hand field displays   the 
cursor position (using the time ruler format) or the MIDI timecode/MTC   status.

Double-click either of the fields in the Time Display window to type   a value in the edit box. When you press Enter, 
the cursor will move to   that position.
You can change the format of the left-hand field or the appearance of   the Time Display by right-clicking the Time 
Display and choosing a new   format from the shortcut menu.

Item Description

Edit  Cursor Position 
- Beats 
Edit  Cursor Position 
- Time 

Allow you   to move the cursor to the position you specify.                     

Time  at Cursor 
Format

Choose   Time Format and choose a setting  from the submenu to set the time units used 
in the Time Display and Time Ruler. 
For   a description of each of the time units available in the submenu, see   "Change the 
format of the time ruler" in the The   Time Ruler topic.

Time  at Cursor Displays   the time based on the current cursor position.                     

MIDI  Timecode Out Displays outgoing MIDI timecode.

MIDI  Clock Out Displays outgoing MIDI clock.

MIDI  Timecode In Displays incoming MIDI timecode.

Generate  MIDI 
Timecode

Enables generation of MIDI Timecode during playback.   For more information, see 
"Generating MIDI Timecode" on page 275.

Generate  MIDI 
Clock

Enables generation of MIDI Clock during playback.   For more information, see "Generate 
MIDI Clock" on page 277.

Trigger  from MIDI 
Timecode

Enables playback to be triggered using MIDI   timecode. For more information, see 
"Triggering from MIDI Timecode" on page 276.

Setting Default Track Properties
You can use any track's settings to specify default settings for new   tracks.

Use a track's settings   as the new defaults             

 1. Right-click a track header   and choose Set Default  Track Properties from the shortcut menu.
 2. Select the check box for each item that   you want to use as a default when creating a new track:

Item Description
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Volume Select this check box if you want   to use the current setting of the Volume fader whenever you add 
an audio track.                                 

Until you set a default   track volume in the Set Default Track Properties dialog, the setting of   the 
Preview fader will determine the volume   of new tracks.                                 

Pan  
Type

Select this check box if you want   to use the current panning mode whenever you add an audio 
track.                                 
To set   the panning mode, right-click the Pan slider and choose a mode from the shortcut   menu. For 
more information about panning, see "Audio Track Controls" on page 45.                                 

Height Select   this check box if you want to use the current track height whenever you   insert an audio or 
video track.                                 

Track  
FX

Select this check box if you want   to use the current track effect chain and settings whenever you 
insert   an audio track.                                 
Default track effects are limited   to the first four plug-ins in the chain.                                 
For more   information about audio track effects, see "Track Effects" on page 153.                                 

 3. Click OK.

Restore the original track settings

 1. Right-click a track header   and choose Set Default  Track Properties from the shortcut menu.
 2. Select the Restore  original defaults check box.
 3. Click   OK. 

Preferences
From the Options menu, choose Preferences   to display the Preferences dialog. This dialog contains various user 
options.

Preferences - General Tab
From the Options menu, choose Preferences and select the General   tab to specify miscellaneous options.

Item Description

Automatically  open 
last project on startup

Select this   check box if you want to automatically reopen the project that was open   the 
last time the application was closed. When the check box is cleared,   the application 
starts with a blank project.                     

Show  logo splash 
screen on startup

Select this   check box if you want the ACID logo splash screen to be displayed when   the 
application starts.                     

Use  Newsfeed to stay 
informed about ACID 
product updates

When this   check box is selected, the software will periodically display information   from 
MAGIX at startup. Clear the check box to bypass the Net Notify dialog.                     

Draw  contents of 
events

Select this   check box if you want to draw waveforms in events. Clearing the check   box 
can improve performance on some systems.                     

Create  undos for FX 
parameter changes

Select this check box if   you want to create undos   when a plug-in parameter is changed in 
the FX pages.

Confirm  media file 
deletion when still in 
use

When this   check box is selected, a message box will appear asking if you want to   delete 
a media file that is currently in use by the project.                     
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Close  media files 
when ACID is not the 
active application

When this check box is selected,   files can be edited in external editors   while they are 
contained in events in your ACID project.

Close  audio and MIDI 
ports when ACID is 
not the active 
application

Select this check box if you want to close audio   and MIDI ports when you switch to 
another application. External control   is also suspended when ACID is not active.
Clear the check box if you   want to leave ports open. For example, if you have a MIDI 
keyboard routed   to a soft synth, clearing the check box would allow you to continue to   
hear the soft synth while you're working with a sequencer.

When you edit a clip in an external editor, audio,   MIDI, and external control 
hardware is released regardless of the Close audio and MIDI ports when ACID is 
not  the active application check box setting. The ports are re-enabled   when focus is 
restored to ACID.

Enable  multimedia 
keyboard support

When this   check box is selected, you can use a multimedia keyboard to control playback   
of a project.                     

Automatically render 
large Wave files as 
Wave64 

The .wav format is limited by a maximum file size of ~2GB. When this check box is 
selected, you can render larger files as Wave64 files.

Prompt  for region and 
marker names if not 
playing

When this   check box is selected, an edit box is displayed so you can name markers   and 
regions as you place them.                     

Create  project file 
backups on save 
(.acd-bak)

When this   check box is selected, backup project files are created when you open   or save. 
Backup files are stored in the same folder as your project and   use the extension .acd-bak. 
You can use these files to revert to a project's   previous state.                     

Preserve  pitch for 
new Beatmapped 
tracks when tempo 
changes

Select the   check box if you want to maintain the pitch of Beatmapped tracks when   the 
project tempo changes.                     

Automatically  start 
the Beatmapper 
Wizard for long files

Select the   check box if you want to start the Beatmapper   Wizard when you add a file that 
is longer than 30 seconds to your   project.                     

Use  slower updates 
to prevent playback 
clicks during editing

Select this   check box if you want to update the audio engine more slowly. Selecting   this 
option can prevent unwanted artifacts during timeline editing.                     

Enable  autosave Select this check box to create a temporary   project file that can aid in crash recovery. This 
file is saved every   five minutes, and your original project is not overwritten.                     
During normal startup and shutdown,   the application cleans *.autosave.acd and 
*.autosave.acd-bak   files from your project folder.                     
If you choose to restore your project   when you restart the application after a crash, the 
*.autosave.acd file   is renamed to *.restored.acd and is used as your project file.                     
Even after you use Save   As to save your restored project, the *.restored.acd file will 
remain.   Check your project folder occasionally and delete unneeded files.

Use  SPTI Direct for 
CD burning

Select this check box if   you want to use SPTI (SCSI Pass-Through Interface) to 
communicate with   your CD burning drive.

Autoname  extracted 
CD tracks

Select this check box if you want to automatically   assign file names to tracks that you've 
extracted   from CDs.
File names   will include the CD's identification number and track number.                     

Keep bypassed   FX Select this check box if you   want effects to remain open so you can bypass/enable 
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running effects with no pause   for A/B testing. When the check box is cleared, effects are fully 
bypassed,   conserving processing power.

Confirm   groove 
deletion when still in 
use

When this check box is selected,   a message box will appear asking if you want to delete 
a groove   from the Groove Pool window when it is in use by the project.

Enable   Windows XP 
theme support

When this check box is selected,   the ACID window will inherit the appearance of the 
current theme when   using Windows XP. When the check box is cleared, user interface 
elements   will maintain the classic Windows operating system appearance.

Allow snapping   for 
Post-Groove Markers

When this check box is selected, groove markers      in the Groove Editor will snap to the   
current grid spacing if snapping is enabled.   Hold shift while dragging to bypass 
snapping.
Clear the check box if you do not want groove   markers to snap to the grid.

Check .acd   file type 
association at startup

When this check box is selected,   ACID will check whether .acd, .acd-zip, and .acd-bak 
files are associated   with ACID software and will prompt you to restore the file 
association   if necessary.

Recently  used project 
list

Select the   check box and enter a number in the edit box if you want to list your   most 
recently used projects at the bottom of the File menu.                     

Default  All Click to restore the General   tab to the default settings.

Preferences - Audio Tab
From the Options menu, choose Preferences   and select the Audio tab to specify playback and recording options. 

Item Description

Open  files as 
loops if 
between

Enter a lower and upper limit to specify   which files will be opened as loops if stretching 
properties are not saved   in the file.                     
Files that   are shorter than the lower limit will be opened as one-shot tracks; files   longer than the 
upper limit will start theBeatmapper   Wizard.                     

Quick  fade edit 
edges of audio 
events

When the check box is selected, ACID software   will place a rapid fade on the edges of audio 
events (10 ms by default)   to soften potentially harsh transitions. When the command is not 
selected,   edges of new events are not faded (fades that were applied before the   check box is 
cleared are not removed).
Right-click an event and select or clear the   Quick Fade Edges command to override   the default 
event fade behavior for individual events.

Selecting or clearing the check box will not affect   existing quick fades in your project. To 
remove all quick fades from a   project, enter 0 in the Quick fade time   box.

Quick  fade 
time

Enter a time (in milliseconds) to specify   the duration of fades applied to the edges of events.                     

Changing this setting   will affect all existing quick fades in your project.                     

Waveform 
display while 
recording

Choose a setting from the   drop-down list to specify whether you want to display waveforms in 
the   timeline while recording audio. Turning   off waveform displays can improve performance.

ACID type for 
recorded audio

Choose a setting from the   drop-down list to specify the type of clip that will be created when 
you   record audio.

Record action 
when nothing   
is armed

Choose a setting from the   drop-down list to specify what happens if you click the Record   
button  when no tracks are armed:

New Audio 
Track

Creates a new audio track where you can record.
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New MIDI 
Track

Creates a new MIDI track where you can record.

Do Nothing The Record   button is unavailable unless an audio or MIDI track is armed for 
recording.

Include project 
name when   
naming 
recorded 
media

Select this check box if   you want to use the project name to identify recorded clips. 
For example, if this check   box is selected and you're working with My   Remix.acd, recorded files 
will be named My   Remix Track X Recording X.wav.
If this check box is not   selected, recorded files will be named Track   X Recording X.wav.

Track prefader 
sends listen   to 
mute

Select this check box if you   want pre-volume sends from tracks to busses and assignable effects 
to   respond to the track mute state. 
When the check box is cleared,   the pre-volume sends are not affected by the mute state (in 
order to facilitate   cue mixes). 
For example, assume you have   a project with one track and Bus A that is routed to a hardware 
output.   By default, the bus send is pre volume, so the Master and Bus A will have   the same 
output when you play your project:

 

If you mute the track, the   track's output to the Master bus is muted, but the prefader send to Bus   
A continues playing (if the Track prefader  sends listen to mute check box is not selected):

 

If you switch the track send   to post volume, the track's outputs to the Master bus and Bus A are 
muted:
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If you select the Track  prefader sends listen to mute check box and switch the track send   back 
to pre volume, the track's outputs to the Master bus and Bus A are   muted:

Use legacy 
track send gain

Select this check box if you   want to configure audio track sends to behave as they did in ACID 
6.0   and earlier. When the check box is selected, you can open projects created   with earlier 
versions of ACID and be assured they will sound the same   as they did in earlier versions of 
ACID.

Metronome 
sound

Choose a setting from the   drop-down list to choose the sound that will be used to play the 
metronome.

Normalize peak 
level

Type a value or use the   spinner to change the value that will be used when normalizing   clips. 

Default All Click to restore the Audio   tab to the default settings.

Advanced Audio Configuration
The Advanced Audio Configuration dialog allows you to view information   about and adjust settings for audio device 
selected in the Audio  device type drop-down list on the Audio   Device tab of the Preferences dialog.
To display the dialog, select a device from the Audio device type drop-down list, click Apply,   and then click 
Advanced.

Microsoft Sound Mapper   or Windows Classic Wave Driver             

Item Description

Audio  devices This list   contains all of the audio devices that are installed in your computer.   Select a device 
from the list to set the options below for that device.                         

Interpolate  
position

When this   check box is selected, the software will attempt to compensate for inaccurate   
devices by interpolating the playback or recording position. If you notice   that your playback 
cursor is offset from what you are hearing, enable   this option for the playback device.                         

Position  bias If the position of playback or recording   does not match what you hear after you enable 
Interpolate  position, you can attempt to compensate   using the Position  bias slider.                         
Moving this   slider will offset the position forward or backward to compensate for   the 
inaccuracies of the device.                         
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Do  not pre-roll 
buffers before 
starting 
playback

When this check box is selected, the   software will not create buffers prior to starting playback. 
Some devices   do not behave properly if this check box is cleared.                         
If your audio   stutters when you start playback try selecting this check box.                         

Audio  buffers Drag the slider   to set the number of audio buffers that will be used. Adjusting this setting   can 
decrease gapping or help you synchronize the input and output.                         

Buffer  size Choose a setting from the drop-down   list to indicate the buffer size you want to use. Choose 
MME to   use the Playback  buffering setting on the Audio   Device tab in the Preferences dialog.                         
For example, if you choose MME from  the Buffer size drop-down, set the Audio buffers slider 
to 5,   and set Playback  buffering  to   0.35 seconds, five 0.07-second buffers are created.                         
If you choose   1024 from the Buffer size drop-down   and set the Audio buffers slider   to 5, five 
1024-byte buffers   are created.

Priority Choose a setting from the drop-down   list to set the priority that is assigned to your audio 
buffers.                         
Increasing   the buffers' priority can help you attain smoother playback, but it can   also adversely 
affect other processes.                         

ASIO             

When an ASIO driver is selected,   the Advanced Audio Configuration dialog displays information about the   settings 
for the selected driver. Click the Configure  button to open the driver manufacturer's configuration applet and   adjust 
settings. 
The lower portion of the dialog   lists the device name and the name for each of the selected ASIO device's   ports. You 
can use these controls to customize   input and output port names.

ReWire Device Driver

Item Description

Number   of 
extra stereo 
ports

Specifies the number of extra   stereo ports the ACID Music Studio ReWire device will expose to 
ReWire mixer applications.
After changing this setting,   you'll need to close and restart ACID software and   any active ReWire 
mixer application. Port changes cannot be changed dynamically   when using ReWire.

Number   of 
extra mono 
ports

Specifies the number of extra   mono ports the ACID Music Studio ReWire device will expose to 
ReWire mixer applications.
After changing this setting,   you'll need to close and restart ACID software and   any active ReWire 
mixer application. Port changes cannot be changed dynamically   when using ReWire.
Some ReWire mixers work better   with mono inputs than stereo inputs. Check your ReWire mixer 
application’s   documentation for more specific requirements.

Priority Choose a setting from the drop-down   list to set the priority that is assigned to your audio buffers.
                         
Increasing   the buffers' priority can help you attain smoother playback, but it can   also adversely 
affect other processes.                         

Preferences - Audio Device Tab
Use the Audio Device tab to specify   playback and recording options. To display this tab, choose Preferences  from 
the Options menu, then   click the Audio Device tab.   Click the Advanced   button to access the advanced audio 
preferences. 

Item Description
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Audio  device 
type

Choose a driver type from the drop-down list.

Microsoft 
Sound 
Mapper

The default setting. Allows the Sound Mapper   to choose an appropriate playback 
device.

Direct 
Sound 
Surround 
Mapper

Allows the Surround Mapper to choose appropriate   playback devices for the front, 
rear, and center/LFE channels in a 5.1 surround project.

Windows 
Classic 
Wave 
Driver

Allows you to choose a specific audio device   using a classic Wave driver. 
For stereo projects, choose a device from the   Default Stereo and Front playback 
device  drop-down list.
For 5.1-surround projects, choose devices from   the Default Stereo and Front 
playback device, Default Rear playback device, and Default Center and LFE 
playback device drop-down lists.

ASIO Allows you to   choose a specific audio device using a low-latency ASIO driver.                                  
For stereo projects, choose a device from the   Default Stereo and Front playback 
device  drop-down list.
For 5.1-surround projects, choose devices from   the Default Stereo and Front 
playback device, Default Rear playback device, and Default Center and  LFE 
playback device drop-down lists.

ReWire 
Device 
Driver

Allows you to use ACID software as a ReWire   device in a ReWire mixer 
application.
If a ReWire mixer application starts ACID software,   that ACID window will start in 
ReWire mode and cannot be switched from   ReWire mode. 
If a ReWire mixer connects to an existing ACID   window, that window will run in 
ReWire mode, and you can switch out of   ReWire mode if necessary. If you exit 
that instance of the software and   start ACID software again, the new instance will 
start in ReWire mode,   and you can switch out of ReWire mode if necessary by   
choosing a different audio device type.

Default  
Stereo and 
Front 
playback 
device

Choose the device that you want to use for playing   stereo sound data and the front-left and -right 
channels of a 5.1 surround   project.
Selecting the Microsoft Sound Mapper allows   Windows to select an appropriate device to use for 
the current sound data.

If you have selected Microsoft  Sound Mapper, you will not be able to assign busses to 
different devices.

Default Rear 
playback 
device

Choose the device that you want to use for playing   the rear channels of a 5.1 surround project.

Default  
Center and 
LFE playback 
device

Choose the device that you want to use for playing   the center and low-frequency effect channels 
of a 5.1 surround project.

Playback  
buffering 
(seconds)

Specifies the size   of the audio segments that are sent to the sound card.                     
The larger the number, the more buffering   is performed during playback. This value must be as 
low as possible without   gapping. To set it, start at .25 and play back a typical song. Move some   
of the track faders. If the playback gaps, try increasing this slider   in small increments until the 
gapping goes away. As you increase this   slider, the RAM meter at the bottom of the ACID 
window will indicate more   RAM usage. You need to strike a balance between RAM usage and 
playback   buffering.                     
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If you simply   cannot get playback to be free of gapping, you need to either decrease   the number 
of tracks you are trying to play simultaneously, install more   RAM in your computer so you can 
increase buffering, buy a faster access   hard drive, or minimize the number of audio plug-ins you 
are trying to   use simultaneously.                     

Enable  track 
buffering

Select this check box and drag the Track  buffering slider if you want to adjust the amount of 
audio that   is prerendered ahead of the cursor position.
When the check box is selected, a separate processing   thread is used to render audio from tracks. 
On multiprocessor or multicore   computers, a thread will be created for each logical processor.
When the check box is cleared, a single processing   thread is used to render audio from tracks and 
busses.

Default  audio 
recording 
device

Choose the device that you want to use   for recording sound data.                     
Selecting   the Microsoft  Sound Mapper allows the operating   system to select an appropriate 
device to use for the current sound data.                     

Automatically  
detect and 
offset for 
hardware 
recording 
latency

Select the check box to automatically compensate   for offset between the time you initiate 
recording and when your sound   card starts recording.
Clear the check box and drag the User  recording latency offset slider to specify an offset value.

Enable   
multithreaded 
soft synth 
playback

Select this check box if you want ACID to use   multiple processing threads for playing soft 
synths. On multicore/multiprocessor   computers, this setting can significantly increase 
performance during   playback and real-time rendering.
Clear the check box if you're using a single-core   processor or if you're using soft synths that do 
not support multithreaded   rendering.

Advanced Click this button to open the Advanced   Audio Configuration dialog.

Default   All Click to restore the Audio tab to the default   settings.
       

Preferences - MIDI Tab
From the Options menu, choose Preferences   and select the MIDI tab to set options for using MIDI devices with 
ACID   software. 

If   you have a MIDI controller that includes buttons and knobs that you map   to external control functions, you 
can use the device as an external   control device and as a MIDI input device for recording   MIDI  for example, you 
can use the buttons, knobs, and sliders   on the device for external control, and still use the keyboard, pitch   wheel, 
and modulation wheel for recording MIDI. 

MIDI messages that are mapped to external control functions are filtered   when you record MIDI. If a note 
message is assigned to a control surface   function, both the note-on and note-off messages will be filtered. 

Item Description

Make these devices available 
for MIDI track playback

Select the check box for each   MIDI device that you want to use as a MIDI 
output for MIDI tracks and generating MIDI clock.

To load a program map for a hardware synth, right-click   the Device box 
for your MIDI device and choose Load Device Template   from the 
shortcut menu. 
The selected program map will be used for any   track that is routed to 
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the MIDI device. The device   name will be displayed on the MIDI Output   
button on the track   header, and the programs from the device map will 
be available when   you click the Program button  in the   track header.

To assign an input device to a MIDI output port,   right-click the Device 
box, choose  Input from the shortcut menu,   and then choose an input 
device from the submenu. For example, by assigning   an input device, 
you can choose which controller you want to use to play   a MIDI device.
When you assign an input device   to a MIDI output port, the device 
name is displayed in the Device   column in the appropriate row in the 
Make  these devices available for MIDI input list.

If you want an output device to receive MIDI   thru data from an input 
device, right-click the MIDI  Thru From column and choose a device 
from the shortcut menu.
When you choose a MIDI Thru From device, the device name is 
displayed in the Device   column in the MIDI Thru To column   in the 
Make these devices available for MIDI input list.

Make  these devices available 
for MIDI input

Select the check box for   each MIDI device that you want to be available 
for recording   MIDI, and controlling soft synths.

To assign an   output port to an input device, right-click the Device box, 
chooseOutput from the shortcut menu, and then choose an   output 
device from the submenu.

If you want a MIDI input device to echo its   MIDI data to an output 
device, right-click the MIDI  Thru To column and choose a device from 
the shortcut menu. You   can select multiple devices to send MIDI thru 
data. 

Auto  MIDI input routing When this check box is selected, the focus   track will accept input from 
any MIDI input device. 
When multiple tracks are selected, the focus   track displays a blinking 
indicator in its track number: .

The Solo  Listen to MIDI Input button  in the Soft Synth   Properties 

window is unavailable when this check box is selected.                     

Default  All Click to restore the MIDI   tab to the default settings.

Tips:

 l Double-click   the Device box   and type a new name to identify the MIDI device connected to each MIDI   input or 
output port. For MIDI tracks that use these input and output   ports, these device names will be used on the MIDI 
Input and MIDI Output buttons on the track header.   

 l If you want   notes received from a MIDI input port to be echoed to a MIDI output port   for monitoring, you can 
right-click the MIDI Thru From and MIDI  Thru To box for any enabled output or input ports. For more 
information   about setting up MIDI thru, see "Using External MIDI Devices" on page 222.

Preferences - Video Tab
From the Options menu, choose Preferences   and then click the Video tab to set options for the video track and 
configure   an external monitor. Your   video will be sent to this device when you click the Preview  on External Monitor 
button  in the Video Preview window.

Audio   is not output to the external monitor.
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Item Description

Show source  frame 
numbers on event 
thumbnails as

Choose a setting from the   drop-down list to change the format used to display 
frame numbers in the   video track,   or choose None to turn off frame   numbering.

Device Choose a video   output device from the drop-down list.                     

Details Displays information   regarding the video output device specified in the Device drop-
down list.                     

If project is invalid for DV 
output,
conform to the following

If your source   media does not conform to DV standards, choose a setting from the 
drop-down   list to adjust the video to display properly on your external monitor.                     

Sync  offset (frames) If audio and video do not play back   in synchronization on your external monitor, 
drag this slider to specify   a frame offset to restore synchronization.                     

This setting affects   synchronization on an external monitor only. Audio and 
video synchronization   in your ACID project is unaffected.                     

Record  engage delay 
(frames)

This control   has no effect on your ACID project.                     

Default  All Click to restore the Video   tab to the default settings.

Preferences - Editing Tab
From the Options menu, choose Preferences   and select the Editing tab to specify options for editing on the ACID   
timeline.

Item Description

Project  
tempo range

Use the up   and down arrows or enter a value in the edit boxes to specify the minimum   and 
maximum tempo available in the ACID project. Changing this option   will affect the resolution of 
the Tempo slider.                     

Tempo curve  
segmentation

Choose a setting from the drop-down list to   change the timing resolution ACID uses to 
interpolate tempo curves.

Editing  
application X

Displays the path to each editor you   want to have displayed in the Track List shortcut menu and in 
the Tools   menu. Click the Browse  button to choose an editor.                     
Right-click in the track list, and choose   Edit in [editor  name] to edit a the media file   associated 
with a track.                     

You can specify any   editing tool you want to use; however, this feature was designed for use   
with destructive audio/MIDI editors.                     

Browse Click to  select the .exe   file for each editor you want to have available in the track list shortcut   
menu and in the Tools menu.                     

Name Enter the name that you want to use   to identify each editor. This name is displayed in the track list 
shortcut   menu and the Tools menu.                     

Clear Click to remove   an assigned editor.                     

Default All Click to restore the Editing   tab to the default settings.

Preferences - Sync Tab
From the Options menu, choose Preferences   and select the Sync tab to specify the options for setting up 
synchronization   of other applications and devices with ACID software. 
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Sync Settings             

The following settings, available on the Sync Tab, are used   for setting up MIDI timecode generation from the ACID 
timeline.

Item Description

Generate MIDI 
Timecode settings

These settings are for setting   up MIDI timecode generation from the ACID timeline.

Output device This option   specifies the MIDI device to which the MIDI timecode will be sent. The   
MTC slave should also be set to this device.                             

Frame rate This option   specifies the frame rate for generating MIDI timecode. The MTC slave must   
be set to the same frame rate.                             

Generate  MIDI Clock 
settings

These settings   are for setting up MIDI clock generation from the ACID timeline.                             

Output device This option   specifies the MIDI device to which the MIDI clock will be sent. The MIDI   
clock slave should also be set to this device.                             

Trigger  from MIDI 
Timecode settings

These settings   are for setting up MIDI timecode triggering from another application or   
external device.                             

Input device This option   specifies the MIDI device from which the MIDI timecode will be received.   
The MTC master should also be set to this device.                             

Frame rate This option   specifies the frame rate at which the MTC master will send timecode to   the 
ACID application.                             

Advanced Click to open   the Advanced Sync properties dialog for the selected MIDI settings.                             

Default  All Click to restore the Sync   tab to the default settings.

MIDI Timecode Input - Advanced Settings             

The MIDI Timecode Input dialog appears when you have clicked   on the Advanced  button on the Sync tab of the   
Preferences dialog. This dialog contains advanced options for MIDI Time   Code input. It is only displayed if a device 
is selected for MTC input   on the previous dialog.

Item Description

Free-wheel  for 
time code loss

When this   option is selected, playback will continue for a specified period of time   without 
chasing if timecode is lost for some reason. Enabling this option   can compensate for infrequent 
losses in timecode. If losses in timecode   are frequent, troubleshooting should be done to find 
the cause of the   problem.                         

Free-wheel  
slack time

Use the up   and down arrows or enter a value in the edit box to specify the amount   of time that 
timecode can be lost before the Free-wheel  playback time starts. A longer   time is more 
tolerant of breaks in the incoming timecode.                         

Free-wheel  
playback time

Specifies   the amount of time that playback will continue after theFree-wheel slack time has 
been exceeded.                         

Synchronization  
delay time

Use the up and down arrows or enter   a value in the edit box to specify the amount of time it 
takes for to   synchronize itself to incoming timecode.                         
On slower computers, this time should   be set to approximately two seconds. On faster 
computers, it may be set   lower.                         

Setting this value too low can sometimes result in audible   pitch shifting at the start of 
playback.                         

Offset  adjust If synchronization is consistently behind   or ahead of your MTC generator, enter a value in the 
box to adjust a synchronization   offset with quarter-frame accuracy.                         
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 l If synchronization   is behind, set this value to a negative number. A setting of - 4 usually   
does the trick.                             

 l If   synchronization is ahead, set this value to a positive number. A setting   of +4 usually 
does the trick, though it is rare that ACID software will   sync ahead.                             

MIDI Timecode Output - Advanced Settings             

This tab contains advanced options for MTC (MIDI timecode)   input. It is only displayed if a device is selected for 
MTC input on the   Sync tab of the main Preferences dialog.

Item Description

Full-frame  
message 
generation

This option specifies when   to send full-frame timecode messages while Generate MIDI Timecode is 
enabled.   Full-frame messages are used by some external synchronizable audio devices   to seek to a 
proper location prior to actually starting synchronization.   Tape-based recorders especially benefit 
from seeking to full-frame messages   because of the time it takes to move the transport to the proper 
location.   However, full-frame messages are ignored by some devices and may actually   cause 
unexpected behavior in other devices.                         
Check your hardware documentation   to find out if they support full-frame messages.                         

MIDI Clock Output - Advanced Settings             

The MIDI Clock Output dialog appears when you have clicked   on the Advanced  button on the Sync tab of the   
Preferences dialog. This dialog   contains advanced options for MIDI Clock output. It is only displayed   if a device is 
selected for MIDI Clock output on the previous dialog.

Item Description

Send  Start 
instead of 
Continue when 
beginning 
playback

Select this check box if you want to   send a Start command rather than a Continue command 
when Generate MIDI Clock is enabled.                         
When the check   box is cleared, a Continue command is sent, as this type of command allows   
the chasing device to start from a specific time. However, some older   sequencers that support 
MIDI clock chase do not support the Continue command   and must start playback from the 
beginning every time.                         

Song  Position 
Pointer 
generation

This option   specifies when to send Song Position Pointer messages while Generate MIDI 
Clock is enabled. Song Position Pointer messages   are used by MIDI applications and devices 
to seek to a proper location   prior to actually starting synchronization.                         

Preferences - Display Tab
From the Options menu, choose Preferences   and select the Display tab to specify options for the appearance of the   
ACID workspace.

Item Description

Track 
colors

Use these controls to change   the default colors used to display tracks in your project.
Select a track from the Track drop-down list, and then click   the color swatch to display a color picker.
You can choose any color using   the RGBA or HSLA controls. Click the  button to switch between 

RGB and HSL color   modes, or click the eyedropper  to sample a color from your screen. 
When you click OK or Apply, all tracks that   used the selected color are updated.

Envelope   
colors

Choose an envelope type   from the Envelope type drop-down   list and click the color swatch to 
display a color picker, where you can choose any color using the RGBA or HSLA   controls. Click the 

 button to switch between RGB and HSL color modes,   or click the eyedropper  to sample a color 

from your screen.
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Using custom envelope colors can help you avoid getting   lost in a maze of envelopes when 
you're using track envelopes to control   effects automation.

Section   
colors

Use these controls to change   the default colors used to display sections   in your project.
Choose a section letter   from the Section drop-down list   and click the color swatch to display a color 
picker, where you can choose   any color using the RGBA or HSLA controls. Click the  button to 

switch between RGB and HSL color   modes, or click the eyedropper  to sample a color from your 
screen.

Icon color   
saturation

Drag the slider to adjust   the color intensity of icons in the ACID window. Drag to the left to decrease   
the color saturation, or drag to the right to increase it.

Icon color   
tint

Drag the slider to adjust   the amount of tinting that is applied to the icons in the ACID window.   Drag 
the slider to the right to add an average of the title bar colors   to the icons. Drag to the left to decrease 
the amount of tinting applied.

You can use the Display Properties control   panel to change your active window title bar colors. In 
the Windows 2000   operating system, open the Display Properties control panel and select   the 
Appearance tab. Then choose Active Title Bar from the Item   drop-down list. In the Windows 
XP operating system, open the Display Properties   control panel and select the Appearance tab. 
Then click the Advanced button and choose Active Title Bar   from the Item drop-down list.

Default   
All

Click to restore the Display   tab to the default settings.

Preferences - Other Tab
From the Options menu, choose Preferences   and select the Other tab to set up list-based preview from the Explorer   
window.

Item Description

Enable  multiple-selection preview 
in Explorer window

Select this   check box if you want to preview multiple selected files 
sequentially   from the Explorer window.                     

Number  of times to repeat each 
Loop

Enter the   number of times you want to play loops before the next file 
begins playing.                     

Seconds  of each One-Shot to play Enter the   amount of time you want one-shots to play before the next 
file begins   playing.                     

Number  of Beatmapped measures 
to play

Enter the   number of measures you want to play from Beatmapped 
files before the next   file begins playing.                     

Default  All Click to restore the Other   tab to the default settings.

Preferences - Folders Tab
From the Options menu, choose Preferences   and select the Folders tab to indicate where your project media is 
saved.

Item Description

Default   project folder This box displays the path to the folder that   will be used for creating new   projects. Click 
the Browse   button to choose a different folder.

Use a single   default 
folder for project 
media saves

Select this radio button if   you want to save all project media in a single folder.

Use separate   defaults 
for each type of 
project media save

Select this radio button if   you want to choose where to save each type of project media. 
The following boxes display   the location where each type of media file will be saved.
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Record This box displays the path to the folder that   will be used when you record   new 
audio or MIDI tracks. Click the Browse   button to choose a different folder.

The folder you specify here is used by default   for new projects, but if you 
want to choose a project-specific recorded   files folder, you can use the 
Recorded  files folder box on the Audio tab of the Project Properties 
dialog.

Extract  
from 
CD

This box displays the path to the folder that   will be used for tracks that you 
extract from audio CDs. Click the Browse   button to choose a different folder.

Render  
project

This box displays the path to the folder that   will be used when you render   your 
project. Click the Browse   button to choose a different folder.

Render 
to new

This box displays the path to the folder that   will be used when you render to a 
new   track. Click the Browse button   to choose a different folder.

Chop  
to new

This box displays the path to the folder that   will be used when you create new 
tracks with the Chopper window. Click the Browse   button to choose a 
different folder.

New  
MIDI

This box displays the path to the folder that   will be used when you export   
MIDI. Click the Browse button   to choose a different folder.

MIDI files are not created when you record   MIDI or create new MIDI 
clips.   MIDI data for clips is stored within the ACID project.

Default groove folder This   box displays the path to the folder where default grooves for new ACID projects are 
saved. Click the Browse button to choose a different  folder.
This   folder is also used as the default location for saving exported grooves from the 
Groove Pool window.                        

Temporary files 
folder

Displays the folder where temporary files are   created. Click the Browse button   to specify a 
new folder.

When a media file is added to a project from a removable   device, a copy of the media 
file is stored in a subfolder within this   folder. This keeps the media file available for 
use even if the source   of the media is no longer accessible.

Be aware that   these subfolders are cleared when you close the application. However,   
they are not cleared if the application closes inappropriately.

Free storage space in 
selected   folder

This box displays the amount of space available   in the folder specified in the Temporary  
files folder box.

Default  All Click to restore the Folders   tab to the default settings.

Preferences - External Control & Automation Tab
Use the External Control &   Automation tab to set up and customize control surfaces. To display this   tab, choose 
Preferences   from the Options menu, then click the External Control & Automation   tab. 

You can connect one Mackie Control Universal (with up to four   Mackie Control Universal Extenders), one 
Frontier TranzPort,   and up to five generic MIDI controllers.

The selected device isn't enabled until you select the External Control command   from the Options menu.

Item Description

Smooth and thin 
automation   data 

When recording automation or drawing   envelope curves, ACID software creates as many 
envelope points or   keyframes as possible to represent your control movements. 
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after recording or 
drawing

Select this check box if you want to reduce   the number of envelope points/keyframes after 
recording/drawing is finished.

Thinning is not applied to MIDI controller   envelopes that you record from a hardware   
device. 

Set controls to 
default values   
when automation 
is turned off

Select this check box if you want controls to   return to their default values when set the 
track's automation   recording mode to Automation Off.   Automated effect parameters do not 
have default settings and will retain   their last-set values when you turn automation off.
When the check box is cleared, controls will   retain their last-set values when you turn 
automation off.

Available devices Choose a device from each drop-down list, and   then click Add to choose the control   
surfaces that will be available to ACID software. Adding a device loads   its default profile. 

 l For   information about setting up and using a control surface, please see Using a 
Control   Surface.

 l For   information about using a Mackie Control Universal, please see Using a Mackie 
Control.

 l For   information about using a Frontier TranzPort, please see Using a Frontier TranzPort.
 l For   information about using a generic control surface, please see Using a Generic 

Control Surface.

Active control 
devices

Lists the control devices that you've added.   If you want to customize the behavior of   the 
controller, double-click the device name.

Default All Restores all control surface preferences to   the default settings.
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Keyboard Shortcuts
From the Help menu, choose Keyboard  Shortcuts to view the shortcut keys that are available. The available   shortcut 
keys are arranged in tables according to function.

The following shortcuts represent   the default configuration. Your system may differ if you've used the 
Customize Keyboard dialog   to customize your keyboard shortcuts.          

General Shortcuts
Command Shortcut

Display online   help                     F1                     

Display context-sensitive   help Shift+F1 and   click an item                     

Refresh screen                     F5

Shortcut menu                     Shift+F10

Temporarily   suspend snapping                     Hold Shift  while dragging

Project File Shortcuts
Command Shortcut

Create new   project                     Ctrl+N

Create new   project and bypass the Project Properties 
dialog                     

Ctrl+Shift+N

Open existing   project or media file                     Ctrl+O

Save project                     Ctrl+S

Open project   properties                     Alt+Enter

Close the   current project                     Ctrl+F4

Magnification and View
Command Shortcut

Focus to track view Alt+0

Show Explorer window Alt+1

Show Chopper window Alt+2

Show Mixing Console window Alt+3

Show Video Preview window Alt+4

Show Media Manager window Alt+5

Show Track Properties window Alt+6

Show Surround Panner window Alt+7

Show Soft Synth Properties   window Alt+8

Show Audio Plug-In window Alt+9

Show Plug-In Manager window Ctrl+Alt+1
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Show Groove Pool window Ctrl+Alt+2

Show Clip Properties window Ctrl+Alt+3

Show/hide bus tracks B

Show/hide event information Ctrl+Shift+I                     

Shift focus   forward through open ACID windows                     F6

Shift focus   backward through open ACID windows                     Shift+F6

Shift focus   forward (clockwise) through track list, 
timeline, bus track timeline,   and bus track list (when 
track view or timeline has focus)                     

Tab

Shift focus   backward (counterclockwise) through track 
list, bus track list, bus track   timeline, and timeline (when 
track view or timeline has focus)                     

Shift+Tab

Restore project   magnification to the default settings                    F9

Restore track   height to a level where all track list 
controls are displayed                     

Shift+F9

Reduce timeline   magnification so the entire length of 
the project and as many tracks as   possible are displayed
                     

Ctrl+F9

Zoom time in/out small increments
(when timeline has focus)

Up or Down Arrow

Zoom time in/out large increments
(when timeline has focus)

Ctrl+Up or Down Arrow

Zoom in time until each video   thumbnail represents one 
frame

Alt+Up Arrow

Zoom track height in/out   (when timeline has focus) Shift+Up or Down Arrow

Zoom audio waveforms in/out   vertically in timeline, 
Chopper, and Clip Properties

Alt+Shift+Up   or Down Arrow

Change track   height for all tracks                     Ctrl+Shift+Up  or Down Arrow

Minimize/restore   track height for all tracks                     `

Return all   tracks to the default height                     Ctrl+`  (grave accent)

Minimize/restore   the window docking area                     F11  or
Alt+`  

Maximize/restore   timeline vertically and horizontally
(window docking area and track list will be hidden)                     

Ctrl+F11 or
Ctrl+Alt+`

Minimize/restore   the track list                     Shift+F11  or
Shift+Alt+`

Explorer window 
Command Shortcut

Add all selected files to   the track list Enter

Add   selected file or currently playing file to the track list                     Ctrl+Enter
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Cursor placement, loop region and time selection
Command Shortcut

Go to beginning   of active loop region or viewable area 
(if no time selection)                     

Home

Go to end   of active loop region or viewable area (if no 
time selection)                     

End

Toggle cursor   between beginning and end of loop 
region                     

Keypad 5

Time select   loop region (when Time Selection tool  

is selected)                     
Shift+Q

Toggle previous   selection                     Backspace

Go to beginning   of project                     W or Ctrl+Home

Go to end   of project                     Ctrl+End

Move left   by grid marks                     Page Up

Move right   by grid marks                     Page Down

Go to (using   measures, beats, and ticks)                     Ctrl+G

Go to (using   absolute time)                     Shift+G

Set end of   time selection 
(using measures, beats, and ticks when Time Selection 
tool    is selected)                     

Ctrl+Shift+G

Center in   view                     \

Move cursor   to corresponding marker or select 
corresponding region                     

Number keys  (not Keypad)

Move left/right   one pixel                     Left/Right  Arrow

Move to marker(s)                     Ctrl+Left/Right  Arrow

Move left/right   to event edit points on current track 
including fade edges                     

Ctrl+Alt+Left/Right  Arrow

Move through   a video event one frame at a time                     Alt+ Left  or Right Arrow

Create or extend loop region/time   selection Shift+Left or Right Arrow

Double loop region/selection   length ' (apostrophe)

Halve loop region/selection   length ; (semicolon)

Shift loop region/selection   left , (comma)

Shift loop region/selection   right . (period)

Select previous section Ctrl+[                     

Select next section Ctrl+]

Event Editing
Command Shortcut

Add entire media length   for all media except video Ctrl+click   in timeline                     
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(only when Paint tool  is selected)

Cycle clip forward for   all selected events C

Cycle clip backward   for all selected events Shift+C                     

Copy to new MIDI clip Ctrl+Shift+C                     

Select Draw   tool Ctrl+D                     

Select next   edit tool in list                     D

Select previous   edit tool in list                     Shift+D

Show velocity information   in MIDI events (when in 
inline MIDI editing mode)

F

Toggle inline MIDI editing   mode G

Undo                     Ctrl+Z

Redo                     Ctrl+Shift+Z

Cut selection                     Ctrl+X

Copy selection                     Ctrl+C

Copy event                     Ctrl+drag

Paste from   clipboard                     Ctrl+V

Paste repeat   from clipboard                     Ctrl+B

Paste insert                     Ctrl+Shift+V

Insert event at cursor Y

Paste event at cursor Shift+Y

Delete selection                     Delete

Move selected   event(s) right 1 pixel                     Keypad 6

Move selected   event(s) left 1 pixel                     Keypad 4

Temporarily   suspend Snap To                     Shift while  dragging an event

Erase entire   event                     Ctrl+click  event with Erase tool

Split event(s)                     S

Join selected   events                     J

Reverse event U

Trim events   to selection length. 

This command has no effect if there is no selected   
data. Trimming does not copy data onto the 
clipboard. Available only when   the Time Selection 
tool is active.                     

Ctrl+T

Slip Trim:   moves the media with the edge as it is 
trimmed                     

Alt+drag edge  of event

Slip: move   media within event without moving the 
event                     

Alt+drag inside  the event

Slide: move   event while leaving the underlying media in 
place                     

Ctrl+Alt+drag  event

Pitch up 1 semitone Numeric Keypad  +
=

Pitch down   1 semitone                     Numeric Keypad -
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-

Pitch up 4 semitones Shift+=
Shift+Numeric Keypad +

Pitch down   4 semitones                     Shift+-
Shift+Numeric Keypad -

Pitch up 1 octave Ctrl+Numeric Keypad +

Pitch down   1 octave                     Ctrl+Numeric Keypad -

Reset pitch                     Ctrl+Shift+-/=
Ctrl+Shift+Numeric Keypad   +/-

Change an   event's gain setting                     Numeric Keypad / or *

Change an   event's gain setting by 10%                     Shift+Numeric Keypad / or   *

Change an   event's gain setting by 25%                     Ctrl+Numeric Keypad / or   *

Set an event's   gain to 0.0 dB                     Shift+Ctrl+Numeric Keypad   *

Set an event's   gain to silence                     Shift+Ctrl+Numeric Keypad   /

Render to new track                     
Chop to new   clip if the Chopper window has focus                     

Ctrl+M

Playback
Command Shortcut

Start/stop   playback                     Spacebar                     

Stop playback                     Esc

Toggle looped   playback                     Q

Play from   start                     Shift+Spacebar or Ctrl+Shift+Spacebar  when the 
timeline or track view has focus
Shift+F12 from any window                     

Play from   cursor                     Ctrl+Spacebar when the timeline or track view has 
focus
F12 from any window                     

Pause/resume   playback                     Enter when the timeline or track view has focus
Ctrl+F12 from any window                     

Record                     Ctrl+R

Go to start   of project                     Ctrl+Home  or W

Go to end   of project                     Ctrl+End

Skip backward                     Page Up

Skip forward                     Page Down

Timeline
Command Shortcut

Record                     Ctrl+R                     

304

www.magix-audio.com



Go to (using measures.beats.ticks) Ctrl+G                     

Go to (using   current time ruler format)                     Shift+G                     

Set end of   time selection (using measures, beats, and 
ticks when Time Selection tool    is selected)                     

Ctrl+Shift+G                     

Group Events Ctrl+Alt+G

Toggle snapping                     F8                     

Temporarily   suspend snapping                     Shift+drag  
(press Shift after clicking)                     

Toggle snap   to grid                     Ctrl+F8                     

Ripple edit   mode                     Ctrl+L                     

Draw tool                     Ctrl+D                     

Select next   edit tool in list                     D                     

Select previous   edit tool in list                     Shift+D                     

Mark in point                     I or [                     

Mark out point                     O or ]                     

Render to   new track                     Ctrl+M                     

Insert/show/hide   track panning envelope                     P                     

Insert/remove   track panning envelope                     Shift+P                     

Insert/show/hide   track volume envelope                     V                     

Insert/remove   track volume envelope                     Shift+V                     

Adjust envelope   point value in fine increments 
without changing the point's timeline position                     

Ctrl+ drag  envelope point or segment                     

Adjust envelope   point value in normal increments 
without changing the point's timeline   position                     

Ctrl+Alt+ drag envelope point or segment                     

Adjust envelope point's timeline   position without 
changing its value

Alt+ drag

Insert audio track Ctrl+Q

Insert MIDI track Ctrl+Alt+Q

Insert folder track Ctrl+Alt+F

Insert region                     R                     

Insert marker   (standard)                     M                     

Insert time marker H

Insert disc-at-once CD track   marker N

Change tempo                     Alt+drag time  marker                     

Insert tempo   change                     T                     

Insert key   change                     K                     

Insert time signature change Shift+K

Insert tempo and key change Shift+T                     

Maximize timeline   vertically
(window docking area will be hidden)                     

F11                     

Maximize timeline   vertically and horizontally
(window docking area and track list will be hidden)                     

Ctrl+F11                     
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Maximize timeline   horizontally
(track list will be hidden)                     

Shift+F11                     

Track List
Command Shortcut

Mute selected   tracks                     Z                     

Solo selected   tracks                     X                     

Record                     Ctrl+R                     

Cycle through   effect automation envelopes                     E  or Shift+E                     

Render to   new track                     Ctrl+M                     

Show/hide   bus tracks                     B

Insert audio track Ctrl+Q

Insert MIDI track Ctrl+Alt+Q

Insert folder track Ctrl+Alt+F

MIDI
Command Shortcut

Insert new MIDI track Ctrl+Alt+Q

Show   velocity information in MIDI events (when in 
inline MIDI editing mode                     

F

Toggle   inline MIDI editing mode                     G

Generate MIDI   timecode                     F7                     

Generate MIDI   Clock                     Shift+F7                     

Trigger from   MIDI timecode                     Ctrl+F7                     

Reset all   MIDI ports                     Ctrl+Alt+F7                     

Chopper
Command Shortcut

Create or extend selection Shift+Right/Left Arrow

Mark the start point of   a loop region I or [

Mark the endpoint of a loop   region.
Once the endpoint is established, the loop region will 
highlight.

O or ]

Insert Chopper   selection in the timeline at the current 
cursor position                     

/ or A                     

Shift Chopper selection   left by the length of the 
selection

, or <

Shift Chopper selection   right by the length of the 
selection

. or >

Shift Chopper selection   left by the length of the Ctrl+Shift+,
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increment arrow

Shift Chopper selection   right by the length of the 
increment arrow

Ctrl+Shift+.

Shift timeline   cursor left by the length of the increment 
arrow                     

Ctrl+,                     

Shift timeline   cursor right by the length of the increment 
arrow                     

Ctrl+.                     

Links the   length of the increment arrow with the length 
of the selection.
When toggled   on, the length of the increment remains 
equal to the length of the selection.
 When toggled off, you can configure the increment 
independently of the   Chopper selection.                     

N                     

Halve the   length of the Chopper selection                     ; (semicolon)                     

Double the   length of the Chopper selection                     ' (apostrophe)                     

Double the   length of the increment arrow                     Ctrl+' (apostrophe)                     

Halve the   length of the increment arrow                     Ctrl+; (semicolon)                     

Insert region                     R                     

Insert marker                     M                     

Chop to new   track                     Ctrl+M                     

Surround   Panner
Command Shortcut

Constrain   motion to 45-degree increments                     Shift+drag   the pan point (only when Move Freely  

is selected)

Constrain   motion to a constant radius from the center                     Alt+drag the   pan point (only when Move  Freely  is 

selected)                     

Constrain   motion to the maximum circle that will fit in 
the Surround Panner                     

Alt+Shift+drag   the pan point (only when Move  Freely 
 is selected)                     

Move the pan   point forward/back
(when the pan point is selected)                     

Up/Down Arrow                     
Mouse wheel                     

Move the pan   point left/right
(when the pan point is selected)                     

Left/Right Arrow                     
Shift + mouse  wheel forward/back                     

Move the pan   point forward/back in fine increments
(when the pan point is selected)                     

Ctrl+drag the pan point                     
Ctrl+Up/Down Arrow                     
Ctrl+mouse wheel                     
Page Up/Page  Down                     

Move the pan   point left/right in fine increments
(when the pan point is selected)                     

Ctrl+drag the pan point                     
Ctrl+ Left/Right Arrow                     
Ctrl+Shift+mouse wheel                     
Shift+Page  Up/Page Down                     

Move the pan   point to a corner, edge, or center of the 
Surround Panner

Numeric keypad                     
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(when the pan point is selected)                     

Move the pan   point to a corner on the largest circle that 
will fit in the Surround   Panner
(when the pan point is selected)                     

Ctrl+Numeric  Keypad 1,3,7,9                     

Mixing   Console
Command Shortcut

Rename   selected channel F2

Insert   new audio track                     Ctrl+Q

Insert new MIDI track Ctrl+Alt+Q

Cycle default/narrow/wide   channel strips D/N/W

Hide the selected channel   strip Shift+H

Show the Channel List pane Shift+C

Show all channel strips Q

Show/hide audio bus channel   strips U

Show/hide audio track channel   strips A

Show/hide MIDI track channel   strips C

Show/hide assignable effects   channel strips E

Show/hide soft synth channel   strips V

Show/hide master bus channel   strip T

Show/hide preview channel   strip P

Show/hide fader ticks Shift+T

Show/hide control region labels Shift+L

Show/hide Faders control region F

Show/hide Insert FX control   region I

Show/hide I/O control region H

Show/hide Meters control region M

Show/hide Sends control region S

Change selection   of a channel strip                     Left/Right  Arrow                     

Move the right   channel of the fader for the selected 
channel strip                     

Ctrl+Up/Down  Arrow                     

Move the left   channel of the fader for the selected 
channel strip                     

Shift+Up/Down  Arrow                     

Select multiple   adjacent mixer controls                     Shift+Left/Right  Arrow                     

Select multiple   nonadjacent mixer controls                     Ctrl+Left/Right  Arrow                     

Delete the   selected channel strip                     Delete                     

Move the fader   of the selected channel strip 
(for assignable FX, this only moves the   output fader)                     

Up/Down Arrow
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Mouse   Shortcuts
Command Shortcut

Zoom in on timeline Rotate mouse wheel forward   or back

Vertical scroll Ctrl+wheel

Change meter resolution Ctrl+wheel when hovering over   a meter

Horizontal scroll Shift+wheel

Zoom in/out in piano roll   or drum grid Shift+wheel while hovering   over the piano roll/drum 
grid in the timeline

Auto-scrolling Press mouse wheel and move   the mouse in the desired 
direction

Move the cursor in grid increments Ctrl+Shift+wheel

Move the cursor in video frames Ctrl+Alt+Shift+wheel

Adjust slider/fader Wheel up or down while hovering   over slider/fader 
handle

Adjust slider/fader in fine   increments Ctrl + wheel up or down while   hovering over 
slider/fader handle
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Signal Flow Diagrams
Here it is: everything you ever wanted to know and more about audio processing in ACID software.——
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Audio signal flow             
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Notes:

 l This diagram describes non-MIDI   audio events.
 l In 5.1 surround sound projects,   tracks routed to the Surround Master bus send surround panning (six-channel)   

information. Tracks routed to busses (e.g., Bus A) send stereo panning   (two-channel) information.
 l Assignable effect chain panning   is available only in 5.1 surround sound projects. In 5.1 surround sound   projects, 

assignable effect chains routed to the Surround Master bus send   surround panning (six-channel) information. 
Assignable effect chains routed   to busses (e.g., Bus A) send stereo panning (two-channel) information.

 l Bus panning is available only in   5.1 surround sound projects. In 5.1 surround sound projects, busses routed   to 
the Surround Master bus send surround panning (six-channel) information.   Busses routed to hardware send 
stereo panning (two-channel) information.
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MIDI signal flow
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Notes:

 l Soft synth panning is available   only in 5.1 surround sound projects. In 5.1 surround sound projects, soft   synth 
bus controls routed to the Surround Master bus send surround panning   (six-channel) information. Soft synth 
bus controls routed to busses (e.g.,   Bus A) send stereo panning (two-channel) information.

 l Bus panning is available only in   5.1 surround sound projects. In 5.1 surround sound projects, busses routed   to 
the Surround Master bus send surround panning (six-channel) information.   Busses routed to hardware send 
stereo panning (two-channel) information.
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Troubleshooting
We're here for you. . . really. This topic is meant to help you get   over those annoying little hurdles that are keeping 
you from doing what   you really want to do: get back to creating some great music with ACID   software.

The audio from my ASIO   sound card keeps dropping out. What gives?             

Increase your latency settings

 1. From the Options menu, choose   Preferences.   The Preferences dialog is displayed.
 2. Select the Audio Device   tab and click the Advanced   button. The Advanced Audio Configuration dialog is 

displayed.
 3. Select the ASIO driver tab   and click the Configure   button to display the configuration applet from your hardware 

manufacturer.
 4. Type a new latency value,   apply the change, and close the configuration applet to return to the   Advanced Audio 

Configuration dialog.
 5. Click the Apply   button in the Advanced Audio Configuration dialog.

Turn off other audio devices
You can only use a single ASIO   driver at a time, and some ASIO drivers can conflict with other audio   driver models 
(such as WDM and wave drivers).

My audio skips and gaps when I play my project.   Can I fix it?             
Getting your computer to play back a complex project can   be a bit like walking a tightrope: there's a delicate balance 
between   responsive playback and glitch-free playback. The trick is finding the   sweet spot for your hardware.
For more information about setting advanced audio preferences,   see "Microsoft Sound Mapper   or Windows Classic 
Wave Driver             " on page 289.

 1. From the Options menu, choose   Preferences,   and then click the Audio Device tab.
 2. Click the Advanced  button to display the Advanced Audio Configuration dialog for your   sound card.
 3. Adjust your buffer size   until playback is responsive and clear.
 4. For wave devices, try raising and   lowering from the default settings until you find the sweet spot. Use   the Buffer 

size drop-down  list to choose a buffer size in samples, or choose MME   to use the Playback buffering setting 
on the Audio Device tab in the Preferences dialog.   You can also try increasing the Audio buffers setting to 
increase the number of buffers created. As a   last resort, choose Time Critical from the Priority drop-down list.

 5. For ASIO devices, start with a setting   of 2048 samples. If playback is glitch free, you can try decreasing the   
setting. If you hear glitches, you may need to raise the setting.

Higher sample rates (and bit depths) may require   a larger buffer because more data is being put through your 
device per   buffer.

Troubleshooting 315



Why can't I hear the output of my MIDI controller   through the soft synth or 
MIDI thru port?             

Turn on real-time MIDI monitoring
If you have a MIDI track routed   to an external MIDI device, real-time MIDI monitoring must be enabled   to allow 
ACID software to communicate with the MIDI port.
Real-time MIDI monitoring is enabled by default,   but if you've turned it off, you can turn it on again by choosing 
Enable Real-Time MIDI    from the Options menu.

When the Enable  Real-Time MIDI command is selected, audio plug-ins continue running   even when playback is 
stopped. Turning the command off can conserve processing   power, but input from external MIDI controllers will be 
ignored.

Enable the VST instrument
If you're using a VST instrument, select   the Enable button    in the Soft Synth   Properties window to hear its output.

Try a different soft synth
Unfortunately, some soft synths work better   than others. Try routing your soft   synth to a different  VST instrument.

When I try to play my project, the ACID application   tells me that it can't 
open the Microsoft GS Wavetable   Synth. Whatever can I do?             
ASIO sound drivers can cause conflicts with the Microsoft   GS Wavetable Synth. To play your project, choose a 
different device   for MIDI playback and verify that no other application is trying to use   non-ASIO drivers.

Why don't all my automatable plug-ins appear   in the Automatable folder?             
Unfortunately, there is no standard way for a DirectX host   application to determine whether a DirectX plug-in is 
automatable. For this reason,   the application does not check a plug-in until you try to use it (just   think of the time 
we're saving you at startup).
After you use a plug-in, the application can determine whether   it is automatable and it will appear in the correct 
folder in the Plug-In   Chooser and will be indicated by the   icon if it is automatable.

I want to adjust the buffer size and buffer   flushing for my VSTi plug-ins, but I 
can't find a setting in the Preferences   dialog.             
Adjusting these settings can resolve issues with some specific   VSTi plug-ins. These settings will vary with your 
specific configuration   and can be modified via the Windows Registry.

Incorrectly modifying the registry can degrade   performance or cause serious problems with your operating 
system. If you're   uncertain how to change these settings, please use the defaults.             
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 1. Start the Windows Registry   Editor.
 2. Browse to the key [HKEY_CURRENT_USER\Software\MAGIX\ACID Music Studio\11\Metrics\VSTi Synth].
 3. Edit the appropriate DWORD value:

DWORD Default 
Value

Explanation

FlushOnStopCount 00000000
                                 

Some VST   instruments (such as FruityLoops) do not flush their buffers 
on close   and will output these buffers the next time you play or render 
your project.   Entering a value in the FlushOnStopCount DWORD allows 
you to flush up to 500 buffers   of audio.                                 

FrameSize 00000006
                                 

Frame size defaults to 6 ms, but   can be set as high as 2000 ms. This 
should rarely need to be modified.                                 
 

Both of these settings apply to playback,   seeking, and rendering. Excessively high values can cause latency that   
can appear as an application crash. For example, if you set your buffer   size to 2000 ms and set ACID software 
to flush 500 buffers, you'll create   a 1000 second hang on every stop, seek, or render.

When I try to play my project, I see an error   message that tells me a MIDI 
port is currently in use. What should I do?
If you have a MIDI port configured in both ACID software   and a ReWire client application,   they will conflict when 
both applications try to access them at the same   time.
If you want to use the MIDI port to play synths within a   ReWire client, clear the port's check box in the Make  these 
devices available for MIDI track playback and Generate MIDI clock   section of MIDI tab in the Preferences   dialog.
If you want to use your MIDI port in ACID software, make   sure your ReWire client is not configured to use the port.
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Glossary
ABCDEFGHILMNOPRSTVW

-A-
Activation Number
This number is based on the Computer   ID number of the computer on which the software is installed. Each   
computer has a unique number, similar to a license plate. An activation   code is created based on that number. When 
you register the software,   MAGIX will generate an activation code for you. Once the code is entered,   the software 
will not time out. Since the activation number is based on   the Computer ID, it is important that you have the 
software installed   on the computer where you will be using it.
ActiveX
A Microsoft technology that enables different programs to   share information. ActiveX extends Microsoft Windows-
based architecture   to include Internet and corporate intranet features and capabilities.   Developers use it to build user 
interactivity into   programs and World Wide Web pages.
Adaptive Delta Pulse Code Modulation (ADPCM)
A method of compressing audio data. Although the theory   for compression using ADPCM is standard, there are 
many different algorithms   employed. For example, Microsoft's ADPCM algorithm is not compatible with   the 
International Multimedia Association's (IMA) approved ADPCM.
Advanced Streaming Format (ASF)
See Windows Media Format.
Aliasing         
A type of distortion that occurs when digitally recording   high frequencies with a low sample rate. For example, in a 
motion picture,   when a car's wheels appear to slowly spin backward while the car is quickly   moving forward, you are 
seeing the effects of aliasing. Similarly, when   you try to record a frequency greater than one half of the sampling rate   
(the Nyquist Frequency), instead of hearing   a high pitch, you may hear a low-frequency rumble.
To prevent aliasing, an anti-aliasing filter is used to   remove high-frequencies before recording. Once the sound has 
been recorded,   aliasing distortion is impossible to remove without also removing other   frequencies from the sound. 
This same anti-aliasing filter must be applied   when resampling to a lower sample rate.
ASIO
A low-latency audio driver model developed by Steinberg   Media Technologies AG.
Attack
The attack of a sound is the initial portion of the sound.   Percussive sounds (drums, piano, guitar plucks) are said to 
have a fast   attack. This means that the sound reaches its maximum amplitude in a very   short time. Sounds that 
slowly swell up in volume (soft strings and wind   sounds) are said to have a slow attack.
Audio Compression Manager (ACM)
The Audio Compression Manager, from Microsoft, is a standard   interface for audio compression and signal 
processing for Windows. The   ACM can be used by Windows programs to compress and decompress .wav   files.
Audio Proxy File
An audio proxy (.sfap0) file is created when an audio stream   is not efficient to access or if it does not seek 
accurately. The application   will take the audio stream from the file and save it to a separate and   more manageable 
audio proxy file. While audio proxy files may be large   (because they are uncompressed), the performance increase is 
significant.
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The file is saved as a proprietary *.sfap0 file, with the   same name as the original media file and has the same 
characteristics   as the original audio stream. For example, movie.avi yields a movie.avi.sfap0   audio proxy. Additional 
audio streams in the same file are saved as movie.avi.sfap1,   movie.avi.sfap2, etc. This is a one-time process that will 
greatly speed   up editing. The conversion happens automatically and does not result in   a loss of quality or 
synchronization. The original source file remains   unchanged (the entire process is nondestructive). Audio proxy files 
can   be safely deleted at any time since the application will recreate these   files as needed.

Audio proxy files   are saved to the same folder as the source media. If the source media   folder is read-only (e.g. a 
CD-ROM), the files will be saved to a temporary   directory.

ASX File
ASF Stream Redirector file. See Redirector   file.
Attenuation
A decrease in the level of a signal.

-B-
Bandwidth
When discussing audio equalization, each frequency band   has a width associated with it that determines the range 
of frequencies   that are affected by the EQ. An EQ band with a wide bandwidth will affect   a wider range of 
frequencies than one with a narrow bandwidth.
When discussing network connections, refers to the rate   of signals transmitted; the amount of data that can be 
transmitted in   a fixed amount of time (stated in bits/second): a 56 Kbps network connection   is capable of receiving 
56,000 bits of data per second.
Beats Per Minute (BPM)
The tempo of a piece of music can be written as a number   of beats in one minute. If the tempo is 60 BPM, a single 
beat will occur   once every second.
Bit
The most elementary unit in digital systems. Its value can   only be 1 or 0, corresponding to a voltage in an electronic 
circuit. Bits   are used to represent values in the binary numbering system. As an example,   the 8-bit binary number 
10011010 represents the unsigned value of 154   in the decimal system. In digital sampling, a binary number is used 
to   store individual sound levels, called samples.
Bit Depth
The number of bits used to represent a single sample. For   example, 8- or 16-bit are common sample sizes. While 8-
bit samples take   up less memory (and hard disk space), they are inherently noisier than   16-bit samples.
Buffer
Memory used as an intermediate repository in which data   is temporarily held while waiting to be transferred between 
two locations.   A buffer ensures that there is an uninterrupted flow of data between computers.   Media players may 
need to rebuffer when there is network congestion.
Bus
A virtual pathway where signals from tracks and effects   are mixed. A bus's output is a physical audio device in the 
computer from   which the signal will be heard.
Byte
Refers to a set of 8 bits. An 8-bit sample requires one   byte of memory to store, while a 16-bit sample takes two 
bytes of memory   to store

-C-
Clip
A clip refers to a media   file on a track. A single audio track can contain any combination of loops,   one-shots, or 
Beatmapped clips. MIDI tracks can contain only MIDI clips.
When a clip is used on the timeline, an event   is drawn to represent the clip. 

Glossary 319



Clipboard
The clipboard is where data that you have cut or copied   from an ACID project is stored. You can then paste the data 
back into   a project at a different location.
Clipping
Occurs when the amplitude of a sound is above the maximum   allowed recording level. In digital systems, clipping is 
seen as a clamping   of the data to a maximum value, such as 32,767 in 16-bit data. Clipping   causes sound to distort.
Codec
Coder/decoder: refers to any technology for compressing   and decompressing data. The term codec   can refer to 
software, hardware, or a combination of both technologies.
Compression Ratio (audio)
A compression ratio controls the ratio of input to output   levels above a specific threshold. This ratio determines how 
much a signal   has to rise above the threshold for every 1 dB of increase in the output.   For example, with a ratio of 3:1, 
the input level must increase by three   decibels to produce a one-decibel output-level increase:
Threshold   = -10 dB         
Compression   Ratio = 3:1         
Input   = -7dB         
Output   = -9 dB         
Because the input is 3dB louder than the threshold and the   compression ratio is 3:1, the resulting signal is 1 dB louder 
than the   threshold.
Compression Ratio (file size)
The ratio of the size of the original uncompressed file   to the compressed contents. For example, a 3:1 compression 
ratio means   that the compressed file is one-third the size of the original.
Computer ID
Each computer has a unique number, similar to a license   plate. An activation number is created   based on that 
number. Since the activation number is based on the Computer   ID, it is important that you have the software 
installed on the computer   where you will be using it. The Computer ID is automatically detected   and provided to you 
when you install the software.

The Computer ID is used for registration purposes only.   It doesn't give us access to any personal information 
and can't be used   for any purpose other than for generating a unique activation number for   you to use the 
software.

Crossfade
Mixing two pieces of audio by fading one out as the other   fades in.

-D-
DC Offset
DC offset occurs when hardware, such as a sound card, adds   DC current to a recorded audio signal. This current 
results in a recorded   wave is not centered around the zero baseline. Glitches and other unexpected   results can occur 
when sound effects are applied to files that contain   DC offsets.
In the following example, the red line represents 0 dB.   The lower waveform exhibits DC offset; note that the 
waveform is centered   approximately 2 dB above the baseline.
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Decibel (dB)
A unit used to represent a ratio between two numbers using   a logarithmic scale. For example, when comparing the 
numbers 14 and 7,   you could say 14 is two times greater than the number 7; or you could   say 14 is 6 dB greater than 
the number 7. Where did we pull that 6 dB   from? Engineers use the equation dB = 20 x log (V1/V2) when 
comparing   two instantaneous values. Decibels are commonly used when dealing with   sound because the ear 
perceives loudness in a logarithmic scale.
In an ACID project, most measurements are given in decibels.   For example, if you want to double the amplitude of a 
sound, you apply   a 6 dB gain. A sample value of 32,767 (maximum positive sample value for   16-bit sound) can be 
referred to as having a value of 0 dB. Likewise,   a sample value of 16,384 can be referred to having a value of -6 dB.
Device Driver
A program that enables Windows to connect different hardware   and software. For example, a sound card device 
driver is used by Windows   software to control sound card recording and playback.
Digital Rights Management (DRM)
A system for delivering songs, videos, and other media over   the Internet in a file format that protects copyrighted 
material. Current   proposals include some form of certificates that validate copyright ownership   and restrict 
unauthorized redistribution.
Digital Signal Processing (DSP)
A general term describing anything that alters digital data.   Signal processors have existed for a very long time (tone 
controls, distortion   boxes, wah-wah pedals) in the analog (electrical) domain. Digital Signal   Processors alter the data 
after it has been digitized by using a combination   of programming and mathematical techniques. DSP techniques are 
used to   perform many effects such as equalization   and reverb simulation.
Since most DSP is performed with simple arithmetic operations   (additions and multiplications), both your 
computer's processor and specialized   DSP chips can be used to perform any DSP operation. The difference is   that 
DSP chips are optimized specifically for mathematical functions while   your computer's microprocessor is not. This 
results in a difference in   processing speed.
Disk-Based Files
Disk-based files are usually longer audio clips that are   played from hard disk rather than being stored in RAM. Disk-
based files   are used for vocals or any other long audio file that does not loop.
Drag and Drop
A quick way to perform certain operations using the mouse.   To drag and drop, you click and hold a highlighted 
selection, drag it   (hold the left mouse button down and move the mouse) and drop it (let   go of the mouse button) at 
another position on the screen.
Dynamic Range
The difference between the maximum and minimum signal levels.   It can refer to a musical performance (high- 
volume vs. low-volume signals)   or to electrical equipment (peak level before distortion vs. noise floor).   For example, 
orchestral music has a wide dynamic range, while thrash metal   has a very small (always loud) range.

-E-
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Envelopes
Envelopes allow   you to automate the change of a certain parameter over time. In the case   of volume, you can create a 
fade out (which requires a change over time)   by adding an envelope and creating a point in the line to indicate where   
the fade starts. Then you pull the end point of the envelope down to -infinity.
Equalization (EQ)
Equalizing a sound file is a process by which certain frequency   bands are raised or lowered in level. EQ has various 
uses. The most common   use for an ACID project users is to simply adjust the subjective timbral   qualities of a 
sound.
Event
An instance of a media file on a track. An event may play   an entire media file or a portion of the file.

-F-
File Format
A file format specifies the way in which data is stored   on your floppy disks or hard drive. In Windows, the most 
common file format   is the Microsoft .wav format. For information on the different file formats   supported by ACID 
software, see "Opening a Project or File" on page 26 or "Save As" on page 35.
Frame Rate
Audio uses frame rates only for the purposes of synching   to video or other audio. To synchronize with audio a rate of 
30 non-drop   is typically used. To synchronize with video, 29.97 drop is usually used.
Frequency Spectrum
The frequency spectrum of a signal refers to its range of   frequencies. In audio, the frequency range is basically 20 Hz 
to 20,000   Hz. The frequency spectrum sometimes refers to the distribution of these   frequencies. For example, bass-
heavy sounds have a large frequency content   in the low end (20 Hz - 200 Hz) of the spectrum.

-G-
Groove
A groove refers to the rhythmic pattern of a piece of music.   By deviating from a machine-quantized beat, individual 
beats may be played   early or late to change the feel of the music. Applying a groove can simulate   the timing patterns 
of human musicians, lending a human feel to MIDI-generated   music or quantizing several distinct pieces of music 
to a common timing.

-H-
Hertz (Hz)
The unit of measurement for frequency or cycles per second   (CPS).

-I-
In-Place Plug-In
An in-place plug-in processes audio data so that the output   length always matches the input length. A non-in-place 
plug-in's output   length need not match a given input length at any time: for example, Time   Stretch, Gapper/Snipper, 
Pitch-Shift (without preserving duration), and   some Vibrato settings can create an output that is longer or shorter 
than   the input. 
Plug-ins that generate tails when there is no more input   but otherwise operate in-place (such as reverb and delay) 
are considered   in-place plug-ins.
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Insertion Point
The insertion point (also referred to as the cursor position)   is analogous to the cursor in a word processor. It is 
where markers or   commands may be inserted depending on the operation. The Insertion Point   appears as a vertical 
flashing black line and can be moved by clicking   the left mouse button anywhere in the full-view control area.

-L-
Loop
Loops are small audio clips that are designed to create   a repeating beat or pattern. Loops are usually one to four 
measures long   and are stored completely in RAM for playback.

-M-
Marker
A marker is an anchored,   accessible reference point in a file.
Media Control Interface (MCI)
A standard way for Windows programs to communicate with   multimedia devices such as sound cards and CD 
players. If a device has   an MCI device driver, it can easily be controlled by most multimedia Windows   software.
MIDI Clock
A MIDI device-specific timing reference. It is not absolute   time like MIDI Time Code (MTC); instead it is a tempo-
dependent number   of "ticks" per quarter note. MIDI clock is convenient for synchronizing   devices that need to 
perform tempo changes mid-song. ACID software supports   MIDI clock out, but does not support MIDI clock in.
MIDI Port
A MIDI port is the physical MIDI connection on a piece of   MIDI hardware. This port can be a MIDI in, out or 
through. Your computer   must have a MIDI-capable card to output MIDI time code to an external   device or to receive 
MIDI time code from an external device.
MIDI Time Code (MTC)
MTC is an addendum to the MIDI 1.0 specification and provides   a way to specify absolute time for synchronizing 
MIDI-capable applications.   MTC is essentially a MIDI representation of SMPTE time code.
Multiple-Bit-Rate Encoding
Multiple-bit-rate encoding (also known as Intelligent Streaming   for the Windows Media platform and SureStream™   
for the RealMedia G2 platform) allows you to create a single file that   contains streams for several bit rates. A 
multiple-bit-rate file can accommodate   users with different Internet connection speeds, or these files can 
automatically   change to a different bit rate to compensate for network congestion without   interrupting playback.

To take advantage of multiple-bit-rate encoding, you   must publish your media files to a Windows Media server 
or a RealServerG2.

Musical Instrument Device Interface (MIDI)
A standard language of control messages that provides for   communication between any MIDI-compliant devices. 
Anything from synthesizers   to lights to factory equipment can be controlled via MIDI. ACID software   uses MIDI for 
synchronization purposes.

-N-
Normalize
Refers to raising the volume so that the highest level sample   in the file reaches a user defined level. Use 
normalization to make sure   you are using all of the dynamic range available to you.
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Nyquist Frequency
The Nyquist Frequency (or Nyquist Rate) is one half of the   sample rate and represents the highest frequency that can 
be recorded   using the sample rate without aliasing. For example, the Nyquist Frequency   of 44,100 Hz is 22,050 Hz. 
Any frequencies higher than 22,050 Hz will   produce aliasing distortion in the sample if no anti-aliasing filter is   used 
while recording.

-O-
Offline Media
A media file that cannot be located on the computer. If   you choose to leave the media offline, you can continue to 
edit events   on the track; the events will point to the original location of the source   media file.
One-Shot
One-shots are RAM-based audio clips that are not designed   to loop. Things such as cymbal crashes and sound 
bites could be considered   one-shots. Longer files can be treated as one-shots if your computer has   sufficient 
memory.

-P-
Pan
To place a mono or stereo sound source perceptually between   2 or more speakers.
Peak Data File
The file created when a file is opened for the first time.   This file stores the information regarding the graphic display 
of the   waveform so that opening a file is almost instantaneous. This file is   stored in the directory where the audio file 
resides and has a .sfk extension.   If this file is not in the same directory as the audio file or is deleted,   it will be 
recalculated the next time you open the file.
Phase
Inverting the phase of sound data reverses the polarity   of a waveform around its baseline. Inverting a waveform does 
not change   the sound of a file; however, when you mix different sound files, phase   cancellation can occur, producing 
a "hollow" sound. Inverting   one of the files can prevent phase cancellation.
In the following example, the red line represents the baseline,   and the lower waveform is the inverted image of the 
upper waveform.

Pre-roll/Post-roll
Pre-roll is the amount of time elapsed before an event occurs.   Post-roll is the amount of time after the event. The 
time selection defines   the pre- and post-roll when recording into a selected event.
Proxy File
See Audio Proxy File.
Pulse Code Modulation (PCM)
PCM is the most common representation of uncompressed audio   signals. This method of coding yields the highest 
fidelity possible when   using digital storage. PCM is the standard format for .wav and .aif files.

-Q-
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Quantize
To conform to prescribed values. For example, if a recorded   MIDI file consisted of notes with irregular timing, you 
could quantize   the notes to a straight time. If a file consisted of notes played in straight   time, you could quantize 
those notes to a groove   to apply a different feel. Snapping is a form   of quantization that forces edits to divisions on 
the timeline grid or   ruler. 

-R-
Real-Time Streaming Protocol (RTSP)
A proposed standard for controlling broadcast of streaming   media. RTSP was submitted by a body of companies 
including RealNetworks   and Netscape.
Redirector File 
A metafile that provides information to a media player about   streaming-media files. To start a streaming media 
presentation, a Web   page will include a link to a redirector file. Linking to a redirector   file allows a file to stream; if 
you link to the media file, it will be   downloaded before playback.
Windows Media redirector files use the .asx   or .wax extension; RealMedia redirector files use the .ram, .rpm, or .smi   
extension.
Resample
The act of recalculating samples in a sound file at a different   rate than the file was originally recorded. If a sample is 
resampled at   a lower rate, sample points are removed from the sound file, decreasing   its size, but also decreasing its 
available frequency range. When resampling   to a higher sample rate, the software will interpolate extra sample 
points   in the sound file. This increases the size of the sound file, but does   not increase the quality. When down-
sampling, one must be aware of aliasing.

-S-
Sample
The word sample   is used in many different (and often confusing) ways when talking about   digital sound. Here are 
some of the different meanings:

 l A discrete point in time which a sound   signal is divided into when digitizing. For example, an audio CD-ROM 
contains   44,100 samples per second. Each sample is really only a number that contains   the amplitude value of a 
waveform measured over time.

 l A sound that has been recorded in   a digital format; used by musicians who make short recordings of musical   
instruments to be used for composition and performance of music or sound   effects. These recordings are called 
samples. In this Help system, we   try to use sound file instead   of sample whenever referring   to a digital 
recording.

 l The act of recording sound digitally,   i.e. to sample an instrument means to digitize and store it.

Sample Rate
The Sample Rate (also referred to as the Sampling Rate or   Sampling Frequency) is the number of samples per 
second used to store   a sound. High sample rates, such as 44,100 Hz provide higher fidelity   than lower sample rates, 
such as 11,025 Hz. However, more storage space   is required when using higher sample rates.
Sample Size
See Bit Depth.
Sample Value
The Sample Value (also referred to as sample amplitude)   is the number stored by a single sample. In 16-bit audio, 
these values   range from -32768 to 32767. In 8-bit audio, they range from -128 to 127.   The maximum allowed 
sample value is often referred to as 100% or 0 dB.
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Secure Digital Music Initiative (SDMI)
The Secure Digital Music Initiative (SDMI) is a consortium   of recording industry and technology companies 
organized to develop standards   for the secure distribution of digital music. The SDMI specification will   answer 
consumer demand for convenient accessibility to quality digital   music, enable copyright protection for artists' work, 
and enable technology   and music companies to build successful businesses.
Shortcut Menu
A context-sensitive menu that appears when you click on   certain areas of the screen. The functions available in the 
shortcut menu   depend on the object being clicked on as well as the state of the program.   As with any menu, you can 
select an item from the shortcut menu to perform   an operation. Shortcut menus are used frequently for quick access 
to many   commands.
Signal-to-Noise Ratio
The signal-to-noise ratio (SNR) is a measurement of the   difference between a recorded signal and noise levels. A 
high SNR is always   the goal.
The maximum signal-to-noise ratio of digital audio is determined   by the number of bits per sample. In 16-bit audio, 
the signal to noise   ratio is 96 dB, while in 8-bit audio its 48 dB. However, in practice this   SNR is never achieved, 
especially when using low-end electronics.
Society of Motion Picture and Television Engineers (SMPTE)
SMPTE time code is used to synchronize time between devices.   The time code is calculated in 
Hours:Minutes:Second:Frames, where Frames   are fractions of a second based on the frame rate. Frame rates for 
SMPTE   time code are 24, 25, 29.97 and 30 frames per second.
Streaming
A method of data transfer in which a file is played while   it is downloading. Streaming technologies allow Internet 
users to receive   data as a steady, continuous stream after a brief buffering period. Without   streaming, users would 
have to download files completely before playback.

-T-
Tempo
Tempo is the rhythmic rate of a musical composition, usually   specified in beats per minute (BPM).
Threshold
A threshold determines the level at which the signal processor   begins acting on the signal. During normalization, 
levels above this threshold   are attenuated (cut).
Time Format
The format used to display the time ruler and selection   times. These can include: Time, Seconds, Frames and all 
standard SMPTE   frame rates.
Track
A discrete timeline for audio data. Audio events sit on   tracks and determine when a sound starts and stops. Multiple 
audio tracks   are played together to give you a composite sound that you hear through   your speakers.
Track List
The Track List   contains the master controls for each track. From here you can adjust   the mix, select playback devices, 
and reorder tracks.
Track View
The majority of the Track View   is made up of the space where you will draw events on each track.

-U-
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µ-Law
µ-Law (mu-Law) is a companded compression   algorithm for voice signals defined by the Geneva Recommendations 
(G.711).   The G.711 recommendation defines µ-Law as a method of encoding 16-bit   PCM signals into a non-linear 8-
bit format. The algorithm is commonly   used in European and Asian telecommunications. µ-Law is very similar to   A-
Law, however, each uses a slightly different coder and decoder.
Undo/Redo
These commands allow you to change a project back to a previous   state, when you don't like the changes you have 
made, or reapply the changes   after you have undone them.

-V-
VSTi
A Virtual Studio Technology instrument (VSTi) is a software   synthesizer plug-in produced by Steinberg Media 
Technologies AG.

-W-
wav
An digital audio standard developed by Microsoft and IBM.   One minute of uncompressed audio requires 10 MB of 
storage.
Waveform
A waveform is the visual representation of wave-like phenomena,   such as sound or light. For example, when the 
amplitude of sound pressure   is graphed over time, pressure variations usually form a smooth waveform.
Waveform Display
Each event shows a graph of the sound data waveform. The   vertical axis corresponds to the amplitude of the wave. 
For 16-bit sounds,   the amplitude range is -32,768 to +32,767. For 8-bit sounds, the range   is -128 to +127. The 
horizontal axis corresponds to time, with the leftmost   point being the start of the waveform. In memory, the 
horizontal axis   corresponds to the number of samples from the start of the sound file.
Windows Media Format
Microsoft's Windows Media file   format that can handle audio and video presentations and other data such   as 
scripts, URL flips, images and HTML tags. Advanced Streaming Format   files can be saved with the .asf or .wma   
extensions. 
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.MID Files  297

5

5.1 Surround  184, 186, 193
Panning  186
Project Properties  19, 184
Rendering  193
Setup  184

A

Ableton Live  235
Absolute Frames  282
Acid Music Studio restrictions  11
ACID Project with Embedded Media  35
ACID Type for Recorded Audio  106
ACID Types  24
ACID Window  12
ACID Zip file  35
ACIDized Media  56
Active Control Devices  299
Add Channels Panning Mode  181
Add to Groove Pool  75
Add to Project (MIDI)  20, 214
Add to Project with Events (MIDI)  20, 214
Add to Project with Events Rippled (MIDI)  20, 214
Adding  42, 61-62, 153, 155-156, 166, 179

Busses  166
Effects  153
Effects to a Bus  155
Effects to a Soft Synth  156
Effects to a Track  153
Events to a Track  61-62
Groove to Groove Pool  76, 122
Tracks  22
Tracks to a CD  38

Adding Clips to a Track  53, 70, 251
Adding Input Busses  175
Adding MIDI Files to a Project  214
Adding MIDI Notes  236
Adding or Editing Note Information (Clip Properties)  256
Adding Plug-Ins  153, 160
Additional Transient Detection  76
Adjusting  99, 102, 146

Adjusting an Event's Length  99
Adjusting Envelopes  134, 138, 146
Adjusting Quick Fades  102

Advanced Audio Preferences  289
Advanced File Settings  36
Advanced Sync Preferences  294

Aftertouch (Clip Properties)  263
Allow Snapping for Post-Groove Markers  285
Apply Groove  123
Arm for Record  45
arpeggiator  114, 246, 274
Arranging Tracks  43, 45, 242
ASIO Audio Drops Out  315
ASIO Configuration  289
ASIO Device and Port Naming  281
ASR  100
Assignable FX  179-180

Adding an Assignable Effects Chain  179
Assignable FX Envelopes  134
Routing Tracks to Assignable Effects  180
Using Assignable Effects  179

Assigning Soft Synths to Busses  167, 221
Assigning Tracks to Busses  169
Audio  84, 157, 165, 287, 289, 310

Buffers  290
Bypassing Audio Effects  165
Device Preferences  290
Editors  84
Plug-In Window  157
Preferences  287
Properties  19
Signal Flow  310

Audio Device Preferences  290
Audio Device Type  291
Audio Track Properties  53
Auto MIDI Input Routing  292
Autodetected  45
Automatable Plug-Ins Don't Appear in Folder  315
Automatic Crossfades (Ctrl+Shift+X)  69
Automatically Detect and Offset for Hardware Recording 

Latency  290
Automatically Open Last Project on Startup  285
Automatically Render Large Wave Files as Wave64  285
Automatically Start Beatmapper Wizard for Long 

Files  285
Automating Effects  134, 142
Automating Effects with Envelopes  144
Automating VSTi Parameters  219
Automation  138
Automation Envelopes  134, 137, 142, 145
Automation Overview  134
Automation with Generic Control Surfaces  211
Automation, Recording Parameters  149
Autoname Extracted CD Tracks  285
Autoname New MIDI Tracks  285
Autosave  286
Auxiliary Bus Envelopes  134
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B

Backward Events  95, 101
Balance Panning Mode  181
Bank LSB (Clip Properties)  263
Bank MSB (Clip Properties)  263
Banks  160, 217

VST Effects  157
VSTi  217

Beat Anchor  78
Beat Markers  78
Beat Ruler  13
Beatmap Markers  58
Beatmapped Clips  24, 58
Beatmapper Wizard  56, 58
Both Channels  75
Bounce Tracks  55
Buffer Size  290
Burning CDs  38-39
Busses  166

Adding  166
Assigning Tracks to Busses  169
Bus Envelopes  136
Bus Tracks (B)  142
Deleting  166
Effects  155
Renaming  166
Routing Busses  167
Using  166

Bypass  157, 165, 218
Bypass VSTi  217
Bypass/Enable FX Automation  157
Bypassing Audio Effects  165

C

Cancelling Operations  17
CC Messages  268
CD  25, 38-39

Burning Disc-at-Once (Red Book) CDs  39
Burning Track-at-Once CDs  38
Extracting Audio From  25

Changing MIDI Note Duration  265
Changing Tempo and Key  31
Changing Track Height  45
Channels  76
Channels in MIDI Files  214, 242, 273
Chasing MIDI Timecode  275
Choosing a Drum Map for a Track  236
Chop to New  96
Chopper (Alt+2)  95
Clean Clip Pool  70, 90
Clear  90
Clear Undo History  90
Click Track  29
Clicks in Playback  285
Clip Colors  70
Clip Pool  53, 251

Clip Take Offset  78, 110
Clips  70

Clip Properties (Ctrl+Alt+3)  70
Editing Audio Clip Properties  76
Editing in an Audio Editor  84
Editing MIDI Clip Properties  253

Clips - Overview  70
Cloning Grooves  125
Cloning Loops  95
Close Audio and MIDI Ports When ACID is Not the Act

ive Application  285
Close Media Files When ACID is Not the Active Applic

ation  285
Closing a CD Project  38
Collapse Track Keyframes  186
Color  75
Combine Channels  75
Combine Events  93
Commands, Metadata  130
Condense Tracks  43
Configure Soft Synth Parameter Automation  219
Confirm Groove Deletion When Still in Use  285
Confirm Media File Deletion When Still in Use  285
Conserving CPU Processing  165
Consolidate Tracks  43
Constant Power Panning Mode  181
Contacting Technical Support  10
Continue Command  296
Continuous Controllers  138, 242
Control Surfaces  200, 207, 209, 211, 298
Controller Change Number (Clip Properties)  263
Controller Change Value (Clip Properties)  263
Controller Envelopes  140
Controller Maps  251, 268
Controllers, MIDI  222
Convert to Stretch Marker  81
Copy  16
Copy (Ctrl+C)  45, 87
Copy Envelope  146
Copy to New Clip  53, 70, 236, 251
Count-In  29
Countoff (Metronome)  29
Create Empty MIDI Clip  70
Creating  39-40, 95, 125, 157, 285

Disc-at-Once CDs  39
Events During Playback  61-62
FX Chain Presets  157
Grooves  125
Loops with the Chopper  95
Project File Backups on Save  286
Track-at-Once CDs  38
Undos for FX Parameter Changes  285

Creating Drum Maps  271
Creating Program (Patch) Maps  269
Creating Tracks  42
Crossfades  69
Cue Microphone  175
Curves, Tempo  31
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Custom Keyboard Shortcuts  279
Custom Rendering Templates  36
Custom Time Signature Dialog  31
Customizing ACID  279
Customizing ASIO Device and Port Naming  281
Customizing the Toolbar  279
Cut  16
Cut (Ctrl+X)  45, 87
Cutting, Copying, and Pasting MIDI Notes  236

D

DAO  39
Data LSB (Clip Properties)  263
Data MSB (Clip Properties)  263
Default  46, 123, 284, 297

Groove Folder  298
Groove for New Tracks  123
Project Folder  297
Track Height  46
Track Properties  284

Default Audio Recording Device  290
Default Center and LFE Playback Device  290
Default Rear Playback Device  291
Delay Compensation  106, 153, 155-156, 179
Delete  128, 167, 194

Busses  166
Events (Del)  90
Marker  128
MIDI Notes  237
Video  194

Deleting Input Busses  175
Deleting MIDI Events (Clip Properties)  261
Destructive MIDI Processing and Filtering  265
Device Names, Customizing for ASIO Devices  281
DirectX Plug-ins  153
Display Preferences  296
DLS Soft Synths  45
Draw Contents of Events  285
Draw Tool  16, 61-62
Drawing Envelopes  146, 285
Drawing Looped MIDI Events  251
Drum Maps  271
Drum Maps, Choosing  236
Duplicating Grooves  125
Duration MIDI Filter  265

E

E-mail  10
Edit

Editing Tool  62
Edit in Sound Forge  84
Edit Keyboard Shortcuts  279
Edit Source Project  34, 75-76
Editable Event Parameters (Clip Properties)  263

Editing  45, 61, 76, 84, 87, 221, 253, 294
Cutting, Copying, and Pasting Events  87
Cutting, Copying, and Pasting Tracks  45
Drum Maps  271
Edit in Audio Editor  84
Events  61
MIDI Clip Properties  253
MIDI Events  236
MIDI Notes on the Timeline  236
MIDI Track Properties  253
Note Duration  241
Note Position  240
Preferences  294
Program (Patch) Maps  269
Soft Synths  221
Track Properties  76
Tracks  42

Editing ASIO Device and Port Naming  281
Editing Controller Maps  268
Editing Frozen MIDI Tracks  249
Editing the Key of a MIDI Clip  251
Editing Tool  62
Effects  153, 155-156, 179, 181

Assignable Effects  179
Assignable Effects Envelopes  181
Automation Envelopes  137
Bus Effects  155
Effects Packages  157
FX Automation, Enabling/Bypassing  157
FX Packages  157
FXB Presets for VST/VSTi  157, 217
FXP Presets for VS/VSTi  157, 217
Soft Synth Effects  156
Track Effects  153

Effects Envelopes  144
Élastique  76
Embedded Media  35
Enable Automation for a Generic Control Surface  211
Enable Autosave  285
Enable Envelope Drawing  285
Enable Inline MIDI Editing  16
Enable Media Manager  285
Enable Metronome Countoff  30
Enable Multimedia Keyboard Support  285
Enable Multiple-Selection Preview in Explorer 

Window  297
Enable or Bypass FX Automation  157
Enable Real-Time MIDI  222, 316
Enable Snapping  16
Enable Track Buffering  290
Enable Windows XP Theme Support  285
Envelope Thinning  146
Envelope Tool  16
Envelopes  134, 142, 146

Assignable FX  134
Changing Colors  296
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Effects Parameter Envelopes  134
Envelope Tool  62
Event  100
Locking to Events  134
Pan  134
Using  134
Volume  134

Erase Tool  17, 64
Erasing CD-RW Discs  38
European Broadcasting Union  283
Event Clip Settings  75
Events  61-62, 68, 87, 100-101

Adding to Tracks  61-62
Changing Length  62
Copying  87
Cutting  87
Editing  61, 93-94
Envelopes  100
Event Length  62
Modifying Properties  101
Pasting  87
Pitch-Shifting  67, 101
Reversing  95, 101
Selecting  65
Sliding  99
Slip Trimming  99
Slipping  99
Snapping  87
Stretching  76
Trimming  99

Events at Play Cursor  61-62
Expand Track Keyframes  186
Explorer Window (Alt+1)  20
Export  35, 37, 125

Grooves  125
Keyboard Map  280
Loops  37
MIDI Clips  273
MIDI Tracks  273
Projects  35, 273
Tracks  36, 273

External Control & Automation Preferences  298
External Control Surface  199, 207, 209, 211, 298
External Editor, Updating Track Properties After 

Editing  76
External Effects Processors  172
External MIDI Device Program Maps  269
External MIDI Devices  222
External MIDI Inputs, Routing to Soft Synths  221
External MIDI Outputs, Soloing  221
External Synthesizers  174
External Video Monitor  196
Extra Mono Ports (ReWire)  289
Extra Stereo Ports (ReWire)  289
Extracting from CD  25

F

Fade Offset  100
Fade Properties  134, 148
FaderPort  209
Fast Tempo Transition  31
Filtering MIDI Events  261
Fit To Time  33
Fixed (Sliced) Segments  76
Flip Envelope  146
Flushing VSTi Buffers  315
Folder Preferences  297
Folder Tracks (Ctrl+Alt+F)  43
Formant Shift  77
Four-Bar Countoff  30
Free-Wheel  295
Freeze Track (MIDI)  249
Freeze Tracks  55
Frontier TranzPort  207
FX  153, 155-156, 179, 181

Assignable Effects  179
Assignable Effects Envelopes  181
Automation Envelopes  137
Bus Effects  155
Effects Packages  157
FX Automation, Enabling/Bypassing  157
FX Packages  157
FXB Presets for VST/VSTi  157, 217
FXP Presets for VST/VSTi  157, 217
Soft Synth Effects  156
Track Effects  153

G

Gain and Automation/Trim Controls  134
Gain Offset  134
Gapping Audio Playback  315
Generating MIDI Clock (Shift+F7)  275, 277, 294
Generating MIDI Timecode (F7)  275, 294
Generic Control Surface  211
Get Media From the Web  16
Getting Around  12
Go To (Ctrl+G / Shift+G)  67
Go to End (Ctrl+End)  14
Go to Start (Ctrl+Home)  14
Grid Spacing  283
Groove Erase Tool  16
Groove Tool  16
Grooves  122, 125

Creating  76, 125
Duplicating  125
Exporting  125
Groove Cloning  125
Groove Erase Tool  65
Groove Markers, Snapping  285
Groove Pool  122
Groove Strips  123
Groove Tool  64
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Grooves and the Metronome  29
Importing  125
Overview  122

Grovel for Plug-Ins  153

H

Hardware Synthesizer Modules  174
Hit Marker (H)  129
Hold  32
Hold Tempo Transition  31
host ctrl #  229
host learn  229
How to Create a Basic Project  18

I

Icon Color Saturation  296
Icon Color Tint  296
If Project is Invalid for DV Output, Conform to the Fol

lowing  293
Import Keyboard Map  279
Importing Grooves  125
In-Place MIDI Editing  236
Input Busses  175-176
Input Busses and MIDI Tracks  174
Input Device for MIDI Ports  292
Input Filters  119, 251
Input Monitor  107, 176
Insert  44, 61-62, 130

Assignable FX  179
Audio Track (Ctrl+Q)  42
Bus  166
Event at the Play Cursor (Y)  61-62
Folder Track (Ctrl+Alt+F)  43
Metadata Commands  133
MIDI Track (Ctrl+Alt+Q)  42
Section (Shift+S)  84
Time  62

Insert Bus  166
Insert Event button (Clip Properties)  261
Insert Events at Play Cursor  61
Insert Silence  62
Interpolate Position  289
Invert Envelope  146
Invert Phase  75
Invert Surround Panning Keyframes  186
Invert Track Phase  47

J

Joining Events (J)  93

K

Keep Bypassed FX Running  285
Key  31
Key Bindings  279

Key, Changing for MIDI Clips  251
Keyboard Preferences  279
Keyboard Shortcuts  300
Keyframes  247
Keyframes, Tempo  31

L

Latency  291
Left Only  76
Legacy Track Send Gain  289
LFE  192
Linear Tempo Transition  31
Link to Main Track Pan  45, 169
Listening to Your Creation  28
Load Bank  217
Lock Envelopes to Events  16, 138
Locking Events  102
Loop Clips  24, 253
Loop Cloning  95
Looped MIDI Events  251
Looped Playback (Q or Ctrl+Shift+L)  28
Looping Segments  79
Loops  37
Loops, Creating  95
Low-Pass Filter for LFE Channel  19

M

Manually Beatmapping Clips  58
Maps, Groove  122
Markers (M)  128
Markers/Command  130
Master Bus  166
Maximize Track  45
Measure Markers  58
Measures, Marking while Recording  106
Media  20
Media Catalog Number (MCN) for DAO CDs  19
Media Explorer  20
Media Manager, Turning Off  285
Media Types  24
Merge Envelope Data  138, 253
Merge Events  93
Merge Recording  113
Message Filter (MIDI Input)  119
Metronome  15-16, 29
Metronome Countoff  15
Microsoft GS Wavetable Synth Doesn't Open  315
MIDI  214

Channels  253
Clip Properties  253
Controllers  222
Effects  156
External Devices  222
Input Device  114, 223
MIDI Clip Time Signature  251
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MIDI Controller Data, Displaying on the Timeline  138, 
253

MIDI Events, Joining  93
MIDI Export  273
MIDI Files, Adding to Projects  20
MIDI Filters  265
MIDI Input Devices  292
MIDI Input Filters  119
MIDI Merge Recording  113
MIDI Port in Use  315
MIDI Preferences  292
MIDI Recording  115
MIDI Step Record  116
MIDI Track Channel  242
MIDI Track Output  216
MIDI Track Playback Devices  113, 292
MIDI Track Properties  251
MIDI Track Voice  242
MIDI Tracks Make No Sound  315
Output Device  216, 222
Piano Roll  236
Plug-Ins (OPT)  253
Recording  113
Stuck Notes  275
Thru Ports  113

MIDI Clip Key  251
MIDI Controller Maps  268
midi ctrl #  229
MIDI File Locations  297
midi learn  229
MIDI plugins  274
MIDI Track Freeze  249
MIDI Zones (Split Keyboard) Using Input Filters  119
Minimize Track Height (~)  45
Mirror Envelope  146
Mix to New Track  55
Mixer  166
Mixing Audio  166, 186
Mixing Console  166
Monitoring an External Source  175
Monitoring Clip Stretching  56
Moving a Marker  128
Moving Events  68
Moving Tracks  43
MTC  275-276
Multichannel MIDI Files  214
Multiple-Selection Preview in Explorer Window  297
Multiple Input Devices, Recording to a Single Track  113
Multiple Media Files per Track  70
Multiple Mono  35
Multiple Selection Preview  20
Multiple Stereo  35
Multiport VST Instruments  217
Multiprocessor Track Rendering  290
Multitempo Files  56
Multitrack MIDI Files  214
Mute (Z)  45
Mute Envelope  138

Muting Events  102
Muting Folder Tracks  43
My Favorites  21

N

Naming a Marker  128
Navigating  12, 18
New  16
New Features  9
New Groove  125
New in Version 7  9
New Project  19
New Track  55
Next Clip  76
Nonlooping Segments  76
Normalize  75
Normalize Peak Level  289
Note Duration  241, 267
NRP LSB (Clip Properties)  263
NRP MSB (Clip Properties)  263
Number of Beatmapped Measures to Play  297
Number of Beats  76
Number of Extra Mono Ports (ReWire)  289
Number of Extra Stereo Ports (ReWire)  289
Number of Times to Repeat Each Loop  297

O

Off Velocity (Clip Properties)  263
Offset  283
Offsetting Gain  134
One-Bar Countoff  30
One-Shot Clips  24, 253
Online Support  10
Open  16, 26
Open as New Project (MIDI)  20, 214
Open Files as Loops if Between  287
Open in Audio Editor  84
Opening MIDI Files  20
OPT  254
OPT Envelopes, Merging to Events  138
Optimizing a File  56
Orion  235
Other Preferences  297
Outboard Effects Processors  172
Outboard Synthesizers  174
Output Settings  251
Outputs  42, 166-167
Outputs, VST Instruments with Multiple Outputs  217
Overlapping Events  69
Override Default MIDI Volume or Pan Envelope 

Mapping  138, 268

P

Packed NRPN (Clip Properties)  263
Packed RPN (Clip Properties)  263
Paint Length (for MIDI and One Shots)  61-62
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Paint Tool  16, 61, 63
Pan  45
Pan Envelopes  137
Panic Button (MIDI)  275
Panning  186
Panning Modes  45, 181
Parameter Automation in VST Instruments  219
Paste  16, 87

Events Across Tracks  87
Paste Events at Play Cursor (Shift+Y)  62
Paste Insert (Ctrl+Shift+V)  87
Paste Repeat (Ctrl+B)  87
Pasting Tracks (Ctrl+V)  45

Path  310
Pause  14
Pen  63
Pencil  62
Piano Roll  236
Pitch-Shift Event  67
Pitch-Shifting Tracks  45
Pitch Shift Segments  79
Play  14, 28
Play All  14
Play Cursor, Adding Events  61-62
Play Looped  14, 28
Play Quantized  78
Playback  28, 42
Playback Buffering  290
Playing from the List Editor (Clip Properties)  262
Playing from the Piano Roll (Clip Properties)  260
Plug-and-Play CD/DVD Drive Detection  285
Plug-In Chain  153, 180
Plug-In Chooser, Adding Effects  153
Plug-In Delay Compensation  106, 153, 155-156, 179
Plug-In Manager (Ctrl+Alt+1)  160
Plug-In Window  157
Plug-Ins  153, 160
Port Names, Customizing for ASIO Devices  281
Ports, Multiport VST Instruments  217
Position Bias  289
Post Volume  169, 180
Pre-Roll Buffers Before Starting Playback  290
Pre Volume  181
Prefader Sends Listen to Mute  289
Preferences  285

Audio  287
Audio Device  290
Display  296
Editing  294
External Control & Automation  298
Folder  297
General  285
Keyboard  279
MIDI  292
Other  297
Sync  294

Video  293
Preserve Formants when Stretching  76
Preserve Pitch for New Beatmapped Tracks When Tempo 

Changes  285
Presets  153, 159
PreSonus FaderPort  209
Previewing (Clip Properties)  262
Previewing 5.1 Surround Projects  184
Previewing Media  20
Previewing MIDI Events (Clip Properties)  262
Previous Clip  76
Program Change Keyframe  247
Program Changes  247
Program Map Editor  269
Project Tempo Range  294
Projects  18

Project Key  31
Project Path  34, 84
Project Path in Rendered File  34, 76
Project Properties  19
Project Tempo  31
Project Tempo Range  294
Project Time Signature  31

Prompt for Region and Marker Names if Not Playing  285
Properties  19, 53, 101, 251
ProTools  236
Publish  16
Punch-In Recording  110

Q

Quantize
Quantize Playback  76

Quantize (Clip Properties)  261
Quantize Filter (MIDI Input)  119
Quantize MIDI  265
Quick Fade Edit Edges of Audio Events  101, 287

R

Real-Time Rendering  178
Record  14
Record Device Selector  45
Record Offset  106
Recording  106, 113, 149, 176

Audio (Ctrl+R)  106, 176
Automation  149
MIDI (Ctrl+R)  113
Record Action when Nothing is Armed  106
Record Folder  297

Recording Automation with a Generic Control 
Surface  211

Recording Multiple MIDI Devices  113
Recording VSTi Parameters Automation  219
Red Plug-In Icon  153
Redetect Beats  76
Redo  16
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Redo (Ctrl+Y)  90
Region (R)  129
Regions to Denote Measures in Recorded Files  106
Remixing  95
Remove from Project  53, 252
Remove from Project and Delete File(s)  53
Remove Groove from Track  122
Remove Unused Clips  53, 74, 251
Remove Unused Events  90
Remove Unused Grooves  124
Remove Video  194
Rename  75
Rename Clip  70
Rendering  35, 37, 55, 178, 193

Render Temporary Image Before Burning  38
Render to New Track (Ctrl+M)  55
Rendering Each Bus to a Separate File  35
Rendering Files  35
Rendering Projects with MIDI Tracks  37
Rendering Your 5.1-Channel Mix  193

Reordering Tracks  45
Replacing a Track  76
Resetting MIDI Ports (Ctrl+Alt+F7)  275
Restore Track Height  45
Reverse Event (U)  95, 101
ReWire Overview  231

ReWire Device Driver Preferences  289
ReWire Device Mode  233
ReWire Mixer Mode  231

Rewritable CD  38
Right Only  75
Ripple Edits (Ctrl+L)  91
Root Note for Transposing  76
Routing  167, 216, 221

Busses to Busses  167
Busses to Hardware Outputs  167
Soft Synths  167, 221
Tracks to Soft Synths or MIDI Ports  216

Routing Soft Synths to Busses  221
Routing Tracks to Busses  169
Ruler Format  282

S

Samples  282
Save  16
Save Each Track as a Separate File  35
Saving  34-35

ACID Projects (Ctrl+S)  34
Media-Usage Relationships in Active Media 

Library  285
Save As  35
VST Effect Banks  157
VST Instrument Banks  217

Scanning For Plug-Ins  153, 160
Scoring  195
Scroll Bars  13
Seconds  282

Seconds of Each One-Shot to Play  297
Section Colors  296
Sections  84
Selecting  42-43, 63

Events  65
MIDI Notes  237
Playback Devices  42
Select All (Ctrl+A)  65
Select Tool  62
Tracks  43

Selection Tool  17
Set Controls to Default Values when Automation is 

Turned Off  298
Setting Default Track Properties  284
Setting the Input Device for MIDI Ports  292
Setting Track and Event Properties  76, 101
Setting Up the Piano Roll View (Clip Properties)  255
Sharp Tempo Transition  31
Shortcuts  300
Show Full-Size Groove Strips  122
Show Logo Splash Screen on Startup  285
Show Output Meters  45
Signal Flow Diagram  310
Silence  62
Skipping Audio  315
Sliced Segments  79
Sliding Events  99, 194
Slip-Trimming Events  99
Slipping Events  99, 194
Smooth and Thin Automation Data After Recording  298
Smooth Tempo Transition  31
Smoothness  191
SMPTE Drop - 30 fps  282
SMPTE EBU - 25 fps  282
SMPTE Film Sync - 24 fps  282
SMPTE Non-Drop - 29.97 fps  282
SMPTE Non-Drop 30 - 30 fps  282
Snap to Scale (Clip Properties)  256
Snapping (F8 / Ctrl+F8)  87

Snap Offset  195
Snap to Grid  283

Soft Synth  37, 42, 167, 219, 221, 231
Adding  216
Editing Soft Synths  221
Muting / Soloing  221
Rendering Projects with MIDI Tracks  37
Routing to Busses  167, 221
Routing Tracks  216
Selecting Playback Devices  42
Soft Synth Automation Envelopes  219

Soft Synth Parameter Automation  219
Solo (X)  45
Solo External MIDI Inputs  222
Solo Listen to MIDI Input  221
Solo Track  260
Soloing Folder Tracks  43
Sonar  234
Sorting Tracks  43
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Sound Forge  84
Source Project  34, 84
Splitting a MIDI Keyboard Using MIDI Input Filters  119
Splitting Events (S)  93
Start Offset  101
Start Time (Clip Properties)  263
Starting a New Project (Ctrl+N)  19
Static Control, Audio Track Gain and Panning  45
Static Control, MIDI Tracks  138
Static Control, Surround Panning and Center Channel 

Gain  186
Static Controls vs. Automation Controls  134
Status Bar  17
Stems, Velocity  236
Step Recording  113
step sequencer  114, 246
Step sequencer  274
Stop  14
Stretching  57, 76

Stretch Markers  79
Stretch/compress  56
Stretching Mode for Beatmapped Tracks  76

Stuck Notes  275
Summary Information (Alt+Enter)  19
Support, Contacting  10
Surround  184, 186, 193

Panning  186
Project Properties  19, 184
Rendering  193
Setup  184
Surround Panner Window  186
Surround Projects  19

Swap Channels  75
Synchronization  275-277, 294

MIDI Clock (Shift+F7)  277
Synchronization Offset  275
Synchronizing ACID with ReWire Synths  231
Synchronizing Audio and Video  195
Timecode (F7)  275-276
Video Sync Offset (Frames)  293

Synth Control of Patch  242
Synthesizer Modules  174
Sysex Keyframe  142

T

Takes  106
Talkback Microphone  175
TAO  38
Tap Rhythm  62
Technical Support  10
Templates  36
Tempo  31, 56
Tempo Changes  58
Tempo Curve Segmentation  33, 294
Tempo Transitions  31

Tempo/Key/Time Signature Change (T/K)  31
Temporary Files Folder  298
Temporary Image File  38
Text Event  (Clip Properties)  263
The Toolbar  16
The Video Track  194
The Video Window  196
Thin Automation Data After Recording  298
Time  76, 282
Time & Frames  282
Time Display  284
Time Display window  67
Time Marker (H)  129
Time Ruler Offset  283
Time Selection  66
Time Selection Tool  16, 64
Time Signature for MIDI Clips  251
Time Signatures (T)  31
Time Window  284
Time/ Zoom Level  255
Timecode  275-276

Generating (F7)  275
Synchronization  275
Timecode Offset  275
Triggering From (Ctrl+F7)  276

Timeline (Track View)  12, 283
Timeline MIDI Editing  236
Toolbar  16, 279
Tools  13
Tools, Editing  62
Track Buffering  292
Track Color  70
Track Colors  296
Track Freeze  55
Track Output Meters  45
Track Phase  47
Track Prefader Sends Listen to Mute  287
Track Properties  53, 251
Track View (Timeline)  12, 61-62, 128

Adding Events  61-62
Inline MIDI Editing  236
Markers  128

Tracks  42, 45, 76, 169
Adding  22
Applying Envelopes  142
Bouncing  55
Changing Color  45
Changing Height  45
Editing Audio Track Properties  53
Editing MIDI Track Properties  251
Height  13, 46
Muting (Z)  45
Panning  45
Pitch Shifting (+/-)  45
Reordering  45
Replacing  76
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Selecting  43
Selecting Playback Devices  42
Setting Default Properties  284
Soloing (X)  45
Track Folders  43
Track FX  153
Track List  12, 15, 42, 45
Types of Media  24
Volume  45

Tracktion  234
Transitioning Tempo  31
Transport Controls  14, 28, 199, 207, 209
Transposing MIDI Clips  251
TranzPort  207
Trigger from MIDI Timecode (Ctrl+F7)  276
Trim (Ctrl+T)  94, 99, 194
Trim Control  49, 134, 138, 187

Trim Control, Audio Track Gain and Panning  45
Trim Control, MIDI Tracks  138
Trim Control, Surround Panning and Center Channel 

Gain  186
Trim Controls vs. Automation Controls  134

Troubleshooting  315
Two-Bar Countoff  30
Type 0 MIDI Files  23
Type 1 MIDI Files  23

U

Undo  16
Undo (Ctrl+Z)  90
Undo All  91
Undo/Redo History list  90
Unfreeze MIDI Tracks  249
Universal Product Code (UPC) for DAO CDs  19
Unused Media, Deleting from Project  70, 90
Updating Track Properties After Editing in External 

Editor  76
Use as Track Pan  242, 268
Use as Track Volume  138, 242, 268
Use Bright Colors for Loop Stretch Markers  285
Use Device Patch Map  242
Use Legacy Track Send Gain  289
Use Net Notify to Stay Informed About MAGIX 

Products  285
Use Original Tempo  75
Use Program Change and Bank  242
Use Slower Updates to Prevent Playback Clicks During 

Editing  285
Use SPTI for CD Burning  285
Use Vertical Meters  45
Using

Beatmapper Wizard  56
Bus Effects  155
Chopper Window (Alt+2)  95
Control Surfaces  200, 207, 211, 298
Envelopes  134
External Video Monitor  196

Track Effects  153
Using External Effects  172
Using Hardware-Based Effects  172
Using Input Busses  175
Using the List Editor  261
Using the Piano Roll (Clip Properties)  254
Usint External (Hardware) Synthesizers  174

V

Velocity  (Clip Properties)  263
Velocity (Clip Properties)  258
Velocity Filter (MIDI Input)  119
Velocity Stems  241
Video  194-195
Video Preferences  293
VITA  229
Vita Sampler  230
Vita Solo instruments  229
Vita Solo Instruments  227
Volume  45, 100
Volume Envelopes (V)  134
Volume, Metronome  29
VST  157, 217, 219

VST Effects  153, 156, 179
VST Instruments  217
VSTi  217
VSTi Buffers  315
VSTi Parameters, Automating  219

VST Instruments with Multiple Outputs  217

W

Waveform Color  70
What's New in This Version  8
Window Docking Area  12, 15
Windows XP Theme Support  296
Working with Grooves  122
Working with Video  194

Y

Yellow Plug-In Icon  153

Z

Zoom (F9 / Ctrl+F9 / Shift+F9)  13
Zoom Level  256
Zoom Time  256
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